Basic Customization

AutoCADP® is a general-purpose drafting system designed with an open
architecture so you can customize and extend its many features. As a result, you
can expand and shape AutoCAD according to your needs.

Topics in this section

= QOverview of Customization

m  Organize Program and Support Files

You can change the default directory structure for the program and
support files to suit your needs.

m  Customize a Publish to Web Template
You can create customized templates to use in the Publish to Web wizard
by modifying one of the Publish to Web template (PWT) files provided.
Use any HTML editor or text editor.

=  Define Custom Commands

You can define external commands that run from within AutoCAD. You
can also create command aliases for AutoCAD commands in the
acad.pgp file, an ASCII text file that stores command definitions.
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Basic Customization > Overview of Customization >

Overview of Customization

I” Quick Reference 1

Commands
CUSTOMIZE
Customizes tool palettes

CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

REDEFINE
Restores AutoCAD internal commands overridden by UNDEFINE

UNDEFINE
Allows an application-defined command to override an internal command

System Variables
TOQOLTIPS

Controls the display of tooltips on toolbars

Utilities

No entries

Command Modifiers
No entries
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Basic Customization >

Organize Program and Support Files

You can change the default directory structure for the program and support files
to suit your needs.

Topics in this section

= QOverview of File Organization
m  Multiple Configurations

If you use more than one pointing device or use different plotters, you
can set up more than one configuration file to make it easy to switch
between devices.

=  Multiple Drawing Folders

Keeping your drawing and other associated files in separate directories
makes it easier to perform basic file maintenance.
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Basic Customization > Organize Program and Support Files > Overview of File
Organization >

Overview of File Organization
I” Quick Reference 1

Commands
OPTIONS
Customizes the program settings

System Variables
LOCALROOTPREFIX

Stores the full path to the root folder where local customizable files were
installed
ROAMABLEROQOTPREFIX

Stores the full path to the root folder where roamable customizable files were
installed

Utilities

No entries

Command Modifiers
No entries
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Basic Customization > Organize Program and Support Files > Multiple
Configurations >

Multiple Configurations
I” Quick Reference 1

Commands
OPTIONS
Customizes the program settings

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Basic Customization > Organize Program and Support Files > Multiple Drawing
Folders >

Multiple Drawing Folders
I” Quick Reference 1

Commands
No entries

System Variables
CMDECHO

Controls whether prompts and input are echoed during the AutoLISP command
function

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page



ms-its:ACAD_ACR.chm::/CMDECHO.htm
javascript:doComments('./html/ac.cmtdialog.htm');

Basic Customization > Customize a Publish to Web Template >

Customize a Publish to Web Template
I"” Quick Reference 1

Commands
PUBLISHTOWEB
Creates HTML pages that include images of selected drawings

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Basic Customization > Define Custom Commands >

Define Custom Commands

I” Procedure 1

To open the program parameters file (acad.pgp)
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Basic Customization > Define Custom Commands > Define External
Commands >

Define External Commands
I"” Quick Reference 1

Commands
REINIT

Reinitializes the digitizer, digitizer input/output port, and program parameters
file

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Basic Customization > Define Custom Commands > Create Command Aliases >

Create Command Aliases

I” Quick Reference 1

Commands
REINIT

Reinitializes the digitizer, digitizer input/output port, and program parameters
file

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Custom Linetypes

A library of standard linetypes is provided in the acad.lin and acadiso.lin files.
You can use the linetypes as they are, modify them, or create your own custom
linetypes.

Topics in this section

= QOverview of Linetype Definitions

Linetypes are defined in one or more linetype definition files that have a
lin file extension.

=  Simple Custom Linetypes

Each linetype is defined on two lines in a linetype definition file. The
first line contains the linetype name and an optional description. The
second line is the code that defines the actual linetype pattern.

m  Text in Custom Linetypes
Characters from text fonts can be included in linetypes.

=  Shapes in Custom Linetypes

A complex linetype can contain embedded shapes that are saved in shape
files. Complex linetypes can denote utilities, boundaries, contours, and
SO On.
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Custom Linetypes > Overview of Linetype Definitions >
Overview of Linetype Definitions

I” Quick Reference 1

Commands
LINETYPE
Loads, sets, and modifies linetypes

System Variables
MEASUREINIT

Controls whether a drawing you start from scratch uses imperial or metric
default settings

Utilities

No entries

Command Modifiers
No entries
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Custom Linetypes > Simple Custom Linetypes >
Simple Custom Linetypes

I"” Quick Reference 1

Commands
LINETYPE
Loads, sets, and modifies linetypes

System Variables
MEASUREINIT

Controls whether a drawing you start from scratch uses imperial or metric
default settings

Utilities

No entries

Command Modifiers
No entries
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Custom Linetypes > Text in Custom Linetypes >
Text in Custom Linetypes

I"” Quick Reference 1

Commands
LINETYPE
Loads, sets, and modifies linetypes

System Variables
MEASUREINIT

Controls whether a drawing you start from scratch uses imperial or metric
default settings

Utilities

No entries

Command Modifiers
No entries
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Custom Linetypes > Shapes in Custom Linetypes >
Shapes in Custom Linetypes

I” Quick Reference 1

Commands
LINETYPE
Loads, sets, and modifies linetypes

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
MEASUREINIT

Controls whether a drawing you start from scratch uses imperial or metric
default settings

Utilities

No entries

Command Modifiers

No entries
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Custom Hatch Patterns

A library of standard hatch patterns is provided in the acad.pat and acadiso.pat
files. You can use the hatch patterns as they are, modify them, or create your
own custom hatch patterns.

Topics in this section

m  QOverview of Hatch Pattern Definitions

In addition to using the predefined hatch patterns that are supplied, you
can design and create your own custom hatch patterns.

m  Hatch Patterns with Dashed Lines

To define dashed-line patterns, you append dash-length items to the end
of the line definition item.

= Hatch Patterns with Multiple Lines

Complex hatch patterns can have an origin that passes through offsets
from the origin and can have multiple members in the line family.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Custom Hatch Patterns > Overview of Hatch Pattern Definitions >

Overview of Hatch Pattern Definitions

I"” Quick Reference 1

Commands
ADCENTER
Manages and inserts content such as blocks, xrefs, and hatch patterns

BHATCH
Fills an enclosed area or selected objects with a hatch pattern or gradient fill

FILL
Controls the filling of objects such as hatches, 2D solids, and wide polylines

HATCH

Fills an enclosed area or selected objects with a hatch pattern, solid fill, or
gradient fill

HATCHEDIT
Modifies an existing hatch or fill

SOLID
Creates solid-filled triangles and quadrilaterals

System Variables
FILLMODE
Specifies whether hatches and fills, 2D solids, and wide polylines are filled in

HPANG
Specifies the hatch pattern angle

HPBOUND
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Controls the object type created by the BHATCH and BOUNDARY commands

HPDOUBLE
Specifies hatch pattern doubling for user-defined patterns

HPNAME
Sets a default hatch pattern name of up to 34 characters without spaces

HPSCALE
Specifies the hatch pattern scale factor, which must be greater than zero

HPSPACE

Specifies the hatch pattern line spacing for user-defined simple patterns, which
must be greater than zero

Utilities

No entries

Command Modifiers
No entries
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Custom Hatch Patterns > Hatch Patterns with Dashed Lines >

Hatch Patterns with Dashed Lines
I"” Quick Reference 1

Commands
ADCENTER
Manages and inserts content such as blocks, xrefs, and hatch patterns

BHATCH
Fills an enclosed area or selected objects with a hatch pattern or gradient fill

FILL
Controls the filling of objects such as hatches, 2D solids, and wide polylines

HATCH

Fills an enclosed area or selected objects with a hatch pattern, solid fill, or
gradient fill

HATCHEDIT
Modifies an existing hatch or fill

SOLID
Creates solid-filled triangles and quadrilaterals

System Variables
FILLMODE
Specifies whether hatches and fills, 2D solids, and wide polylines are filled in

HPANG
Specifies the hatch pattern angle

HPBOUND
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Controls the object type created by the BHATCH and BOUNDARY commands

HPDOUBLE
Specifies hatch pattern doubling for user-defined patterns

HPNAME
Sets a default hatch pattern name of up to 34 characters without spaces

HPSCALE
Specifies the hatch pattern scale factor, which must be greater than zero

HPSPACE

Specifies the hatch pattern line spacing for user-defined simple patterns, which
must be greater than zero

Utilities

No entries

Command Modifiers
No entries
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Custom Hatch Patterns > Hatch Patterns with Multiple Lines >

Hatch Patterns with Multiple Lines
I"” Quick Reference 1

Commands
ADCENTER
Manages and inserts content such as blocks, xrefs, and hatch patterns

BHATCH
Fills an enclosed area or selected objects with a hatch pattern or gradient fill

FILL
Controls the filling of objects such as hatches, 2D solids, and wide polylines

HATCH

Fills an enclosed area or selected objects with a hatch pattern, solid fill, or
gradient fill

HATCHEDIT
Modifies an existing hatch or fill

SOLID
Creates solid-filled triangles and quadrilaterals

System Variables
FILLMODE
Specifies whether hatches and fills, 2D solids, and wide polylines are filled in

HPANG
Specifies the hatch pattern angle

HPBOUND
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Controls the object type created by the BHATCH and BOUNDARY commands

HPDOUBLE
Specifies hatch pattern doubling for user-defined patterns

HPNAME
Sets a default hatch pattern name of up to 34 characters without spaces

HPSCALE
Specifies the hatch pattern scale factor, which must be greater than zero

HPSPACE

Specifies the hatch pattern line spacing for user-defined simple patterns, which
must be greater than zero

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface

When you work in the program, you use a variety of ribbon panels, menus,
toolbars, shortcut keys, and other user interface elements to help you accomplish
your tasks efficiently. You can also streamline your environment by customizing
these elements.

Topics in this section

= QOverview of Customize User Interface

Using AutoCAD's customization tools, you can tailor your drawing
environment to suit your needs.

m  Work with Customization Files

Customization (CUI) files are used to store commands, user interface
elements, and references to partial CUI files and AutoLISP files. CUI
files can be designated as main, partial, or enterprise. The CUI file
designation determines the order the file is loaded. User interface
elements can be transferred between CUI files, which helps to make the
migration process easier.

m  Customize Commands

You can easily create, edit, and reuse commands. The Customize tab of
the Customize User Interface (CUI) Editor displays a master list of
commands that are loaded in the product. You can add any commands
from this list to toolbars, menus, and other user interface elements.

m  Create Macros

A macro defines the action that results when an interface element is
selected. A macro accomplishes a drawing task that would otherwise
take a series of actions by a user. A macro can contain commands,
special characters, DIESEL (Direct Interpretively Evaluated String



Expression Language) or AutoLISP programming code.

Customize Quick Properties

With the Quick Properties panel, for a selected object, you can access a
sub-set of the properties that are accessible from the Properties palette.

Customize Rollover Tooltips
Rollover tooltips display the current values of selected properties.
Customize Toolbars

Toolbar customization can be as easy as placing or resizing a toolbar in a
drawing area to gain the most drawing efficiency or space. You can also
create and modify toolbars and flyout toolbars, add commands and
control elements, and reposition and remove toolbar buttons.

Customize the Quick Access Toolbar

The Quick Access toolbar is located to the right of the menu browser and
provides direct access to a defined set of commands.

Create Pull-Down and Shortcut Menus

Pull-down menus are displayed as a list under a menu bar or as part of
the menu browser. Shortcut menus (also called context menus) are
displayed at or near the crosshairs or cursor when you right-click in the
drawing window, text window, command window, in toolbar areas, or
the ribbon.

Customize Ribbon Panels and Tabs

You can customize the ribbon by creating and modifying ribbon panels
and organizing ribbon panels into groups of task based tools with ribbon
tabs.

Add Shortcut Keys and Temporary Override Keys

You can assign shortcut keys (sometimes called accelerator keys) to
commands you use frequently, and temporary override keys to execute a
command or change a setting when a key is pressed.

Create a Double Click Action

Double click actions are used to make editing commands accessible
when the cursor is positioned over an object in a drawing and a double-
click is registered from a pointing device. The double click actions are
object type sensitive, allowing you to set up a specific command to use



for a specific object type.
Customize Mouse Buttons

You can change the standard behavior of pointing devices in the
program.

Customize I .egacy Interface Elements

The term “legacy” refers to those user interface elements that are not
commonly used with the current version of the program, but are still
supported because some users prefer them to alternative user interface
elements that are now provided.

Load an AutoLISP File

AutoLISP (LSP or MNL) files contain scripts that add customization
actions and behaviors to the interface. You can load AutoLISP files into

a CUI file using the Customize tab of the Customize User Interface
(CUI) Editor.

Customize Workspaces

You can customize workspaces to create a drawing environment that
displays only those commands on the Quick Access toolbar, toolbars,
menus, ribbon tabs, and palettes that you select.

Customize User Interface FAQs

FAQs will help you to find answers to some of the most commonly
asked questions about using the Customize User Interface (CUI) Editor.
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Customize the User Interface >

Overview of Customize User Interface

Using AutoCAD's customization tools, you can tailor your drawing environment
to suit your needs.

Customization capabilities, including the CUI (Customize User Interface) file
format and the Customize User Interface (CUI) Editor, help you to easily create
and modify customized content. The XML-based CUI file replaces the menu
files used in releases prior to AutoCAD 2006. Instead of using a text editor to
customize menu files (MNU and MNS files), you customize the user interface
from within AutoCAD. You can

m  Add or change toolbars, menus, and ribbon panels (including shortcut
menus, image tile menus, and tablet menus)

= Add and modify the commands on the Quick Access toolbar
m  Create or change workspaces

= Assign commands to various user interface elements

= (Create or change macros

m  Define DIESEL strings

m  Create or change aliases

m  Add descriptive text for command tooltips

=  Control the properties displayed when using rollover tooltips

Topics in this section

=  Important Customization Terms
You should know several terms for customizing AutoCAD 2009.



»  How Customization Has Changed

Although the basic customization techniques remain the same as in
previous versions of the product, the environment that you use to
customize the product was changed starting with AutoCAD 2006.

= QOverview of the Customize User Interface Editor

The Customize User Interface (CUI) Editor is used to modify
customization that is in the XML-based CUI file.
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Customize the User Interface > Overview of Customize User
Interface > Important Customization Terms >

Important Customization Terms
I” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUIEXPORT
Exports customized settings from acad.cui to an enterprise or partial CUI file

CUIIMPORT
Imports customized settings from an enterprise or partial CUI file to acad.cui

CUILOAD
Loads a CUI file

CUIUNLOAD
Unloads a CUI file

CUSTOMIZE
Customizes tool palettes

RIBBON
Opens the ribbon window

RIBBONCLOSE
Closes the ribbon window

TOOLPALETTES
Opens the Tool Palettes window
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TOOLPALETTESCLOSE
Closes the Tool Palettes window

QUICKCUI

Displays the Customize User Interface dialog box in a collapsed state

System Variables
DBLCLKEDIT

Controls the double click editing behavior in the drawing area

ENTERPRISEMENU

Displays the file name for the enterprise CUI (if defined), including the path for
the file name

MENUNAME
Stores the customization file name, including the path for the file name

ROLLOVERTIPS
Controls the display of rollover tooltips in the application

TOQOLTIPS
Controls the display of tooltips on toolbars

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Overview of Customize User Interface > How
Customization Has Changed >

How Customization Has Changed
I” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUIEXPORT
Exports customized settings from acad.cui to an enterprise or partial CUI file

CUIIMPORT
Imports customized settings from an enterprise or partial CUI file to acad.cui

CUILOAD
Loads a CUI file

CUIUNLOAD
Unloads a CUI file

QUICKCUI

Displays the Customize User Interface dialog box in a collapsed state

System Variables
No entries

Utilities

No entries

Command Modifiers
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No entries
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Customize the User Interface > Overview of Customize User
Interface > Overview of the Customize User Interface Editor >

Overview of the Customize User Interface Editor
I” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUIEXPORT
Exports customized settings from acad.cui to an enterprise or partial CUI file

CUIIMPORT
Imports customized settings from an enterprise or partial CUI file to acad.cui

CUILOAD
Loads a CUI file

CUIUNLOAD
Unloads a CUI file

QUICKCUI

Displays the Customize User Interface dialog box in a collapsed state

System Variables
DBLCLKEDIT
Controls the double click editing behavior in the drawing area

ENTERPRISEMENU

Displays the file name for the enterprise CUI (if defined), including the path for
the file name
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MENUNAME
Stores the customization file name, including the path for the file name

TOQOLTIPS
Controls the display of tooltips on toolbars

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Work with Customization Files >

Work with Customization Files

I” Procedure 1

To create a customization file from scratch

To create a CUI file from an existing CUI file

To rename a customization group name
To restore a customization backup file

To reset a standard customization file

To designate a CUI file as the main CUI file

To copy and paste a user interface element

To duplicate a user interface element

To transfer customizations

To load a partial CUI file using the CUILOAD command

To load a partial CUI file using the Customize tab

To unload a partial CUI file using the CUIUNLOAD command

To unload a partial CUI file using the Customize tab

To add commands to a partial CUI file

To designate a CUI file as an enterprise CUI file

To modify an enterprise CUI file
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Customize the User Interface > Work with Customization Files > Basics of
Customization Files >

Basics of Customization Files
[ Concept ||| Procedre | | G

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

MENU
Loads a customization file

OPTIONS
Customizes the program settings

System Variables
MENUNAME
Stores the customization file name, including the path for the file name

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Work with Customization Files > Migrate and
Transfer Customizations >

Migrate and Transfer Customizations
[ Concert | Procedere ] | S S Gl

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUIEXPORT
Exports customized settings from acad.cui to an enterprise or partial CUI file

CUIIMPORT
Imports customized settings from an enterprise or partial CUI file to acad.cui

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Work with Customization Files > Create and L.oa
a Partial CUI File >

Create and Load a Partial CUI File
I"” Quick Reference 1

Commands

CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUILOAD

Loads a CUI file

CUIUNLOAD
Unloads a CUI file

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Work with Customization Files > Create an
Enterprise CUI File >

Create an Enterprise CUI File
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUIEXPORT
Exports customized settings from acad.cui to an enterprise or partial CUI file

CUILOAD
Loads a CUI file

CUIUNLOAD
Unloads a CUI file

MENU
Loads a customization file

OPTIONS
Customizes the program settings

System Variables
ENTERPRISEMENU

Displays the file name for the enterprise CUI (if defined), including the path for
the file name

MENUNAME
Stores the customization file name, including the path for the file name
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Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Commands >

Customize Commands

I” Procedure 1

To create a command
To remove a command
To edit a command

To use a command

To copy and paste a command

To duplicate a command

To find a search string in a CUI file

To find a search string in the Command List pane

To find where a command in the Command List pane is used

To replace a search string

To replace a command

To gray out (disable) a command's menu label

To mark command's menu label

To simultaneously gray out (disable) and mark a command's menu label
To edit or create a button image

To assign a standard image to a command

To assign a custom image to a command

To import a custom image to the image list




To add tags to a command
To remove a tag from a command
To add a tooltip to a command

To add extended help to a command
To create an XAML file

To create a status line help message
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Customize the User Interface > Customize Commands > Create, Edit, and Reuse
Commands >

Create, Edit, and Reuse Commands
|| (| vk Reference |

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
TOQOLTIPS

Controls the display of tooltips on toolbars

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Commands > Find Command Names
and Search Strings >

Find Command Names and Search Strings
| I | (R | Ok Reference |

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Control the Display of
Command Labels >

Control the Display of Command Labels
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Commands > Create Images for

Commands >

Create Images for Commands
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Commands > Assign Tags to
Commands >

Assign Tags to Commands
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

OPTIONS
Customizes the program settings

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Customize the User Interface > Customize Commands > Create Tooltips and
Extended Help for Commands >

Create Tooltips and Extended Help for Commands
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

OPTIONS
Customizes the program settings

System Variables
TOQOLTIPS
Controls the display of tooltips on toolbars

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Create Status Line Help
Messages >

Create Status Line Help Messages
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

OPTIONS
Customizes the program settings

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface >

Create Macros

A macro defines the action that results when an interface element is selected. A
macro accomplishes a drawing task that would otherwise take a series of actions
by a user. A macro can contain commands, special characters, DIESEL (Direct
Interpretively Evaluated String Expression Language) or AutoL.ISP
programming code.

Note As AutoCAD is revised and enhanced, the sequence of prompts for various
commands (and sometimes command names) might change. Therefore, your
custom macros might require minor changes when you upgrade to a new release
of AutoCAD.

You add macros to interface elements by using the Customize User Interface
(CUI) Editor. Select an existing command or create a new command in the
Command List pane. Enter macros in the Macros section of the Properties pane.
There are no length limitations for macros. However, you do need to know how
specific characters are used in macros and be aware of other considerations or
limitations.

Macro Basics

A macro in a user interface element can be as simple as a command (such as
circle) and some special characters (such as ACAC).

For example, the macro ACAC_circle \1, draws a circle with a radius of 1
unit. The components that define this macro are explained in the table below.

Components in CIRCLE macro

Component Component type Result




ACAC Special control Cancels any running

character commands
_ Special control Automatically
character translates the

command that
follows into other

languages
CIRCLE Command Starts the CIRCLE
command
\ Special control Creates a pause for
character the user to specify the

center point

1 Special control Responds to the
character prompt for the circle's
radius (1)

For a list of special control characters that you can use in macros, see Use
Special Control Characters in Macros.

Cancel Running Commands

Make sure that you have no AutoCAD commands in progress before you
execute a macro. To automatically cancel a command before executing a macro,
enter ACAC at the beginning of the macro (which is the same as pressing ESC
twice). Although a single AC cancels most commands, ACAC is required to
return to the command prompt from a dimensioning command and ACACAC is
required based on the current option of the Layer command. ACAC handles
canceling out of most command sequences and therefore is the recommended
sequence used to ensure no command is active before the macro is started.

Verify Macro Characters

Every character in a macro is significant, even a blank space.



When you place a space at the end of the macro, AutoCAD processes the macro
as though you had entered a command (circle, for example) and then pressed the
SPACEBAR to complete the command.

Terminate Macros

Some macros require special terminators. Some commands (TEXT, for example)
require you to press ENTER rather than SPACEBAR to terminate the command.
Some commands require more than one space (or ENTER) to complete, but
some text editors cannot create a line with trailing blanks.

Two special conventions resolve these problems.

= A semicolon (;) in a macro automatically issues ENTER at the command
prompt.

m [f a line ends with a control character, a backslash (\), a plus sign (+), or
a semicolon (;), AutoCAD does not add a blank space after it.

An item that ends with a backslash (\) pauses a macro for user input.

Compare the following macros:

ucs
ucs ;

The first example enters ucs at the command prompt and presses SPACEBAR.
The following prompt is displayed.

Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis] <World>:

The second example enters ucs, presses SPACEBAR, and presses ENTER,
which accepts the default value (World).

Suppress Echoes and Prompts in Macros

Characters in a macro appear in the command window as though you had typed
the characters on the keyboard. They are also displayed in the user interface
element. This display duplication is called “echoing”. You can suppress the
“echoed” displays with the MENUECHO system variable. If echoes and
prompts from item input are turned off, a AP in the item turns them off.
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Create Long Macros

You can create a macro of any length, without requiring any special characters at
the end of a line. The Properties pane in the Customize User Interface (CUI)
Editor accepts a macro of any length.

Topics in this section

= Use Special Control Characters in Macros

You can use special characters, including control characters, in macros.
In a macro, the caret (1) is equivalent to pressing the CTRL key on the
keyboard. You can combine the caret with another character to construct
macros that do such things as turn the grid on and off (AG) or cancel a
command (AC).

=  Pause for User Input in Macros

To accept input from the keyboard or pointing device in the middle of a
command, place a backslash (\) in the macro at the point where you want
input.

= Provide International Support in Macroes

To develop menus that can be used with a non-English-language version
of AutoCAD, precede each command or option with the underscore
character (_). The underscore character allows the standard commands
and options to be translated automatically.

m  Use Built-in Commands in Macros

To develop macros that use built-in commands that are part of
AutoCAD, precede each command with the period character (.). The
period character allows the built-in command to be used even if it has
been undefined with the UNDEFINE command making the macro
predicable when it is used on other systems that share the same
customization file.

»  Repeat Commands in Macros

You can use a leading asterisk (*) to repeat a command in a macro until
you choose another command.

= Use Single Object Selection Mode in Macros

Single Object Selection mode cancels the normal repetition of the Select



Objects prompt in editing commands. After you select one object and
respond to any other prompts, the command ends.

Use Macros to Swap User Interface Elements

You can replace the contents of active menus, mouse buttons, tablet
buttons, tablet menus, or screen menus. The swapped content can be that
of another user interface element of the same type in the main CUI file,
or it can come from a partial CUI file.

Use Conditional Expressions in Macros

You can add conditional expressions to a macro by using a command
that introduces macro expressions written in DIESEL (Direct
Interpretively Evaluated String Expression Language).

Use AutoLISP in Macros

Creating commands that use AutoLISP is a more advanced way to use
the AutoCAD customization feature.

Please send us your comment about this page
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Customize the User Interface > Create Macros > Use Special Control Characters
in Macros >

Use Special Control Characters in Macros
I” Quick Reference 1

Commands

CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUILOAD

Loads a CUI file

CUIUNLOAD
Unloads a CUI file

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Create Macros > Pause for User Input in
Macros >

Pause for User Input in Macros
I” Quick Reference 1

Commands
CHANGE
Changes the properties of existing objects

SELECT
Places selected objects in the Previous selection set

System Variables

PICKADD

Controls whether subsequent selections replace the current selection set or add to
it

PICKAUTO

Controls automatic windowing at the Select Objects prompt

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Create Macros > Provide International Support in
Macros >

Provide International Support in Macros
I” Quick Reference 1

Commands
CHANGE
Changes the properties of existing objects

SELECT
Places selected objects in the Previous selection set

System Variables

PICKADD

Controls whether subsequent selections replace the current selection set or add to
it

PICKAUTO

Controls automatic windowing at the Select Objects prompt

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Create Macros > Use Built-in Commands in
Macros >

Use Built-in Commands in Macros
I” Quick Reference 1

Commands
REDEFINE
Restores AutoCAD internal commands overridden by UNDEFINE

UNDEFINE
Allows an application-defined command to override an internal command

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Customize the User Interface > Create Macros > Repeat Commands in Macros >

Repeat Commands in Macros

I” Quick Reference 1

Commands
No entries

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Customize the User Interface > Create Macros > Use Single Object Selection
Mode in Macros >

Use Single Object Selection Mode in Macros
I” Quick Reference 1

Commands

No entries

System Variables

No entries

Utilities

No entries

Command Modifiers

No entries
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Customize the User Interface > Create Macros > Use Macros to Swap User
Interface Elements >

Use Macros to Swap User Interface Elements
I” Quick Reference 1

Commands

No entries

System Variables

No entries

Utilities

No entries

Command Modifiers

No entries
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javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Create Macros > Use Conditional Expressions in
Macros >

Use Conditional Expressions in Macros
I” Quick Reference 1

Commands

No entries

System Variables
FILLMODE
Specifies whether hatches and fills, 2D solids, and wide polylines are filled in

Utilities

No entries

Command Modifiers

No entries
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Customize the User Interface > Create Macros > Use AutolL.ISP in Macros >

Use AutoLISP in Macros
I” Quick Reference 1

Commands

CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUILOAD

Loads a CUI file

CUIUNLOAD
Unloads a CUI file

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Quick Properties >

Customize Quick Properties

I"” Quick Reference 1

Commands

CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

DSETTINGS

Sets grid and snap, polar and object snap tracking, object snap modes, and
Dynamic Input

System Variables
QPLOCATION
Sets the location mode of Quick Properties panel

QPMODE

Sets the on or off state of Quick Properties panel

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Rollover Tooltips >
Customize Rollover Tooltips

I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

OPTIONS
Customizes the program settings

System Variables
ROLLOVERTIPS
Controls the display of rollover tooltips in the application

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Toolbars >

Customize Toolbars

I” Procedure 1

To create a toolbar

To create a flyout toolbar from scratch

To create a toolbar from a pull-down menu

To create a flyout toolbar from another toolbar

To create a flyout toolbar from a pull-down menu

To add a command to a toolbar in the Customizations In pane

To add a command to a toolbar in the Toolbar Preview pane

To add a command to a toolbar outside the CUI Editor

To reposition a button on a toolbar in the Customizations In pane
To reposition a command on a toolbar in the Toolbar Preview pane
To reposition a command on a toolbar outside the CUI Editor

To remove a button from a toolbar in the Customizations In pane

To remove a button from a toolbar in the Toolbar Preview pane

To remove a command from a toolbar outside the CUI Editor

To change properties of a toolbar

To change the tooltip of a button

To add a control to a toolbar in the Customizations In pane

To add a control to a toolbar in the Toolbar Preview pane




To switch a control in a toolbar
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Customize the User Interface > Customize Toolbars > Create and Edit Toolbars >

Create and Edit Toolbars
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

QUICKCUI

Displays the Customize User Interface dialog box in a collapsed state

RIBBON
Opens the ribbon window

RIBBONCLOSE
Closes the ribbon window

System Variables
TOQOLTIPS

Controls the display of tooltips on toolbars

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Toolbars > Add or Switch Toolbar
Controls >

Add or Switch Toolbar Controls
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Customize the User Interface > Customize the Quick Access Toolbar >

Customize the Quick Access Toolbar

I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

OPTIONS
Customizes the program settings

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Create Pull-Down and Shortcut Menus >

Create Pull-Down and Shortcut Menus

I” Procedure 1

To create a pull-down menu

To add a command to a pull-down menu

To change the caption of a menu item

To create a shortcut menu

To create a command shortcut menu

To create an object shortcut menu

To create a submenu

Please send us your comment about this page
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢
Pull-Down Menu >

Create a Pull-Down Menu
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
MENUBAR

Controls the display of the menu bar

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢
Shortcut Menu >

Create a Shortcut Menu
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
SHORTCUTMENU

Controls whether Default, Edit, and Command mode shortcut menus are
available in the drawing area

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create
Submenus >

Create Submenus
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page



ms-its:ACAD_ACR.chm::/CUI.htm
javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Create Pull-Down and Shortcut
Menus > Reference Pull-Down or Shortcut Menus >

Reference Pull-Down or Shortcut Menus
I” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Swap
and Insert Pull-Down Menus >

Swap and Insert Pull-Down Menus
I” Quick Reference 1

Commands

CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUILOAD

Loads a CUI file

CUIUNLOAD
Unloads a CUI file

TOOLBAR
Displays, hides, and customizes toolbars

WORKSPACE
Creates, modifies, and saves workspaces and makes a workspace current

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Ribbon Panels and Tabs >

Customize Ribbon Panels and Tabs

I” Procedure 1

To create a ribbon panel

To copy an existing toolbar to ribbon panels

To remove a ribbon panel

To add a row to a ribbon panel

To add a sub-panel to a row on a ribbon panel

To remove a row or sub-panel from a ribbon panel

To reposition a row or sub-panel on a ribbon panel

To add a command to a ribbon panel
To reposition a command on a ribbon panel
To remove a command from a ribbon panel

To create a flyout in a row on a ribbon panel

To show the label and set the orientation of a command or flyout on a ribbon
anel

To set the size of a command or flyout on a ribbon panel

To set the button and flyout style of a flyout on a ribbon panel

To control the display of ribbon panel titles on the ribbon

To associate a tool palette group with a ribbon panel

To add a control to a ribbon panel

To reposition a control on a ribbon panel




To remove a control from a ribbon panel

To change the properties of a gallery button on a ribbon panel

To create a ribbon tab

To remove a ribbon tab

To add a ribbon panel to a ribbon tab

To remove a ribbon panel from a ribbon tab

To set the initial position of a ribbon panel on a ribbon tab
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

RIBBON
Opens the ribbon window

RIBBONCLOSE
Closes the ribbon window

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Ribbon Panels and Tabs > Add or
Switch Ribbon Panel Controls >

Add or Switch Ribbon Panel Controls
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

RIBBON
Opens the ribbon window

RIBBONCLOSE
Closes the ribbon window

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Tabs >

Create and Edit Ribbon Tabs
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

RIBBON
Opens the ribbon window

RIBBONCLOSE
Closes the ribbon window

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Add Shortcut Keys and Temporary Override
Keys >

Add Shortcut Keys and Temporary Override Keys
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
TOQOLTIPS

Controls the display of tooltips on toolbars

TEMPOVERRIDES
Turns temporary override keys on and off

Utilities

No entries

Command Modifiers

No entries
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Customize the User Interface > Create a Double Click Action >

Create a Double Click Action
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

OPTIONS
Customizes the program settings

System Variables
DBLCLKEDIT
Controls the double click editing behavior in the drawing area

PICKFIRST

Controls whether you select objects before (noun-verb selection) or after you
issue a command

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Mouse Buttons >

Customize Mouse Buttons

I” Procedure 1

To add a mouse button combination
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Customize the User Interface > Customize Mouse Buttons > Accept Coordinate
Entry in Button Menus >

Accept Coordinate Entry in Button Menus
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Customize the User Interface > Customize Legacy Interface Elements >
Customize Legacy Interface Elements

I” Procedure 1

To define rows and columns in a tablet menu

To clear a tablet menu assignment

To display the screen menu

To set screen menus to reflect the current command
To add commands to the screen menu

To create a submenu on a screen menu

To create an image tile slide
To view an image tile slide

To create an image tile slide library

To create an image tile menu and assign an image tile slide

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Customize Legacy Interface Elements > Create
Tablet Menus >

Create Tablet Menus
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

TABLET
Calibrates, configures, and turns on and off an attached digitizing tablet

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page



ms-its:ACAD_ACR.chm::/CUI.htm
ms-its:ACAD_ACR.chm::/TABLET.htm
javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Customize Legacy Interface
Elements > Customize Tablet Buttons >

Customize Tablet Buttons
I” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Legacy Interface Elements > Create
Screen Menus >

Create Screen Menus
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

OPTIONS
Customizes the program settings

System Variables
MENUCTL
Controls the page switching of the screen menu

SCREENBOXES
Stores the number of boxes in the screen menu area of the drawing area

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Legacy Interface Elements > Create
Image Tile Menus >

Create Image Tile Menus
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

MSLIDE
Creates a slide file of the current model viewport or the current layout

VSLIDE
Displays an image slide file in the current viewport

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Load an AutoL.ISP File >

Load an AutoLISP File
I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

APPLOAD
Loads and unloads applications and defines which applications to load at startup

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Customize the User Interface > Customize Workspaces >
Customize Workspaces

I"” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUIEXPORT
Exports customized settings from acad.cui to an enterprise or partial CUI file

CUIIMPORT
Imports customized settings from an enterprise or partial CUI file to acad.cui

CUILOAD
Loads a CUI file

CUIUNLOAD
Unloads a CUI file

WORKSPACE
Creates, modifies, and saves workspaces and makes a workspace current

System Variables
WSCURRENT

Returns the current workspace name in the command line interface and sets a
workspace to current

Utilities

No entries
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Command Modifiers
No entries
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Customize the User Interface > Customize User Interface FAQs >

Customize User Interface FAQs

I” Quick Reference 1

Commands
CUI

Manages customized user interface elements such as workspaces, toolbars,
menus, shortcut menus and keyboard shortcuts

CUIEXPORT
Exports customized settings from acad.cui to an enterprise or partial CUI file

CUILOAD
Loads a CUI file

CUIUNLOAD
Unloads a CUI file

CUIUNLOAD
Unloads a CUI file

MENU
Loads a customization file

OPTIONS
Customizes the program settings

QUICKCUI

Displays the Customize User Interface dialog box in a collapsed state

WORKSPACE
Creates, modifies, and saves workspaces and makes a workspace current
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System Variables
ENTERPRISEMENU

Displays the file name for the enterprise CUI (if defined), including the path for
the file name

MENUNAME
Stores the customization file name, including the path for the file name

WSCURRENT

Returns the current workspace name in the command line interface and sets a
workspace to current

Utilities

No entries

Command Modifiers

No entries
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DIESEL

Expressions in DIESEL (Direct Interpretively Evaluated String Expression
Language) take strings as input and generate string results. You can use DIESEL
in menu macros or to display text on the status line.

Topics in this section

m  Customize the Status Line

You can use the MODEMACRO system variable to display information
on the status line.

m  DIESEL Expressions in Macros

You can use DIESEL string expressions in customization (CUI) files as
an additional method of creating macros.

= Catalog of DIESEL Functions

Status retrieval, computation, and display are performed by DIESEL
functions. All functions have a limit of 10 parameters, including the
function name itself. If this limit is exceeded, you get a DIESEL error
message.

s  DIESEL Error Messages

Generally, if you make a mistake in a DIESEL expression, what went
wrong will be obvious. Depending on the nature of the error, DIESEL
embeds an error indication in the output stream.
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DIESEL >

Customize the Status Line

You can use the MODEMACRO system variable to display information on the
status line.

Topics in this section

=  Overview of the MODEMACRO System Variable
m  Set MODEMACRO Values

You can use text strings and DIESEL to display messages in the user-
defined section of the status line.

m  Set MODEMACRO with AutoL.ISP
Another way to set MODEMACRO values is to use AutoLISP.
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DIESEL > Customize the Status Line > Overview of the MODEMACRO Systen
Variable >

Overview of the MODEMACRO System Variable
I” Quick Reference 1

Commands
SETVAR
Lists or changes the values of system variables

System Variables
MODEMACRO

Displays a text string on the status line, such as the name of the current drawing,
time/date stamp, or special modes

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Customize the Status Line > Set MODEMACRO Values >

Set MODEMACRO Values
I” Quick Reference 1

Commands
SETVAR
Lists or changes the values of system variables

System Variables
MODEMACRO

Displays a text string on the status line, such as the name of the current drawing,
time/date stamp, or special modes

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Customize the Status Line > Set MODEMACRO with AutoL.ISP >

Set MODEMACRO with AutoLISP
I” Quick Reference 1

Commands
SETVAR
Lists or changes the values of system variables

System Variables
MODEMACRO

Displays a text string on the status line, such as the name of the current drawing,
time/date stamp, or special modes

Utilities

No entries

Command Modifiers
No entries
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DIESEL > DIESEL Expressions in Macros >

DIESEL Expressions in Macros
I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

USERS1-5
Provides storage and retrieval of text string data

Utilities

No entries

Command Modifiers

No entries
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DIESEL >
Catalog of DIESEL Functions

Status retrieval, computation, and display are performed by DIESEL functions.
All functions have a limit of 10 parameters, including the function name itself. If
this limit is exceeded, you get a DIESEL error message.

Topics in this section

=+ (addition)

= - (subtraction)

m * (multiplication)
m /(division)

= = (equal to)

m < (less than)

m > (greater than)

= != (not equal to)

m <= (less than or equal to)

m >= (greater than or equal to)

= and
= angtos
= edtime
= eq
= eval
= fix
= getenv

= getvar
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DIESEL > Catalog of DIESEL Functions > + (addition) >
+ (addition)
I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > - (subtraction) >

- (subtraction)

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > * (multiplication) >

* (multiplication)

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > / (division) >

/ (division)

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > Catalog of DIESEL Functions > = (equal to) >

= (equal to)
I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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< (less than)">

DIESEL > Catalog of DIESEL Functions > < (less than) >
< (less than)

I” Quick Reference 1

Commands

No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > Catalog of DIESEL Functions > > (greater than) >

> (greater than)

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > != (not equal to) >

I= (not equal to)

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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<= (less than or equal to)">

DIESEL > Catalog of DIESEL Functions > <= (less than or equal to) >

<= (less than or equal to)
I” Quick Reference 1

Commands

No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > Catalog of DIESEL Functions > >= (greater than or equal to) >

>= (greater than or equal to)

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > and >

and

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > angtos >

angtos

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > edtime >

edtime

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page



ms-its:ACAD_ACR.chm::/MENUECHO.htm
javascript:doComments('./html/ac.cmtdialog.htm');

DIESEL > Catalog of DIESEL Functions > eq >

eq
I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > eval >

eval

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > fix >

fix

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > Catalog of DIESEL Functions > getenv >

getenv

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > getvar >

getvar

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > if >
if
I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > Catalog of DIESEL Functions > index >

index

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > Catalog of DIESEL Functions > nth >

nth
I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > Catalog of DIESEL Functions > or >

or

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > rtos >

Itos

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > Catalog of DIESEL Functions > strlen >

strlen

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > substr >

substr

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers
No entries
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DIESEL > Catalog of DIESEL Functions > upper >

upper
I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > Catalog of DIESEL Functions > xor >

XO0r

I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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DIESEL > DIESEL Error Messages >

DIESEL Error Messages
I” Quick Reference 1

Commands
No entries

System Variables
MENUECHO
Sets menu echo and prompt control bits

Utilities

No entries

Command Modifiers

No entries
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Slides and Command Scripts

Slides are snapshots of drawing files that can be used in many ways. A script
reads and executes commands from a text file. One way to use a script is to
create a slide show.

Topics in this section

m  Create Slides

Slides are snapshots of drawing files. You can use slides for giving
presentations, creating custom image tile menus, and viewing an image
of another drawing while you work.

m  Create Command Scripts

A script is a text file that contains a series of commands. Common uses
for scripts are to customize startup and to run slide shows.
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Slides and Command Scripts > Create Slides >

Create Slides
I” Procedure 1

To make a slide

To view a slide

To create a slide library

To view a slide in a slide library
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Slides and Command Scripts > Create Slides > Overview of Slides >

Overview of Slides

I"” Quick Reference 1

Commands
MSLIDE
Creates a slide file of the current model viewport or the current layout

REDRAW
Refreshes the display in the current viewport

VSLIDE
Displays an image slide file in the current viewport

System Variables
FILEDIA
Suppresses display of file navigation dialog boxes

Utilities
SLIDELIB
Compiles slide files listed in an ASCII file into a slide library file

Command Modifiers
No entries
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Slides and Command Scripts > Create Slides > View Slides >

View Slides
I"” Quick Reference 1

Commands
REDRAW
Refreshes the display in the current viewport

VSLIDE
Displays an image slide file in the current viewport

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Slides and Command Scripts > Create Slides > Create and View Slide Libraries >

Create and View Slide Libraries

I"” Quick Reference 1

Commands
MSLIDE
Creates a slide file of the current model viewport or the current layout

REDRAW
Refreshes the display in the current viewport

VSLIDE
Displays an image slide file in the current viewport

System Variables
No entries

Utilities
SLIDELIB
Compiles slide files listed in an ASCII file into a slide library file

Command Modifiers
No entries
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Slides and Command Scripts > Create Command Scripts >
Create Command Scripts

I” Procedure 1

To create a script that changes settings in a drawing

To run a script at startup

To run slide shows from scripts

To create a script that preloads slides
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Slides and Command Scripts > Create Command Scripts > Overview of
Command Scripts >

Overview of Command Scripts
I"” Quick Reference 1

Commands
DELAY
Provides a timed pause within a script

GRAPHSCR
Switches from the text window to the drawing area

RESUME
Continues an interrupted script

RSCRIPT
Repeats a script file

SCRIPT
Executes a sequence of commands from a script file

TEXTSCR
Opens the text window

VSLIDE
Displays an image slide file in the current viewport

System Variables
No entries

Utilities

No entries
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Command Modifiers
No entries
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Slides and Command Scripts > Create Command Scripts > Run Scripts at
Startup >

Run Scripts at Startup
I"” Quick Reference 1

Commands
No entries

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Slides and Command Scripts > Create Command Scripts > Run Slide Shows fron
Scripts >

Run Slide Shows from Scripts
I"” Quick Reference 1

Commands
DELAY
Provides a timed pause within a script

GRAPHSCR
Switches from the text window to the drawing area

RESUME
Continues an interrupted script

RSCRIPT
Repeats a script file

SCRIPT
Executes a sequence of commands from a script file

TEXTSCR
Opens the text window

VSLIDE
Displays an image slide file in the current viewport

System Variables
No entries

Utilities

No entries
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ms-its:ACAD_ACR.chm::/TEXTSCR.htm
ms-its:ACAD_ACR.chm::/VSLIDE.htm

Command Modifiers
No entries
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Introduction to Programming Interfaces

In addition to accessing commands from the command prompt and menu
interfaces, AutoCAD provides application programming interfaces (APIs) that
you can use to control drawings and databases. The type of interface you use
depends on your application needs and programming experience.

The programming interfaces introduced here are ActiveX® Automation, VBA
(Visual Basic® for Applications), AutoLISP®, Visual LISP™ | ObjectARX™ |
and .NET. The type of interface you use depends on your application needs and
programming experience.

Topics in this section

ActiveX Automation

ActiveX Automation is a technology developed by Microsoft® and is
based on the COM (component object model) architecture. You can use
it to customize AutoCAD, share your drawing data with other
applications, and automate tasks.

AutoCAD VBA

Microsoft Visual Basic for Applications (VBA) is an object-based
programming environment designed to provide rich development
capabilities. The main difference between VBA and VB (Visual Basic 6)
is that VBA runs in the same process space as AutoCAD, providing an
AutoCAD-intelligent and very fast programming environment.

AutoL.ISP and Visual L.ISP

AutoLISP is based on the LISP programming language, which is simple
to learn and very powerful. Because AutoCAD has a built-in LISP
interpreter, you can enter AutoLISP code at the command prompt or load
AutoLISP code from external files. Visual LISP (VLISP) is a software




tool designed to expedite AutoLISP program development.

ObjectARX

ObjectARX technology provides the foundation for design software
applications to share intelligent object data. You can run third-party
ObjectARX application programs or write your own.

NET

With the Microsoft .NET Framework, you can create applications that
interoperate with AutoCAD using programming languages like VB
.NET and C#.
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Introduction to Programming Interfaces >

ActiveX Automation

ActiveX Automation is a technology developed by Microsoft® and is based on
the COM (component object model) architecture. You can use it to customize
AutoCAD, share your drawing data with other applications, and automate tasks.

Topics in this section

= QOverview of ActiveX

You can create and manipulate AutoCAD objects from any application
that serves as an Automation controller. Thus, Automation enables
macro programming across applications, a capability that does not exist
in AutoLISP.

m  Define a Command to Start Your Application

You can use the acad.pgp file to define a new AutoCAD command that
runs an external command to start your application.

m Start an Application from a Menu or Toolbar

After defining a new command to start your application, you can make
that command available from a menu or toolbar.
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Introduction to Programming Interfaces > ActiveX Automation > Overview of
ActiveX >

Overview of ActiveX
I” Quick Reference 1

Commands
NETLOAD
Loads a .NET application

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces > ActiveX Automation > Define a
Command to Start Your Application >

Define a Command to Start Your Application
I” Quick Reference 1

Commands

No entries

System Variables

No entries

Utilities

No entries

Command Modifiers

No entries
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Introduction to Programming Interfaces > ActiveX Automation > Start an
Application from a Menu or Toolbar >

Start an Application from a Menu or Toolbar
I” Quick Reference 1

Commands
MENULOAD
Obsolete

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces >
AutoCAD VBA

Microsoft Visual Basic for Applications (VBA) is an object-based programming
environment designed to provide rich development capabilities. The main
difference between VBA and VB (Visual Basic 6) is that VBA runs in the same
process space as AutoCAD, providing an AutoCAD-intelligent and very fast
programming environment.

Topics in this section

= QOverview of AutoCAD VBA
m  Use AutoCAD VBA Applications

You load a VBA project with the VBALOAD command. Once loaded,
its modules and macros are available in the Macros dialog box.

= Automatically I.oad and Execute VBA Projects

You can load VBA projects automatically each time you run AutoCAD.
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Introduction to Programming Interfaces > AutoCAD VBA > Overview of
AutoCAD VBA >

Overview of AutoCAD VBA
I” Quick Reference 1

Commands
VBAIDE
Displays the Visual Basic Editor

VBALOAD
Loads a global VBA project into the current work session

VBAMAN
Loads, unloads, saves, creates, embeds, and extracts VBA projects

VBARUN
Runs a VBA macro

VBASTMT
Executes a VBA statement on the AutoCAD command line

VBAUNLOAD
Unloads a global VBA project

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces > AutoCAD VBA > Use AutoCAD VBA
Applications >

Use AutoCAD VBA Applications
I” Quick Reference 1

Commands
VBAIDE
Displays the Visual Basic Editor

VBALOAD
Loads a global VBA project into the current work session

VBAMAN
Loads, unloads, saves, creates, embeds, and extracts VBA projects

VBARUN
Runs a VBA macro

VBASTMT
Executes a VBA statement on the AutoCAD command line

VBAUNLOAD
Unloads a global VBA project

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces > AutoCAD VBA > Automatically [.oad
and Execute VBA Projects >

Automatically Load and Execute VBA Projects
I” Quick Reference 1

Commands
APPLOAD
Loads and unloads applications and defines which applications to load at startup

VBAIDE
Displays the Visual Basic Editor

VBALOAD
Loads a global VBA project into the current work session

VBAMAN
Loads, unloads, saves, creates, embeds, and extracts VBA projects

VBARUN
Runs a VBA macro

VBASTMT
Executes a VBA statement on the AutoCAD command line

VBAUNLOAD
Unloads a global VBA project

System Variables
No entries

Utilities

No entries
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Command Modifiers
No entries
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Introduction to Programming Interfaces >
AutoLISP and Visual LISP

AutoLISP is based on the LISP programming language, which is simple to learn
and very powerful. Because AutoCAD has a built-in LISP interpreter, you can
enter AutoLISP code at the command prompt or load AutoLISP code from
external files. Visual LISP (VLISP) is a software tool designed to expedite
AutoLISP program development.

Topics in this section

= QOverview of AutoL.ISP and Visual LISP

m  Use AutoL.ISP Applications

AutoLISP applications are stored in ASCII text files that you can edit.
Before you can use an AutoLISP application, it must first be loaded.

= Automatically I.oad and Run AutoL.ISP Routines

You can load AutoLISP routines each time you run AutoCAD. You can
also execute certain commands or functions at specific times during a
drawing session.
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Introduction to Programming Interfaces > AutoLISP and Visual LISP > Overview
of AutoL.ISP and Visual LISP >

Overview of AutoLISP and Visual LISP
I” Quick Reference 1

Commands
No entries

System Variables

PICKADD

Controls whether subsequent selections replace the current selection set or add to
it

PICKAUTO

Controls automatic windowing at the Select Objects prompt

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces > AutoL.ISP and Visual LISP > Use
AutoLISP Applications >

Use AutoLISP Applications
I” Quick Reference 1

Commands
APPLOAD
Loads and unloads applications and defines which applications to load at startup

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Introduction to Programming Interfaces > AutoL.ISP and Visual LISP >

Automatically Load and Run AutoLISP Routines

You can load AutoLISP routines each time you run AutoCAD. You can also
execute certain commands or functions at specific times during a drawing

session.

Topics in this section

Overview of AutoL.ISP Automatic I.oading
The ACAD.LSP File

You can create an acad.lsp file if you regularly use specific AutoLISP
routines. When you start AutoCAD, it searches the support file search
path for an acad.lIsp file. If an acad.Isp file is found, it is loaded into
memory.

The ACADDOC.LSP File

The acaddoc.lsp file is intended to be associated with each document (or
drawing) initialization. This file is useful if you want to load a library of
AutoLISP routines to be available every time you start a new drawing
(or open an existing drawing).

The MNL File for an AutoL.ISP Menu

When AutoCAD loads a customization file, it searches for an MNL file
with a matching file name. If it finds the file, it loads the file into
memory. This function ensures that AutoCAD loads the AutoLISP
functions that are needed for proper operation of a menu.

Prevent AutoL.ISP Errors When L.oading Startup Files

If an AutoLISP error occurs while you are loading a startup file, the
remainder of the file is ignored and is not loaded.

S::STARTUP Function: Postinitialization Execution



You can define an S::STARTUP function to perform any needed setup
operations after the drawing is initialized.
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Introduction to Programming Interfaces > AutoLISP and Visual
LISP > Automatically [.oad and Run AutoL.ISP Routines > Overview of
AutoLISP Automatic L.oading >

Overview of AutoLISP Automatic Loading

Commands
APPLOAD
Loads and unloads applications and defines which applications to load at startup

System Variables
ACADLSPASDOC

Controls whether the acad.lsp file is loaded into every drawing or just the first
drawing opened in a session

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces > AutoL.ISP and Visual
LISP > Automatically L.oad and Run AutoLLISP Routines > The ACAD.LSP
File >

The ACAD.LSP File

Commands
APPLOAD
Loads and unloads applications and defines which applications to load at startup

System Variables
ACADLSPASDOC

Controls whether the acad.lsp file is loaded into every drawing or just the first
drawing opened in a session

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces > AutoL.ISP and Visual
LISP > Automatically L.oad and Run AutoL.ISP Routines > The ACADDOC.LSP
File >

The ACADDOC.LSP File

Commands
APPLOAD
Loads and unloads applications and defines which applications to load at startup

System Variables
ACADLSPASDOC

Controls whether the acad.lsp file is loaded into every drawing or just the first
drawing opened in a session

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces > AutoL.ISP and Visual
LISP > Automatically L.oad and Run AutoLLISP Routines > The MNL File for an
AutoLISP Menu >

The MNL File for an AutoL.LISP Menu
(S ik trence|

Commands
No entries

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces > AutoL.ISP and Visual
LISP > Automatically [.oad and Run AutoL.ISP Routines > Prevent AutoLLISP
Errors When Loading Startup Files >

Prevent AutoLISP Errors When Loading Startup Files
() cuicraerce|

Commands
No entries

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Introduction to Programming Interfaces > AutoL.ISP and Visual
LISP > Automatically L.oad and Run AutoLISP Routines > S::STARTUP
Function: Postinitialization Execution >

S::STARTUP Function: Postinitialization Execution
(B ik etrmes|

Commands
No entries

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces >
ObjectARX

ObjectARX technology provides the foundation for design software applications
to share intelligent object data. You can run third-party ObjectARX application
programs or write your own.

Topics in this section

= Overview of ObjectARX

= Use ObjectARX Applications

To load an ObjectARX application, you use the Load option of the ARX
command. After loading, all commands defined by this application are
available at the command prompt.

=  Automatically I.oad ObjectARX Applications
Some ObjectARX samples contain an acad.rx file, which lists
ObjectARX program files that are loaded automatically when you start
AutoCAD.
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Introduction to Programming Interfaces > ObjectARX > Overview of
ObjectARX >

Overview of ObjectARX
I” Quick Reference 1

Commands
No entries

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Introduction to Programming Interfaces > ObjectARX > Use ObjectARX
Applications >

Use ObjectARX Applications
I” Quick Reference 1

Commands
ARX
Loads, unloads, and provides information about ObjectARX applications

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Introduction to Programming Interfaces > ObjectARX > Automatically L.oad
ObjectARX Applications >

Automatically Load ObjectARX Applications
I” Quick Reference 1

Commands
APPLOAD
Loads and unloads applications and defines which applications to load at startup

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Introduction to Programming Interfaces >
NET

With the Microsoft .NET Framework, you can create applications that
interoperate with AutoCAD using programming languages like VB .NET and
C#.

Topics in this section

=  Overview of .NET

» Loading Managed Applications in AutoCAD

To load a managed application, enter NETLOAD at the AutoCAD
command prompt and browse to the desired DLL file. Managed
applications are unloaded only when AutoCAD exits.
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Introduction to Programming Interfaces > .NET > Overview of .NET >

Overview of .NET
I” Quick Reference 1

Commands
No entries

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Introduction to Programming Interfaces > .NET > Loading Managed Application
in AutoCAD >

Loading Managed Applications in AutoCAD
I” Quick Reference 1

Commands
NETLOAD
Loads a .NET application

System Variables
No entries

Utilities

No entries

Command Modifiers

No entries
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Shapes and Shape Fonts

You can define shapes to use as drawing symbols and text fonts. This section
explains how to create and compile your own shape and font files.

Topics in this section

= Overview of Shape Files

m  Create Shape Definition Files
AutoCAD font and shape files (SHX) are compiled from shape
definition files (SHP). You can create or modify shape definition files
with a text editor or word processor that saves files in ASCII format.
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Shapes and Shape Fonts > Overview of Shape Files >

Overview of Shape Files

I"” Quick Reference 1

Commands
COMPILE
Compiles shape files and PostScript font files into SHX files

LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Shapes and Shape Fonts > Create Shape Definition Files > Shape Descriptions >
Shape Descriptions

I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Shapes and Shape Fonts > Create Shape Definition Files > Vector Length and
Direction Code >

Vector Length and Direction Code
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Shapes and Shape Fonts > Create Shape Definition Files >
Special Codes

In addition to defining vectors, a specification byte can use special codes to
create additional forms and specify certain actions.

To use a special code, the second character of the three-character string (the
vector length specification) must be 0, or you can specify only the code number.
For example, 008 and 8 are both valid specifications.

Specification byte codes

End of shape definition

001 Activate Draw mode (pen
down)

002 Deactivate Draw mode
(pen up)

003 Divide vector lengths by
next byte

004 Multiply vector lengths
by next byte

005 Push current location
onto stack

006 Pop current location from



stack

007 Draw subshape number
given by next byte

008 X-Y displacement given
by next two bytes

009 Multiple X-Y
displacements, terminated
(0,0)

00A Octant arc defined by
next two bytes

00B Fractional arc defined by
next five bytes

00C Arc defined by X-Y
displacement and bulge

00D Multiple bulge-specified
arcs

00E Process next command

only if vertical text

Topics in this section

Codes 0, 1, and 2: End of Shape and Draw Mode Control

Codes 3 and 4: Size Control

Codes 5 and 6: I.ocation Save/Restore

Code 7: Subshape

Codes 8 and 9: X-Y Displacements

Code 00A: Octant Arc



m Code 00B: Fractional Arc
= Codes 00C and 00D: Bulge-Specified Arcs

= Code 00E: Flag Vertical Text Command
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes > Code
0, 1, and 2: End of Shape and Draw Mode Control >

Codes 0, 1, and 2: End of Shape and Draw Mode Control
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes > Code
3 and 4: Size Control >

Codes 3 and 4: Size Control
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes > Code
5 and 6: L.ocation Save/Restore >

Codes 5 and 6: Location Save/Restore
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes > Code
7: Subshape >

Code 7: Subshape
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes > Code
8 and 9: X-Y Displacements >

Codes 8 and 9: X-Y Displacements
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes > Code
00A: Octant Arc >

Code 00A: Octant Arc
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes > Code
00B: Fractional Arc >

Code 00B: Fractional Arc
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes > Code
00C and 00D: Bulge-Specified Arcs >

Codes 00C and 00D: Bulge-Specified Arcs
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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ms-its:ACAD_ACR.chm::/LOAD.htm
ms-its:ACAD_ACR.chm::/SHAPE.htm
javascript:doComments('./html/ac.cmtdialog.htm');

Shapes and Shape Fonts > Create Shape Definition Files > Special Codes > Code
00E: Flag Vertical Text Command >

Code 00E: Flag Vertical Text Command
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Shapes and Shape Fonts > Create Shape Definition Files > Text Font
Descriptions >

Text Font Descriptions
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

STYLE
Creates, modifies, or specifies text styles

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files >
Sample Files

This topic contains sample files that help extend the font characters provided
with AutoCAD.

Topics in this section

=  Extended Simplex Roman
m  Extended Standard Font for UNICODE

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Sample Files
> Extended Simplex Roman >

Extended Simplex Roman
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Sample Files
> Extended Standard Font for UNICODE >

Extended Standard Font for UNICODE
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files >
Big Font Descriptions

Some languages, such as Japanese, use text fonts with thousands of non-ASCII
characters. In order for drawings to contain such text, AutoCAD supports a
special form of shape definition file called a Big Font file.

Topics in this section

»  Define a Big Font

Special codes in the first line of a Big Font file specify how to read two-
byte hexidecimal codes.

m  Define an Extended Big Font File

To reduce the size of composite Kanji characters, you can define an
extended Big Font file. Extended big fonts use the subshape code,
followed immediately by a 0.

=  Use Big Font Text in a Drawing

To use a Big Font for drawing text, you set up a text style and then
specify the name of the Big Font file.

= Use a Big Font to Extend a Font

To include special symbols in text strings, you can use a Big Font
instead of extending a standard text font.

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Big Font
Descriptions > Define a Big Font >

Define a Big Font
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Shapes and Shape Fonts > Create Shape Definition Files > Big Font
Descriptions > Define an Extended Big Font File >

Define an Extended Big Font File
I” Quick Reference 1

Commands
COMPILE
Compiles shape files and PostScript font files into SHX files

LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Big Font
Descriptions > Use Big Font Text in a Drawing >

Use Big Font Text in a Drawing
I” Quick Reference 1

Commands
STYLE
Creates, modifies, or specifies text styles

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Big Font
Descriptions > Use a Big Font to Extend a Font >

Use a Big Font to Extend a Font
I” Quick Reference 1

Commands
COMPILE
Compiles shape files and PostScript font files into SHX files

LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Shapes and Shape Fonts > Create Shape Definition Files > Unicode Font
Descriptions >

Unicode Font Descriptions
I” Quick Reference 1

Commands
LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries
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Shapes and Shape Fonts > Create Shape Definition Files > Superscripts and
Subscripts in SHX Files >

Superscripts and Subscripts in SHX Files
I"” Quick Reference 1

Commands
COMPILE
Compiles shape files and PostScript font files into SHX files

LOAD
Makes shapes available for use by the SHAPE command

SHAPE
Inserts a shape from a shape file that has been loaded using LOAD

System Variables
No entries

Utilities

No entries

Command Modifiers
No entries

Please send us your comment about this page
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Basic Customization >

Overview of Customization

| o vconce |

AutoCAD can be customized in simple ways. For example, you can change the
directory structure or move a button from one toolbar to another. If you want to
change the interface further, you can edit the CUI file and use DIESEL code to
create customizations with your own commands.

You can also use a number of powerful application programming interfaces
(APIs) to add to and modify AutoCAD to suit your needs.

The list that follows is arranged from least to most complex:

Organize files. You can organize program, support, and drawing files.
For example, you can make a separate folder for each project that
includes only the support files that project needs.

Customize Tool Palettes. You can create a tool by dragging objects
from your drawing onto a tool palette. You can create a tool palette by
right-clicking on the Tool Palettes title bar and selecting New Palette.
For information about customizing tool palettes, see “Customize Tool
Palettes” in the User's Guide.

Create custom templates. Use templates to define common parameters
when you publish a drawing using the Publish to Web wizard.

Run external programs and utilities from within AutoCAD. You can,
for example, copy a disk or delete a file from within AutoCAD by
adding the appropriate external command to the program parameters
(PGP) file, acad.pgp.

Define command aliases. You can define simple abbreviations, or
aliases, for frequently used commands from within AutoCAD by adding
the command to the PGP file acad.pgp. For example, you might want to
start the BLOCK command by entering b.



= Create custom linetypes, hatch patterns, shapes, and text fonts. You
can create linetypes, hatch patterns, shapes, and text fonts that conform
to your company standards and working methods.

=  Customize the user interface. The CUI file controls many aspects of
the user interface, including the behavior of your pointing device buttons
and the functionality and appearance of pull-down, tablet, and image tile
menus, toolbars, and accelerator keys. You can edit or create a CUI file
to add commands or combine commands and assign them to a menu,
toolbar, or other location.

= Customize the status line. You can use the DIESEL string expression
language and the MODEMACRO system variable to provide additional
information at the status line, such as the date and time, system variable

settings, or retrievable information using AutoLISP®,

= Automate repetitive tasks by writing scripts. A script is an ASCII text
file containing commands that are processed like a batch file when you
run the script. For example, if a set of drawings needs to be plotted a
certain way, you can write a script that opens each drawing, hides and
displays various layers, and issues PLOT commands. You can use scripts
with slides to create automated presentations like those used at trade
shows. A slide is a “snapshot” of the drawing area that cannot be edited.
Slides can also be used in image tile menus and dialog boxes.

=  Redefine or disable selected AutoCAD commands, either at the
command prompt or as part of an AutoLISP or ObjectARX®
program. You can redefine certain AutoCAD commands to issue
supplementary messages and instructions or, for example, to create a
drawing management system in which the QUIT command is redefined
to write billing information to a log file before ending the editing
session.

In addition to the methods described in the Customization Guide, there are
application programming interfaces (APIs) available for customizing AutoCAD.
Introduction to Programming Interfaces briefly describes these APIs and

provides cross-references to more information.

See Also
m  Organize Program and Support Files



Customize Toolbars

Customize a Publish to Web Template
Create Command Aliases

Custom Linetypes
Custom Hatch Patterns

Customize the User Interface
DIESEL
Customize the Status Line

Introduction to Programming Interfaces
Slides and Command Scripts
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Basic Customization >

Customize a Publish to Web Template

[ conce )T

You can create customized templates to use in the Publish to Web wizard by
modifying one of the Publish to Web template (PWT) files provided. Use any
HTML editor or text editor.

To create a custom template, add or modify any of the following elements:

Images
Text
Hyperlinks
Color

Title

Video, animation, and so on

There are four default Publish to Web templates that you can customize:

Array of Thumbnails. Creates a web page containing an array of
thumbnail images.

Array Plus Summary. Creates a web page containing an array of
thumbnail images and summary information about each image.

List of Drawings. Creates a web page containing a list of drawings and
an image frame.

List Plus Summary. Creates a web page containing a list of drawings,
an image frame, and summary information about a selected image.

Note You must be familiar with HTML syntax to customize the Publish to Web
templates.



You can make changes or additions to the look and feel of a template, but you
cannot change the arrangement of images within it. For example, in the Array of
Thumbnails template, the images are presented across the page in rows. You
cannot alter the presentation of the images, but you can wrap text and graphics
around the table of images.

warning To ensure that you do not overwrite the default Publish to Web template
files, back up those files before you make any changes to them.

Please send us your comment about this page
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Basic Customization >

Define Custom Commands

[_concre | RN

You can define external commands that run from within AutoCAD. You can also
create command aliases for AutoCAD commands in the acad.pgp file, an ASCII
text file that stores command definitions.

Topics in this section

= Define External Commands

External commands start other programs or utilities while AutoCAD is
running.

m  Create Command Aliases

A command alias is an abbreviation that you enter at the command
prompt instead of entering the entire command name.

Please send us your comment about this page
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Basic Customization > Organize Program and Support Files >
Overview of File Organization

| o nconce |

AutoCAD uses support files for purposes such as storing customization
definitions, loading AutoLISP and ObjectARX applications, and describing text
fonts.

The default directory structure for the AutoCAD program and support files is
designed to efficiently organize those files into logical groups. If this
organization does not suit your needs, you can change it. However, some
applications look for certain files in specific locations, and you should verify that
your modifications do not conflict with the requirements of those applications.
Without the full path, including drive and directory, AutoCAD can locate only
those files that are found in the library search path.

The location of the support folder changed in AutoCAD 2004. The location of
local customizable files is stored in the LOCALROOTPREFIX system variable.
The location of roamable customizable files is stored in the
ROAMABLEROOTPREFIX system variable. If a network supports roaming,
customizable files in the user's roaming profile are available on the machine the
user is logged onto.

The following LISP script creates the CUSTFILES command, which launches
Windows® Explorer in the correct folder.

(defun c:custfiles ()
(command "shell"
(strcat "explorer \"" (getvar "roamablerootprefix") "\"")

)

(princ)

)

Library Search Path



The library search path specifies where the program searches for files when you
do not specify a full path name, as follows:

m  Current directory. (This is typically determined by the “Start In” setting
in your shortcut icon.)

= Directory that contains the current drawing file.

m Directories listed in the search path specified on the Files tab in
OPTIONS. (See Specify Search Paths and File Locations in the User's
Guide.)

m  Directory that contains the AutoCAD program files.

Depending on the current environment, two or more directories may be the
same.

If a file is not in this search path, you must specify both its path name and file
name before AutoCAD can find it. For example, if you want to insert the
part5.dwg drawing into your current drawing and it is not in the library search
path, you must specify its full path name, as shown here:

Command: insert

Enter block name or [?]: /files2/olddwgs/part5

If the drawing exists in that location, AutoCAD prompts you to finish the
INSERT command in the usual manner.

Directory Structure

AutoCAD uses tree-structured directories and subdirectories. It is recommended
that you keep supplemental files (such as AutoLISP applications and
customization files) separate from the AutoCAD program and support files. This
makes it easier to track possible conflicts and to upgrade each application
without affecting the others.

The default location for AutoCAD is in the Program Files folder. You can create
a new directory on the same level (for example, /AcadApps) and store your
custom AutoLISP and VBA macros, customization files, and other third-party
applications in subdirectories on the next level. If you want to maintain multiple
drawing directories (for separate job files), you can create a directory such as
/AcadJobs with subdirectories for each job.
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Command Search Procedure

When you enter a command, AutoCAD goes through a series of steps to evaluate
the validity of the command name. A command can be a built-in command or
system variable, an external command or alias defined in the acad.pgp file, or a
user-defined AutoLISP command. Commands can also be defined by
ObjectARX applications or a device driver command. You can enter a command
on the command prompt or choose a command from the appropriate menu.
Commands can also be entered from a script file or by an AutoLISP or
ObjectARX application.

The following list describes the search order AutoCAD uses to validate a
command name.

1.

If the input is a null response (SPACEBAR or ENTER), AutoCAD uses
the name of the last command issued. HELP is the default.

AutoCAD checks the command name against the list of built-in
commands. If the command is in the list and is not preceded by a period
(.), AutoCAD then checks the command against a list of undefined
commands. If the command is undefined, the search continues.
Otherwise, the command is run, unless another reason prevents it from
doing so. Running it transparently or in Perspective mode might be
impossible.

AutoCAD checks the command name against the names of commands
defined by a device driver, and then by those defined by the display
driver.

AutoCAD checks the command name against the external commands
defined in the program parameters file (acad.pgp). If the command name
corresponds to a defined external command, that command runs, and the
search is complete.

AutoCAD checks the command name against the list of commands
defined by AutoLISP or ObjectARX applications. At this point, an
autoloaded command is loaded.

AutoCAD checks the command name against the list of system
variables. If the command name is in the list, AutoCAD executes the
SETVAR command, using the input as the variable name.



7. If the command name corresponds to a command alias defined in the
program parameters file, AutoCAD uses the expanded command name
and continues the search, starting a new search against the list of built-in
commands.

8. If all the preceding steps fail, the search terminates with a warning
message about illegal command names.

See Also

m  Overview of AutoLISP Automatic [.oading

m  Specify Search Paths and File Locations in the User's Guide
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Basic Customization > Organize Program and Support Files >

Multiple Configurations
[T | uick Reference ||

If you use more than one pointing device or use different plotters, you can set up
more than one configuration file to make it easy to switch between devices.

When you configure AutoCAD for a pointing device and plotter drivers, the
information you supply is recorded in a configuration file. The default location
of the acad2009.cfg configuration file is listed in the Options dialog box, Files
tab, under Help and Miscellaneous File Names, but you can specify an
alternative path or file name.

Typically, only a single configuration is necessary, but you may need multiple
configurations. For example, if you use a mouse for most of your work but
occasionally require a large digitizing tablet, you can set up your system to
handle multiple configurations rather than reconfiguring each time you change a
device.

The configuration file stores the values of many AutoCAD system variables and
the configuration options defined in the Options dialog box. If you want different
settings for these system variables and operating parameters, you can save those
values to different configuration files. For a list of the system variables and
where they are stored, see System Variables in the Command Reference.

To take advantage of multiple configurations, you must set up AutoCAD to use
different configuration files. Use the /c switch to specify alternative
configuration files at startup.

See Also
m  Customize Startup in the User's Guide
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Basic Customization > Organize Program and Support Files >

Multiple Drawing Folders
[T | uick Reference ||

Keeping your drawing and other associated files in separate directories makes it
easier to perform basic file maintenance.

Keeping your drawing files and other associated files in separate directories
makes it easier to perform basic file maintenance. The scenario described in this
topic is based on the sample directory structure described in Overview of File
Organization, but you can expand or alter it to meet your needs.

You can set up the /AcadJobs directory to contain your drawing subdirectories.
The drawing subdirectories can contain other subdirectories that hold related
support files for a particular drawing type or job. The /AcadJobs/Job1/Support
directory can contain blocks and AutoLISP files specific to the drawing files in
/AcadJobs/Job1. Specifying support (with no path prefix) in the Support path
adds the support directory within the current directory to the Support path.
Notice that if you use the Options dialog box to specify a directory, AutoCAD
creates a hard-coded path to that directory. To use the relative naming
convention previously described, you must specify the Support path with the /s
switch on the command line. See Customize Startup in the User's Guide.

To make sure that the required drawing directory is the current directory when
you start AutoCAD, and that all files and subdirectories in that directory are
easily accessible, you can create a program icon or a Start menu item that
specifies the correct working directory for each job. This functionality works
only if you set the AutoCAD system variable REMEMBERFOLDERS to O.

You can use a batch program as an alternative to using icons or menus. With
batch programs you can create new job directories automatically. The following
batch program verifies that a specified directory exists, sets that directory to be
current, and then runs AutoCAD.

@echo off
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C:

if exist \AcadJobs\Jobs\%1l goto RUNACAD
echo.

echo *** Creating \AcadJobs\Jobs\%1
echo *** Press Ctrl+C to cancel.
echo.

pause

mkdir \AcadJobs\Jobs\%1

:RUNACAD

cd \AcadJobs\Jobs\%1

start C:\ AutoCAD\acad.exe

Using an ASCII text editor (such as Notepad), save the batch program to a file
named acad.bat. Be sure to change the drive and directory names to match those
on your system. Place this file in a directory that is on your system search path
(for example, C:\winnt). You can run this batch program using the Run
command on the Start menu or by double-clicking the file in Explorer. If you
saved the file as acad.bat, use the following syntax:

acadjobname

where jobname is the name of the job directory to make current.

Please send us your comment about this page
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Basic Customization > Customize a Publish to Web Template >

Customize a Publish to Web Template
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To create quick access to the Publish to Web templates

To customize a Publish to Web template

Please send us your comment about this page
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Basic Customization > Customize a Publish to Web Template >

Customize a Publish to Web Template
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To customize a Publish to Web template

1.

Browse to the Publish to Web template folder, click File menu » Open.

See To create quick access to the Publish to Web templates.

Double-click the PTWTemplates folder to open it. The following folders
are displayed. Each contains a Publish to Web template and preview
images (BMP) that you see when you run the Publish to Web wizard.

m Templatel. Contains the Array of Thumbnails template and a
preview image

m Template2. Contains the Array Plus Summary template, a preview
image, and HTML frames

m Template3. Contains the List of Drawings template, a preview
image, and HTML frames

m Template4. Contains the List Plus Summary template, a preview
image, and HTML frames

Right-click the folder you want to use, and click Copy.
Press ALT+2, right-click the PTWTemplates folder, and click Paste.

Reopen the PTWTemplates folder, and right-click the new folder and
rename it.

Right-click the new folder and click Open to display its contents.

Rename the Publish to Web template (PWT) file with an .htm or .html
file extension.



8.

10.

Open the template file in an HTML editor or a text editor.

The template file contains comments that help you determine which
areas of the code you can modify to create your new web page.

Review the comments and make changes to the parts of the template you
want to customize.

Save the template with a .pwt file extension. Make sure you save the file
to the template folder you created in step 3.

Note Each template folder can contain only one PWT file. If you create a
new PWT file, make sure you delete any other PWT files that exist in the
same folder.

When you run the Publish to Web wizard, the new template is displayed
in the list of templates.
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To open the program parameters file (acad.pgp)

m  Click Tools » Customize » Edit Program Parameters (acad.pgp)
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External commands start other programs or utilities while AutoCAD is running.

While AutoCAD is running, you can invoke other programs or utilities, such as
the following:

m  Windows system commands and utilities, such as start, type, dir, or
copy

m  Applications such as text editors or word processors
m Database managers, spreadsheets, and communications programs
m  User-supplied programs, such as batch files or VBA macros

When you enter an external command, AutoCAD looks for the command in
acad.pgp. The first section of acad.pgp defines external commands. You can add
command definitions by editing acad.pgp in an ASCII text editor (such as
Notepad). To open the PGP file, click Tools » Customize » Edit Program
Parameters (acad.pgp).

Note Before you edit acad.pgp, create a backup file so that you can restore it later,
if necessary.

When you define an external command, you specify a command name to be used
at the command prompt and an executable command string that is passed to the
operating system. Each line in the external commands section has five comma-
delimited fields, as follows:

command, [executable], flags[, [*]prompt[, return_code]]

command

The command that is entered at the command prompt. If the name is an



internal AutoCAD command name, it is ignored. The name is not case-
sensitive.

executable

The constant string sent to the operating system when you enter a command
name. It can be any command that you can execute at the operating-system

prompt. The string can include switches or parameters. The case-sensitivity
of this string depends on the application you are running.

flags
A required bitcoded parameter. Add these integer values in any combination
to achieve the result you want.
0 Start the application and wait for it to finish.
1 Don't wait for the application to finish.
2 Run the application in Minimized mode.
4 Run the application “hidden.”
8 Put the argument string in quotes.
Bit values 2 and 4 are mutually exclusive; if both are specified only the 2 bit

is used. Using value 2 or 4 without value 1 should be avoided, because
AutoCAD becomes unavailable until the application has completed.

Bit value 8 allows commands like del to work properly with file names that
have embedded spaces. This eliminates the possibility of passing a space-
delimited list of file names to these commands. If you prefer multiple file
support, do not use the bit value 8.

prompt

An optional field. It specifies the prompt to display on the AutoCAD
command line or for the dynamic input tooltip. The response to this prompt is
appended to the string supplied in the executable field. If the first character of
the prompt field is an asterisk (*), the response can contain spaces and the
user must press ENTER to terminate it. Otherwise, the response is terminated
by either SPACEBAR or ENTER. If no prompt is specified, no input is
requested; however, you must add a comma if a return code is to be supplied
or if you want the prompt to have a trailing space.

return_code

An optional bitcoded parameter. You can add these integer values together in



any combination to achieve the result you want. For example, if values 1 and
2 are required, you use 3 as the return code. The values are defined as
follows (codes @ and 4 are meaningless in a windowed environment and are
therefore not included):

1 Loads a DXB file. AutoCAD loads the DXB file named $cmd.dxb into the
drawing after the command is terminated. After the DXB file is loaded, the
$cmd.dxb file is deleted. This action produces the same result as the DXBIN
command.

2 Constructs a block definition from a DXB file. AutoCAD creates a block
definition from the DXB file named $cmd.dxb. The response to the prompt
field is used as the block name. This name must be a valid block name that
does not currently exist in the drawing; therefore, this mode cannot redefine a
previously defined block. After AutoCAD loads the DXB file, the $cmd.dxb
file is deleted. The default name for the INSERT command is set to the newly
defined block.

The file can also contain comment lines preceded by a semicolon (;).

Windows System Commands

The start and cmd Windows system commands are very useful when defining
external commands. If you specify an executable string that does not use the
start or cmd command, AutoCAD is unavailable until that window is closed.

The start command starts a separate window and runs a specified program or
command. If start is used without any parameters, it opens a new command
prompt window. The start command has many command line switches that
affect the display of the new window. To launch a Windows application, use
start without any switches. The start command is also very useful for starting a
document that is associated with an application. For example, you can use start
to directly open a document created with a word processor or an HTML file.

The cmd command opens a command prompt window that acts as a shell of
AutoCAD. This window must be closed before control returns to the AutoCAD
command prompt. Two command line switches, /c and /k, are useful for external
commands. The /c switch carries out the specified command and then stops (the
window closes). The /k switch carries out the specified command and then
continues (the window remains open). When using the /k switch, you must close
the command window (with the exit command).



In general, use start to start a new window or application that is to be a separate
process from AutoCAD. Use cmd to run a batch file or command script that
does not create a separate window, or to create a window that must be closed
before control is passed back to AutoCAD. For more information about these
commands and switches, see your Windows system command documentation.

Custom-Defined Commands

The following example defines three new commands: RUN, LISTSET, and
DXB2BLK.

RUN, cmd /c,0, *Batch file to run: ,
LISTSET,cmd /k SET,0
DXB2BLK,cmd /c DXBCOPY,0,DXB file: ,2

The RUN command runs a batch file or command script. The cmd command
followed by the /c switch opens a command window, runs the batch file, and
then closes.

The LISTSET command displays the current DOS environment variable
settings. Because this example uses cmd /k rather than start, the command
window must be closed before returning to AutoCAD. If you want this window
to remain active, use start /realtime. For more information about these
commands and switches, see your Windows system command documentation.

The DXB2BLK command creates a block definition from the specified DXB
file. The DXB file converts all objects into lines. One beneficial by-product of
this procedure is that it provides a simple method for exploding text objects into
lines.

DXB2BLK passes the specified DXB file name to the dxbcopy batch file, which
copies that file name to the file name $cmd.dxb. AutoCAD then creates a block
from the specified DXB file. The name provided to the DXB file prompt is used
as the new block name. To create the dxbcopy.cmd file, enter the following at the
Windows Command Prompt:

echo copy %1.dxb $cmd.dxb > dxbcopy.cmd

This creates the dxbcopy.cmd file in the current directory. Move this file to a
directory that is in your DOS path, or explicitly specify the file's location in the
acad.pgp file. For example, if the dxbcopy.cmd file is in D:\cad, enter the



following in the external commands section of your acad.pgp file.

DXB2BLK, cmd /c D:\CAD\DXBCOPY,®,DXB file: ,2

To create a DXB file, choose AutoCAD DXB File Format as the current printer,
and then plot to a file. For more information about configuring printers, see Set
Up Plotters and Printers in the Driver & Peripheral Guide.
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A command alias is an abbreviation that you enter at the command prompt
instead of entering the entire command name.

For example, you can enter c instead of circle to start the CIRCLE command.
An alias is not the same as a keyboard shortcut, which is a combination of
keystrokes, such as CTRL+S for SAVE.

An alias can be defined for any AutoCAD command, device driver command, or
external command. The second section of the acad.pgp file defines command
aliases. You can change existing aliases or add new ones by editing acad.pgp in
an ASCII text editor (such as Notepad). To open the PGP file, click Tools >
Customize » Edit Program Parameters (acad.pgp). The file can also contain
comment lines preceded by a semicolon (;).

Note Before you edit acad.pgp, create a backup so that you can restore it later, if
necessary.

To define a command alias, add a line to the command alias section of the
acad.pgp file using the following syntax:

abbreviation, *command

where abbreviation isthe command alias that you enter at the command
prompt and command is the command being abbreviated. You must enter an
asterisk (*) before the command name to identify the line as a command alias
definition.

If you can enter a command transparently, you can also enter its alias
transparently. When you enter the command alias, the full command name is
displayed at the command prompt and the command is executed.

You can create command aliases that include the special hyphen (-) prefix, such


ms-its:ACAD_ACR.chm::/SAVE.htm

as those listed here, that accesses the version of a command that displays
command prompts instead of a dialog box.

BH, *-BHATCH
BD, *-BOUNDARY

Note You cannot use command aliases in command scripts. Using command
aliases in customization files is not recommended.

If you edit acad.pgp while AutoCAD is running, enter reinit to use the revised
file. You can also restart AutoCAD to automatically reload the file.
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Linetypes are defined in one or more linetype definition files that have a .lin file
extension.

The linetype name and definition determine the particular dash-dot sequence, the
relative lengths of dashes and blank spaces, and the characteristics of any
included text or shapes. You can use any of the standard linetypes that AutoCAD
provides, or you can create your own linetypes.

A LIN file can contain definitions of many simple and complex linetypes. You
can add new linetypes to an existing LIN file, or you can create your own LIN
file. To create or modify linetype definitions, edit the LIN file using a text editor
or word processor or use LINETYPE at the command prompt.

When you create a linetype, you must load the linetype before you can use it.

The LIN files included in AutoCAD are acad.lin and acadiso.lin. You can
display or print these text files to better understand how to construct linetypes.
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Each linetype is defined on two lines in a linetype definition file. The first line
contains the linetype name and an optional description. The second line is the
code that defines the actual linetype pattern.

The second line must begin with the letter A (alignment), followed by a list of
pattern descriptors that define pen-up lengths (spaces), pen-down lengths
(dashes), and dots. You can include comments in an LIN file by beginning the
line with a semicolon (;).

Linetype Definition Format

The format of the linetype definition is

*linetype _name, description
A,descriptorl,descriptor2,

For example, a linetype called DASHDOT is defined as

*DASHDOT, Dash dot __ . __
A,.5,-.25,0,-.25

This indicates a repeating pattern starting with a dash 0.5 drawing units long, a
space 0.25 drawing units long, a dot, and another space 0.25 drawing units long.
This pattern continues for the length of the line, ending with a dash 0.5 drawing
units long. The linetype would be displayed as shown below.

LIN files must be saved in ASCII format and use an .lin file extension.
Additional information about each field in a linetype definition follows.



Linetype Name

The linetype name field begins with an asterisk (*) and should provide a unique,
descriptive name for the linetype.

Description

The description of the linetype should help you visualize the linetype when you
edit the LIN file. The description is also displayed in the Linetype Manager and
in the Load or Reload Linetypes dialog box.

The description is optional and can include
m A simple representation of the linetype pattern using ASCII text
= An expanded description of the linetype
m A comment such as "Use this linetype for hidden lines"

If you omit the description, do not insert a comma after the linetype name. A
description cannot exceed 47 characters.

Alignment Field (A)

The alignment field specifies the action for pattern alignment at the ends of
individual lines, circles, and arcs. Currently, AutoCAD supports only A-type
alignment, which guarantees that the endpoints of lines and arcs start and stop
with a dash.

For example, suppose you create a linetype called CENTRAL that displays the
repeating dash-dot sequence commonly used as a centerline. AutoCAD adjusts
the dash-dot sequence on an individual line so that dashes and line endpoints
coincide. The pattern fits the line so that at least half of the first dash begins and
ends the line. If necessary, the first and last dashes are lengthened. If a line is too
short to hold even one dash-dot sequence, AutoCAD draws a continuous line
between the endpoints. For arcs also, the pattern is adjusted so that dashes are
drawn at the endpoints. Circles do not have endpoints, but AutoCAD adjusts the
dash-dot sequence to provide a reasonable display.

You must specify A-type alignment by entering a in the alignment field.



Pattern Descriptors

Each pattern descriptor field specifies the length of segments making up the
linetype, separated by commas (no spaces are allowed):

m A positive decimal number denotes a pen-down (dash) segment of that
length.

= A negative decimal number denotes a pen-up (space) segment of that
length.

= A dash length of 0 draws a dot.

You can enter up to 12 dash-length specifications per linetype, provided they fit
on one 80-character line in the LIN file. You need to include only one complete
repetition of the linetype pattern defined by pattern descriptors. When the
linetype is drawn, AutoCAD uses the first pattern descriptor for the starting and
ending dashes. Between the starting and ending dashes, the pattern dash
specifications are drawn sequentially, beginning with the second dash
specification and restarting the pattern with the first dash specification when
required.

A-type alignment requires that the first dash length be O or greater (a pen-down
segment). The second dash length should be less than 0 if you need a pen-up
segment and more than 0 if you are creating a continuous linetype. You must
have at least two dash specifications for A-type alignment.
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Characters from text fonts can be included in linetypes.

Characters from text fonts can be included in linetypes. Linetypes with
embedded characters can denote utilities, boundaries, contours, and so on. As
with simple linetypes, lines are dynamically drawn as you specify the vertices.
Characters embedded in lines are always displayed completely; they are never
trimmed.

Embedded text characters are associated with a text style in the drawing. Any
text styles associated with a linetype must exist in the drawing before you load
the linetype.

The format for linetypes that include embedded characters is similar to that for
simple linetypes in that it is a list of pattern descriptors separated by commas.

Character Descriptor Format

The format for adding text characters in a linetype description is as follows:

["text", textstylename, scale,rotation, xoffset, yoffset]

This format is added as a descriptor to a simple linetype. For example, a linetype
called HOT WATER_SUPPLY is defined as

*HOT_WATER_SUPPLY, ---- HW ---- HW ---- HW ---- HW ---- HW ----
A, .5,-.2, ["HW", STANDARD, S=.1,R=0.0,X=-0.1,Y=-.05], -.2

This indicates a repeating pattern starting with a dash 0.5 drawing units long, a
space 0.2 drawing units long, the characters HW with some scale and placement
parameters, and another space 0.2 drawing units long. The text characters come
from the text font assigned to the STANDARD text style at a scale of 0.1, a



relative rotation of 0 degrees, an X offset of -0.1, and a Y offset of -0.05. This
pattern continues for the length of the line, ending with a dash 0.5 drawing units
long. The linetype would be displayed as shown below.

- Hev- HN—HN—H'EZL

Notice that the total upstroke length is 0.2 + 0.2 = 0.4 and that the text origin is
offset -.01 units in the X direction from the end of the first upstroke. An
equivalent linetype would be

*HOT_WATER_SUPPLY, ---- HW ---- HW ---- HW ---- HW ---- HW ----
A, .5,-.1, ["HW", STANDARD, S=.1,R=0.0,X=0.0,Y=-.05], -.3

The total upstroke is still 0.1 + 0.3 = 0.4, but the text origin is not offset in the X
direction.

Additional information about each field in the character descriptor follows. The
values to be used are signed decimal numbers such as 1, -17, and 0.01.

text

The characters to be used in the linetype.

text style name

The name of the text style to be used. If no text style is specified, AutoCAD
uses the currently defined style.

scale

S=value. The scale factor to be used for the text style relative to the scale
of the linetype. The height of the text style is multiplied by the scale factor. If
the height is 0, the value for S=value alone is used as the height.

rotation

R=value or A=value. R= specifies relative or tangential rotation with
respect to the line. A= specifies absolute rotation of the text with respect to
the origin; that is, all text has the same rotation regardless of its position



relative to the line. The value can be appended with a d for degrees (degrees
is the default value), r for radians, or g for grads. If rotation is omitted, 0
relative rotation is used.

Rotation is centered between the baseline and the nominal cap height.

xoffset

X=value. The shift of the text on the X axis of the linetype, which is along
the line. If xoffset is omitted or is 0, the text is elaborated with no offset.
Use this field to control the distance between the text and the previous pen-up
or pen-down stroke. This value is not scaled by the scale factor defined by
S=value, but it is scaled to the linetype.

yoffset

Y=value. The shift of the text in the Y axis of the linetype, which is at a 90-
degree angle to the line. If yoffset is omitted or is 0, the text is elaborated
with no offset. Use this field to control the vertical alignment of the text with
respect to the line. This value is not scaled by the scale factor defined by
S=value, but it is scaled to the linetype.
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A complex linetype can contain embedded shapes that are saved in shape files.
Complex linetypes can denote utilities, boundaries, contours, and so on.

As with simple linetypes, complex lines are dynamically drawn as the user
specifies vertices. Shapes and text objects embedded in lines are always
displayed completely; they are never trimmed.

The syntax for complex linetypes is similar to that of simple linetypes in that it is
a comma-delimited list of pattern descriptors. Complex linetypes can include
shape and text objects as pattern descriptors, as well as dash-dot descriptors.

The syntax for shape object descriptors in a linetype description is as follows:

[shapename, shxfilename] or [shapename,shxfilename, transform]

where transform is optional and can be any series of the following (each
preceded by a comma):

R=## Relative rotation
A=## Absolute rotation
S=## Scale

X=## X offset

Y=## Y offset

In this syntax, ## is a signed decimal number (1, -17, 0.01, and so on), the
rotation is in degrees, and the remaining options are in linetype-scaled drawing
units. The preceding transform letters, if they are used, must be followed by
an equal sign and a number.



The following linetype definition defines a linetype named CON1LINE that is
composed of a repeating pattern of a line segment, a space, and the embedded
shape CON1 from the ep.shx file. (Note that the ep.shx file must be in the
support path for the following example to work properly.)

*CONLILINE, --- [CON1] --- [CON1] --- [CON1]
A,1.0,-0.25, [CON1,ep.shx],-1.0

Except for the code enclosed in square brackets, everything is consistent with the
definition of a simple linetype.

As previously described, a total of six fields can be used to define a shape as part
of a linetype. The first two are mandatory and position-dependent; the next four
are optional and can be ordered arbitrarily. The following two examples
demonstrate various entries in the shape definition field.

[CAP, ep.shx, S=2,R=10, X=0.5]

The code above draws the CAP shape defined in the ep.shx shape file with a
scale of two times the unit scale of the linetype, a tangential rotation of 10
degrees in a counterclockwise direction, and an X offset of 0.5 drawing units
before shape elaboration takes place.

[DIPS, pd.shx, X=0.5,Y=1,R=0, S=1]

The code above draws the DIP8 shape defined in the pd.shx shape file with an X
offset of 0.5 drawing units before shape drawing takes place, and a Y offset of
one drawing unit above the linetype, with O rotation and a scale equal to the unit
scale of the linetype.

The following syntax defines a shape as part of a complex linetype.

[shapename, shapefilename, scale, rotate, xoffset, yoffset]

The definitions of the fields in the syntax follow.

shapename

The name of the shape to be drawn. This field must be included. If it is
omitted, linetype definition fails. If shapename does not exist in the
specified shape file, continue drawing the linetype but without the embedded
shape.



shapefilename

The name of a compiled shape definition file (SHX). If it is omitted, linetype
definition fails. If shapefilename is unqualified (that is, no path is
specified), search the library path for the file. If shapefilename is fully
qualified and not found at that location, remove the prefix and search the
library path for the file. If it is not found, continue drawing the linetype but
without the embedded shape.

scale

S=value. The scale of the shape is used as a scale factor by which the
shape's internally defined scale is multiplied. If the shape's internally defined
scale is 0, the S=value alone is used as the scale.

rotate

R=value or A=value. R= signifies relative or tangential rotation with
respect to the line's elaboration. A= signifies absolute rotation of the shape
with respect to the origin; all shapes have the same rotation regardless of
their relative position to the line. The value can be appended with a d for
degrees (if omitted, degree is the default), r for radians, or g for grads. If
rotation is omitted, O relative rotation is used.

xoffset

X=value. The shift of the shape in the X axis of the linetype computed from
the end of the linetype definition vertex. If xoffset is omitted or is 0, the
shape is elaborated with no offset. Include this field if you want a continuous
line with shapes. This value is not scaled by the scale factor defined by S=.

yoffset

Y=value. The shift of the shape in the Y axis of the linetype computed from
the end of the linetype definition vertex. If yoffset is omitted or 0, the
shape is elaborated with no offset. This value is not scaled by the scale factor
defined by S=.

See Also
= Shapes and Shape Fonts
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To create a simple linetype

1.
2.
3.

At the command prompt, enter -linetype.
Enter c (Create).

Enter a name for the linetype and press ENTER.

The linetype name can include up to 255 characters. Linetype names can
contain letters, digits, and the special characters dollar sign ($), hyphen
(-), and underscore (_). Linetype names cannot include blank spaces.

In the Create or Append Linetype File dialog box, select an LIN linetype
library file from the File Name box and choose Save.

If you select an existing file, the new linetype name is added to the
linetype names in the file.

Enter text that describes the new linetype (optional).

At the Enter Pattern prompt, specify the pattern of the line. Follow these
guidelines:

= All linetypes must begin with a dash.
= Enter zeros for dots.

= Enter negative real numbers for spaces. The value defines the
length of the space in drawing units.

m Enter positive real numbers for dashes. The value defines the
length of the dash in drawing units.

m Separate each dot, dash, or space value from the next with a



comma.
m Use a space between a dot and a dash.
7. Press ENTER to end the command.

Note When you create a linetype, it is not loaded into your drawing automatically.
Use the Load option of LINETYPE.
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To include text characters in linetypes
1. Create a simple linetype, as described in To create a simple linetype.

2. Add the text character descriptor within the linetype pattern, using the
following format:

["text",textstylename,scale,rotation,xoffset,yoffset

3. Press ENTER to exit LINETYPE.
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In addition to using the predefined hatch patterns that are supplied, you can
design and create your own custom hatch patterns.

In addition to using the predefined hatch patterns that are supplied, you can
design and create your own custom hatch patterns. Developing a hatch pattern
definition requires knowledge, practice, and patience. Because customizing
hatches requires familiarity with hatch patterns, it is not recommended for new
users.

The hatch patterns supplied by AutoCAD are stored in the acad.pat and
acadiso.pat text files. You can add hatch pattern definitions to this file or create
your own files.

Regardless of where the definition is stored, a custom hatch pattern has the same
format. It has a header line with a name, which begins with an asterisk and is no
more than 31 characters long, and an optional description:

*pattern-name, description
It also has one or more line descriptors of the following form:

angle, x-origin,y-origin, delta-x,delta-y,dash-1,dash-2, ..

The default hatch pattern ANSI31 shown in the Boundary Hatch and Fill dialog
box looks like this:

and is defined as follows:



*ANSI31, ANSI Iron, Brick, Stone masonry
45, 0,0, 0,.125

The pattern name on the first line, *ANSI31, is followed by a description:

ANSI Iron, Brick, Stone masonry. This simple pattern definition
specifies a line drawn at an angle of 45 degrees, that the first line of the family of
hatch lines is to pass through the drawing origin (0,0), and that the spacing
between hatch lines of the family is to be 0.125 drawing units.

Hatch pattern definitions follow these rules:

m  FEach line in a pattern definition can contain up to 80 characters. You can
include letters, numbers, and the special characters underline (_), hyphen
(-), and dollar sign ($). However, you must begin a pattern definition
with a letter or number, not a special character.

m  AutoCAD ignores both blank lines and text to the right of a semicolon.

m  Each pattern line is considered to be the first member of a line family,
created by applying the delta offsets in both directions to generate an
infinite family of parallel lines.

m  The delta-x value indicates the displacement between members of the
family in the direction of the line. It is used only for dashed lines.

m The delta-y value indicates the spacing between members of the
family; that is, it is measured perpendicular to the lines.

m A line is considered to be of infinite length. A dash pattern is
superimposed on the line.

The process of hatching consists of expanding each line in the pattern definition
to its infinite family of parallel lines. All selected objects are checked for
intersections with any of these lines; any intersections cause the hatch lines to be
turned on and off as governed by the hatching style. Each family of hatch lines is
generated parallel to an initial line with an absolute origin to guarantee proper
alignment.

If you create a very dense hatch, AutoCAD may reject the hatch and display a
message indicating that the hatch scale is too small or its dash length too short.
You can change the maximum number of hatch lines by setting the MaxHatch
system registry variable using (setenv “MaxHatch” “n”) where n is a number
between 100 and 10000000 (ten million).



Note When changing the value of MaxHatch, you must enter MaxHatch with the
capitalization as shown.
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To define dashed-line patterns, you append dash-length items to the end of the
line definition item.

To define dashed-line patterns, you append dash-length items to the end of the
line definition item. Each dash-length item specifies the length of a segment
making up the line. If the length is positive, a pen-down segment is drawn. If the
length is negative, the segment is pen-up, and it is not drawn. The pattern starts
at the origin point with the first segment and cycles through the segments in
circular fashion. A dash length of 0 draws a dot. You can specify up to six dash
lengths per pattern line.

The hatch pattern ANSI33, shown in the Boundary Hatch and Fill dialog box,
looks like this:

ey
/H “ /
F // // ./.-""'K
and is defined as follows:

*ANSI33, ANSI Bronze, Brass, Copper
45, .176776695,0, 0,.25, .125,-.0625

For example, to modify a pattern for 45-degree lines to draw dashed lines with a
dash length of 0.5 units and a space between dashes of 0.5 units, the line
definition would be

*DASH45, Dashed lines at 45 degrees
45, 0,0, 0,.5, .5,-.5

This is the same as the 45-degree pattern shown in Overview of Hatch Pattern
Definitions, but with a dash specification added to the end. The pen-down length




is 0.5 units, and the pen-up length is 0.5, meeting the stated objectives. If you
wanted to draw a 0.5-unit dash, a 0.25-unit space, a dot, and a 0.25-unit space
before the next dash, the definition would be

*DD0OT45, Dash-dot-dash pattern: 45 degrees
45, 0,0, 0,.5, .5,-.25, 0,-.25

The following example shows the effect of delta-x specifications on dashed-
line families. First, consider the following definition:

*GOSTAK
o, 0,0, 0,.5, .5,-.5

This draws a family of lines separated by 0.5, with each line broken equally into
dashes and spaces. Because delta- X is zero, the dashes in each family
member line up. An area hatched with this pattern would look like this:

Now change the pattern to

*SKEWED
o, 0,0, .5,.5, .5,-.5

It is the same, except that you have set delta-x to 0.5. This offsets each
successive family member by 0.5 in the direction of the line (in this case, parallel
to the X axis). Because the lines are infinite, the dash pattern slides down the
specified amount. The hatched area would look like this:

Please send us your comment about this page
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Custom Hatch Patterns >

Hatch Patterns with Multiple Lines
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Complex hatch patterns can have an origin that passes through offsets from the
origin and can have multiple members in the line family.

Not all hatch patterns use origin points of 0,0. Complex hatch patterns can have
an origin that passes through offsets from the origin and can have multiple
members in the line family. In composing more complex patterns, you need to
carefully specify the starting point, offsets, and dash pattern of each line family
to form the hatch pattern correctly.

The hatch pattern AR-B816 shown in the Boundary Hatch and Fill dialog box
looks like this:

S

and is defined as follows with multiple lines describing the pattern:

*AR-B816, 8x16 Block elevation stretcher bond
0, 0,0, 0,8
90, 0,0, 8,8, 8,-8

The following figure illustrates a squared-off, inverted-U pattern (one line up,
one over, and one down). The pattern repeats every one unit, and each unit is 0.5
high and wide.

This pattern would be defined as follows:



*IUS, Inverted U's

90, 0,0, 0,1, .5,-.5
®, 0,.5, 0,1, .5,-.5
270, .5,.5, 0,1, .5,-.5

The first line (the up bar) is a simple dashed line with 0,0 origin. The second line
(the top bar) should begin at the end of the up bar, so its origin is 0,.5. The third
line (the down bar) must start at the end of the top bar, which is at .5,.5 for the
first instance of the pattern, so its origin is at this point. The third line of the
pattern could be the following:

90, .5,0, 0,1, .5,-.5

or

270, .5,1, 0,1, -.5,.5

The dashed pattern starts at the origin points and continues in the vector
direction given by the angle specification. Therefore, two dashed-line families
that are opposed 180 degrees are not alike. Two solid-line families are alike.

The following pattern creates six-pointed stars.

S W | S
RS S T
N LSt Sy W

This example can help you refine your skills at pattern definition. (Hint: 0.866 is
the sine of 60 degrees.)

The following is the AutoCAD definition of this pattern:

*STARS, Star of David

o, 0,0, 0,.866, .5,-.5

60, 0,0, 0,.866, .5,-.5

120, .25,.433, 0,.866, .5,-.5

Please send us your comment about this page
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Custom Hatch Patterns > Overview of Hatch Pattern Definitions >

Overview of Hatch Pattern Definitions
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To create a simple hatch pattern

1. Open the acad.pat or acadiso.pat file in a text editor that saves in ASCII
format (for example, Microsoft® Windows® Notepad).

2. Create a header line that includes an asterisk and a pattern name. The
name of the hatch pattern is limited to 31 characters.

3. (Optional) To include a description in the header line, follow the pattern
name with a comma and description text.

4. Create a descriptor line that includes
= An angle at which the line is drawn
= An X,Y origin point
m Adelta-x of 0

= A delta-y of any value

Please send us your comment about this page
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Hatch Patterns with Dashed Lines
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To create a hatch pattern with dashed lines

1. Open the acad.pat or acadiso.pat file in a text editor that saves in ASCII
format (for example, Notepad).

2. Create a header line that includes an asterisk and a pattern name. The
name of the hatch pattern is limited to 31 characters.

3. (Optional) To include a description in the header line, follow the pattern
name with a comma and description text.

4. Create a descriptor line that includes

An angle at which the line is drawn
An X,Y origin point

A delta- x of any value if you want to offset alternating lines in
the line family

A delta-y of any value

A value for a dash length

A value for a dot length

An optional second value for a different dash length

An optional second value for a different dot length

Please send us your comment about this page
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Custom Hatch Patterns > Hatch Patterns with Multiple Lines >

Hatch Patterns with Multiple Lines
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To create a hatch pattern with multiple lines

1. Open the acad.pat or acadiso.pat file in a text editor that saves in ASCII
format (for example, Notepad).

2. Create a header line that includes an asterisk and a pattern name. The
name of the hatch pattern is limited to 31 characters.

3. (Optional) To include a description in the header line, follow the pattern
name with a comma and description text.

4. Create a descriptor line that includes

An angle at which the line is drawn
An X,Y origin point

A delta-x of any value if you want to offset alternating lines in the
line family

A delta-y of any value

A value for a dash length

A value for a dot length

An optional second value for a different dash length

An optional second value for a different dot length

5. Create a second line including all the parameters in the previous step.

6. (Optional) Create additional lines to complete the multiple-line hatch
pattern.
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Customize the User Interface >

Work with Customization Files

[ concepe NN

Customization (CUI) files are used to store commands, user interface elements,
and references to partial CUI files and AutoLISP files. CUI files can be
designated as main, partial, or enterprise. The CUI file designation determines
the order the file is loaded. User interface elements can be transferred between
CUI files, which helps to make the migration process easier.

With the Customize User Interface (CUI) Editor, you can do the following with
customization files:

m  Create a new CUI file from scratch

m  Save an existing CUI file with a different name
m Transfer customization between two CUI files

m  Migrate customization from a MNS or MNU file
m  Reset and restore CUI files

m Load a CUI file as a partial CUI file
Topics in this section

m  Basics of Customization Files

Customization files are loaded into AutoCAD to define elements that
make up the user interface and are edited using the Customize User
Interface (CUI) Editor.

=  Migrate and Transfer Customizations

You can migrate custom MNU or MNS files from earlier releases using
the Customize User Interface (CUI) Editor. The program transfers all of



the data in the MNU or MNS file to a CUI file without modifying the
original menu file. The new CUI file is an XML-based file that has the
same name as your original menu file, but with a .cui extension.

Create and L.oad a Partial CUI File

Create, load, or unload partial customization files as you need them.
Loading and using a partial CUI file allows you to create and modify
most interface elements (toolbars, menus, ribbon panels, and so on) in a
separate CUI file without having to import the customizations to your
main CUI file.

Create an Enterprise CUI File

An enterprise CUI file typically stores customization information that is
shared by many users, but is controlled by a CAD manager. Enterprise
CUI files make maintaining and modifying customization data easier for
the individual responsible for controlling company standards.

Please send us your comment about this page
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Customize Commands
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You can easily create, edit, and reuse commands. The Customize tab of the
Customize User Interface (CUI) Editor displays a master list of commands that
are loaded in the product. You can add any commands from this list to toolbars,
menus, and other user interface elements.

When you change properties of a command in the master list or on the tree view,
the properties of the command are changed everywhere that command is used.

The following table shows the Scale command properties as they appear in the
Properties pane.

Properties for the Scale command on the Modify menu

Prope.rtles Description Example

pane item

Name String Scale
displayed as a

menu name or
as a tooltip
when you click
a toolbar
button. The
string must
include
alphanumeric
characters with
no punctuation



other than a
hyphen (-) or
an underscore

@2

Description  String Enlarges or reduces selected objects,
displayed as a keeping the proportions of the object the
tooltip when same after scaling
the cursor
hovers over a
toolbar or
panel button,
or menu item.

Extended Displays the

Help File file name and
ID for the
extended
tooltip that is
displayed
when the
cursor hovers
over a toolbar

or panel

button.
Command String that SCALE
Display contains the
Name name of the

command that
is related to the

command.
Macro The command  $M=3(if,$(eq,$(substr,$(getvar,cndnames)
macro. It ,1,4),GRIP),_scale,\CAC_scale)

follows the
standard macro



syntax.

Note When you
change the
name of a
macro, the
name of its
corresponding
menu item or
toolbar button
does not
change. You
must change a
menu item or
toolbar button
name by
selecting it in
the tree view.

Tags Keywords
associated to a
command.
Tags provide
an additional
field to search
for a loaded
command
when using the
Search field in
the menu
browser.

Element ID  Tag that ID_Scale
uniquely
identifies a
command.

Small ID string of the RCDATA_16_SCALE



Image

Large
Image

small-image
resource (16 x
16 bitmap).
The string
must include
alphanumeric
characters with
no punctuation
other than a
hyphen (-) or
an underscore
(_). It can also
be a user-
defined
bitmap. Click
the [...] button
to open the
Select Image
File dialog
box.

ID string of the
large-image
resource (32 X
32 bitmap). If
the specified
bitmap is not
32 x 32, the
program scales
it to that size.
The string
must include
alphanumeric
characters with
no punctuation
other than a
hyphen (-) or

RCDATA_16_SCALE



an underscore
(_). It can also
be a user-
defined
bitmap. Click
the [...] button
to open the
Select Image
File dialog box

Topics in this section

= Create, Edit, and Reuse Commands

You can create a new command from scratch, copy an existing command
to create a new command, or edit the properties of an existing command.
When you create or edit a command, the properties you can define are
the command name, description, extended help file, command display
name, macro, tags, element ID (for new commands only), and small or
large image.

= Find Command Names and Search Strings

You can search one or more CUI files for commands or search strings
(including commands or user interface element names, command display
names, descriptions, macros, and tags). You can also replace commands
or search strings one at a time or all at once.

= Control the Display of Command IL.abels

You can control the way that menu labels indicate a command's
availability in the program. Display menu commands as grayed out
(disabled), mark them with a check mark or border, or use a combination
of indicators.

= Create Images for Commands

Images can be associated with a command, and are displayed on a
toolbar button or next to a menu item in a pull-down menu. You can use
images that come with the program or create your own.

= Assign Tags to Commands



With command tags, you can search for a command or a group of
commands with the menu browser.

Create Tooltips and Extended Help for Commands

Tooltips are descriptive messages that are displayed near the cursor when
it hovers over a toolbar or panel button, or menu item.

Create Status Line Help Messages

Status line help messages are simple, descriptive messages that are
displayed on the status line (at the bottom of the application window)
when the cursor hovers over a menu item.

Please send us your comment about this page
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With the Quick Properties panel, for a selected object, you can access a sub-set
of the properties that are accessible from the Properties palette.

You can customize the properties that are displayed on the Quick Properties
panel. The properties (displayed when an object is selected) are common to all
object types and are specific to the object that was selected. The available
properties are the same as those on the Properties palette and for rollover
tooltips.

Note You can synchronize the properties that are displayed on the Quick
Properties panel with those for rollover tooltips.

The Quick Properties panel is displayed when objects are selected, if the object
type of the selected objects is supported for Quick Properties, and if the
QPMODE system variable is set to 1 or 2. See Display and Change the
Properties of Objects in the User’s Guide for more information about controlling
the display of the Quick Properties.

When customizing the Quick Properties panel, you control which object types
display properties on the Quick Properties panel and which properties are
displayed. You use the Objects pane to add and remove the object types that are
set to display properties on the Quick Properties panel. Once an object type is
selected from the Objects pane, you can then decide which properties from the
Properties pane you would want displayed when that object type is selected in
the drawing window.

You can change the general properties for a selected object type or for all object
types. Selecting an object type from the Objects pane allows you to control the
display of the general properties for that selected object type, or you can click
the General button at the bottom of the Objects pane to override the general
properties of all object types. When the General button at the bottom of the


javascript:hhctrl_d0e8416.Click()

Objects pane is clicked, a list of the general properties that can be used to
override the properties of all individual object type is displayed along with the
Reset Overrides button. Select the general properties that you want displayed for
all object types and click Reset Overrides.

When an object is added to the list on the Objects pane, the state of the general
properties used for all object types is assigned to the general properties of the
newly added object. For example, if the properties Color and Layer are checked
under the General properties, the same checked properties are assigned to the
object that is being added to the Object list.

Note When the system variable QPMODE is set to a value of 1, the general
properties that are checked are displayed in the Quick Properties panel for all
object types that are not in the list on the Objects pane.

See Also

=  Customize Rollover Tooltips

m  To control which object types are used with the Quick Properties
panel (Procedure)

m  To control the display of a property for an object on the Quick
Properties panel (Procedure)

m  To control the display of custom properties and attributes for block
references on the Quick Properties panel (Procedure)

m To override the general properties for all object types (Procedure)
m To restore the default settings for Quick Properties (Procedure)

m  To synchronize Quick Properties with rollover tooltips (Procedure)

Please send us your comment about this page
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Customize Rollover Tooltips
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Rollover tooltips display the current values of selected properties.

The properties and values that are displayed in a rollover tooltip can be
customized by object type. When customizing the display of the properties for a
rollover tooltip, you can display properties common to all object types or
properties that are specific to an object type. The available properties are the
same as those on the Properties palette and for Quick Properties.

Note You can synchronize the properties you use for rollover tooltips with those
for the Quick Properties panel.

Rollover tooltips are only displayed for objects when the ROLLOVERTIPS
system variable is set to 1. See Set Interface Options in the User’s Guide for
more information about controlling the display of rollover tooltips and other
tooltip settings for the program.

When customizing rollover tooltips, you control which object types display a
tooltip when the cursor hovers over an object in the drawing window. You use
the Objects pane to add and remove the object types for which you want to see a
rollover tooltip. Once an object type is listed in the Objects pane, you can then
specify which properties in the Properties pane to display on a rollover tooltip
for the selected object type.

You can change the general properties for a selected object type or for all object
types. Selecting an object type from the Objects pane allows you to control the
display of the general properties for that selected object type, or you can click
the General button at the bottom of the Objects pane to override the general
properties of all object types. When the General button at the bottom of the
Objects pane is clicked, a list of the general properties that can be used to
override the properties of all individual object type is displayed along with the
Reset Overrides button. Select the general properties that you want displayed for
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all object types and click Reset Overrides.

When an object is added to the list on the Objects pane, the checked general
properties will be automatically checked in the property list for that object type.
For example, if the properties Color and Layer are checked under the General
properties, the same checked properties are assigned to the object that is being
added to the Object list.

Note When an object is not in the list on the Objects pane, the general properties
that are checked are displayed in the rollover tooltips.

See Also
= Customize Quick Properties

m To control which objects support rollover tooltips (Procedure)

= To control which properties are displayed on a rollover tooltip
(Procedure)

m To override the general properties for all object types that support
rollover tooltips (Procedure)

= To restore the default settings for rollover tooltips (Procedure)

m  To synchronize rollover tooltips with Quick Properties (Procedure)
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Toolbar customization can be as easy as placing or resizing a toolbar in a
drawing area to gain the most drawing efficiency or space. You can also create
and modify toolbars and flyout toolbars, add commands and control elements,
and reposition and remove toolbar buttons.

Topics in this section

m  Create and Edit Toolbars

Some of the simplest toolbar customizations can make your daily
drawing tasks more efficient. For example, you can consolidate
frequently used commands and controls onto one toolbar, remove
buttons that you never use, or change some simple toolbar properties.

= Add or Switch Toolbar Controls

Toolbar controls are drop-down lists of items that can affect the objects
in a drawing or the way the program behaves from a toolbar. For
example, the Layers toolbar contains controls for defining layer settings.
In the Customize User Interface (CUI) Editor, you can add, remove, and
relocate controls within toolbars.

Please send us your comment about this page
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The Quick Access toolbar is located to the right of the menu browser and
provides direct access to a defined set of commands.

The Quick Access toolbar is always located in the same place in the program,
but different commands may be displayed on it based on the current workspace.
You can customize the Quick Access toolbar by

m  Using the Workspace Contents pane in the Customize User Interface
(CUI) Editor.

m  Adding and removing commands directly from the Quick Access toolbar
when the Customize User Interface (CUI) Editor is displayed.

Customizing toolbars and the Quick Access toolbar are very similar. You can
add, remove, and reposition commands to tailor the interface the way you work.
However, you cannot add controls or flyouts to the Quick Access toolbar like
you can with toolbars. To learn more about customizing toolbars, see Create and
Edit Toolbars.

See Also
m  Customize Commands

m  Customize Workspaces
m To add a command to the Quick Access toolbar (Procedure)

=  Toremove a command from the Quick Access toolbar with the CUI
Editor (Procedure)
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Pull-down menus are displayed as a list under a menu bar or as part of the menu
browser. Shortcut menus (also called context menus) are displayed at or near the
crosshairs or cursor when you right-click in the drawing window, text window,
command window, in toolbar areas, or the ribbon.

A pull-down menu can contain up to 999 commands. A shortcut menu can
contain up to 499 commands. The command limit includes all menus in a
hierarchy. If commands in the menu file exceed these limits (which is unlikely),
the program ignores the extra commands. If a pull-down or shortcut menu is
longer than the available display space, it is truncated to fit. When a pull-down
or shortcut menu is truncated, two arrows are added to the menu; one is added at
the top and another to the bottom. With the arrows, you can scroll the list of
menu items up or down. The following table shows the properties for the File
menu as they appear in the Properties pane. The properties for a pull-down menu
and shortcut menu are identical.

Properties for the File menu

Name String used as the caption of &File
the menu on the menu bar.

Description Text used to describe the
element; does not appear in the
user interface.

Aliases Specifies the aliases for the POP1,



menu. Click the [...] button to FILE
open the Aliases dialog box.

Each alias in the CUI file

should be unique; and it is

used to reference the menu
programmatically.

Element ID Tag that uniquely identifies a ID_MnFile

mendu.

Pull-Down Menu Aliases

Pull-down menus should have one alias in the range of POP1 through POP499.
Menus with an alias of POP1 through POP16 are loaded by default when a menu
loads. All other menus must be added to a workspace to be displayed.

Note When you create a pull-down or shortcut menu, you must also add at least
one command to the menu. Otherwise, the menu will not be saved to the file.

Topics in this section

Create a Pull-Down Menu

You can create a pull-down menu, add a submenu, and add commands
on the Customize tab of the Customize User Interface (CUI) Editor. The
process is very similar to working with toolbars and flyouts with only
minor differences.

Create a Shortcut Menu

Shortcut menus are displayed at or near the location of your cursor when
you right-click on the pointing device. The shortcut menu and the
options it provides depend on the location of the cursor and other
conditions, such as whether an object is selected or a command is in
progress. You can also use scripts to display shortcut menus.

Create Submenus

You create submenus in much the same way that you create a menu.

Reference Pull-Down or Shortcut Menus




Using a method similar to that used to activate submenus, you can
activate or deactivate another pull-down or shortcut menu. This is called
referencing a menu.

Swap and Insert Pull-Down Menus

Using the Customize User Interface (CUI) Editor, you can use
workspaces to control the swapping of pull-down menus. However, you
can also swap a pull-down menu programmatically (for example, when a
user loads an application that requires an additional menu). Menu
swapping activates one menu directly from another menu.

Please send us your comment about this page
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You can customize the ribbon by creating and modifying ribbon panels and
organizing ribbon panels into groups of task based tools with ribbon tabs.

Topics in this section

m  Create and Edit Ribbon Panels

By customizing ribbon panels, you can organize commands that you use
frequently similar to toolbars. With ribbon panels, you can quickly
access commands, and reduce the number of user interface elements that
are displayed.

®  Add or Switch Ribbon Panel Controls

Ribbon panel controls are drop-down lists, sliders, text boxes, and other
panel-specific controls. For example, the Layers panel contains controls
for changing the layers in a drawing. In the Customize User Interface
(CUI) Editor, you can add, remove, and relocate controls on panels.

m  Create and Edit Ribbon Tabs

Ribbon tabs control the display and order of ribbon panels on the ribbon.
You add ribbon tabs to a workspace to control which ribbon tabs are
displayed on the ribbon.

Please send us your comment about this page
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Add Shortcut Keys and Temporary Override Keys
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You can assign shortcut keys (sometimes called accelerator keys) to commands
you use frequently, and temporary override keys to execute a command or
change a setting when a key is pressed.

Show Me: Create a Shortcut Key

Click the Play arrow below the following image to start the animation.

The following animation shows how to create a custom shortcut key.



Shortcut keys are key combinations that start commands. For example, you can
press CTRL+O to open a file and CTRL+S to save a file, which is the same
result as choosing Open and Save from the File menu. The following table
shows the properties of the Save shortcut key as they appear in the Properties
pane.




Properties for the Save Shortcut Key

Properties pane

. Description Example
item
Name String that is only used in ~ Save
the CUI Editor and is not
displayed in the user
interface.
Description Text used to describe the Saves the current

element; does not appear drawing
in the user interface.

Extended Help File Displays the file name
and ID for the extended
tooltip that is displayed
when the cursor hovers
over a toolbar or panel
button.

Command Display String that contains the QSAVE

Name name of the command
that is related to the
command.
Macro The command macro. It ACAC_gsave

follows the standard
macro syntax.

Key(s) Specifies the keystroke CTRL+S
combination that is used
to execute the macro.
Click the [...] button to
open the Shortcut Keys
dialog box.




Tags Keywords associated to a
command. Tags provide
an additional field to
search in the menu
browser.

Element ID Tag that uniquely ID_Save
identifies a command.

Note A shortcut key inherits its properties from the command that is used to
create it.

Temporary override keys temporarily turn on or turn off one of the drawing aids
that are set in the Drafting Settings dialog box (for example, Ortho mode, object
snaps, or Polar mode). The following table shows the Object Snap Override:
Endpoint temporary override key properties as they appear in the Properties
pane.

Properties for the Object Snap Override : Endpoint Temporary
Override Key

Prope.rtles Description Example

pane item

Name String that is only used in Object Snap Override :
the CUI Editor and is not Endpoint
displayed in the user
interface.

Description  Text used to describe the Object Snap Override :
element; does not appear Endpoint
in the user interface.

Keys Specifies the keystroke SHIFT+E
combination that is used



to execute the temporary
override. Click the [...]
button to open the
Shortcut Keys dialog box.

Macrol Specifies the macro that AP'_.osmode 1

(Key should be executed when $(if,$(eq,$(getvar,

Down) Fhe keystroke combination osnapoverride),_.osnapoverride
is held down by the user. 1)

Macro?2 Specifies the macro that

(Key Up) should be executed when

the keystroke combination
is released by the user. If
left blank, AutoCAD
restores any variables to
their previous state.

Shortcut keys can be associated with any command in the command list. You can
create new shortcut keys or modify existing shortcut keys.

The following table lists the default actions for shortcut keys.

ALT+F11 Displays the Visual
Basic Editor

ALT+F8 Displays the Macros
dialog box

CTRL+0 Toggles Clean Screen

CTRL+1 Toggles Properties



palette

CTRL+2 Toggles DesignCenter

CTRL+3 Toggles the Tool
Palettes window

CTRL+4 Toggles Sheet Set
Manager

CTRL+6 Toggles dbConnect
Manager

CTRL+7 Toggles Markup Set
Manager

CTRL+8 Toggles the QuickCalc
palette

CTRL+9 Toggles the Command
Line window

CTRL+A Selects all the objects
in drawing
that are not locked or
frozen

CTRL+SHITF+A Toggles Groups

CTRL+B Toggles Snap

CTRL+C Copies objects to the
Windows Clipboard

CTRL+SHIFT+C Copies objects to the
Windows Clipboard

with Base Point




CTRL+D Toggles Dynamic
UCS
CTRL+E Cycles through
isometric planes
CTRL+F Toggles running
object snaps
CTRL+G Toggles Grid
CTRL+H Toggles PICKSTYLE
CTRL+SHIFT+H Toggles the display of
palettes with
HIDEPALETTES and
SHOWPALETTES
CTRL+I Toggles the
Coordinates display
CTRL+J Repeats last command
CTRL+K Inserts a hyperlink
CTRL+L Toggles Ortho mode
CTRL+M Repeats last command
CTRL+N Creates a new drawing
CTRL+O Opens an existing
drawing
CTRL+P Plots the current

drawing




CTRL+SHIFT+P Toggles the Quick
Properties interface
CTRL+Q Quits AutoCAD
CTRL+R Cycles through the
viewports
on the current layout
CTRL+S Saves current drawing
CTRL+SHIFT+S Displays up the Save
As dialog box
CTRL+T Toggles Tablet mode
CTRL+V Pastes data from the
Windows Clipboard
CTRL+SHIFT+V Pastes data from the
Windows Clipboard as
a Block
CTRL+X Cuts objects from the
current drawing to the
Windows Clipboard
CTRL+Y Cancels the preceding
Undo action
CTRL+Z Reverses the last
action
CTRL+[ Cancels current

command

CTRL+\

Cancels current



command

CTRL+PAGE UP

Moves to the next
layout tab to the left of
the current tab

CTRL+PAGE DOWN

Moves to the next
layout tab to the right
of the current tab

F1 Displays Help

F2 Toggles Text Window

F3 Toggles OSNAP

F4 Toggles TABMODE

F5 Toggles ISOPLANE

F6 Toggles UCSDETECT

F7 Toggles GRIDMODE

F8 Toggles
ORTHOMODE

F9 Toggles SNAPMODE

F10 Toggles Polar
Tracking

F11 Toggles Object Snap
Tracking

F12 Toggles Dynamic

Input



The following table lists the default actions for temporary override keys on an
English U.S. keyboard. For more information about default temporary override
keys on other keyboards, see Override Object Snap Settings.

F3 Toggles OSNAP

F6 Toggles UCSDETECT

F8 Toggles ORTHOMODE

F9 Toggles SNAPMODE

F10 Toggles Polar Tracking

F11 Toggles Object Snap Tracking
F12 Toggles Dynamic Input
SHIFT Toggles ORTHOMODE
SHIFT+’ Toggles OSNAP

SHIFT+, Object Snap Override: Center
SHIFT+. Toggles Polar Tracking
SHIFT+/ Toggles UCSDETECT
SHIFT+; Enables Object Snap Enforcement
SHIFT+] Toggles Object Snap Tracking
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SHIFT+A Toggles OSNAP

SHIFT+C Object Snap Override: Center
SHIFT+D Disable All Snapping and Tracking
SHIFT+E Object Snap Override: Endpoint
SHIFT+L Disable All Snapping and Tracking
SHIFT+M Object Snap Override: Midpoint
SHIFT+P Object Snap Override: Endpoint
SHIFT+Q Toggles Object Snap Tracking
SHIFT+S Enables Object Snap Enforcement
SHIFT+V Object Snap Override: Midpoint
SHIFT+X Toggles Polar Tracking

SHIFT+Z Toggles UCSDETECT

In the Customize User Interface (CUI) Editor, you can view, print, or copy a list
of shortcut keys, temporary override keys, or both. The shortcut keys and
temporary override keys in the list are those keys used by the CUI files that are
loaded in the program.

See Also
m  Customize Commands

m  (Create Macros

m  To create a shortcut key (Procedure)

m  To modify a shortcut key (Procedure)

m  To create a temporary override key (Procedure)




m  To modify a temporary override key (Procedure)

m To print a list of shortcut keys or temporary override keys
(Procedure)

Please send us your comment about this page
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Double click actions are used to make editing commands accessible when the
cursor is positioned over an object in a drawing and a double-click is registered
from a pointing device. The double click actions are object type sensitive,
allowing you to set up a specific command to use for a specific object type.

Double click actions execute a command that displays either the Properties
palette or a specialized editor that is more powerful, convenient, or frequently
used for the object type that is double-clicked in a drawing. The following table
shows the definition of the Attribute Block double click action in the CUI Editor.

Properties for the Attribute Block double click action

Properties pane

item Description Example
Name String used to identify the  Attribute Block
double click action in the
CUI Editor.
Description Text used to describe the
element in the CUI
Editor.
Object Name Determines the type of ATTBLOCKREF

object the double click
action is associated to.

Element ID Uniquely identifies a DC_0002



double click action in the
CUI Editor.

Double Click Action Object Names

Double click actions are referenced by the value of the Object Name property
that must match a valid drawing interchange format (DXF"") name. There are
some exceptions that do not use the DXF name. These exceptions are for blocks,
dynamic blocks, and external references, which use special object names. For
example, the double click action named “Attribute Dynamic Block” in the
acad.cui file uses the object name ATTDYNBLOCKREF.

The following table shows the object names that are specific to blocks, dynamic
blocks, and external references.

Object names specific to inserted objects

BLOCKREF Block reference without attributes

ATTBLOCKREF Block reference with attributes

DYNBLOCKREF Dynamic block reference without
attributes

ATTDYNBLOCKREF Dynamic block reference with
attributes

XREF External reference (xref)

Note If more than one object is selected or if a double click action is not
associated with an object type, the default command used is PROPERTIES.

The following table shows some of the object names that are set up in the
acad.cui file. Expand the Double Click Actions node in the Customize User



Interface (CUI) Editor for a complete listing of all the actions that are defined.

Object Type Command (Macro)

ATTDEF DDEDIT
ATTRIB ATTIPEDIT
ATTBLOCKREF EATTEDIT

ATTDYNBLOCKREF  EATTEDIT

BLOCKREF $M=5$(if,$(and,$(>,$(getvar,blockeditlock),0)),A\CAC
DYNBLOCKREF $M=5$(if,$(and,$(>,$(getvar,blockeditlock),0)),A\CAC
HATCH HATCHEDIT

IMAGE IMAGEADJUST

LWPOLYLINE PEDIT

MLINE MLEDIT

MTEXT MTEDIT

POLYLINE PEDIT

SECTIONOBJECT LIVESECTION

SPLINE SPLINEDIT

TEXT DDEDIT

XREF REFEDIT




Note Double click actions cannot be created for OLE and Viewport objects.

See Also
m  Customize Commands

m  (Create Macros

m  To create a double click action (Procedure)

»  To modify a double click action (Procedure)

Please send us your comment about this page
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You can change the standard behavior of pointing devices in the program.

Mouse buttons define how a Windows system pointing device functions. You
can customize the behavior of a mouse or other pointing device in the Customize
User Interface (CUI) Editor. If a pointing device has more than two buttons, you
can change the behavior of the second and third buttons. The first button on any
pointing device cannot be changed in the Customize User Interface (CUI) Editor.

By using the SHIFT and CTRL keys, you can create a number of combinations
to suit your needs. Your pointing device can recognize as many commands as it
has assignable buttons. The Mouse Buttons section of the tree node is organized
by keyboard combination such as Click, SHIFT+Click, CTRL+Click, and
CTRL+SHIFT+Click. The tablet buttons are numbered sequentially. Drag a
command to assign the command to a mouse button. Create additional buttons
by dragging commands to a Click node.

The following table shows the Click mouse button properties as they appear in
the Properties pane.

Properties for the Click Mouse Button

Aliases Specifies the aliases for AUX1
the mouse button. Click
the [...] button to open
the Aliases dialog box.
Each alias in the CUI file
should be unique and it is



used to reference the
mouse button
programmatically.

Topics in this section

= Accept Coordinate Entry in Button Menus

When you click one of the buttons on a multibutton pointing device, the
program reads not only the button number but also the coordinate of the
crosshairs at the time you click. By carefully constructing macros, you
can choose to either ignore the coordinate or use it with the command
activated by the button.

Please send us your comment about this page
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The term “legacy” refers to those user interface elements that are not commonly
used with the current version of the program, but are still supported because
some users prefer them to alternative user interface elements that are now
provided.

Legacy interface elements include:
= Tablet menus
= Tablet buttons
= Screen menus

m  Image tile menus
Topics in this section

m  Create Tablet Menus

You can configure up to four areas of your digitizing tablet as menu
areas for command input.

m  Customize Tablet Buttons

To customize tablet buttons, you follow the same procedures as for
customizing mouse buttons.

m  Create Screen Menus

Screen menus provide a legacy interface for displaying menus in a
palette. You create and edit screen menus in the Customize User
Interface (CUI) Editor.

m  Create Image Tile Menus




The purpose of an image tile menu is to provide an image that can be
selected instead of text. You can create, edit, or add image tiles and
image tile slides.

Please send us your comment about this page
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AutoLISP (LSP or MINL) files contain scripts that add customization actions and
behaviors to the interface. You can load AutoLISP files into a CUI file using the
Customize tab of the Customize User Interface (CUI) Editor.

For more information about using AutoLISP, see AutoL.ISP and Visual LISP.

Tip MINL files with the same name and location as your main, enterprise, or
partial CUI files are loaded automatically. These files cannot be removed.

See Also

m To load an AutoLISP file in the Customize User Interface Editor
(Procedure)

Please send us your comment about this page
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You can customize workspaces to create a drawing environment that displays
only those commands on the Quick Access toolbar, toolbars, menus, ribbon tabs,
and palettes that you select.

Customization options for workspaces include creating a workspace using the
Customize User Interface (CUI) Editor, changing the properties of a workspace,
and displaying a toolbar in all workspaces.

Create or Modify a Workspace Using the Customize User Interface Editor

The easiest way to create or modify a workspace is to set up the toolbars and
palettes that best suit a drawing task, and then save that setup as a workspace in
the program. That workspace can be accessed any time you need to draw within
that workspace environment.

You can also set up a workspace using the Customize User Interface (CUI)
Editor. In the CUI Editor, you can create or modify workspaces with precise
properties and elements (commands, toolbars, menus, ribbon tabs, and palettes)
that you want to access for certain tasks.

Show Me: Create a Workspace

Click the Play arrow below the following image to start the animation.

The following animation shows how to create a workspace. The animation
covers the creation of the workspace, and how to control the display of toolbars,
menus and palettes.



Following is an example of the Customize User Interface (CUI) Editor,
Workspace Contents pane. You click Customize Workspaces to create or modify
the selected workspace.



Workspace Contents

>

[ Customize Workspace ]
Elﬁ- AutaCAD Default (cument)
-7 Quick Access Toolbar
= Toolbars
#-[5E Menus
--EE Palettes
@£ Ribbon Tabs

Click Customize Workspace fo add content.

The following is an example of the Customizations In <file name> pane after
you click Customize Workspaces in the Workspace Contents pane. Check boxes
are displayed next to each element that you can add to a workspace. You click a
check box to add the element to the workspace.

Customizations in Main CUI o
__Main CLUI File (_ac:ad.c:u_i]_l f:' H

=i ACAD =
=48 Workspaces

----- L% 2D Drafting & Annotation (cument)

----- £ 30 Modeling

----- £k AutoCAD Classic Default

[-{v| = Toolbars

-[V|[E] Fie

-w| [ Edit

. |=T| Insert

e |=T| Format

-w| [ Tools

~w| [H] Dimension
=== B

m

Change the Properties of a Workspace

In the Customize User Interface (CUI) Editor, you can define workspace
properties, such as the workspace name, description, whether it is displayed on
the Model or layout tab, and so on. The following table shows the AutoCAD
Classic workspace properties as they appear in the Properties pane.

Properties for the AutoCAD Classic Workspace




Properties Pane
Item

Name

Description

String displayed in the drop-
down box on the Workspaces
toolbar, at the command
prompt for the WORKSPACE
command, under the
Workspaces menu item in the
Tools menu, and in the CUI
Editor.

Example

AutoCAD Classic

Description

Text that describes the
workspace; does not appear
in the user interface.

Start On

Determines if the Model tab,
last active layout tab, or the
current active tab in the
drawing is displayed when
the workspace is restored or
set current.

Model

Menu bars

Determines if the menu bar is
displayed or not when the
workspace is restored or set
current.

Off

Status bars

Determines if the status bars
for the drawing window or
application are displayed or
not when the workspace is
restored or set current. The
available options are All Off,
Application Only, All On, or
Drawing Status Bar Only.

Application only




Model/Layout tabs Determines if the On
Model/layout tabs are visible
or not in the drawing window
when the workspace is
restored or set current.

Screen menus Determines if the Screen Off
menu is visible or not when
the workspace is restored or
set current.

Scroll bars Determines if the scroll bars On
are visible or not when the
workspace is restored or set
current.

Display and Change the Display Properties of a Toolbar

You can control which toolbars are displayed and if they are set to be docked or
floating in a workspace. You can define the size, location, or appearance of
toolbars by changing their properties in the Workspace Contents pane of the
Customize User Interface (CUI) Editor.

Displaying Menus on the Menu Browser and Menu Bar

Menus and the order in which they are displayed are controlled through the
Customize User Interface (CUI) Editor; you can also toggle the display of the
menu bar with workspaces.

Change the Properties of a Palette

Many windows, known as palettes, can be set to be docked, anchored, or
floating. You can define the size, location, or appearance of these windows by
changing their properties in the Workspace Contents pane of the Customize User
Interface (CUI) Editor. These windows include:

m  Advanced Render Settings



» Command Line

m  dbConnect Manager

= DesignCenter

m  External References

m Layer Properties Manager
= Lights in Model

m  Materials

m  Markup Set Manager
= Properties

m  QuickCalc

= Ribbon

m  SheetSet Manager

= Sun Properties

»  Tool Palette

m  Visual Styles Manager

The following table shows the Tool Palettes properties as they appear in the
Properties pane.

Properties for the Tool Palettes window

Show Visibility state of the palette. Yes
The available options are Yes,
No, or Do Not Change. Do
Not Change keeps the last
used state of the palette when
the workspace is restored or
set current.




Orientation

Allow Docking

Auto Hide

Use Transparency

The on screen docking or
floating state of the palette.
The available options are
Floating, Left, Right, or Do
Not Change. Do Not Change
keeps the last used state of
the palette when the
workspace is restored or set
current. Some palettes like
the Command Line also
support a dock location of
Top and Bottom.

Controls if the user can dock
the palette by dragging it to
one of the designated docking
areas. The available options
are Yes, No, or Do Not
Change. Do Not Change
maintains the last used setting
for the palette when the
workspace is restored or set
current.

Controls if the palette rolls up
when not in use. The
available options are On, Off,
or Do Not Change. Do Not
Change maintains the last
used setting for the palette
when the workspace is
restored or set current.

Controls if the palette appears
transparent. The available
options are Yes, No, or Do

Floating

Yes

Off

No



Not Change. Do Not Change
maintains the last used setting
for the palette when the
workspace is restored or set
current.

Transparency Amount Controls how opaque the 0
palette is displayed. The valid
range is 0 through 100.

Default Group Controls which of the user All Palettes
defined palette groups should
be displayed.

Height Determines how tall the 598

palette is when it is floating.

Width Determines how wide the 172
palette is when it is floating.

Display Ribbon Tabs

Ribbon tabs and the order in which they are displayed on the ribbon are
controlled through the Customize User Interface (CUI) Editor, in the Workspace
Contents pane.

Import a Workspace to a Main CUI File

You can import a workspace to the main CUI file using the Transfer tab of the
Customize User Interface (CUI) Editor.

Setting a Default Workspace

Workspaces in a CUI file can be marked as default. This identifies which
workspace in the CUI file should be restored when the CUI file is loaded into the
program the first time, or after the CUI file has been loaded with the CUILOAD
command.
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See Also

Set Interface Options in the User’s Guide

Customize the Quick Access Toolbar

Customize Toolbars

Create a Pull-Down Menu
Create and Edit Ribbon Tabs

To create a workspace using the Customize User Interface Editor
(Procedure)

To create a workspace using the Workspace toolbar (Procedure)

To change the properties of a workspace (Procedure)
To modify the Quick Access toolbar (Procedure)

To display menus on the menu browser or menu bar (Procedure)

To reposition menus on the menu browser or menu bar (Procedure)

To display toolbars (Procedure)

To change the properties of a toolbar (Procedure)

To display ribbon tabs (Procedure)

To reposition a ribbon tab on the ribbon (Procedure)

To reposition a ribbon panel on a ribbon tab (Procedure)
To control the display of ribbon panels for a ribbon tab (Procedure)

To change the properties of a palette (Procedure)
To duplicate a workspace (Procedure)

To set a workspace current (Procedure)

To set a workspace as default (Procedure)

To restore a workspace with a command line switch (Procedure)
To import a workspace to a main CUI file (Procedure)

Please send us your comment about this page
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FAQs will help you to find answers to some of the most commonly asked
questions about using the Customize User Interface (CUI) Editor.

Migrating/Upgrading

Question: How do I get my menu customization from a previous release to work
in the new release?

Answer: In past releases this had to be done through a text editor, such as
Notepad. With the CUI Editor, you use the Transfer tab to browse and select
your MNS/MNU or CUI file that contains your menu customization. Once the
previous customization file has been selected, you drag the user interface
elements between two CUI files. See To transfer customizations for more
information.

Commands

Question: How do I create a new command and add it to a user interface
element, such as a pull-down menu?

Answer: Commands are created and managed through the Command List pane
located in the lower-left corner of the Customize tab of the CUI Editor. See To
create a command for more information.

Once the command has been created, it can be added to or used to create a
number of different user interface elements. To add the command to a menu for
example, expand the menu under the Menus node in the Customizations In <file
name> pane that you want to add the command to and then drag the command
under the menu. See To create a pull-down menu for more information.




Menus

Question: Why doesn’t my menu display on the menu browser or menu bar?

Answer: Workspaces are used to control the display of menus on the menu
browser and menu bar. See To display menus on the menu browser or menu bar
for more information.

Question: How do I change the order of a pull-down menu?

Answer: Workspaces are used to control the positioning of menus on the menu
browser and menu bar. See To reposition menus on the menu browser or menu
bar for more information.

Toolbars

Question: Why do my toolbars not stay in the same place after I close and
restart AutoCAD 2009?

Answer: This happens because of the way menus are loaded into AutoCAD at
startup. This problem only happens when partial and enterprise CUI files are
used. To resolve this problem, you can use the new /w command line switch.
This causes AutoCAD 2009 to re-initialize the workspace upon startup and place
the toolbars in their correct locations. See To restore a workspace with a
command line switch for more information.

Question: Why do my icons on a toolbar display as a cloud with a question
mark after I migrate them using the Transfer tab in the CUI Editor?

Answer: This happens because the images for the custom icons are not located in
the AutoCAD support file paths. Locate the images using Windows Explorer and
add the images location to the Support File Search Path node under the Files tab
of the Options dialog box, or copy them into the folder C:\Documents and
Settings\<user profile name>\Application Data\Autodesk\<product name>\
<release number>\<language>\Support\Icons.

Question: Why does my toolbar flyout not work?

Answer: A flyout might not work for a few different reasons. There might not be
any commands currently assigned to the toolbar that it is referencing or a control
is part of the toolbar that is being referenced for the toolbar flyout. Launch the
CUI Editor and verify that there are commands on the toolbar that is being



referenced and if there are, make sure there are no controls on the toolbar such as
the Layer list control.

Question: Why do I get an AutoCAD message box when I try to use a toolbar
flyout?

Answer: The AutoCAD message box is displayed because the toolbar that is

being referenced for the toolbar flyout is not found. AutoCAD can’t find the

toolbar because it no longer exists, is not currently loaded because the partial
CUI file it is in is not loaded, or the alias for the toolbar has been changed.

Launch the CUI Editor and select the flyout on the toolbar that currently is not
working properly. In the Properties pane look at the Source Toolbar property.
Use the Find option to look for a toolbar element with an alias that matches the
text string in the Source Toolbar property of the flyout that does not work. If one
is not located, remove the flyout from the toolbar and drag the toolbar that you
want to reference as a flyout on the toolbar. Close the CUI Editor. The flyout
should now work correctly once again.

Double Click Actions

Question: When I double-click an object nothing happens. Why is this
happening?

Answer: There are a few different reasons why when double-clicking on an
object in the drawing nothing happens. The first and most common problem is
with the system variable PICKFIRST is set to 0. PICKFIRST must be set to a
value of 1 in order for double-click editing to work. The next possible solution is
that double-click editing has been disabled. Double-click editing is controlled by
the system variable DBLCLKEDIT. If it is set to O it is currently turned off.
DBLCLKEDIT should be set to 1.

Workspaces

Question: Why do my changes not appear after I click Apply?

Answer: This happens because the workspace that you made changes to is not
the current workspace. To resolve this problem, you need to set the workspace
current and then when changes are applied they will appear. See To set a
workspace current for more information.




Enterprise CUI Files

Question: How do I edit an enterprise CUI file if it is read-only in the CUI
Editor?

Answer: An enterprise CUI file can only be edited when it is loaded as the main
CUI file or as a partial CUI file to the main CUI file. It is recommended that you
load it as the main CUI file when you need to make edits. If you are creating a
workspace that needs to include user interface elements from the CUI file that is
normally designated as the main CUI file, load the main CUI file as the
enterprise CUI file. Make edits to the enterprise CUI file. See To modify an
enterprise CUI file for more information.

Please send us your comment about this page
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You should know several terms for customizing AutoCAD 2009.

Customization (CUI) File

An XML-based file that stores customization data. You modify a
customization file through the Customize User Interface (CUI) Editor. CUI
files replace MNU, MNS, and MNC files that were used to define menus in
releases prior to AutoCAD 2006.

Customization Group

A name that is assigned to a CUI file to identify customization content in the
CUI file. A CUI file loaded into AutoCAD must have a unique customization
group name to prevent conflicts between CUI files in the program. In
previous releases, called a menu group.

Element ID

A unique identifier of an interface element. In previous releases, called a tag.

Enterprise Customization File

A CUI file that is typically controlled by a CAD manager. It is often accessed
by many users and is stored in a shared network location. The file is read-
only to users to prevent the data in the file from being changed. A CAD
manager creates an enterprise CUI file by modifying a main CUI file and
then saving the file to a shared network location. Users then specify this file
in the Options dialog box, Files tab.

Interface Element

An object that can be customized, such as a toolbar, pull-down menu,
shortcut key, palette, and so on. It is a node in the Customizations In <file
name> pane that contains user interface items.



Interface Item

The individual parts of a user interface element, such as a toolbar button,
pull-down menu item, shortcut key, temporary override key, and so on.

Legacy Menu File (MNS)

An ASCII based file that stores menu customization data for AutoCAD 2005
and earlier. Most of the file needed to be edited outside of AutoCAD using a
text editor such as Notepad, but there were a few features that could be
customized in AutoCAD using the CUSTOMIZE command. The MNS file
has been replaced by the CUI file. A CUI file can be generated from an MNS
file using the Transfer tab of the CUI command.

Legacy Menu Template (MNU)

An ASCII based file that is used as a template to define the contents of the
MNS file when the MNU file is loaded into AutoCAD with the MENU or
MENULOAD command. The MNU file is used in AutoCAD 2005 and
earlier, and is very similar to the MNS file. The MNU file has been replaced
by the CUI file. A CUI file can be generated from a MINU file using the
Transfer tab of the CUI command.

Macro

A series of commands that are run in a defined sequence to accomplish a
drawing task.

Main Customization File

A writable CUI file that defines most of the user interface elements
(including the standard menus, toolbars, keyboard accelerators, and so on).
The acad.cui file (the default main CUI file) is automatically loaded when
you start AutoCAD.

Ribbon

An interface element that displays panels made up of commands and controls
that can be docked horizontally or vertically along the program’s application
window.

Ribbon panel

An organizational structure used to lay out commands and controls for
display on the ribbon or as a floating user interface.



Palette

An interface element that can be docked or floating in the drawing area.
Palettes include the Command Line window, Tool Palettes Window,
Properties palette, and so on.

Partial Customization File

Any CUI file that is not defined as the main or enterprise CUI file. You can
load and unload partial CUI files as you need them during a drawing session.

Quick Access toolbar

An interface element that is located to the right of the menu browser and
provides direct access to a defined set of commands.

Tree Node

A hierarchical structure in the Customize User Interface (CUI) Editor that
contains interface elements and items that can be imported, exported, and
customized.

Workspace

A collection of user interface elements, including their contents, properties,
display states, and locations.

Please send us your comment about this page
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Although the basic customization techniques remain the same as in previous
versions of the product, the environment that you use to customize the product
was changed starting with AutoCAD 2006.

All of the previous customization options are still available. You are still able to
create, edit, and delete interface elements; you can create partial customization
files; you can use macros and advanced entries such as DIESEL expressions and
AutoLISP routines.

However, you no longer perform customization tasks by creating or editing
MNU or MNS text files by hand. All customizations are done through the
program interface, in the Customize User Interface (CUI) Editor.

Menu Files Versus Customization Files

In releases prior to AutoCAD 2006, you customized the user interface by editing
an MNU or MNS file in an ASCII text editor such as Notepad. You manually
entered and verified customization data in the text file, which could be a tedious
and error-prone process. As a result, a simple syntax error (such as mismatched
parentheses) in the text file could invalidate the entire menu file, leading you
back to the text file to investigate where you made the error.

With the Customize User Interface (CUI) Editor, you drag a command to a menu
or toolbar or right-click to add, delete, or modify a user interface element. The
Customize User Interface (CUI) Editor displays element properties and a list of
options to choose from. This prevents you from creating syntax errors or spelling
mistakes that may have occurred when you manually entered text in an MNU or
MNS file.

The MINU and MNS files used in the past have been replaced with just one file
type, the XML-based CUI file.



The XML-based format of the CUI file allows the product to track
customizations. When upgrading to a future version of the program, all of your
customizations are automatically integrated into the new release. The XML
format also supports a backward-compatible customization file. This means that
you can view a CUI file from a future version in the previous release while
preserving the customization data from the future version. However, you cannot
modify the future version's CUI file in the previous release. For more
information about migrating customization data, see Migrate and Transfer
Customizations.

The following table lists the menu files that previously shipped with the product
and shows how those files are mapped to AutoCAD 2009.

Menu files mapped to CUI files

Description of

Description In AutoCAD 2009
change

MNU ASCII text file.  CUI An XML file
In previous that defines
releases, most user
defined most interface
user interface elements. The
elements. The main CUI file,
main MNU acad.cui, is
file, acad.mnu, automatically
was loaded when
automatically you start the
loaded when product.
you started the Partial CUI
product. files can be
Partial MNU loaded or
files could be unloaded as
loaded or you need them
unloaded as during a
you needed drawing

them during a session.



MNS

MNC

drawing
session.

Source menu CUI
file. Was the

same as the

MNU ASCII

text file but did

not contain

comments or

special

formatting.

Compiled CUI
ASCII text file.
Contained
command
strings and
syntax that
defined the
functionality
and appearance
of user
interface
elements.

An XML file
that defines
most user
interface
elements. The
main CUI file,
acad.cui, is
automatically
loaded when
you start the
product.

Partial CUI
files can be
loaded or
unloaded as
you need them
during a
drawing
session.

An XML file
that defines
most user
interface
elements. The
main CUI file,
acad.cui, is
automatically
loaded when
you start the
product.

Partial CUI
files can be



loaded or
unloaded as
you need them
during a
drawing
session.

MNL Menu LISP MNL No change.
file. Contains
AutoLISP
expressions
that are used
by the user
interface
elements.

MNR Menu resource MNR No change.
file. Contains
the bitmaps
that are used
by the user
interface
elements.

Menu Text File Structure Versus CUI Structure

In releases prior to AutoCAD 2006, you added, edited, and deleted menu
information directly in a text file. In AutoCAD 2006 and later, you use the
Customize User Interface (CUI) Editor.

Following is an example of how the Window menu looked in the legacy menu
file acad.mnu.

Contents of the Window menu in acad.mnu

Window menu Description




Close

Closze All
Lock Location r

Cascade
Tile Horizontally
Tile Vertically

Arrange [cons

v 1 Drawingl.dwg

***pOP10
* *WINDOW

ID MnWindow [&Window]
ID DWG_CLOSE [Cl&0se]ACAC_close

ID WINDOW_CLOSEALL [C&lose
AllJACAC_closeall

[--]

ID WINDOW_CASCADE
[&Cascade]\CAC_syswindows;_cascade

ID WINDOW _TILE_HORZ [Tile
&Horizontally]J\CAC_syswindows;_hor

ID WINDOW _TILE VERT [&Tile
Vertically]\CAC_syswindows;_vert

ID_WINDOW_ARRANGE [&Arrange
Icons] CAC_syswindows;_arrange

Compare the menu data above with the same menu data as it is displayed in the
Customize User Interface (CUI) Editor, in the tree view.

Customizations in All CUI Files

All Customization Files

>

@ H

+-T7] Toals
-] Draw
-7 Dimension
[ ] Modify
=3 Windaw

----- ¥ Cascade

----- J Tile Horizontally
----- J Tile Verically
----- J Amange lcons

[#-{] Help

= L

m

-

For a more detailed comparison, following are examples of the Window menu



properties, Close command properties, Close All command properties, and the
Window shortcut menu that is displayed with the Insert Separator option.

Window menu Properties pane

Properties

24|

H General
Mame &Window
Description

E Advanced
Aliazes POP10, WINDOW

>

Window menu, Properties pane for the Close command

Properties

24|

B Display
MName Cléoze

EH Command
Command Mame Close
Description Closes the cument drawing
Extended Help File
Command Display Name CLOSE
Macro “CC_close
Tags

E Advanced

>

E Images
Small image
Large image

Window menu, Properties pane for the Close All command



>

Properties

24|
B Display
MName Célose All
EH Command
Command Mame Close Al
Description
Extended Help File
Command Display Name CLOSEALL
Macro “CC_closeall
Tags
E Advanced

E Images
Small image
Large image

Window menu tree node, shortcut menu displayed with Insert Separator option

+-[T] Tools

+-[7] Draw

+-[F] Dimension

+r=| Modify

- 7
..... H Clos Insert Separator
..... * Clod
..... * - Mew Menu
+-{] Loc Mew Sub-menu
..... * -
----- ¥ Cas Rename
..... * Tile Delet
..... * Tile EhE
""" K Ara Duplicate

+- ] Help Fl

e an o Conw I

Menu Group Versus Customization Group

There is no difference between a menu group (the term used in previous
releases) and a customization group. A CUI file loaded into AutoCAD must have
a unique customization group name to prevent conflicts between customization
files in the program.

The main CUI file, acad.cui by default, has a customization group named
ACAD. You can load as many customization files into the program, as long as
they each have a unique customization group name.

Following is an example of how you change the ACAD customization group
name in the Customize tab of the Customize User Interface (CUI) Editor. You



can change the partial CUI file (named CUSTOM in this example) using the
same method.

Customizations in All CUI Files

>

[AII Customization Files v| i =
+@ W Rename
+=E Ty Delete
- M e
+E = Restore ACAD.CUI
-7 R Reset ACAD.CUI
..... 0 =
i R Find...
+L:75J o Replace...
L R
+§E’_?, Double Click Actions
+'% Mouse Buttons
& LISF Files
+t|. Legacy
=] Partial CUI Files =
ol -— PP
Dynamic Help

Dynamic Help is a feature that is in the online Help system and references some
of the customization elements that are found in the CUI file when it is loaded
into AutoCAD. What Dynamic Help does, is it looks up the Element ID of a
command that has been identified in the online Help system, and where that
command is currently being referenced on a ribbon panel or menu when the CUI
file is loaded.

If the command is on a ribbon panel or menu, access to the command is updated
in the online Help system to reflect the new location of the command. If one of
the standard commands that ships with AutoCAD is moved from one ribbon
panel or menu to another, the online Help system will automatically reflect this
change the next time it is displayed. Currently, only commands on ribbon panels
and menus work with Dynamic Help.

Dynamic Help may not display properly if a command is not available:
= In one of the loaded CUI files

®=  On an accessible menu, ribbon panel, or ribbon tab in the current
workspace

Note Dynamic Help only works with the online Help documents that come with



AutoCAD, and has no affect on third-party documentation.

See Also

m  Migrate and Transfer Customizations
m Create and [.oad a Partial CUI File

= (Create an Enterprise CUI File
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Customize the User Interface > Overview of Customize User Interface >

Overview of the Customize User Interface Editor

[_concrr )T

The Customize User Interface (CUI) Editor is used to modify customization that
is in the XML-based CUI file.

The Customize User Interface (CUI) Editor is used to modify customization that
is in the XML-based CUI file. The editor allows you to create and manage
commands that are used in the CUI file in a centralized location. Along with
commands, you are able to customize many of the different user interface
elements. From the CUI Editor you can customize

Double click actions

Legacy user interface elements (tablets, tablet buttons, screen menus and
image tile menus)

Mouse buttons
Pull-down menus
Quick Access toolbar
Quick properties
Toolbars

Ribbon panels
Ribbon tabs

Rollover tooltips
Shortcut keys
Shortcut menus

Temporary override keys



m  Workspaces

Customization Environment

Before you start customizing your own menus, toolbars, and other user interface
elements, you should familiarize yourself with the customization environment.
To open the Customize User Interface Editor, click Tools tab » Customization
panel » User Interface. Once the Customize User Interface (CUI) Editor is
opened, view the contents of the loaded customization files by expanding the
elements in the tree structure, and view the properties of the elements by
selecting them.

Select the Transfer tab to see how to migrate or transfer customizations; select
the Customize tab to see how to create or modify user interface elements.

Once you are familiar with the environment, you can start to take advantage of
the capabilities of the tools. For more information about the improved
customization capabilities, see How Customization Has Changed.

Following is an example of the Customize User Interface (CUI) Editor,
Customize tab. You use this tab to customize interface elements in CUI files.



|E| Customize User Interface [o [ ]z
Customizations in All CUI Files o Toolbar Preview 2
| All Customization Files | @
=-{l] ACAD A Medify I =]
{:_ﬁ Workspaces | =) &. &' 2w
E-%= Toolbars '3
B-55 Dimension | [ 1
B-55 Draw — Button Image 2
(-5 Draw Order =
H _ ] -
'I.' Inquiry (") Large ...::... .@ (= E @ "—-ﬁ’ -'55' §
L orm -y (|
Ef’: ©) Smal I_-_::_':E'-' + &% 8 ¥ —
-5 Layouts : n e
-5 Modify @ Beth r i XY |2 (XY X2
L om " RCDATA_16_HATEDI @
G e |||y (5[
FE a | -
il | @8 0L/ |-
- Edi Polyline Ermperties 2
¢ Edit Spline = 8| |
Command List: o El Display -
' Mame Edit Hatch i
Q@ B Command
: Command MName Edit Hatch
[A” Commands "] oK Description Modifies an existing hatch objer
Extended Help File
Command Source Command Display Hame | HATCHEDIT 3
% DWF Underay... ACAD Macro “C"C_hatchedit
Dwag Editing Time EXPRESS Tags
™ DWG Reference... ACAD w B Advanced
Dynamic Block - Double Click ACAD = Element ID MM_1584
- B
Edge Jitter ACAD R g
% ol i Small image RCDATA_16_HATEDI
‘¥ Edit Attrbute... ACAD _Largemage RCDATA_32 HATEDI i
% Edit Block Inplace ACAD Display
I3 Edtt Hatch ACAD
Edit Image EXPRESS
& Edit Pohvline ACAD =
[ ok | [ Cancal | Apply Hep | (©

Customize the user interface to make the drawing environment specific to
certain types of tasks. For example, if you want a toolbar that contains the
commands you use most often, you can create a new Favorites toolbar in the
Customize User Interface (CUI) Editor and then load the new toolbar in
AutoCAD.

Customizations In Pane

The Customizations In pane is used to navigate the different user interface
elements that are in the loaded customization files. In this pane, you create and



modify user interface elements such as workspaces, toolbars, and menus. Along
the top of the pane you will find tools that load partial customization files into
the main customization file, save changes to the loaded customization files, and
control how you view the loaded customization files.

The tree view is used to create new user interface elements such as toolbars and
menus. Once a new user interface element is created, commands can then be
added by dragging them from the Command List pane. Along with being able to
create user interface elements and add commands to a user interface element,
you can change the order in which commands appear on toolbars, menus, and
ribbon panels by dragging them up and down.

Customizations in All CUI Files o
[AII Customization Files v| =
+-{ZEE Menus -

+JIEI Ribbon Tabs
}--1':]] Ribbon Panels
----- Cluick Properties

..... + & Rollover Tooltips
+-RifEl] Shortcut Menus
-;----_I_I Keyboard Shortcuts
+§E’_?, Double Click Actions
+"% Mouse Buttons

----- @ LISP Files
+ﬂ. LEEIEIC}'

_@ Partial CUI Files

-[§] CUSTOM

G- [ IMPRESSION

&[5 EXPRESS

m

Command List Pane

The Command List pane is used to create and locate commands that are
contained in the loaded customization files. Use the Create a New Command
button to create a new custom command in the CUI file that is listed in the
Customization File drop-down list at the top of the Customizations In <file
name> pane. A command must be created before it can be associated with a user
interface element in the Customizations In <file name> pane.

Next to the Create a New Command button is the Find Command or Text button.
The Find Command or Text button displays the Find and Replace dialog box,
where you can search for or replace text strings in the Command List pane only.

The Categories drop-down list near the top of the Command List pane contains a



listing of preset categories used to filter the commands displayed in the
Command list box. There are many different categories that you can select from,
for example

= All Commands. Displays all of the commands for each of the loaded
customization files.

m  Custom Commands. Displays the user defined commands that have
been added to the loaded customization files. These commands are not
part of a customization file that ships with AutoCAD.

= Controls Elements. Displays the special controls that can be added to a
toolbar or ribbon panel, such as drop-down lists, sliders, and other
controls.

Available commands and controls are displayed in the bottom of the Command
List pane. The names of the available commands, the image that is assigned to a
command, and the name of the customization group that the command is
assigned to are displayed. When the cursor hovers over top of a command, the
macro assigned to the command is displayed in a tooltip.

At the top of the Command List pane is the Command Filter field which allows
you to filter the Command list based on the text string entered. The text string is
matched with any part of a command name, and the commands with the
matching text strings are displayed in the Command list box.

Dynamic Display Pane

The Dynamic Display pane controls the display of additional panes that respond
to the item that is selected in either the Customizations In pane or Command List
pane. Based on the item selected, one or more of the following panes will be
displayed:

= Button Image
= Information

= Panel Preview
= Properties

m  Quick Properties



m  Shortcuts

m  Toolbar Preview

= Workspace Contents

Toolbar Preview o
Meodify I [=]
BHozs/wScR
Button Image o
- [ ] | [ | | -~
|:_:||_a|'ge ...::...l @m-%@# D
" & ¢ &% &
) Small . |
ok { o) {
© Both r |¥|—= x|y
RCDATA_16 HATEDI | , vy, y7 /
Ax=le] |
Properties o
=
El Display
MName Edit Hatch
EH Command
Command Name Edit Hatch
Description Maodifies an existing hatch object
Extended Help File
Command Display Mame HATCHEDIT
Macro “C"C_hatchedit
Tags
E Advanced
Element IO MM_1534
E Images
Small image RCDATA_16_HATEDI
Large image RCDATA_32_HATEDI
Display
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Customize the User Interface > Work with Customization Files > Basics of
Customization Files >

Basics of Customization Files
[Concer || || Qe Reference||

To create a customization file from scratch

To create a CUI file from an existing CUI file

To rename a customization group name
To restore a customization backup file

To reset a standard customization file

To designate a CUI file as the main CUI file

To copy and paste a user interface element

To duplicate a user interface element
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Customize the User Interface > Work with Customization Files > Basics of
Customization Files >

Basics of Customization Files
[Concer || || Qe Reference||

To create a customization file from scratch

--
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Transfer tab, in the right pane,
click the Create a New Customization File button.

= =]
Customizations in New CUI File |
New CUI File MEER
{'ﬂ Workspaces =
[#-%= Toolbars
&-fZEE Menus

3. In the right pane, select Save As from the drop-down list.

Customizations in New CUI File |

Save As.. ']é 1:;7"
Main CUI File (acad.cui) ]
Mew

Cpen...
Mew CUI File

-85 Fibbon Panels

- Quick Properties

.5 Rollover Toottips

-- Shortcut Menus

4. In the Save As dialog box, specify the location to save the new
customization file to and enter a name in the File name text field.

5. Click Save to create the customization file in the specified location.
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Customize the User Interface > Work with Customization Files > Basics of
Customization Files >

Basics of Customization Files
[ o | | || Qo Ferrerce ||

To create a CUI file from an existing CUI file

1. In Windows Explorer, navigate to the following location:

C:\Documents and Settings\<user profile name>\Application
Data\Autodesk\<product name>\<release number>\
<language>\support\<customization file name>.cui

Note In some operating systems, the folders that are located under your
profile are hidden by default. To display these files, you may need to
change your display settings. Click Start menu (Windows) » Control
Panel » Folder Options. In the Folder Options dialog box, View tab,
click Show Hidden Files and Folders.

2. Copy the selected CUI file to a new file name (such as enterprise.cui) or
location (such as the shared network location where users will access the
file) so that you preserve the original CUI file (in case you want to
modify or use it again later).
warning This method of creating a new CUI file can result in additional

work if you do not want all the commands and user interface elements in
the copied CUI file.
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Customize the User Interface > Work with Customization Files > Basics of
Customization Files >

Basics of Customization Files
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To rename a customization group name

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customizations In <file name> pane, select a CUI file from the
drop-down list.

>

Customizations in All CUT Files
Main CUI File {acad.cui) x| 4

All Customization Files

Main CUI File (acad cui et

custom.cui
acimpression.cui ment)

acetmain.cui
Mran

3. In the Customizations In <file name> pane, right-click the customization
group name and click Rename.

»

4. Enter a new customization group name and press ENTER.
Note You can click, wait, and click again on the customization group
name to edit its name in-place.

Rename

Delete

Restore ACAD.CUT
Reset ACAD.CUI

+_R Find...

T
" 3 Replace...
...-_|'_| Ko J

Note The customization group name cannot contain spaces.



5. Click OK.
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Customize the User Interface > Work with Customization Files > Basics of

Customization Files >

Basics of Customization Files

oo B[ e |

To restore a customization backup file

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click the customization

group name.

3. Click Restore <file name>.

SR 3| ACADS

m W
& 5 M
-3 R
B8] R
..... Q
iho R

.. 5

...'_| B KL,

Rename

Delete

Restore ACAD.CUT
Reset ACAD.CUI

Find...

Replace...

4. Click OK.
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Customize the User Interface > Work with Customization Files > Basics of

Customization Files >

Basics of Customization Files

oo B[ e |

To reset a standard customization file

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click over the customization

group name.

3. Click Reset <file name>.

SR 3| ACADS

m W
& 5 W
-3 R
B-87 R
..... Qi
iho R

.. 5

...'_| B KL,

Rename

Delete

Restore ACAD.CUT
Reset ACAD.CUI

Find...

Replace...

4. Click OK.
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To designate a CUI file as the main CUI file
1. Click Tools menu » Options.

2. In the Options dialog box, on the Files tab, click the plus sign (+) next to
Customization Files to expand the list.

& Options
Current profile: <=l Innamed Profilex»> @ Curment drawin

Files |D1'spla},r I Open and Save | Plot and Publish IS},'sta'n I lUser Preferences

Search paths, file names, and file locations:

% Suppart File Search Path

% Working Support File Search Path
% Device Driver File Search Path
~[[B Project Files Search Path

: E Main Customization File

E Enterprise Customization File
% Custom lcon Location

3. Click the plus sign next to Main Customization File to expand it.

4. Select the item below Main Customization File and click Browse.

EIE:% Customization Files

: EIE Main Customization File
o ad
E Enterprise Customization File
% Custom lcon Location

5. In the Select a File dialog box, browse to the location of the



customization file and select it. Click Open.

The file you selected is now designated as the Main CUI file for the
program.
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Customize the User Interface > Work with Customization Files > Basics of
Customization Files >

Basics of Customization Files
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To copy and paste a user interface element

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, Customizations
In <file name> pane, expand the main node for the user interface
element that you want to copy.

3. Right-click over the user interface element, and click Copy.

- Menus
=-[3] File
-3 Edit
-]
&-TH] Inse Insert Separator
-3 Form
&[5 Tool Mew Menu
FTI Drav Mew Sub-menu
-5 Dime
rT| Mod Rename
rTl s Delete
-{H] Help
-3 Ribbon Duplicate
H=-53 Ribbon f
----- Quick Py Copy
----- *g Rollover Paste
r-hfEl) Shortout
o8 Keyboan Find...
[+-4gy Double Replacs..
-y Mouse

4. Right-click over the node that you want to paste the selected user
interface element to, and click Paste.



=-[=E Menus

rT| File
rT| Edit
-] Inse Inzert Separator
-5 Fom
rT| Tool Mew Menu
rT| Drav Mew Sub-menu
rTl Dlimg
g Mad Fename
& Win
rTl Help Delete
B3 Ribbon 7 Daslican
-3 Ribbon § TR
..... Qluick Pr Ly
..... + 5 Rollover Paste
El" Shartcut
E:'}—.I—I Kevboan Find...
- Double
E]% Mouse H REF'la':E"'

Note The key combination CTRL+C can be used to Copy a user interface
element and CTRL+V can be used to Paste a user interface element in
the Customizations In <file name> pane.

5. Click OK.
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Customize the User Interface > Work with Customization Files > Basics of
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To duplicate a user interface element

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, Customizations
In <file name> pane, expand the main node for the user interface
element that you want to duplicate.

3. Right-click over the user interface element, and click Duplicate.

=-[=E Menus
rT| File
&1 Edit
rT| Inse Inzert Separator
-5 Fom
rT| Tool New Menu
rT| Drav Mew Sub-menu
rT| Dlimsg
% .f'-"ll:ld Rename
& Win
rTl Helo Delete
-3 Ribbon T Duplicat
B-55 Ribbon f HplestE
..... Guick Py Copy
..... *g Rollover Paste
DIE?J' Shartcut
oo Keyboan Find...
B4z Double
E]% Mouse H REP'ECE“I

A copy of the selected user interface element is created in-place directly
above the selection in the Customizations In <file name> pane.

Note The key combination CTRL+D can be used to duplicate a user
interface element in-place.



4. Click OK.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Work with Customization Files > Migrate and
Transfer Customizations >

Migrate and Transfer Customizations
[ o | | || Qo Ferrerce ||

To transfer customizations

1. Click Tools tab » Customization panel » Import Customizations. ﬁ

2. In the Customize User Interface Editor, Transfer tab, in the left pane,
click the Open Customization File button.

T

3. In the Open dialog box, locate the customization file (MNU, MNS, or
CUI) from which you want to export customizations, and select it. Click
Open.

4. In the right pane, click the Open Customization File button.

5. In the Open dialog box, locate the customization file (MNU, MNS, or
CUI) to which you want to import customizations, and select it. Click
Open.

6. In the left pane, click the plus sign (+) next to an interface element node
to expand it. Expand the corresponding node in the right pane.

7. Drag an interface element from the left pane to the appropriate location
in the right pane. Menus must be dragged to menus, toolbars to toolbars,
and so on.



-8 Workspaces
7= Toolbars

7 Menus €
£ Ribban Tabs —
-85 Fibbon Panels == NiEn| Title Blocks
5 Quick Properties N ==Nien | Standards
5 Rollover Tooltips --E Ribbon Tabs

8. Click OK.
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To load a partial CUI file using the CUILOAD command
1. At the command prompt, enter cuiload.

2. In the Load/Unload Customizations dialog box, in the File Name box,
enter a path to the CUI file you want to load, or click Browse to locate
the file.

3. Click Load, and then click Close.
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To load a partial CUI file using the Customize tab

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select Main CUI File from the
drop-down list. To the right of the drop-down list, click the Load Partial
Customization File button.

— Y

A

I
3. In the Open dialog box, locate and select the partial CUI file you want to
open, and click Open.

Note If the partial CUI file you are attempting to load has the same
customization group name as the main CUI file, you need to change the
customization group name. Open the CUI file in the Customize User
Interface dialog box, select the customization group name, and right-
click to rename it.

4. To verify that the file has been loaded into the Main CUI file, in the
Customizations In <file name> pane, select the Main CUI File from the
drop-down list.



Customizations in All CUI Files

in CUI File i > (4
All Customization Files 7

Main CUI File (acad cui

custom.cui
BCIMPression.cui

>

5. In the tree view of the main CUI file, click the plus sign (+) next to the
Partial CUI Files node to expand it.

& LISP Files
'Z'-f): Legacy
EI@

Any partial menus loaded in the main CUI file are displayed.
6. Click OK.
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To unload a partial CUI file using the CUIUNLOAD command
1. At the command prompt, enter cuiunload.

2. In the Load/Unload Customizations dialog box, in the Loaded
Customizations Group box, select a CUI file.

3. Click Unload, and then click Close.
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To unload a partial CUI file using the Customize tab

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select Main CUI File from the
drop-down list.

Customizations in All CUI Files o

Main CUI File {acad.cui) x| 4
All Customization Files

Main CUI File (acad cui

custom.cui
acimpression.cul

3. In the tree view of the main CUI file, click the plus sign (+) next to the
Partial CUI Files node to expand it.

Any partial menus loaded in the main CUI file are displayed.

4. Right-click the partial CUI file that you want to unload. Click Unload
CUI File.



=[] Partial CUI Files

Unload CUI File
Save As...
“ommand List: Mew Menu n
Mew Toolbar -
Mew Shortcut Menu ]
Yl Commands
Rename &
Command Delete
% 3D Adjust Clip Planes Restore CUSTOM.CUI
= 30 Adjust Distance
1 3D Align Reset CUSTOM,CUT

The file is removed from the list.

Click OK.
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To add commands to a partial CUI file

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select the partial CUI file from the

drop-down list.

Customizations in All CUI Files o

custom.cui > 4
All Customization Files |

Main CUI File (acad.cui s

acimpression.cui ment)
acetmain.cui

MNran

3. In the Commands List pane, click Create a New Command.

Command List: £
[C-::ntrnl Elements v] = S 3
e |
Command Source / / =
Dim Style Control CONTROL
Find Text Control CONTROL i
Layer Cortrol CONTROL 5

4. Adjust the properties of the new command in the Properties pane as
necessary.

5. Click OK.
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To designate a CUI file as an enterprise CUI file
1. On each user's workstation in AutoCAD, click Tools menu » Options.

2. In the Options dialog box, Files tab, click the plus sign (+) next to
Customization Files to expand the list.

|E| Options
Curment profile; <=l Innamed Profilex»> @ Curment drawin

Files |D1'spla}r I Open and Save | Plot and Publish IS}'sta'n I lUser Preferences

Search paths, file names, and file locations:

% Suppart File Search Path

% Working Support File Search Path
% Device Driver File Search Path
~[[B Project Files Search Path

: E Main Customization File

E Enterprise Customization File
% Custom lcon Location

3. Click the plus sign next to Enterprise Customization File to open it.

4. Select the item below Enterprise Customization Files and click Browse.

EIE:% Customization Files

: E Main Customization File
EI E Enterprise Customization File
F e
% Custom lcon Location

5. In the Select a File dialog box, browse to the location of the enterprise



customization file. Click Open.

The enterprise CUI file if shared, must be saved in a location that all
users can access.

. In the Options dialog box, click OK.

Note In the Deployment wizard, you designate the enterprise CUI file in
the wizard's Specify Settings page. For more information about
designating an enterprise CUI file in the Deployment wizard, see “Select
Search Paths and File Locations” in the Network Administrator's Guide.
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To modify an enterprise CUI file
1. Click Tools menu » Options.

2. In the Options dialog box, Files tab, click the plus sign (+) next to
Customization Files to expand the list.

3. Click the plus sign next to Main Customization File to expand it.

Take note of the current main CUI file’s name and location as you will
need to restore it later.

4. Select the item below Main Customization Files and click Browse. In the
Select a File dialog box, browse to the location of the enterprise
customization file. Click Open.

5. Click the plus sign next to Enterprise Customization File to expand it.

Take note of the current enterprise CUI file’s name and location as you
will need to restore it later.

6. Select the item below Enterprise Customization Files and click Browse.
In the Select a File dialog box, browse to the location of the main
customization file. Click Open.

7. In the Options dialog box, click OK to save the changes.

[ B
8. Click Tools tab » Customization panel » User Interface.

9. In the Customize User Interface Editor, Customize tab, create new
commands and user interface elements as necessary.



10. Once done adding new commands and user interface elements, click
OK. Switch the file names of the main and enterprise values around in
the Options dialog box.

The main and enterprise CUI files should now resemble the original
configuration prior to making the changes.

Tip You can create two different profiles that can be used to switch between your
main and enterprise CUI files. One profile will have the CUI files in a normal
configuration that is used by your drafters, and the other profile has the main and
enterprise CUI files switched around making the enterprise customization file
editable.
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Basics of Customization Files
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Customization files are loaded into AutoCAD to define elements that make up
the user interface and are edited using the Customize User Interface (CUI)
Editor.

AutoCAD comes with several different CUI files that can be tailored to your
work environment. AutoCAD has two main designations for CUI files, main and
enterprise; by default AutoCAD uses a main CUI file. You can customize the
files that come with AutoCAD or you can create your own CUI files from
scratch using the Transfer tab in the Customize User Interface (CUI) Editor.

When customizing the CUI files that come with AutoCAD or creating your own
CUI files, the Customize User Interface (CUI) Editor creates a backup copy of
the file when you first start making changes to the CUI file. This allows you to
restore the file if you delete something that you wanted to keep. If you happen to
modify a CUI file that comes with AutoCAD, you can reset it back to its original
state.

The Customize User Interface allows you to not only create new user interface
elements and commands from scratch, but you can also copy existing user
interface elements and commands to modify them.

See Also
m  Customize Commands
m  Customize Toolbars
m  Create Pull-Down and Shortcut Menus

m  Customize Workspaces
m To create a customization file from scratch (Procedure)

m To create a CUI file from an existing CUI file (Procedure)




To restore a customization backup file (Procedure)
To reset a standard customization file (Procedure)
To rename a customization group name (Procedure)

To designate a CUI file as the main CUI file (Procedure)
To copy and paste a user interface element (Procedure)

To duplicate a user interface element (Procedure)
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Migrate and Transfer Customizations
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You can migrate custom MNU or MNS files from earlier releases using the
Customize User Interface (CUI) Editor. The program transfers all of the data in
the MNU or MNS file to a CUI file without modifying the original menu file.
The new CUI file is an XML-based file that has the same name as your original
menu file, but with a .cui extension.

You can also transfer customization information between files. For example, you
can transfer toolbars from a partial CUI file to the main CUI file so that the
program can display the toolbar information.

Note All elements can be transferred between two CUI files with the exception of
the property settings defined under the Quick Properties and Rollover Tooltips
nodes.

Show Me: Migrate and Transfer Customizations

Click the Play arrow below the following image to start the animation.

The following animation shows how to migrate menu customization that was
created in a previous release of the program and bring it forward into the current
release. It shows how to position a menu on the program’s menu bar through by
using a workspace. For more information about workspaces see Customize

Workspaces.



Note Button images may not appear in the program when you transfer a toolbar,
pull-down menu, or ribbon panel from a CUI file. If the images are loaded from
an image file, those images must reside in a folder that is defined in the Options
dialog box, Files tab under Support File Search Path or Custom Icon Location. If
the images come from a third-party resource DLL, contact the party who created
the resource DLL.

In addition, you can move customizations from the main CUI file to partial CUI



files, or from a partial CUI file to another partial CUI file.

If you transfer user interface elements that reference other user interface
elements, such as a flyout, all the relevant information for that interface element
is also transferred. For example, if you transfer the Draw toolbar, which
references the Insert toolbar, the Insert toolbar is also transferred.

As you make changes to the customization in a CUI file, the changes are
automatically tracked. The tracked changes are used when migrating
customization from release to release with the Migrate Custom Settings dialog
box. In the Migrate Custom Settings dialog box, you can migrate any changes
made to the standard CUI files that come with the program with the new
shipping versions of the files with the same name. You can avoid manually
migrating customizations, which might result in the losing the customizations.

Note The Migrate Custom Settings dialog box can be used to migrate menu
customizations from previous releases. To access the Migrate Custom Settings
dialog box, click Start menu (Windows) » All Programs (or Programs) »
Autodesk » [Autodesk product name] » Migrate Custom Settings.

Following is an example of the Customize User Interface (CUI) Editor, Transfer
tab. You use this tab to migrate customizations.



El Customize User Interface

s

o ==

\ Customizations in Main CUL

J Customizations in New CUI File

[ Main CUI File (acad.cui)

-3 @ New CUI File

2@ H

-8l Workspaces

r-T= Toolbars

-{EEE Menus

t--— Ribbon Tabs

t--{97 Ribbon Panels

----- Quick Properties
----- g Rollover Tooltips
W] Shotcut Nenus
t-mE Keyboard Shortcuts
r-4gy Double Click Actions
-y Mouse Buttons

----- @ LISP Files

EJ---!‘@} Legacy

(o A e W A e R e |

- 4pl Workspaces

H-T= Toolbars

- Menus

t-— Ribbon Tabs

H-f55 Ribbon Panels

----- Cuick Properties
----- *5 Rollover Tooltips
-R4El] Shortout Menus
H-2 5 Keyboard Shortcuts
&gy Double Click Actions
-0y Mouse Buttons

----- @ LISP Files

E]---{:f.'l} Legacy

(A s B e A |

(A s B e A |

This node cannot be transferred

Drag from either file to copy content

[ ok | [ Canesl | Apply

[t | ®

Note CUI files cannot be displayed or used in versions prior to AutoCAD 2006.

See Also

m  To transfer customizations (Procedure)
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Customize the User Interface > Work with Customization Files >

Create and Load a Partial CUI File
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Create, load, or unload partial customization files as you need them. Loading
and using a partial CUI file allows you to create and modify most interface
elements (toolbars, menus, ribbon panels, and so on) in a separate CUI file
without having to import the customizations to your main CUI file.

Show Me: Load a Partial CUI File

Click the Play arrow below the following image to start the animation.

The following animation shows how to load a CUI file as a partial CUI file.
Along with showing how to load a CUI file as a partial CUI file, it shows how to
control the display of toolbars and menus contained in the partial CUI file
through the use of a workspace. For more information on workspaces see

Customize Workspaces.



The order of the partial CUI files in the Partial CUI Files tree determines the
order they are loaded in the program. You can rearrange the tree hierarchy to
change the load order. Use the Transfer tab of the Customize User Interface
(CUI) Editor to create a partial CUI file. See To transfer customizations for more
information. To load or unload a CUI file, you can use the CUILOAD or
CUIUNLOAD command in the program or you can use the Customize tab in the
Customize User Interface (CUI) Editor.



Commands and elements can be added to a partial CUI file that is loaded under
the main CUI file. To add a command to a partial CUI file, the partial CUI file
must be selected from the drop-down list at the top of the Customizations In
<file name> pane. Once the partial CUI file is selected, any new command will
be added to the partial CUI file. See To add commands to a partial CUI file for
more information.

Note When you load a partial CUI file, its workspace information (menus,
toolbars, and palettes) is ignored by the main CUI file. To add workspace content
from a partial CUI file to a main CUI file, you must transfer the workspace. For
more information, see “Import a Workspace to a Main CUI File” in the

Customize Workspaces topic.

See Also

m  To load a partial CUI file using the CUILOAD command
(Procedure)

m To load a partial CUI file using the Customize tab (Procedure)

m  To unload a partial CUI file using the CUIUNLOAD command
(Procedure)

= To unload a partial CUI file using the Customize tab (Procedure)
m  To add commands to a partial CUI file (Procedure)

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Work with Customization Files > Create and L.oa
a Partial CUI File >

Create and Load a Partial CUI File
[Corcr | B[ o e |

To load a partial CUI file using the CUILOAD command
To load a partial CUI file using the Customize tab

To unload a partial CUI file using the CUIUNLOAD command

To unload a partial CUI file using the Customize tab

To add commands to a partial CUI file
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An enterprise CUI file typically stores customization information that is shared
by many users, but is controlled by a CAD manager. Enterprise CUI files make
maintaining and modifying customization data easier for the individual
responsible for controlling company standards.

Create an enterprise CUI file by performing the following tasks:

Create an enterprise CUI file from an existing CUI file or a new CUI
file. Make a copy of the main customization file (acad.cui) or another
customization file of your choice that contains all the base user interface
elements you need. If you want to start with a new customization file,
use the Transfer tab to create a blank customization file.

Designate the new file as your main CUI file. Using the Options dialog
box, you must load the customization file as your the main
customization file so you make edits to all of the different user interface
elements. Make sure to note which customization file is currently
designated as the main customization file, as you will need to restore it
later.

Modify the contents of the enterprise CUI file. Once the
customization file is designated as the main customization file, you can
change the customization group name and modify the CUI file contents
as needed. Changing the customization group name allows you to load
more than one CUI file in the program at one time. CUI files with the
same customization group name cannot be loaded into the program.

Replace the main CUI file. Using the Options dialog box, replace the
previous customization file that was designated as the main
customization file.



= Save the enterprise CUI file to a shared network location. When you
save the new enterprise file to a shared network location, all of your
users that have access to the specified location can access the file.

Note The folder where you place the enterprise CUI file should be in a
shared location that your users can access. To learn more about creating
a network share, see “How to Create a Network Share” in the Network
Administrator's Guide.

= Specify the enterprise CUI file location. The program automatically
designates an enterprise customization file as read-only when you
specify its file location in the Options dialog box. Specifying the
enterprise customization file location can be done on individual
workstations or in the Deployment wizard. For more information about
setting the location in the Deployment wizard, see “Select Search Paths
and File Locations” in the Network Administrator's Guide.

warning Even though the Customize User Interface (CUI) Editor loads
the enterprise customization file as read-only, this still doesn’t
completely protect the file from being modified. The enterprise
customization file could be loaded as the main customization file and
then modified. To protect the enterprise customization file, the location
where it is stored be marked as read-only and write access should be
limited to those you want to be able to edit the file.

See Also

m To designate a CUI file as an enterprise CUI file (Procedure)

=  To modify an enterprise CUI file (Procedure)
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To designate a CUI file as an enterprise CUI file

To modify an enterprise CUI file
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To create a command
To remove a command
To edit a command

To use a command

To copy and paste a command
To duplicate a command
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To create a command

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, Command List
pane, click Create a New Command.

Command List: £
% ]
All Commands v| * &
-y
Command Source .
Close Al ACAD JLL.
Close All Drawings EXPRESS L
& Color... ACAD
Command Alias Edef... EXPRESS
[= Command Linf ACAD
Command1 ACAD
£ Cone ACAD

A new command (named Command1) is displayed in both the Command
List pane and the Properties pane.

3. In the Properties pane, do the following:

= [n the Name box, enter a name for the command. The name is
displayed as a tooltip or menu name when the command is added
to a user interface element.

= In the Description box, enter a description for the command. The
description will be displayed on the status bar or in a tooltip.



When the cursor hovers over the command on a menu, the
description is displayed on the status bar while if it is on a toolbar
or ribbon panel it is displayed in a tooltip.

= In the Extended Help File box, enter the name of the file and ID
to use for the extended help for the command.

= In the Command Display Name box, enter the name of the
command that you want to display for the command.

» In the Macro box, enter a macro for the command.

= In the Tags box, enter the tags you want to use when searching for
commands in the Search field of the menu browser.

m In the Element ID box, enter an element ID for the command.

For information about adding button images to a command, see Create
Images for Commands.

>

1
]
1]
-
i
o’
o

LEEN Command

Description

Extended Help File

Command Display Name

Macro E1T

Tags
E Advanced

Element ID MMLU_0001
E Images

Small image

Large image

MName
Displays the name of the Macro.
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To remove a command

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, Command List
pane, select Custom from the Command Filter drop-down list.

The list is filtered to only show the commands that you have created in
the loaded customization files.

3. Select the command to be removed, and right-click over the command.

4. Click Remove.

Note A command only can be removed when it is not being referenced by
a user interface element, such as a toolbar or menu.

warning There is no way to undo the removal of a command or user
interface element from inside the Customize User Interface (CUI) Editor,
so be careful when removing commands and user interface elements. If
you accidentally remove the wrong command or user interface element
the best thing to do is click Cancel, but this will also undo any other
changes that you might have made. If you already made several changes
to the CUI file and don't want to lose the changes that you already made,
you can open the backup CUI file that is automatically created after a
change is made to a CUI file from the Transfer tab and then proceed to
recover the command or user interface element that was accidentally
removed.
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To edit a command

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, do one of the
following:

m In the Command List pane, select the command you want to edit.

m In the Customizations In <file name> pane, tree view, locate and
then select the command you want to edit.



Customizations in All CUI Files
All Customization Files | @

=-§¢fEl| Object Snap Cursor Menu -
----- Y Temporary track point

>

----- J Mid Between 2 Points
=[] Poirt Fitters

3
[
m

Command List: P

All Commands v] b= g

Command Source

X Snap, Poirt Fiters, X ACAD
XY Snap, Point Fitters, XY ACAD
X2 Snap, Point Fiters, X7 : “_\. ACAD
.¥ Snap, Point Fiters, ACAD
¥2 Snap, Point Fiters, Y2 ACAD

.Z Snan Pnint Fiters 7 ACAN

3. In the Properties pane, do any of the following to edit the command:

In the Name box, enter a name for the command. The name is
displayed as a tooltip or menu name when the command is added
to a user interface element.

In the Description box, enter a description for the command. The
description will be displayed on the status bar or in a tooltip.
When the cursor hovers over the command on a menu, the
description is displayed on the status bar while if it is on a toolbar
or ribbon panel it is displayed in a tooltip.

In the Extended Help File box, enter the name of the file and ID
to use for the extended help for the command.

In the Command Display Name box, enter the name of the
command that you want to display for the command.



» [n the Macro box, enter a macro for the command.

» In the Tags box, enter the tags you want to use when search for
commands with the Search field of the menu browser.

= [n the Element ID box, enter an element ID for the command.
(For new commands only. You cannot modify the element ID of
an existing command).

For information about adding button images to a command, see Create
Images for Commands.

>

Feset Defaults

LR Snap. Poirt Fiters, XY
Description Specifies a XY point fiter
Extended Help File
Command Display Name

Macro A
Tags
B Advanced
Element (D ID_Point Foay
EH Images
Small image RCOATA_16_PTFXY
Large image RCDATA_16_PTFXY
Name

Displays the name of the Macro.
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To use a command

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, Command List
pane, locate the command you want to use and drag it to an interface

element.
----- * Match Properties
----- J Change to Bylayer
[#-{] Object
=[] Clip
..... # Image
b Yref
e Viewport .
..... *’ e r EI
== X S
Command List: / o
i Q
[NJCcu'ru'naru:ls f v] o W
I
Command Source =
DrawOrder byfcolor EXPRESS
= DWF Clip... ACAD
£ DWF Layers ... ACAD A
B DWF Object Snap ACAD
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To copy and paste a command

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, Command List
pane, locate the command you want to copy.

3. Right-click over the command. Click Copy.

Command List: o
| All Commands - & %
Command Source e
""'.,.- Dimension, Dimjogline ACAD
:ﬁ, Dimengion, Dimspace ACAD
BT Dimersion, Flp feme_____can
"2 Dimension, Jog Mew Comrmand
*% Dimension, Lea
I Dimension, Line Rename F2
,rt‘j; D1.men5|.un.0bll e
T Dimension, Ord _
|/ Dimension, Ord Duplicate
2= Dimension, Ord —
k% Dimension, Ove s
Dimension, Pre Replace...
Dimengion, Precision, 0.0 ACAD !

4. Right-click over a user interface element like a toolbar or menu. Click
Paste.



----- ¥ Inspection
----- ¥ Jogged Linear

----- J Dimension Edit
----- J Dimension Text E
----- J Dimension Updal

----- J Dim Style Contro
----- J Dimension Style.
5 Draw

i) Draw Order

5 Inguiry

5 Insert

in Layouts

= Modify

= Modify Il

i Properties

Insert Separator

Mew Toolbar

Mew Flyout

Rename

Remowve

Duplicate
Copy
Paste

Find...

Replace...

Note The key combination CTRL+C can be used to copy a command and
CTRL+V can be used to paste a command.
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To duplicate a command

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, Command List
pane, locate the command you want to duplicate.

3. Right-click over the command. Click Duplicate.

Command List: £

Reset to Default
+ Arc, C Mew Command ACAD
£ A 0 AD
4 Arc,
B fec Rename F2 D
ﬁ Arc, & e AD
o Ay Bkt AD
s uplicate AD
?‘“m-f Find... e
Arc, § ACAD
f-. e Replace... \CAD )

A copy of the selected command is created in-place directly above the
selected command in the Command List pane.

Note The key combination CTRL+D can be used to duplicate a command
in-place.
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To find a search string in a CUI file

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customizations In <file name>
pane, right-click anywhere in the tree view. Click Find.

X y]AcAnd
;:ﬁ W Rename
E= T Delete
{ﬁI M it
12. R Restore ACAD.CUI
--Ej R Reset ACADCUI
- o
..... + = F Find...
I:FQJ 5 Replace...
..._|_| Ko -

3. In the Find and Replace dialog box, Find tab, do the following:
= In the Find What box, enter the search string.

= In the Ignore Case option, clear the check box if you want the
search to find every instance of the search string regardless of its
case.

m In the Restrict Search To option, select the check box if you want
to restrict the search to just one CUI file. Then, under this option,
select a CUI file from the drop-down list.



Restrict Search to:

Main CLI File -

Enterprise CUI File

Partial CUI Files I
| |

m Click Find Next to locate all instances of the search string.

A message is displayed that details the location of the search string and
the number of results generated from the search.

& Find and Replace ()
Find Feplace
Find what: Texd| -

V1
s e Search string found in tree node "Dimension Edit’ property
[7] Restrict Search to: ‘Description’ at position 16 (1/416).

Main CUI File Find Selected Command [ Find Mext ] [ Close ]

4. Click Find Next to continue your search.
5. Click Close.

6. In the Customize User Interface Editor, click Close.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Find Command Names
and Search Strings >

Find Command Names and Search Strings
[ o | | || Qo Ferrerce ||

To find a search string in the Command List pane

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Command List pane, right-click
anywhere in the Command list. Click Find.

3. In the Find and Replace dialog box, Find tab, do the following:
= In the Find What box, enter the search string.

m In the Ignore Case option, clear the check box if you want the
search to find every instance of the search string regardless of its
case.

m Click Find Next to locate all instances of the search string.

A message is displayed that details the location of the search string and
the number of results generated from the search.



‘M Find and Replace m
Find | Heplace|

Find what: | Fiotatd M

¥| lgnore caze : ; : : :
4 Search ztring found in tree node 'Dimenszion Test Edit' property
[ ] Restrict Search to; 'Diezcription’ at pogition 10 [1./137].

kain CLI File Find Selected Command [ Find Mext ] [ Claze ]

4. Click Find Next to continue your search.
5. Click Close.

6. In the Customize User Interface Editor, click Close.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Find Command Names
and Search Strings >

Find Command Names and Search Strings
[ o | | || Qo Ferrerce ||

To find where a command in the Command List pane is used

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Command List pane, right-click
the command name you want to find. Click Find.

= Ribbon AC
Rotate Mew Command
Rotate

B Runs Rename F2

;E Save

E Save sil
Save ! Duplicate

|: Save f .

& Save: Find...

Ed save s Replace...

= Srala ol

3. In the Find and Replace dialog box, Find tab, do the following:
= [n the Find What box, enter the command name.

= In the Ignore Case option, clear the check box if you want the
search to find every instance of the search string regardless of its
case.

m Click Find Selected Command to locate all instances of the
command.



24 Find and Replace
Find | Fieplace

Find what: | Fiotatel [v]

lgnore case : : : : :
[la Search ztring found in tree node 'Dimenszion Test Edit' property
[ ] Restrict Search to: ‘Description’ at position 10[1./137].

Find Selected Command | | FindMext | [ Close. |

In the search results text that is displayed, review the location of the
matching search string, its exact position in the tree node or Properties
pane, and the number of instances in which the command or search
string occurs.

Click Find Selected Command to continue your search.
Click Close.

In the Customize User Interface Editor, click Close.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Find Command Names
and Search Strings >

Find Command Names and Search Strings
[ o | | || Qo Ferrerce ||

To replace a search string

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, Customizations
In <file name> pane, right-click anywhere in the tree view. Click

Replace.

=8 Y| ACAD,
f:ﬂ W Fename
E= T Delete
ij M e
,2, R Restore ACAD.CUI
--Ej R Reset ACADCUI
- o
..... 15 R Find...
I:FﬂJ 5 Replace...
..._|_| Ko ~

3. In the Find and Replace dialog box, Replace tab, do the following:
m In the Find What box, enter the search string.

m In the Replace With box, specify the text string you want to use to
replace the found string.

= In the Ignore Case option, clear the check box if you want the
search to find every instance of the search string, regardless of its
case.

m In the Restrict Search To option, select the check box if you want
to restrict the search to just one CUI file. Then, under this option,
select a CUI file from the drop-down list.



» To step through each instance of a found string before replacing
it, click Replace. In the search results text that is displayed,
review the location of the matching search string, its exact
position in the tree node or Properties pane, and the number of
instances in which the command or search string occurs. You
cannot undo this action.

m To replace all instances of the search string, click Replace All.
You cannot undo this action.

Find what:

Replace with:

lgnore case

Main CLI File

|E| Find and Replace

Replace

Create

[7] Restrict Search to:

Search string found in tree node "Draw’ property ‘Name’ at position
O (14200

[ Feplace ] [H&place .Pc.ll] [ Find Mesxt ] [ Close ]

4. Click Close.

5. In the Customize User Interface Editor, click Close.
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Customize the User Interface > Customize Commands > Find Command Names
and Search Strings >

Find Command Names and Search Strings

oo B[ e |

To replace a command

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, Command List
pane, right-click the command name you want to replace. Click Replace.

= Ribbon

Rotate
Rotate
B Funs

J:.E Save

E Save

Save f

|: Save f

EE:.”" Save :
Ed save !

AC

Mew Command

Rename F2

Copy
Duplicate

Find...

Replace...

=

[i1)

3. In the Find and Replace dialog box, Replace tab, in the Find What box,
the command name you selected in the previous step is displayed. To
complete the dialog box, do the following:

m In the Replace With box, specify the command name you want to
use to replace the found command.

= In the Ignore Case option, clear the check box if you want the
search to find every instance of the command, regardless of its
case.

m To step through each instance of a command name before
replacing it, click Replace. In the search results text that is



displayed, review the location of the matching search string, its
exact position in the tree node or Properties pane, and the number
of instances in which the command or search string occurs. By
renaming the command in the Command list, you rename the
command everywhere that command is used in the CUI file. You
cannot undo this action.

m To replace all instances of the command, click Replace All. You
cannot undo this action.

4. Click Close.

5. In the Customize User Interface Editor, click Close.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Control the Display of
Command Labels >

Control the Display of Command Labels
[Corcr | B[ | o e |

To gray out (disable) a command's menu label

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
menu that contains the command you want to disable.

3. Click the command you want to gray out.

=T Menus
T3] File
&-TF] View
-7 Insert
Elm Format

4. In the Properties pane, in the Name field, add a tilde (~) at the beginning
of the command.

>

|
~aLayer... I
Command Name Layer Properties !

Description Manages layers and layer propertiei
Extended Help File !

Note The command must be selected from the Customizations In pane,



otherwise you are just modifying the name of the command and not the
label that is displayed to the user.

. Click OK.

The changes to the command will be visible after the changes have been
applied and the CUI Editor is closed.

4 Layer...
& 55 Layer StNanager...
= Layer tools J

@ Color...
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Customize the User Interface > Customize Commands > Control the Display of
Command Labels >

Control the Display of Command Labels
[Corcr | B[ | o e |

To mark command's menu label

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
menu that contains the command you want to mark.

3. Select the command you want to mark.

=3 Window

#-[F] Lock Location

----- J Cascade

----- b g Tile Horizontally

----- i Tile Verically
----- J Amange lcons

4. In the Properties pane, in the Name field, add an exclamation point and a
period (! .) at the beginning of the command.



>

1 Tile &Horizontally

Command Name Tile Horizortalhy
Extended Help File

Command Display Mame | SYSWINDOWS

Macro “C"C_syswindows;_hor

Click OK.

The changes to the command will be visible after the changes have been
applied and the CUI Editor is closed.

Close i

Close All

Lock Location r

Cascade
v Tile Horizontally
Tile Vertically

Arrange [cons

v 1 Drawingl.dwg
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Customize the User Interface > Customize Commands > Control the Display of
Command Labels >

Control the Display of Command Labels
[Corcr | B[ | o e |

To simultaneously gray out (disable) and mark a command's menu label

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
menu that contains the command you want to disable and mark.

3. Click the command you want to gray out and mark.

4. In the Properties pane, in the Name field, add a tilde, an exclamation
point, and a period (~! . or ! .~) at the beginning of the command.

5. Click OK.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Create Images for

Commands >

Create Images for Commands

oo | B[ e |

To edit or create a button image

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the Command
List pane or the Customizations In <file name> pane, click a command
to display the Button Image pane (in the upper-right corner).

Button Image

) Large
() Small

i@ Bath

Yz

RCDATA_16_PTFYZ

pis ARl
& 4p | &
W|—e|| x|y
el F ey e
# X |X|®
@O|L|#| o

B (A KN D

< on B

=
&

>

-

3. In the Button Image pane, click a button that is closest in appearance to
the button you want to create. Click Edit.
Tip If you want to start with a blank image, select any image from the list
under the Button Images pane. Click Edit to start the Button Editor. In
the Button Editor, click Clear located on the left side.

4. In the Button Editor, use the Pencil, Line, Circle, and Erase buttons to
create or edit the button image. To use color, select a color from the
color palette, or click More to open the Select Color dialog box.

= Pencil button. Edits one pixel at a time in the selected color. You


javascript:hhctrl_d0e6363.Click()

can drag the pointing device to edit several pixels at once.

= Line button. Creates lines in the selected color. Click and hold to
set the first endpoint of the line. Drag to draw the line. Release to
complete the line.

m Circle button. Creates circles in the selected color. Click and
hold to set the center of the circle. Drag to set the radius. Release
to complete the circle.

= Erase button. Resets the color of one pixel at a time to an off
white color.

Note You cannot edit flyout buttons.

. To save the customized button as a BMP file, click Save. Use Save As to
save it under a different name. Save the new button image to the
following location:

C:\Documents and Settings\<user profile name>\Application
Data\Autodesk\<product name>\<release number>\
<language>\Support\Icons

Note You can save buttons in BMP (*.bmp, *.rle, or *.dib) format only.

When saving a button image, the Button Editor defaults to the folder
defined under Custom Icon Location on the Files tab of the Options
dialog box. Button image files placed in the folder can be migrated with
the Migrate Custom Settings dialog box in future releases.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Create Images for
Commands >

Create Images for Commands
[Concer || || Qe Reference||

To assign a standard image to a command

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the Command
List pane, click any command to display the Button Image pane (in the
upper-right corner) and the Properties pane (in the lower-right corner).

Button Image o
|:| Large @ l'_"@- % @ ,‘-‘E’ |i|
() Small @\ |2 %<
|§| Baoth ﬁ L] i_'-' L
RCDATA_I6_CIRSPT | , ' 4y vy
A XX |—|®
gl | [ i
b~
Reset Defaults
Circle, 3 Points
Description Creates a circle using three points
Extended Help File
Command Display Mame| CIRCLE
Macro “CC_circle _3p
Tags
E Advanced
Element (D ID_Circle3pt
E Images
Small image RCDATA_16_CIR3PT
Large image RCDATA_32 CIR3PT

3. In the Button Image pane, select one of the three image assignment



options; Large, Small, or Both.

Button Image

() Large
() Small

i@ Bath

ACDATA_16_CIR3PT

o

4. Select an image from the image list and the image name is assigned to
the Small, Large, or both the Small and Large image properties of the
selected command.

Button Image

() Large
() Small

i@ Bath

&,

RCDATA_16_CIR3PT

!

illanlloee] el
# X |X|/®
@ O|L|#| -
B \A RN D

e o | a—

>

-

Note As you select an image from the image list, the image’s name is

displayed between the preview of the image and the Edit button in the
Button Image pane. If the image is a custom image stored in a bitmap
file, the file name is displayed.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Create Images for

Commands >

Create Images for Commands

oo | B[ e |

To assign a custom image to a command

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the Command
List pane, click any command to display the Button Image pane (in the
upper-right corner) and the Properties pane (in the lower-right corner).

Button Image o
o ZEE B+ 5]
i £ 0%~
@ Both | 2R Tl

2|2 | 2 X |~

®|1eBd|7

& | | e — —_—

-

=

[ Reset Defaults ]

Description
Extended Help File
Command Display Mame CLOSEALL

Macro
Tags
B Advanced
Element ID
E Images
Small image
Large image

Clase Al

“CC_closeall

Close

ID_WINDOW_CLOSEALL

3. In the Properties pane, select the field next to the Small image property.



An Ellipse button will be displayed on the right side of the property.

4. Click the [...] button next to the property.

E Command i
Mame Close Al '
Description
Extended Help File
Command Display Name CLOSEALL
Macro “CC_closeall
Tags

B Advanced
Element ID ID_WINDOW_CLOSEM
E Images

Large image

5. In the Select Image File dialog box, browse to the image file that you
want to use for the command.

6. Repeat steps 3 through 6 for the Large image property of the command.
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Customize the User Interface > Customize Commands > Create Images for
Commands >

Create Images for Commands
[ o | | || Qo Ferrerce ||

To import a custom image to the image list

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the Command
List pane, click any command to display the Button Image pane.

3. Right-click over the list of images in the Button Image pane and select
Import Image.

. Button Image

> [»

o e EAEREE
) Small + |2 |% |5 €|~
® Both sl Bl e Gl e

vz || A XX
(e Jlogoois.

Import Image...

A= =IRCIE Y R

4. In the Open dialog box, browse to and select the BMP image file that
you want to import and click Open.

5. Select the image assignment option Small, Large, or Both from the
Button Image pane and then the select the image that you imported from
the list of images.



Button Image b
CYr— T d
© Smal ==1 |« 205 | | o |
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Customize the User Interface > Customize Commands > Assign Tags to
Commands >

Assign Tags to Commands
[Corcr | B[ o |

To add tags to a command

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, Command List
pane, select the command to which you want to add a tag.

Command List: o
| All Commands | * ®
Command Source 3
[5 Clip, Viewport ACAD
& Clip, Xef ACAD
% Close ACAD
Close ACAD
Cloze All ACAD
Close All Drawings EXPRESS
& Color... ACAD
Command Alias Editor... EXPRESS
E Command Line ACAD
£ Cone ACAD -

3. In the Properties pane, select the Tags field and click the [...] button.



EH Command

Mame Close Al

Description

Extended Help File

Command Display Name CLOSEALL

Macro “CC_closeall

J
E Advanced

Element ID ID_WINDOW CLOSEALL
E Images

Small image

Large image

4. In the Tag Editor dialog box, in the Tags box, enter a tag.

As you enter a tag, a popup menu might display showing a list of
previously used tags. Click a tag on the menu to use that tag. You can
add more than one tag to a command; separate each tag with a comma.

Tag Editor ==

Mame: Close All

Tags: C|DSEL

5. To add another tag for a command, press the LEFT ARROW key and
enter the tag. Repeat as needed.

6. Click OK.

7. In the Customize User Interface Editor, click OK.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Assign Tags to
Commands >

Assign Tags to Commands
[Corcr | B[ o |

To remove a tag from a command

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, Command List
pane, select the command from which you want to remove a tag.

Command List: o
| All Commands | * ®
Command Source 3
[5 Clip, Viewport ACAD
& Clip, Xef ACAD
% Close ACAD
Close ACAD
Cloze All ACAD
Close All Drawings EXPRESS
& Color... ACAD
Command Alias Editor... EXPRESS
E Command Line ACAD
£ Cone ACAD -

The Properties pane is displayed on the right side.
3. In the Properties pane, select the Tags field and click the [...] button.



EH Command
Mame Close Al
Description
Extended Help File
Command Display Mame CLOSEALL
Macro “CC_closeall

REEE Close ()
Advanced

Element ID ID_WINDOW_CLOSEALL
EH Images

Small image

Large image

=

4. In the Tag Editor dialog box, in the Tags box, click the tag you want to
remove. Press DELETE.

Tag Editor
Mame: Close All

Tags:

The tag is removed.
5. Click OK.

6. In the Customize User Interface Editor, click OK.
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Customize the User Interface > Customize Commands > Create Tooltips and
Extended Help for Commands >

Create Tooltips and Extended Help for Commands
[Corcr | B[ o e |

To add a tooltip to a command

[
1. Click Tools tab » Customization panel » User Interface.
2. In the Customize User Interface Editor, click the Customize tab.

3. In the Command List pane, click the command to which you want to add
a Help message.

[An Commands

Command

& Circle, Center. Radius

‘E‘ Circle, Tan, Tan, Radius
C‘ Circle, Tan, Tan, Tan

4. In the Properties pane, Description field, enter the tooltip text for the
selected command.

EH Command
Mame Circle, Center, Radius
Description
Extended Help File
Command Display Mame CIRCLE

Macro “C"C_circle
Tags
B Advanced
Element (D ID_CircleRad
EH Images
Small image RCDATA_16_CIRRAD

Large image RCDATA_32 CIRRAD



5. Click the Apply button.

The next time the cursor hovers over the command on a toolbar, ribbon
panel, or menu browser, the text is displayed in the tooltip.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Create Tooltips and
Extended Help for Commands >

Create Tooltips and Extended Help for Commands
[Corcr | B[ o e |

To add extended help to a command

[
1. Click Tools tab » Customization panel » User Interface.
2. In the Customize User Interface Editor, click the Customize tab.

3. In the Command List pane, click the command to which you want to add
extended help.

[All Commands

Command

& Circle, Center. Radius

‘E‘ Circle, Tan, Tan, Radius
C‘ Circle, Tan, Tan, Tan

4. In the Properties pane, select the Extended Help File field and click [...]

button.
EH Command
Mame Circle, Center, Radius
Description Creates a circle using a specified
J
Command Display Mame CIRCLE
Macro “C"C_circle
Tags
B Advanced
Element (D ID_CircleRad
EH Images
Small image RCDATA_16_CIRRAD
Large image RCDATA_32 CIRRAD




5. In the Select Extended Help File dialog box, browse to and select the
XAML file that contains the extended help for the command. Click
Open.

6. In the Select Help ID dialog box, select the help ID for the extended help
content. Click OK.

B Select Help ID =)

Choose a help |D from the list below:
MYEH_CMD_0001

i) Tip: Hover the mouse over an item in the list to
preview its tooltip content.

| 0K || Cancel || Help

7. Click the Apply button.

When the command is added to a toolbar or ribbon panel, the extended
help is displayed if extended help is enabled for tooltips and the cursor
hovers over the command for the designated time interval.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Create Tooltips and
Extended Help for Commands >

Create Tooltips and Extended Help for Commands
[Corcr | B[ o e |

To create an XAML file

1. In a text editor (for example, Microsoft® Windows® Notepad), create a
new file and enter the elements needed to define the extended help
content.

As an example, enter the text below in the text editor:

<ResourceDictionary
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presenta
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
xmlns:src="clr-namespace:Autodesk.Windows;assembly=AdWindows
<src:ProgressivePanel x:Key="MYEH_CMD_0003">

<StackPanel>

<TextBlock Background="AntiqueWhite" TextAlignment="Center">
Configures the settings for the current drawing.
</TextBlock>

</StackPanel>

</src:ProgressivePanel>

</ResourceDictionary>

2. Save the file as ASCII text (TXT file), with a file extension of .xaml.

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Create Status Line Help
Messages >

Create Status Line Help Messages
oo | [ | ok e |

To create a status line help message

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, Command List
pane, click the command to which you want to add a help message.

[AII Commands

Command

& Circle, Center. Radius

‘E‘ Circle, Tan, Tan, Radius
C‘ Circle, Tan, Tan, Tan

3. In the Properties pane, Description box, enter the descriptive text for the
selected command.

EH Command
Mame Circle, Center, Radius
Description
Extended Help File
Command Display Mame CIRCLE

Macro “C"C_circle
Tags
B Advanced
Element (D ID_CircleRad
E Images
Small image RCDATA_16_CIRRAD
Large image RCDATA_32 CIRRAD

4. Click the Apply button.

The next time you use the command, the descriptive text you added is



displayed in the status line when the cursor hovers over the command on
a menu.

Command :

Command :

Please send us your comment about this page
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Customize the User Interface > Customize Commands >

Create, Edit, and Reuse Commands

| oo (]| Guic Refeece |

You can create a new command from scratch, copy an existing command to
create a new command, or edit the properties of an existing command. When
you create or edit a command, the properties you can define are the command
name, description, extended help file, command display name, macro, tags,
element ID (for new commands only), and small or large image.

When you change any properties of a command in the Command List pane, the
command is updated for all interface items that reference that command.

Show Me: Create a Command

Click the Play arrow below the following image to start the animation.

The following animation shows how to create a custom command in the main
CUI file. The animation covers assigning a command a name, description, and
macro. For assigning an image to a command see Create Images for Commands.



See Also

m  Create Macros

= Create Images for Commands
m  To create a command (Procedure)

m  To remove a command (Procedure)



To edit a command (Procedure)

To use a command (Procedure)

To copy and paste a command (Procedure)
To duplicate a command (Procedure)

Please send us your comment about this page
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Customize the User Interface > Customize Commands >

Find Command Names and Search Strings

[ conce )T

You can search one or more CUI files for commands or search strings (including
commands or user interface element names, command display names,
descriptions, macros, and tags). You can also replace commands or search strings
one at a time or all at once.

You can limit or expand your search depending on the search results you want to
achieve.

Limit the search to commands located in the Command List pane.
This search does not include the names of user interface elements, the
commands that are associated to them, and their properties. For example,
if you limit the search for the LINE command in the Command List
only, a message similar to the following is displayed when you start your
search: “Search string found in command 'Dimension, Linear' property
'Name' at position 11 (1/12).”

Expand the search to include all properties in all tree view nodes in
the Customizations In pane. This type of search finds all instances or a
search string. For example, if you search for the string “line” and start in
the tree view, a message similar to the following is displayed: “Search
string found in ‘Linear’ property ‘Name’ at position 0 (1/55).”

See Also

m To find a search string in a CUI file (Procedure)

m To find a search string in the Command List pane (Procedure)

m To find where a command in the Command List pane is used
(Procedure)

m To replace a search string (Procedure)




m  To replace a command (Procedure)

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Find Command Names
and Search Strings >

Find Command Names and Search Strings
[Concer || || Qe Reference||

To find a search string in a CUI file

To find a search string in the Command List pane
To find where a command in the Command List pane is used

To replace a search string

To replace a command
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Customize the User Interface > Customize Commands >

Control the Display of Command Labels
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You can control the way that menu labels indicate a command's availability in
the program. Display menu commands as grayed out (disabled), mark them with
a check mark or border, or use a combination of indicators.

Menu commands can also contain DIESEL string expressions that gray out,
mark, or interactively change the text of the displayed label. For more
information about using DIESEL expressions, see DIESEL Expressions in
Macros.

Gray Out (Disable) Menu Labels

To gray out a label in a menu, you begin the command name with a tilde (~).
Any commands associated with the item are not issued, and submenus are
inaccessible.

In the following example, the tilde (~) is placed at the beginning of the Copy
Link command label in the Name cell of the Properties pane.



Properties

>

24|
B Display
MName “Copy Link
H Command
Command Name Copy Link
Description Copies the cument view to the Win

Extended Help File
Command Display Name COPYLINK
Macro “CC_copylink
Tags

E Advanced

E Images .
Small image RCDATA_16_COPY_LINK
Large image RCDATA_32 COPY_LINK

MName
Displays the name of the Menu ltem.

Following is the resulting Copy Link command grayed out in the Edit menu.

< Undo Cui Ctri+Z
Redo Ctrl+Y

o Cut Ctrl+X

|E Copy Ctrl+C

'-_I':L Copy with Base Point Ctrl+Shift+C
Copy Link

E Paste Ctrl+V

L3 Paste as Block Ctrl+Shift+V

Paste as Hyperlink
Il Paste to Original Coordinates
[(; Paste Special...

_‘:.f Clear Del

f_';f@ Select All Ctri+A
OLE Links...

@2’ Find...

Command labels can contain DIESEL string expressions that conditionally
disable or enable command labels each time they are displayed. For example, the
DIESEL string expression in the Macros cell of the Properties pane disables the



MOVE command while any other command is active.

$(if,$(getvar,cmdactive), ~)MOVEACAC_move

The AutoLISP menucmd function can also be used to disable and enable items
from a macro or application. For examples, see Reference Pull-Down or
Shortcut Menus.

Mark Menu Labels

You can mark a menu label by including an exclamation point and a period (! .)
in the Name cell of the Properties pane for the command. A menu item is marked
in one of two ways:

= A check mark. Displayed when a menu item does not have an image
associated with it.

= A border. Displayed when a menu item has an image associated with it;
a border is displayed around the image.

Following is an example of the Edit menu with the OLE Links command marked
with a check mark and the Copy Link command's image marked with a border:

<7 Undo Menubar Ctri+Z
o Cut Ctrl+ X
|E Copy Ctrl+C
'-_I':L Copy with Base Point Ctrl+Shift+C
[[8y| Copy Link

E Paste Ctrl+V
L3 Paste as Block Ctrl+Shift+V
Il Paste to Original Coordinates

[(; Paste Special...

_é Clear Del
&, Select All Ctrl+ 4
& | Find...

Command labels can also contain DIESEL string expressions that conditionally



mark command labels each time they are displayed. When the following
DIESEL string is added to the Macros cell for the applicable command in the
Properties pane, a check mark is placed to the left of the menu label whose
related system variable is currently enabled.

$(if, $(getvar,orthomode), !.)0rtho”0

$(if, $(getvar, snapmode), !.)Snap”B

$(if, $(getvar,gridmode), !.)Grid"G

The AutoLISP menucmd function can be used to mark labels from a macro or
application. For examples, see Reference Pull-Down or Shortcut Menus.

Simultaneously Disable and Mark Command Labels

You can mark and disable commands at the same time using either of the
following formats:

~1, labeltext
| .~ labeltext

The tilde (~) is the special character code to disable a command and an
exclamation point and period (!.) is the special character code to mark a
command.

The tilde (~), exclamation point, and period (! .) are placed at the beginning of
the Copy Link command label in the Name cell of the Properties pane.
Following is the resulting Copy Link marked and grayed out in the Edit menu.



(=9

1N

REL

Undo Menubar Ctrl+Z
Redo Ctrl+
Cut Ctrl+ X
Copy Ctrl+C
Copy with Base Point Ctrl+Shift+C
Copy Link

Paste Ctrl+Y
Paste as Block Ctrl+Shift+Y

Paste as Hyperlink
Paste to Original Coordinates

Paste Special...

Clear Del
Select All Ctrl+A
OLE Links...

Eind...

As with the previous examples, a DIESEL expression can be used to
simultaneously disable and mark a command label.

See Also

m DIESEL Expressions in Macros

m To gray out (disable) a command's menu label (Procedure)

m  To mark command's menu label (Procedure)

m To simultaneously gray out (disable) and mark a command's menu
label (Procedure)

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Control the Display of
Command Labels >

Control the Display of Command Labels
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To gray out (disable) a command's menu label

To mark command's menu label

To simultaneously gray out (disable) and mark a command's menu label
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Customize the User Interface > Customize Commands >

Create Images for Commands

| oo (]| uic Refeece |

Images can be associated with a command, and are displayed on a toolbar button
or next to a menu item in a pull-down menu. You can use images that come with
the program or create your own.

Show Me: Create a Custom Image and Assign it to a Command

Click the Play arrow below the following image to start the animation.

The following animation shows how to create a custom image and assign it to a
custom command.



Autodesk provides standard button images for buttons that start commands. You
can create custom button images to run custom macros. You can either modify
an existing button image or create your own. Button images are saved as BMP
files. The BMP files must be saved in the same folder as the CUI file that it
references.

User-defined bitmaps can be used in place of the small image and large
image resource names in button and flyout commands.



Small images should be 16 x 16 pixels. Large images should be 32 x 32 pixels.
Images that do not match these sizes are scaled to fit.

See Also
m  QOverview of File Organization

m  To edit or create a button image (Procedure)

m To assign a standard image to a command (Procedure)
m  To assign a custom image to a command (Procedure)

m To import a custom image to the image list (Procedure)

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Create Images for
Commands >

Create Images for Commands
oo [ | ok e |

To edit or create a button image

To assign a standard image to a command
To assign a custom image to a command
To import a custom image to the image list
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Customize the User Interface > Customize Commands >

Assign Tags to Commands

| oo (]| uic Refeece |

With command tags, you can search for a command or a group of commands
with the menu browser.

You can assign one or more tags to a command to make it easy to locate when
performing a search from the menu browser. You add tags to a command using
the Tag Editor dialog box. When a tag is assigned to a command, it is displayed
on a tooltip (when the command is on a toolbar or ribbon panel and the cursor
hovers over the command).

You can change the display of tooltips on the Display tab of the Options dialog
box. See Search the Menu Browser in the User’s Guide to learn more about
using search in the menu browser.

See Also

m To add tags to a command (Procedure)
m  Toremove a tag from a command (Procedure)

Please send us your comment about this page
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Customize the User Interface > Customize Commands > Assign Tags to
Commands >

Assign Tags to Commands
~Corcor |l | s e |

To add tags to a command
To remove a tag from a command

Please send us your comment about this page
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Customize the User Interface > Customize Commands >

Create Tooltips and Extended Help for Commands
[REESII|| Procedure [[] Quick Reference |

Tooltips are descriptive messages that are displayed near the cursor when it
hovers over a toolbar or panel button, or menu item.

The Description property associated to a command provides a simple description
for what the command does. The value of the Description property is displayed
as part of a basic tooltip that is displayed when the cursor hovers over a button
on a toolbar, ribbon panel, or menu browser. Along with the description, a
command tooltip also displays the name of the command, and the values
assigned to the Command Display Name and Tags properties.

Additionally, a command can be assigned an extended help file and ID so it can
display a second level of information for the command. The content from the
extended help file is displayed in the extended description area of a tooltip. The
content for the extended description area of a tooltip is stored in an XAML file,
and can contain rich-text and images.

Control the Display of Tooltips

You control the display of tooltips and when the extended help assigned to a
command is displayed from the Options dialog box. See Set Interface Options in
the User’s Guide to learn more about tooltips.

Example of an XAML File

The XAML structure is a format that was developed by Microsoft. The
following is an example of what an XAML file might look like for two custom
commands that exist in your CUI file.

<ResourceDictionary
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"


javascript:hhctrl_d0e6744.Click()

xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
xmlns:src="clr-namespace:Autodesk.Windows;assembly=AdwWwindows">
<src:ProgressivePanel x:Key="MYEH_CMD_0001">

<StackPanel>

<TextBlock Background="AntiqueWhite" TextAlignment="Center">
Creates a rectangular revision cloud on the <Bold>REVISION</Bold> 1
</TextBlock>

<Image Source="images/rectcloud.jpg" Width="Auto" Height="Auto">
</Image>

</StackPanel>

</src:ProgressivePanel>

<src:ProgressivePanel x:Key="MYEH_CMD_0002">

<StackPanel>

<TextBlock Background="Yellow" TextAlignment="Left">

Creates a polygonal revision cloud on the

<Run Text=" REVISION " Foreground="Red" FontStyle="Italic"/>
layer.

</TextBlock>

<Image Source="images/rectcloud.jpg" wWidth="Auto" Height="Auto">
</Image>

</StackPanel>

</src:ProgressivePanel>

</ResourceDictionary>

The ResourceDictionary element is used to define the type of content that is in
the XAML file; while the scr:ProgressivePanel element is used to define each of
the extended help topics in the file. In the previous example there are two
different extended help topics, and they are uniquely defined by the keys
MYEH_CMD_0001 and MYEH_CMD_0002. The Stack Panel element groups
the TextBlock and Image elements together. You can have as many TextBlock
and Image elements under a StackPanel element that you need. The TextBlock
element holds the text; the Image element holds an illustration that is part of the
extended help. To learn more about XAML, visit Microsoft’s web site at
http://www.microsoft.com and perform a search for XAML.

See Also

m  Customize Commands

m To add a tooltip to a command (Procedure)

m To add extended help to a command (Procedure)
m  To create an XAML file (Procedure)



http://www.microsoft.com
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Customize the User Interface > Customize Commands > Create Tooltips and
Extended Help for Commands >

Create Tooltips and Extended Help for Commands
[Corcr | B[ o e |

To add a tooltip to a command

To add extended help to a command
To create an XAML file
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Customize the User Interface > Customize Commands >

Create Status Line Help Messages
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Status line help messages are simple, descriptive messages that are displayed on
the status line (at the bottom of the application window) when the cursor hovers
over a menu item.

You can change or add descriptions for menu items by updating the Description
property for a related command. If the status bar for the program is not
displayed, no descriptive message is displayed for the menu item. The current
workspace controls the display of the application status bar for the program. See
Set Interface Options in the User’s Guide to learn more about workspaces.

See Also
m  Customize Commands

m To create a status line help message (Procedure)

Please send us your comment about this page
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Customize the User Interface > Create Macros >

Use Special Control Characters in Macros

[_concrr )T

You can use special characters, including control characters, in macros. In a
macro, the caret (V) is equivalent to pressing the CTRL key on the keyboard. You
can combine the caret with another character to construct macros that do such
things as turn the grid on and off (AG) or cancel a command (/C).

The macro for the Address command below uses the backslash (\) to pause for
user input and the semicolon (;) for ENTER.

text \.4 0 DRAFT Inc;;;Main St.;;;City, State;

The macro starts the TEXT command, pauses for the user to specify a start point,
and then enters the address on three lines. In the triple semicolon (; ; ; ), the first
semicolon ends the text string, the second repeats TEXT, and the third accepts
the default placement below the previous line.

Macros use the special characters listed in the following table.

Special characters used in macros
Character Description
’

Issues ENTER
M Issues ENTER
N Issues TAB
[blank space] Enters a space; a blank space between

command sequences in a command is


javascript:hhctrl_d0e7361.Click()

equivalent to pressing the SPACEBAR

Pauses for user input (cannot be used
with accelerators)

Allows you to access a built-in
AutoCAD command even if it was
undefined using the UNDEFINE
command.

Translates AutoCAD commands and
options that follow

Displays the current top-level pull-
down, shortcut, or image menu

Repeats a command until another
command is chosen

Introduces a conditional DIESEL
macro expression ($M=)

"B

Turns Snap on or off (equivalent to
CTRL+B)

AC

Cancels the active command or
command option (equivalent to ESC)

AD

Turns Dynamic UCS on or off
(equivalent to CTRL+D)

NE

Sets the next isometric plane
(equivalent to CTRL+E)

NG

Turns Grid on or off (equivalent to
CTRL+G)




AH

Issues BACKSPACE

O Turns Ortho on or off

AP Turns MENUECHO on or off

AQ Echoes all prompts, status listings, and
input to the printer (equivalent to
CTRL+Q)

AT Turns tablet on or off (equivalent to
CTRL+T)

AV Changes the current viewport

N Null character that suppresses the

automatic addition of SPACEBAR at
the end of a command

Please send us your comment about this page
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Customize the User Interface > Create Macros >

Pause for User Input in Macros

[ concepe | NN

To accept input from the keyboard or pointing device in the middle of a
command, place a backslash (\) in the macro at the point where you want input.

circle \1

In the circle example, \1 pauses for the user to specify the center point and then
reads a radius of 1. Note that there is no space after the backslash.

-layer off \;

In this example, the macro starts LAYER at the command prompt (-layer), enters
the Off option (off), and then pauses for the user to enter a layer name (\). The
macro then turns that layer off and exits the LAYER command (;).

Note LAYER normally prompts for another operation and exits only if you press
SPACEBAR or ENTER. In the macro, the semicolon (;) is the equivalent of
pressing ENTER.

A macro typically resumes after one user input, such as a single point location.
Therefore, you cannot construct a macro that accepts a variable number of inputs
(as in object selection) and then continues. However, an exception is made for
SELECT: a backslash (\) suspends the SELECT command until object selection
has been completed. Consider the following example:

select \change previous ;properties color red ;

In this macro, SELECT creates a selection set of one or more objects (select \).
The macro then starts CHANGE (change), references the selection set using the
Previous option (previous;), and changes the color of all selected objects to red
(properties color red ;).

Note The backslash character (\) causes a macro to pause for user input. You


javascript:hhctrl_d0e7637.Click()
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cannot use a backslash for any other purpose in a macro. When you need to
specify a file directory path, use a forward slash (/) as the path delimiter: for
example, /direct/file.

The following circumstances delay resumption of a macro after a pause:

= [f input of a point location is expected, object snap modes may be used
before the point is specified.

m [If X/Y/Z point filters are used, the command remains suspended until the
entire point has been accumulated.

m  For SELECT only, the macro does not resume until object selection has
been completed.

m [f the user responds with a transparent command, the suspended macro
remains suspended until the transparent command is completed and the
originally requested input is received.

m [f the user responds by choosing another command (to supply options or
to execute a transparent command), the original macro is suspended, and
the newly selected item is processed to completion. Then, the suspended
macro is resumed.

Note When command input comes from a command, the settings of the
PICKADD and PICKAUTO system variables are assumed to be 1 and 0,
respectively. This preserves compatibility with previous releases of AutoCAD
and makes customization easier because you are not required to check the
settings of these variables.

Please send us your comment about this page
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Customize the User Interface > Create Macros >

Provide International Support in Macros

[_concrr )T

To develop menus that can be used with a non-English-language version of
AutoCAD, precede each command or option with the underscore character (_).
The underscore character allows the standard commands and options to be
translated automatically.

Please send us your comment about this page
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Customize the User Interface > Create Macros >

Use Built-in Commands in Macros

[_concrr )T

To develop macros that use built-in commands that are part of AutoCAD,
precede each command with the period character (.). The period character allows
the built-in command to be used even if it has been undefined with the
UNDEFINE command making the macro predicable when it is used on other
systems that share the same customization file.

Please send us your comment about this page
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Customize the User Interface > Create Macros >

Repeat Commands in Macros
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You can use a leading asterisk (*) to repeat a command in a macro until you
choose another command.

Once you have selected a command, you might want to use it several times
before moving on to another command. In a macro, you can repeat a command
until you choose another command. You cannot use this feature to choose
options.

If a macro begins with *ACAC, the command is repeated until you terminate by
pressing ESC on the keyboard or by selecting another command.

Note Do not use AC (Cancel) within a macro that begins with the string *ACAC;
this cancels the repetition.

The macros in the following examples repeat the commands:

*ACACmove Single

*ACACcopy Single

*ACACerase Single
*NCACstretch Single Crossing
*ACACrotate Single
*ACACscale Single

Each macro in the example starts a command and then prompts you to select an
object. Any other prompts necessary to complete the command are displayed,
and then the command ends and starts again.

Note Command repetition cannot be used in macros for image tile menus.

Please send us your comment about this page
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Customize the User Interface > Create Macros >

Use Single Object Selection Mode in Macros
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Single Object Selection mode cancels the normal repetition of the Select Objects
prompt in editing commands. After you select one object and respond to any
other prompts, the command ends.

Consider the macro in the following example:

*ACACerase single

This macro terminates the current command and starts ERASE in Single Object
Selection mode. After you choose this command, you either select a single
object to be erased or click a blank area in the drawing and specify window
selection. Any objects selected in this way are erased, and the command is
repeated (due to the leading asterisk) so that you can erase additional objects.
Press ESC to exit this mode.

Please send us your comment about this page
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Customize the User Interface > Create Macros >

Use Macros to Swap User Interface Elements
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You can replace the contents of active menus, mouse buttons, tablet buttons,
tablet menus, or screen menus. The swapped content can be that of another user
interface element of the same type in the main CUI file, or it can come from a
partial CUI file.

You cannot swap interface elements that are of different types (menus and mouse
buttons, for example). However, within a given type, you can swap any user
interface element for any other element.

Note Swapping can lead to some strange behavior for tablet menus, because they
typically have a different number of macros.

Use the following syntax in a macro to swap elements:

$section=menugroup .menuname

The following describes each section of the macro syntax for swapping
elements:

Macro syntax for swapping elements

$
Loads an interface element

section
Specifies the element type. Valid names are:
Al-A4 for Aux menus 1 through 4
B1-B4 for mouse buttons 1 through 4
PO-P16 for pull-down menus 0 through 16
I for the image tile menu



S for the screen menu
T1-T4 for tablet menus 1 through 4

infogroup

Specifies the information group that menuname is a member of (not
necessary if menuname is in the main CUI file).

menuname

Specifies which section or submenu to insert. It is the main label or alias for
the section to load

The following commands illustrate submenu referencing;:

$S=PARTS
$T1=EDITCMDS

You can activate the submenu mechanism in the middle of a command without
interrupting the command. For example, the following command strings are
equivalent:

$S=ARCSTUFF ARC
ARC $S=ARCSTUFF

Each command starts the ARC command, switches to the ARCSTUFF screen
submenu, and awaits the entry of arc parameters. A space must follow the
submenu reference to separate it from subsequent commands in the command.

A pull-down menu can be present either in the menu bar or on the active shortcut
menu but not both.

Please send us your comment about this page
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Customize the User Interface > Create Macros >

Use Conditional Expressions in Macros
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You can add conditional expressions to a macro by using a command that
introduces macro expressions written in DIESEL (Direct Interpretively
Evaluated String Expression Language).

The format is:

$M=expression

Introducing the macro with $M= tells AutoCAD to evaluate a string as a DIESEL
expression, and that expression is the DIESEL expression. The following
example defines a conditional expression in a macro:

FILLMODE $M=$(-,1,$(getvar,fillmode))

The macro switches the FILLMODE system variable on and off by subtracting
the current value of FILLMODE from 1 and returning the resulting value to the
FILLMODE system variable. You can use this method to toggle system variables
whose valid values are 1 or 0.

Termination of Macros That Contain Conditional Expressions

If you use the DIESEL string language to perform “if-then” tests, conditions
might exist where you do not want the normal terminating space or semicolon
(resulting in ENTER). If you add /Z to the end of the macro, AutoCAD does not

automatically add a space (ENTER) to the end of the macro expression.

As with other control characters in commands, the AZ used here is a string
composed of N (a caret) and Z and is not equivalent to pressing CTRL+Z.

In the following examples, AZ is used as a macro terminator.


ms-its:ACAD_ACR.chm::/FILLMODE.htm

ACACSM=$(if, $(=, $(getvar, tilemode),0), $S=mview _mspace )/ Z
ACACSM=$(if, $(=, $(getvar, tilemode),0), $S=mview _pspace ) Z

If these macros did not end with AZ, AutoCAD would automatically add a space
(ENTER), repeating the last command entered.

See Also
m  Use Special Control Characters in Macros
s DIESEL
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Customize the User Interface > Create Macros >

Use AutoL.ISP in Macros
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Creating commands that use AutoLISP is a more advanced way to use the
AutoCAD customization feature.

You can use AutoLISP variables and expressions to create macros that perform
complex tasks. To use AutoLISP efficiently in macros, place AutoLISP code in a
separate MNL file. AutoCAD loads the MNL file when it loads a CUI file with

the same name and in the same location.

You can specify additional AutoLISP files to load in the Customize User
Interface (CUI) Editor. Creating commands that use AutoLISP is a more
advanced way to use the AutoCAD customization feature. Carefully study the
following examples and the information in the AutoLISP Reference and the
AutoLISP Developer's Guide. To access the additional help resources, click Help
menu » Additional Resources » Developer Help. Experimentation and practice
will help you use this feature effectively.

Call a Macro

To programmatically execute a pull-down menu macro, use the following
syntax:

(menucmd "Gmenugroup.element_ID=|")

The previous syntax works only if the menu macro is part of a menu that is on
the AutoCAD menu bar and is available for use. For more information about this
syntax, see the AutoLISP Reference.

Preset Values

An application that uses block insertion presets could provide commands like



these: [Set WINWID][Set WALLTHK][Insert Window]

ACACAP(setq WINWID (getreal "Enter window width: ")) AP
ACACNAP(setq WALLTHK (getreal "Enter wall thickness: ")) AP
ACAC_INSERT window XScale !WINWID YScale !'WALLTHK

This code inserts the block named “window,” scaling its X axis to the current
window width and its Y axis to the current wall thickness. In this example, the
actual values come from the user-defined AutoLISP symbols WINWID and
WALLTHK. The rotation is up to the user to decide so that the window can be
rotated in the wall.

Resize Grips

With the following commands, grip size adjustment can be done on the fly:

AP(setvar "gripsize"(1+ (getvar '"gripsize")))(redraw)(princ)
AP(setvar "gripsize"(1- (getvar '"gripsize")))(redraw)(princ)

To add validity checking to these commands, values less than 0 and greater than
255 cannot be used for the GRIPSIZE system variable.

Prompt for User Input

The following item prompts for two points and draws a rectangular polyline with
the specified points as its corners.

NP(setqg a (getpoint "Enter first corner: "));\+
(setqg b (getpoint "Enter opposite corner: "));\+
pline !'a (list (car a)(cadr b)) 'b (list (car b)(cadr a)) c;~P

Please send us your comment about this page
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Customize the User Interface > Customize Quick Properties >

Customize Quick Properties

[ conce || L] vk Rooronce |

To control which object types are used with the Quick Properties panel

To control the display of a property for an object on the Quick Properties panel

To control the display of custom properties and attributes for block references on

the Quick Properties panel
To override the general properties for all object types

To restore the default settings for Quick Properties

To synchronize Quick Properties with rollover tooltips

Please send us your comment about this page
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Customize the User Interface > Customize Rollover Tooltips >

Customize Rollover Tooltips

[ conce || L] v Roferonce |

To control which objects support rollover tooltips

To control which properties are displayed on a rollover tooltip

To override the general properties for all object types that support rollover
tooltips

To restore the default settings for rollover tooltips

To synchronize rollover tooltips with Quick Properties

Please send us your comment about this page
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Customize the User Interface > Customize Rollover Tooltips >

Customize Rollover Tooltips
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To synchronize rollover tooltips with Quick Properties

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Rollover Tooltips.

3. Click Synchronize with Quick Properties.

--Ej Ribbon Panels ‘ “

Restore Default
Synchronize with Quick Properties

Find...

Replace...

4. Click Apply Quick Properties Settings to Rollover Tooltips.



Quick Properties-Synchronize with Rollover Tooltips

You can synchronize settings for Quick Properties panel and
Rollover Tooltips. What do you want to do?

The Quick Properties panel and Rollover Tocltips will display the same
properties after synchronization. Any changes made to Quick Properties panel
or Rollover Tooltips after synchronization will not be shared.

< Apply Rollover Tooltips settings to Quick Properties
panel

< Apply Quick Properties settings to Rollover Tooltips

5. Click Apply.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Customize Toolbars > Create and Edit Toolbars >

Create and Edit Toolbars
[ concere ||| cuic Refeence |

To create a toolbar

To create a flyout toolbar from scratch

To create a toolbar from a pull-down menu

To create a flyout toolbar from another toolbar

To create a flyout toolbar from a pull-down menu

To add a command to a toolbar in the Customizations In pane

To add a command to a toolbar in the Toolbar Preview pane

To add a command to a toolbar outside the CUI Editor

To reposition a button on a toolbar in the Customizations In pane
To reposition a command on a toolbar in the Toolbar Preview pane
To reposition a command on a toolbar outside the CUI Editor

To remove a button from a toolbar in the Customizations In pane

To remove a button from a toolbar in the Toolbar Preview pane

To remove a command from a toolbar outside the CUI Editor

To change properties of a toolbar

To change the tooltip of a button
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To create a toolbar

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Toolbars. Click New
Toolbar.

=l ACAD
(- KBl Workspaces
] Toolbars,

ij Menus Mew Toclbar
E‘ Ribbaon 1

Ej Ribban Rename

""" Guick P Delete

""" 4 & Rollover

IE_H Sharteout Paste
a3 Keyboar

-4y Double Find...
'% Mouse B Replace...
& LISP Fi

A new toolbar (named Toolbar1) is placed at the bottom of the Toolbars
tree.

3. Do one of the following:
m Enter a new name over the default name Toolbar1.
m Right-click Toolbarl. Click Rename. Enter a new toolbar name.

m Click Toolbar1, wait, and click again over the toolbar’s name
again to edit its name in-place.

4. Select the new toolbar in the tree view, and update the Properties pane:



= In the Description box, enter a description for the toolbar.

» In the On By Default box, click Hide or Show. If you choose
Show, this toolbar will be displayed in all workspaces.

= In the Orientation box, click Floating, Top, Bottom, Left, or

Right.

m In the Default X Location box, enter a number.

m In the Default Y Location box, enter a number.

» In the Rows box, enter the number of rows for an undocked

toolbar.

= [n the Aliases box, enter an alias for the toolbar.

Properties

2|

H General
MName
Description

El Appearance
On By Default
Crientation
Default X Location
Default Y Location
Rows

B Advanced
Alizses

>

My Tools

Show
Floating
200
200

1

Toolbarl

5. In the Command List pane, drag the command you want to add to a
location just below the name of the toolbar in the Customizations In

<file name> pane.
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Command List:
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(% Arc, Center, Start, Angle

6. Click OK.
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To create a flyout toolbar from scratch

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbars tree node to expand it.

3. Right-click the toolbar to which you want to add a flyout toolbar. Click
New Flyout.

. @RI Find Text
- e Insert Separator

=-[E Menus

’2| Ribbon Tabs Copy To Ribbon Panels
-85 Ribbon Pang
- QCuick Prope
..*5 Rollover Too) Mew Flyout
&% Shortout Med
-mm Keyboard S~ Rename
-5y Double Click Delete
% Mouse Butto

Mew Toolbar

m

A new flyout toolbar (named Toolbar1) is placed below the toolbar you
selected.

4. Right-click Toolbarl. Click Rename. Enter a new toolbar name.

Note You can click, wait, and click again over a toolbar name to edit its
name in-place in the Customizations In <file name> pane.



-5 Find Text
SR My Tools

-E@ Toolbarl
gty Toolbarl
m Menus Insert Separator
[#-F=3 Ribbon Tabs
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----- Guick Prope Mew Toolbar

- + & Rollover Tog

-- Shortcut Me: Mew Flyout
&-mm Keyboard Sh

f R

#-4gy Double Click Ename
- Mouse Butto Delete

Note Just renaming the toolbar won’t change the name of the flyout. You
must select and rename the flyout independently if you want them to
both have the same name.

5. In the Command List pane, drag the command you want to add to a
location just below the toolbar flyout name in the Customizations In
<file name> pane.

(-5 Find Text

=-BB My Tools

m

F-{ZEE Menus
- Ribbon Tabs
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----- Ciuick Properties
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Command List: / o
[ All Commands / | * %
Command Source o
(& Circle ACAD il
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€] Circle, 3 Points ACAD
@ Circle, Center, Diameter ACAD

6. Click OK.
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To create a toolbar from a pull-down menu

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbars tree node to expand it.

3. Click the plus sign (+) next to the Menus tree node to expand it.

4. Drag the menu that you want to create a toolbar from and drop it onto
the Toolbars node.

-8 Workspaces
- %= Toolba
=[5 Menu
T3] File
&-TF] View
-7 Inse
-]

rT| Tools

5. Update the workspace as desired to update the display and position for
the new toolbar.
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To create a flyout toolbar from another toolbar

. Click Tools tab » Customization panel » User Interface. i

—_

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbars tree node to expand it.

w

. Click the plus sign (+) next to the toolbar to which you want to add a
flyout toolbar.

4. Locate the toolbar you want to add as a flyout. Drag that toolbar to a
location in the expanded toolbar.

" @52 Find Text

EI”'i' My Tools

gk Ac
R | Circle Commands

ij Menus
- Ribbon Tabs

552 Find Tex
=55 My Tools

. =57 Circle Commands

' o '3l Circle, 2 Points
Y Circle, 3 Pairts
=57 Circle Commands
-4 Circle, 2 Pairts

=T Menus

5. Click OK.
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To create a flyout toolbar from a pull-down menu

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbars tree node to expand it.

3. Click the plus sign (+) next to the Menus tree node to expand it.

4. Drag the menu that you want to create a flyout from and drop it onto the
node of the toolbar where you want to place the flyout.

-5 Find Text

EI'I-.' My Toals

[#-55 Circle Commands
=T Menus
T3] File

]
-] Tools

If the menu is dropped on a toolbar, a new flyout and toolbar are created.



'I-ﬂ Circle Commands

'I' E'.il.';::le Commands

-3 File
-3 View
-7 Insert
rT| Format

5. Reposition the new flyout on the toolbar.

6. Update the workspace for the display and position for the new toolbar.
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To add a command to a toolbar in the Customizations In pane

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, Command List
pane, drag the command you want to add to a location just below the
toolbar name in the Customizations In <file name> pane.

3. Click the plus sign (+) to the left of the toolbar to display the command
you just added.

753 Find Text

£ My Tools
&-fZEE Menus
- Ribbon Ta

= /

Command List: /

| All Commands ,j

Command
Arc, 3 Points
/Z Arc, Center, Start, Angle

4. Click OK.
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To add a command to a toolbar in the Toolbar Preview pane

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the

Toolbar node to expand it.

3. Select the toolbar you want to add a command to.

4. In the Command List pane, drag the command you want to add to the
selected toolbar and drop it on the toolbar’s preview in the Toolbar

Preview pane.

|E| Custornize User Interface

Customize | Transfer

| Customizations in All CUI Files s | Toolbar Preview
Command List: £ ... [£3]
_f
All Commands - B
[ ) ol Pmpertity
Command Source |3 =
. LT | =
(=) Circle Certer Radius ACAD 7
@ Circle, 2 Poirts ACAD B General
@ Circle. 3 Poirts ACAD 3 ga”‘e_ _
(¥) Circle. Center, Diameter ACAD it

You can control where the command is placed by releasing the mouse
button when the black vertical splitter bar is displayed.

5. Click OK.
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To add a command to a toolbar outside the CUI Editor

1.

Display the toolbar you want to add a command to by right-clicking over
a toolbar button. Click the name of the toolbar.

Right-click over any toolbar button. Click Customize.

In the Customize User Interface Editor, Customize tab, Command List
pane, drag the command you want to add and drop it onto the toolbar.

|E| Customize User Interface

= [E] ]

| Customizations in All CUI Files

Command List:

% ]
| All Commands | * %

Command Source =
Drafting Settings... ACAD

¥ Draw Order ACAD g

% Draw Order, Bring Above Objects ACAD L4
'S Draw Order, Bring to Front ACAD
Draw Order, Dimension Objects Only ACAD
T2 Draw Order, Send to Back ACAD
[ Draw Order, Send Under Objects ACAD
Draw Order, Tead and Dimension Objects  ACAD

Draw Order, Test Objects Onby ACAD -

| ok

| | cancel | Apply

1
e

&yt G

You can control the location of the command by using the visual

indicator bar.



4. Click OK.
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To reposition a button on a toolbar in the Customizations In pane

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbar node to expand it.

3. Click the plus sign (+) next to a toolbar to expand it.

4. Drag the name of the button you want to reposition to the new location
in the list of tools.

#-5RE Zoom

=5 Layers |l

When the splitter bar is displayed, you can place the button between two
buttons. When the left arrow appears, you can place the button below
another button.

5. Click OK.
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To reposition a command on a toolbar in the Toolbar Preview pane

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbar node to expand it.

3. Drag the command in the toolbar’s preview that you want to reposition.

Toolbar Preview

>

LayersII [

While dragging the command to the new position, use the visual
indicator bar to specify the location of the command.

4. Click OK.
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To reposition a command on a toolbar outside the CUI Editor

1. Display the toolbar you want to add a command to by right-clicking over
a toolbar button. Click the name of the toolbar.

2. Right-click over any toolbar button. Click Customize.

3. Drag the command on the toolbar that you want to reposition.

While dragging the command to the new position, use the visual
indicator bar to specify the location of the command.

4. Click OK.
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To remove a button from a toolbar in the Customizations In pane

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbar node to expand it.

3. Click the plus sign (+) next to a toolbar to expand it.

4. Right-click the name of the button you want to remove. Click Remove.
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Insert Separator

Mew Toolbar

Mew Flyout

Rename

Remove

Duplicate
Copy

m

>

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Customize Toolbars > Create and Edit Toolbars >

Create and Edit Toolbars
[ concere ||| cuic Refeence |

To remove a button from a toolbar in the Toolbar Preview pane

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbar node to expand it.

3. Drag the button in the toolbar’s preview that you want to remove and
drop it outside of the preview.

Draw Order [E]

e el

4. Click OK.
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To remove a command from a toolbar outside the CUI Editor

1. Display the toolbar from which you want to remove a command by
right-clicking over a toolbar button. Click the name of the toolbar.

2. Right-click over any toolbar button. Click Customize.

The Customize User Interface Editor is displayed.

3. Drag the button you want to remove from the toolbar and drop it over
the drawing window.

4. Click OK.

AutoCAD =™

. Areyou sure you want to delete the "Bring to Front" button
_L from the "Draw Order” toolbar?

| ok || cancel |

5. In the Customize User Interface Editor, click OK.
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To change properties of a toolbar

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the toolbar whose properties
you want to change.

Note Making changes to a toolbar’s properties here only affect the initial
appearance of the toolbar after the CUI file has been loaded. To control
the appearance of a toolbar, it is best to use a workspace.

3. In the Properties pane, make your changes.

Note Before you attempt to change an alias in a toolbar, you need to
understand how aliases function. For more information about aliases, see
Create Command Aliases.

4. Click OK.
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To change the tooltip of a button

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbar node to expand it.

3. Select the toolbar whose tooltip text you want to change.

4. In the Properties pane, Display section, make the desired change to the
Name property (not the Command Name or Command Display Name
properties), and the Description and Extended Help File properties.

5. Click OK.
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To add a control to a toolbar in the Customizations In pane

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, Customizations

In <file name> pane, click the plus sign (+) next to the toolbar to which
you want to add a control.

3. In the Command List pane, in the Categories list, click Control
Elements.

Command List:

>

| Contral Elements - & *®
All Commands

ACAD Commands

IMPRESSION Commands

EXPRESS Commands

Custom Commands

Control Elements
File

| »

m

The Command List pane displays control elements only.

4. In the Command list, drag the control to the Customizations In <file
name> pane to the position where you want to add it in the toolbar.
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5. Click OK.

+-{5EE Menus

- Ribbon Tabs

-7 Ribbon Panels b
Command List: o

[M Commands f v] > S 3
J

Command Source B

Dim Style Control COMTROL

Dim Style, MRU1 ACAD [l

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Customize Toolbars > Add or Switch Toolbar
Controls >

Add or Switch Toolbar Controls

oo B[ e |

To add a control to a toolbar in the Toolbar Preview pane

1.
2.

Click Tools tab » Customization panel » User Interface. ki

In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Toolbar node to expand it.

Select the toolbar to which you want to add a control.

In the Command List pane, in the Categories list, click Control
Elements.

! Command List:

:_?l_!

| Q
[ Control Elements = & K

All Commands

ACAD Commands
IMPRESSION Commands
EXPRESS Commands
Custom Commands

Control Elements
i File

»

m

The Command List pane displays control elements only.

In the Command list, drag the control you want to add to the selected
toolbar to the toolbar’s preview in the Toolbar Preview pane.

You can control where you place the command by releasing the mouse

button when the black vertical splitter bar is displayed in the location
you want.
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6. Click OK.
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To switch a control in a toolbar

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, Customizations
In <file name> pane, click the plus sign (+) next to the toolbar that
contains the control element you want to switch.

3. Click the control element.

-5 Find Text
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4. In the Properties pane, in the Control box, click the arrow to display a
list of controls.
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5. Click a control to replace the original control with the one you selected.

m

6. Click OK.
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Some of the simplest toolbar customizations can make your daily drawing tasks
more efficient. For example, you can consolidate frequently used commands and
controls onto one toolbar, remove buttons that you never use, or change some
simple toolbar properties.

Show Me: Create a Toolbar

Click the Play arrow below the following image to start the animation.

The following animation shows how to create a custom toolbar, and place both
standard and custom commands on it.



You can also specify information to be displayed when the cursor passes over a
button.

Customize a Toolbar

You can add buttons or remove buttons you use infrequently, and rearrange
buttons and toolbars. You can also create your own toolbars and flyout toolbars,
and create or change the button image associated with a command. When



creating a toolbar, you can create a toolbar from scratch, create a copy of an
existing toolbar, or create a toolbar from an existing pull-down menu.

Note Sub-menu items are not included when a toolbar is created from a pull-down

mendu.

Note When you create a toolbar, you should determine in which workspaces you
want to display the toolbar. By default, a new toolbar is displayed in all

workspaces.

The following table shows the properties of the Standard toolbar as they appear
in the Properties pane.

Properties for the Standard toolbar

Prope‘rtles Description Example
pane item
Name String used as the caption for Standard
the toolbar.
Description Text used to describe the Standard Toolbar
element; does not appear in the
user interface.
On By Default  Specifies whether the toolbaris ~ Show
displayed or not the first time
the CUI file is loaded. The
values are Hide or Show.
Orientation Specifies whether the toolbaris  Top
floating or docked (top,
bottom, left, or right) the first
time the CUI file is loaded.
Default X Specifies the location from the 0
Location left edge of the screen when

the toolbar appears when it is



floating, or the location when it
is docked. If docked, a value of
0 indicates the left most
location in a docked area.

Default Y Specifies the location from the 0
Location top edge of the screen when
the toolbar appears when it is
floating, or the location when it
is docked. If docked, a value of
0 indicates the top most
location in a docked area.

Rows Specifies the number of rows 1
the items on the toolbar are
displayed in when the toolbar
is floating.

Aliases Specifies the aliases for the TB_STANDARD,
toolbar. Click the [...] button Standard
to open the Aliases dialog box.
Each alias in the CUI file
should be unique and it is used
to reference the toolbar
programmatically.

Element ID Tag that uniquely identifies a ID_TbStandard
toolbar.

Note The properties On By Default, Orientation, Default X Location, Default Y
Location, and Rows are used only the first time the CUI file is loaded and when
no default workspace is set. After a toolbar is loaded the first time, a workspace
can be used to control the Appearance properties of a toolbar. See the procedure
To change the properties of a toolbar for more information.

When you create a new toolbar, the first task you need to do is to provide a name
for it. A new toolbar has no commands or controls assigned to it. If a toolbar has



no commands or controls on it, it is ignored by the program until you add at least
one command or control to it. You add commands and controls to a toolbar by
dragging a command or control from an existing toolbar or the Command List
pane and dropping it onto a toolbar. Once a command or control has been added
to a toolbar, you can change the text that is displayed in the tooltip when the
cursor hovers over top of the button by changing the Name property that is
displayed in the Properties pane.

Flyouts

A flyout is a set of buttons nested under a single button on a toolbar. Flyout
buttons have a black triangle in the lower-right corner. To create a flyout, you
can start from scratch, drag an existing toolbar onto another toolbar, or drag a
pull-down menu onto another toolbar. When a pull-down menu is dragged onto
another toolbar, a new toolbar is created and a flyout is created in the position
that the pull-down menu was dropped onto the toolbar.

The following table shows the Zoom flyout properties as they appear in the
Properties pane.

Properties for the Zoom flyout on the Standard toolbar

Properties o
- Description Example
pane item

Name String that does not appear in ~ Zoom
the user interface unless the
property Use Own Button is
set to Yes.

Description  Text used to describe the
element, does not appear in
the user interface.

Source A read-only value used to TB_ZOOM
Toolbar specify which toolbar is
being referenced to create



the flyout.

Use Own Controls whether the last No
Button used toolbar button is set as

the current button or not.

The possible values are Yes

or No.
Small ID string of the small-image RCDATA_16_Z0O0OM
Image resource (16 x 16 bitmap).

The string must include
alphanumeric characters
with no punctuation other
than a hyphen (-) or an
underscore (_). It can also be
a user-defined bitmap. Click
the [...] button to open the
Select Image File dialog box.

Large ID string of the large-image RCDATA_16_Z00OM

Image resource (32 x 32 bitmap). If
the specified bitmap is not
32 x 32, the program scales
it to that size. The string
must include alphanumeric
characters with no
punctuation other than a
hyphen (-) or an underscore
(_). It can also be a user-
defined bitmap. Click the
[...] button to open the
Select Image File dialog box

warning Do not change the aliases for a toolbar that is being used as a flyout;
otherwise the link between the toolbar and flyout will become broken.



Customize Toolbars with the Toolbar Preview Pane

You can customize a toolbar using the tree view under the Customizations In
<file name> pane or the Toolbar Preview pane. The Toolbar Preview pane
allows you to add and remove commands or controls visually in real-time
instead of just using the tree view. You can also interactively drag a command or
control in the preview pane to reposition it.

Customize Toolbars from the Application Window

The program allows you to customize toolbars that are displayed in the
application when the Customize User Interface (CUI) Editor is open. You can
drag commands from the Command List pane and drop then directly onto a
visible toolbar that is docked or floating in the application window. You can also
remove, reposition, or copy commands while the CUI Editor is open.

See Also
m  Customize Commands
m  Customize the Quick Access Toolbar

= Customize Workspaces
m  To create a toolbar (Procedure)

m  To create a toolbar from a pull-down menu (Procedure)

m  To create a flyout toolbar from scratch (Procedure)

m To create a flyout toolbar from another toolbar (Procedure)

m  To create a flyout toolbar from a pull-down menu (Procedure)

m To add a command to a toolbar in the Customizations In pane
(Procedure)

m  To add a command to a toolbar in the Toolbar Preview pane
(Procedure)

m To add a command to a toolbar outside the CUI Editor (Procedure)

= To reposition a button on a toolbar in the Customizations In pane
(Procedure)

m To reposition a command on a toolbar in the Toolbar Preview pane
(Procedure)



To reposition a command on a toolbar outside the CUI Editor
(Procedure)

To remove a button from a toolbar in the Customizations In pane
(Procedure)

To remove a button from a toolbar in the Toolbar Preview pane
(Procedure)

To remove a command from a toolbar outside the CUI Editor
(Procedure)

To change properties of a toolbar (Procedure)
To change the tooltip of a button (Procedure)

Please send us your comment about this page
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Customize the User Interface > Customize Toolbars >

Add or Switch Toolbar Controls
I v (|| cuick Refrnce |

Toolbar controls are drop-down lists of items that can affect the objects in a
drawing or the way the program behaves from a toolbar. For example, the Layers
toolbar contains controls for defining layer settings. In the Customize User
Interface (CUI) Editor, you can add, remove, and relocate controls within
toolbars.

The following table lists the toolbar controls found in the Customize User
Interface (CUI) Editor and their definitions. The control elements in the left
column of the table are not always the text that is displayed as a tooltip in the
program (for example, Undo Skinny Button is displayed as Undo in the
program's tooltip). Refer to this table when you want to change a control in a
toolbar.

Control elements for toolbars

Dim Style Control Displays and sets the current
dimension style.

Find Text Control Allows for searching on a text
string contained in the current
drawing.

Layer Control Displays the current layer and

allows you to set a layer current.

Line Type Control Displays and sets the current



linetype.

Line Weight Control

Displays and sets the current line
weight.

Multileader Style Control

Displays and sets the current
multileader style.

Named View Control

Displays and sets the current
named view.

OPT Color Control

Displays and sets the current color.

Plot Style Control

Displays and sets the current plot
style.

Redo Skinny Button Control

Allows you to reverse the previous
undo or undos.

Reference Block Name Control

Displays the name of the xref being
edited.

Table Style Control

Displays and sets the current table
style.

Text Style Control

Displays and sets the current text
style.

UCS Control

Displays the current UCS and
allows you to restore a saved UCS.

Undo Skinny Button Control

Allows you to undo the previous
action or actions.

View Control

Displays and sets the current
standard 3D view for a viewport.

Viewport Scale Control

Displays and sets the current scale



for a floating viewport.

Workspace Control Displays the current workspace and
allows you to set a workspace
current.

See Also

m  Customize Toolbars

m  To add a control to a toolbar in the Customizations In pane
(Procedure)

m  To add a control to a toolbar in the Toolbar Preview pane
(Procedure)

m  To switch a control in a toolbar (Procedure)
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Customize the User Interface > Customize Toolbars > Add or Switch Toolbar
Controls >

Add or Switch Toolbar Controls
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To add a control to a toolbar in the Customizations In pane

To add a control to a toolbar in the Toolbar Preview pane

To switch a control in a toolbar

Please send us your comment about this page
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Customize the User Interface > Customize the Quick Access Toolbar >

Customize the Quick Access Toolbar

[ conce || L] vk Roeronce |

To add a command to the Quick Access toolbar
To remove a command from the Quick Access toolbar with the CUI Editor
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Customize the User Interface > Customize the Quick Access Toolbar >

Customize the Quick Access Toolbar

[ conce || L] vk Roeronce |

To remove a command from the Quick Access toolbar with the CUI Editor

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

3. Select the workspace that you want to modify.

=-{l] ACAD
Eli:ﬁ Workspaces
¢ %% 2D Drafting & Annotation Defautt (cument)

€% 3D Modeling

4. In the Customize User Interface Editor, Customize tab, Workspace
Contents pane, click the plus sign (+) next to the Quick Access toolbar
node to expand it.

5. Right-click the command you want to remove and click Remove from
Workspace.



>

Workspace Contents
[ Customize Workspace ]
=4 MyWaorkspace o

=55 Quick Access Toolbar

*
L
[+1]
=
[41]
m

..... % Pl Remove from Workspace

(%= Toolbars
#-[5E Menus 57

6. Click OK.
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢
Pull-Down Menu >

Create a Pull-Down Menu
[Corcr | B[ o e |

To create a pull-down menu

To add a command to a pull-down menu
To change the caption of a menu item
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢

Pull-Down Menu >

Create a Pull-Down Menu
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To create a pull-down menu

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Menus. Click New

Menu.

&%= Toolbars

e [ [

- Ribbar
-8 Ribbor
- Ciuick
- Rollov
- Shortc
a8 Keybo
-4y Doubls
- Mouss

Mew Menu

Rename

Delete

Paste

Find...

A new menu (named Menul) is placed at the bottom of the Menus tree.

3. Do one of the following:

m Enter a new name over the default name Menul.

= Right-click Menul. Click Rename. Enter a new menu name.

m Click Menul, wait, and click again over the menu’s name again
to edit its name in-place.

4. Select the new menu in the tree view, and update the Properties pane as

follows:

= In the Description box, enter a description for the menu.



m In the Aliases box, an alias is automatically assigned to the new
menu, based on the number of menus already loaded. For
example, if the alias assignment is POP12, eleven menus are
already loaded. View or edit the alias.

m (Optional) If the name change is based upon a DIESEL
expression, the DIESEL expression should be included in the

Name box.
E General
Mame My Tools
Description
E Advanced
Aliazes POP12

Element |0 PMU_0001

5. In the Command List pane, drag the command to a location just below
the menu in the Customizations In <file name> pane.

‘ - &[] Help

... My Toal
[+ Ribbon Ta%

L

Command List:

[AIICommandcs J.r‘
Fi

Command
Arc, 3 Points

,;/f-:- Arc, Center, Start, Angle

Note You can change the name of a command after it has been added to a
menu. This allows you to define how the user can access the menu item
using keyboard navigation with the ALT key. To do this, select the menu
item under the Menus node and then change the Name property in the
Properties pane.

6. Click OK.
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢
Pull-Down Menu >

Create a Pull-Down Menu
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To add a command to a pull-down menu

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the menu to which you want
to add a command.

3. In the Command List pane, drag the command you want to add to a
location just below the menu in the Customizations In <file name> pane.

rT| My Tool
[ Ribbon Ta%

L

i Command List: /

[AIICummands ;‘
Fi

Command
Arc, 3 Points

/% Arc, Center, Start, Angle

Note You can change the name of a command after it has been added to a
menu. This allows you to define how the user can access the menu item
using keyboard navigation with the ALT key. To do this, select the menu
item under the Menus node and then change the Name property in the
Properties pane.

4. Click OK.



For information about creating a command, see Create, Edit, and Reuse
Commands.
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢
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Create a Pull-Down Menu
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To change the caption of a menu item

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Menus node to expand it.

3. Click the plus sign (+) next to the pull-down menu that has the command
whose text you want to change.

4. Select the command whose text you want to change.

5. In the Properties pane, in the Display section, make the desired change
to the Name property (not the Command Name or Command Display
Name properties).

B Display
MName Arc
EH Command
Command Mame Arc
Description Creates an arc using three paints

Extended Help File
Command Display Name ARC

Macro CC_anc
Tags
B Advanced
Element ID MM_1607
E Images
Small image RCDATA_16_ARC3IFT
Large image RCDATA_32 ARC3IPT

6. Click OK.
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢
Shortcut Menu >

Create a Shortcut Menu
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To create a shortcut menu

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Shortcut Menus. Click
New Shortcut Menu.

&-&3 Ribbon Panels
o Cuick Properties
it Rollover Tootips

] o Henue]

a8 Keyboard Short Mew Shortcut Menu
-y Double Click Ag

- Mouse Buttons Paste

& LISP Files )

.5_ Legacy Find...

&-[F] Partial CUI Files Replace...

The new shortcut menu (named ShortcutMenul) is placed at the bottom
of the Menus tree.

3. Do one of the following:
m Enter a new name over the default name ShortcutMenul.

m Right-click ShortcutMenul. Click Rename. Enter a new shortcut
menu name.

m Click ShortcutMenul, wait, and click again over the shortcut
menu’s name again to edit its name in-place.

4. In the Properties pane, do the following:



= In the Description box, optionally enter a description for the
shortcut menu.

m In the Aliases box, click the Ellipsis button. Press ENTER so you
are on a new line in the Aliases dialog box. Enter additional
aliases for the menu, and after each one entered press ENTER.
An alias is automatically assigned, and defaults to the next
available POP number, based on the number of shortcut menus
already loaded in the program.

E General
Mame My Tools
Description

B Advanced
Alizses POP520
Element ID PMU_0001

5. In the Command List pane, drag the command you want to add to the
location just below the shortcut menu in the Customizations In <file
name> pane.

- R Xref Objects Menu =
- [-Fy) Xref Object Menu
Iﬁ*ﬂj MYTQ% "
: — i 5 .
Command List: |
Al Commands [ | * *
I
Command Source E
EF Layout, New [ayout ACAD
[i Leam ACAD
License Bomowing, Bomow License ACAD |

6. Continue adding commands until the new shortcut menu is complete.

7. Click OK.
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢
Shortcut Menu >

Create a Shortcut Menu
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To create a command shortcut menu

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Shortcut Menus. Click
New Shortcut Menu.

&-&3 Ribbon Panels
o Cuick Properties
it Rollover Tootips

] o Henue]

a8 Keyboard Short Mew Shortcut Menu
-y Double Click Ag

- Mouse Buttons Paste

& LISP Files )

.5_ Legacy Find...

&-[F] Partial CUI Files Replace...

The new shortcut menu (named ShortcutMenul) is placed at the bottom
of the Menus tree.

3. Do one of the following:
m Enter a new name over the default name ShortcutMenul.

m Right-click ShortcutMenul. Click Rename. Enter a new shortcut
menu name.

m Click ShortcutMenul, wait, and click again over the shortcut
menu’s name again to edit its name in-place.

4. In the Properties pane, do the following:



= In the Description box, optionally enter a description for the
shortcut menu.

m In the Aliases box, click the Ellipsis button. Press ENTER so you
are on a new line in the Aliases dialog box. Enter additional
aliases for the menu, and after each one entered press ENTER.
An alias is automatically assigned, and defaults to the next
available POP number, based on the number of shortcut menus
already loaded in the program.

In order for the commands on the shortcut menu to appear when a
command is active, make sure to use the alias
COMMAND_commandname. For example, if you want the
commands on the shortcut menu to appear when using the LINE
command use the alias COMMAND_LINE. The commands from
the shortcut menu will appear at the bottom of the shortcut menu
with the alias CMCOMMAND when it is displayed.

H General
Mame Line Command Menu
Description

E Advanced
Aliazes POP520, COMMAMND_LINE

Element [D PMU_D001

5. In the Command List pane, drag the command you want to add to the
location just below the shortcut menu in the Customizations In <file
name> pane.

. -lefEl) Mref Objects Menu

- [-FefE) Xef Object Menu

- LlyfE) Line Command Menu
#2115 Keyboard Shortcuts

G %m Daukle Click Artinne

Command List: o
[AIICommands f v] > S
J
Command Source i
'{Ii! Animation Settings ACAD
(=H
1 Apply

6. Continue adding commands until the new shortcut menu is complete.



7. Click OK.

® SteeringWheels
QuickCalc
J"a Arc
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢
Shortcut Menu >

Create a Shortcut Menu
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To create an object shortcut menu

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Shortcut Menus. Click
New Shortcut Menu.

&-&3 Ribbon Panels
o Cuick Properties
it Rollover Tootips

] o Henue]

a8 Keyboard Short Mew Shortcut Menu
-y Double Click Ag

- Mouse Buttons Paste

& LISP Files )

.5_ Legacy Find...

&-[F] Partial CUI Files Replace...

The new shortcut menu (named ShortcutMenul) is placed at the bottom
of the Menus tree.

3. Do one of the following:
m Enter a new name over the default name ShortcutMenul.

m Right-click ShortcutMenul. Click Rename. Enter a new shortcut
menu name.

m Click ShortcutMenul, wait, and click again over the shortcut
menu’s name again to edit its name in-place.

4. In the Properties pane, do the following:



= In the Description box, optionally enter a description for the
shortcut menu.

m In the Aliases box, click the Ellipsis button. Press ENTER so you
are on a new line in the Aliases dialog box. Enter additional
aliases for the menu, and after each one entered press ENTER.
An alias is automatically assigned, and defaults to the next
available POP number, based on the number of shortcut menus
already loaded in the program.

In order for the commands on the shortcut menu to appear when
an object or objects of the same type are selected, make sure to
use the alias OBJECT _objecttype or OBJECTS_objecttype. For
example, if you want the commands on the shortcut menu to
appear when a LINE object is selected in the drawing use the
alias OBJECT _LINE. The commands from the shortcut menu
will appear near the top of the shortcut menu with the alias
CMEDIT when it is displayed.

Note If you create a shortcut menu with the alias OBJECTS_objecttype,
the commands assigned to the shortcut menu will be displayed when one
or more objects are selected before right-clicking over the drawing area.

H General
Mame Line Object Menu
Description

E Advanced

Alizzes FOP520, OBJECT_LINE

. In the Command List pane, drag the command you want to add to the
location just below the shortcut menu in the Customizations In <file
name> pane.



&-fyfE] ¥ref Objects Menu
G- HfEl) ¥ref Object Menu

Line Object Men
[#-20 Keyboard Short
[+-4g Double Click Actio
Lot .. =
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f

Command List: /

>

| All Commands /

7 & ®

Command
B Layout, Mew
E Leam

License Bomowing, Bomow License

6. Continue adding commands until the new shortcut menu is complete.

Source

ACAD (d

7. Click OK.
Repeat LIME
Recent Input [
{"“ Lengthen

Annotative Object Scale

¥ Cut

Ctrl+X
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create
Submenus >

Create Submenus
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To create a submenu

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Menus. Select the menu you want to add a submenu to.

=-T3] Window

rT| Help

o [
Lo Ao Insert Separator

-3 Ribbon Tabs

E-87 Ribbon Pans Mew Menu

----- Guick Prope Mew Sub-menu
..... *5 Rollover Too
G-HfEl) Shortout Mer Rename

H-mm Keyboard Sh

Delet
-igy Double Click it

3. Right-click the menu. Click New Sub-menu.

The new submenu (named Menu1l) is placed at the bottom of the Menu
you selected to add the submenu to.

4. Do one of the following:
m Enter a new name over the default name Menul.
m Right-click Menul. Click Rename. Enter a new submenu name.

m Click Menul, wait, and click again over the menu’s name again
to edit its name in-place.



5. In the Properties pane, do the following:

m In the Description box, optionally enter a description for the

submenu.
E General
Mame Circle Commands
Description
B Advanced
Element ID PMU_D002

6. In the Command List pane, drag the command you want to add to a
location just below the name of the submenu in the Customizations In

<file name> pane.

] Help U
=-T5] My Tools
e A
... Circle Commands
- Ribbon Tabs
-5 Ribbon Panels E|
— — !
Command List: / &
I
o

[ All Commands 4 | & %

Command Source
@ Circle Center Radius I:I
@ Circle, 2 Points ACAD
@ Circle. 3 Points ACAD
@ Circle, Center, Diameter ACAD
@ Circle, Center, Radius ACAD

7. Continue adding commands until the new submenu is complete.

8. Click OK.

~|| 3 | Standard

Circle Commands 3 O Circle, 2 Points ]
C} Circle, 3 Points
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Customize the User Interface > Create Pull-Down and Shortcut Menus >

Create a Pull-Down Menu

[ conce )T

You can create a pull-down menu, add a submenu, and add commands on the
Customize tab of the Customize User Interface (CUI) Editor. The process is very
similar to working with toolbars and flyouts with only minor differences.

You can add and modify commands on menus. As you modify the positioning of
standard commands on menus, the online Help system is automatically updated
to reflect the change through the Dynamic Help feature. For more information
about how Dynamic Help affects customization, see How Customization Has

Changed.

Note When you create a menu, you should determine in which workspaces you
want to display the menu in. By default, a new menu is displayed in all
workspaces.

Show Me: Create a Pull-down Menu

Click the Play arrow below the following image to start the animation.

The following animation shows how to create a custom pull-down menu, and
place both standard and custom commands on it.



See Also

m  Customize Commands

=  Customize Workspaces
m  To create a pull-down menu (Procedure)

m To add a command to a pull-down menu (Procedure)




m  To change the caption of a menu item (Procedure)
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Customize the User Interface > Create Pull-Down and Shortcut Menus >

Create a Shortcut Menu
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Shortcut menus are displayed at or near the location of your cursor when you
right-click on the pointing device. The shortcut menu and the options it provides
depend on the location of the cursor and other conditions, such as whether an
object is selected or a command is in progress. You can also use scripts to
display shortcut menus.

Context-sensitive shortcut menus display menu options that are relative to the
current command or the selected object when you right-click.

Shortcut Menu Aliases

Shortcut menus are referenced by their aliases and are used in specific situations.
In the Customize User Interface (CUI) Editor, the alias names must follow the
proper naming conventions. For example, the shortcut menu named “Default
Menu” displays the following information in the Aliases section of the
Properties pane:

POP501, CMDEFAULT

CMDEFAULT is one of the reserved aliases that the program looks for in specific
situations. In this case, the shortcut menu assigned the alias CMDEFAULT is
displayed if no objects are selected and no command is in progress when you
right-click over the drawing window.

Aliases for context-sensitive shortcut menus must be numbered between
POP500 and POP999, with the exception of the Object Snap menu which uses
an alias of POPO. The following aliases are reserved for use by the program:

Program aliases for shortcut menus



GRIPS Defines the Hot Grip shortcut
menu. (Right-click the drawing
area while a grip on an object is
selected.)

CMDEFAULT Defines the Default mode shortcut
menu. (Right-click the drawing
area while no command is active
and no objects are selected.)

CMEDIT Defines the Edit mode shortcut
menu. (Right-click the drawing
area while one or more objects are
selected, no grips are selected, and
no command is active.)

CMCOMMAND Defines the Command mode menu.
(Right-click the drawing area while
a command is active.) In addition
to the content of the CMCOMMAND
menu, the command’s options
(keywords within the square
brackets) are inserted into this
menu.

SNAP Defines the Object Snap menu.
(SHIFT+right-click the drawing
area.)

The CMEDIT and CMCOMMAND shortcut menus can be made context-sensitive.
In addition to the content of the CMEDIT menu, the appropriate object menu (if
it exists) is inserted into this menu when one or more of a specific object type are

selected. Object menus use either of the following naming conventions:
OBJECT_objectname



OBJECTS_objectname

If a single object is selected, the OBJECT_objectname menu is used, and if
more than one of the same object type is selected, the OBJECTS_objectname
menu is used. If no OBJECT_objectname is available, the program uses the
OBJECTS_objectname menu (if it exists).

The object name used for the alias is the drawing interchange format (DXF'")
name of the object in all cases except for inserted objects. The following table
shows the object names that are specific to inserted objects (blocks, dynamic
blocks, and xrefs).

Object names specific to inserted objects

BLOCKREF Block reference without attributes

ATTBLOCKREF Block reference with attributes

DYNBLOCKREF Dynamic block reference without
attributes

ATTDYNBLOCKREF Dynamic block reference with
attributes

XREF External reference (xref)

For example, to support an object-specific shortcut menu for one or more
selected block references, you would create or modify a shortcut menu and
change its properties to those in the following table. The important property to
change is Aliases, which would need to modified to include the alias
OBJECT_BLOCKREF.

Properties for the Block Reference Objects shortcut menu




Properties 5 ot
pane item escription

Name

String that is only used
in the CUI Editor and is
not displayed in the user
interface.

Block Objects Menu

Description

Text used to describe the
element; does not
appear in the user
interface.

Shortcut menu for block objects

Aliases

Specifies the aliases for
the shortcut menu. Click
the [...] button to open
the Aliases dialog box.
Each alias in the CUI
file should be unique
and it is used to
reference the shortcut
menu programmatically.

POP512,0BJECTS_BLOCKREF

Element ID

Tag that uniquely
identifies a shortcut
menu.

PM_0021

Like the CMEDIT menu, the CMCOMMAND menu can contain context-sensitive
information. Any menu named COMMAND_commandname is appended to the
CMCOMMAND menu. The text of commandname can be any valid AutoCAD
command, including custom-defined or third-party commands.

In many cases, you can enter a hyphen before a command to suppress the display
of a dialog box and display prompts for the command instead. To create a
context-sensitive menu for a command that displays prompts instead of a dialog
box (such as - INSERT), you need to name the menu COMMAND_ - INSERT.



See Also

m To create a shortcut menu (Procedure)

m  To create a command shortcut menu (Procedure)

m To create an object shortcut menu (Procedure)
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Customize the User Interface > Create Pull-Down and Shortcut Menus > Create ¢
Shortcut Menu >

Create a Shortcut Menu
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To create a shortcut menu

To create a command shortcut menu

To create an object shortcut menu
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Customize the User Interface > Create Pull-Down and Shortcut Menus >

Create Submenus
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You create submenus in much the same way that you create a menu.

The following table describes the non-alphanumeric characters that can be used
in the Customize User Interface (CUI) Editor. Non-alphanumeric characters not
listed are reserved for future use as special menu characters.

Special characters for submenus

$(

Enables the
pull-down
or shortcut
command
label to
evaluate a
DIESEL
string
macro if $(
are the first
characters.

$(if,$(and,$(getvar,CleanScreenState),1),!.)Clean
S&creen

Makes a
command

unavailable.

~Plot Style

Marks a

I.Layer...



command
with a
check mark
or if an icon
is displayed
for the
menu item
it appears
sunken.

& Placed S&ample displays Sample (with the letter a
directly underlined).
before a
character,
specifies
the
character as
the menu
access key
in a pull-
down or
shortcut
menu label.

\t Pushes all Help\tF1 displays Help on the left side of the
label text pull-down menu and F1 on the right side.
entered
after these
characters
to the right
side of the
menu.

See Also

m To create a submenu (Procedure)
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Customize the User Interface > Create Pull-Down and Shortcut Menus >

Reference Pull-Down or Shortcut Menus

| o vconce |

Using a method similar to that used to activate submenus, you can activate or
deactivate another pull-down or shortcut menu. This is called referencing a
menu.

The two methods for referencing a pull-down or shortcut menu are relative and
absolute. Relative referencing uses the customization group and element ID.
Absolute referencing uses the absolute position of a menu item in the menu
hierarchy. Relative referencing is recommended because of its dynamic nature,
which allows it to function regardless of the current state of a menu.

Relative Referencing of Pull-Down and Shortcut Commands

To reference a pull-down or shortcut menu item based on its customization
group and element ID, use the AutoLISP menucmd function. The following
syntax references a menu item based on its element ID.

(menucmd "Gcustomizationgroup.element_id=value")

The following example uses the relative referencing syntax to disable the menu
item ID_Line that is stored in the ACAD customization group. It works
regardless of the menu item's location in the menu.

(menucmd "GACAD.ID_Line=~")

If you know what is contained in the main CUI file, you can create a partial CUI
file with an additional menu item that references the main file. In this manner,
partial CUI files and specific base files can work together.

Absolute Referencing of Pull-Down and Shortcut Menu Items



In addition to referencing a menu item, you can activate or deactivate a menu
item with the $Pn=xxx syntax. This is the format:
$Pn.i=xxx

The $ loads a menu section; Pn specifies the active menu section (0 through 16
are valid values); 1 specifies the menu item number; and xxx (if present),
specifies a string of grayed out or marked characters.

Using the $Pn=xxx syntax, the following example adds a check mark to item 1
in the POP7 section.
$P7.1=!.

The following example uses the AutoL.ISP menucmd function to reference a
pull-down or shortcut menu item. Because customization files are dynamic
(through the loading of partial CUI files), the following syntax won't work in all
cases.

(menucmd "P1.2=~")

This syntax relies on the location of the menu item and does not work if a new
item is inserted before POP1 by the CUILOAD command.

Menu item numbering is consecutive regardless of the hierarchy of the menu.

To make it easy for an item to address itself regardless of its location in the menu
hierarchy, use these forms:

$P@ . A=xXxX

References the current or most recently chosen command.

$P@ . n=xxXx

References item n in the current or most recently chosen menu.

AutoLISP Access to Label Status

The AutoLISP menucmd function accepts $Pn=xxx command strings but
without the leading $. For these functions, the xxx portion of the command
string can have special values.



Pn.1i="?

Returns the current disabled and marked status for the specified item as a
string (for example, ~ for a disabled item, ! . for an item with a check mark,
and "" for an item that is neither grayed out nor marked).

Pn.i=#?

Returns the same type of string as described for Pn. 1=?, but with the
Pn. 1= prefix. This is useful in conjunction with the @ forms, because the
actual menu and item number are returned.

For example, if the fifth item in the POP6 section is disabled, the following
menucmd code returns the following string values.

(menucmd "P6.5=?") returns "~"
(menucmd "P6.5=#?") returns "P6.5=~"
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Customize the User Interface > Create Pull-Down and Shortcut Menus >

Swap and Insert Pull-Down Menus

| o ncence |

Using the Customize User Interface (CUI) Editor, you can use workspaces to
control the swapping of pull-down menus. However, you can also swap a pull-
down menu programmatically (for example, when a user loads an application
that requires an additional menu). Menu swapping activates one menu directly
from another menu.

Swap Pull-Down Menus

Because the program has cascading pull-down menus, there is little need to swap
menus. Also, swapping menus can detract from the consistency of the user
interface. However, using $ commands, you can swap pull-down menus and
submenus. An alternative to menu swapping involves relative (or global)
referencing. Using this method, you can insert the new menu in front of a known
menu and then remove the known menu.

For menu-swapping purposes, the pull-down menu areas are named P1 through
P16. You can change the title that appears in the menu bar by replacing that line
of the menu with a $Pn= command. You can use the special command $Pn="*
from within any command to force the menu currently assigned to area POPn to
pull down for greater flexibility in movement of the pointing device.

The following macro example replaces a menu at position P3 with the menu
named MyMenu in the customization group named MYMENU.

$P3=mymenu.new3

The same thing can be done with the AutoL.ISP menucmd function as follows:

(menucmd "P3=mymenu.new3")



You can use the $Pn="* special command from within any macro to force the
menu currently assigned to area POPn to be displayed.

Note The swapping of pull-down menus does not conform to the Microsoft® user
interface guidelines and is not guaranteed to be available in future releases of the
program.

Insert and Remove Pull-Down Menus

Menu swapping is done by activating one menu directly from another menu.
Menu swapping is supported for the following interface elements:

= Buttons

»  Pull-down menus
= Mouse buttons

» Image tile menus
m Tablet menus

The syntax for the swapping of partial menus is as follows:

$section=menugroup.menuname

section

B1-4, A1-4, P0-16, T1-4

menugroup

Customization group name in the desired CUI file
menuname

Main label or alias

You can use the AutoLISP menucmd function to insert or remove a pull-down
menu. The syntax is similar to that used to swap pull-down menus except that
the left side of the assignment is the pull-down menu before which the new
menu will be inserted. The right side of the assignment is a plus sign (+)
followed by the name of the menu group, a period, and the menu's alias, as
shown in the following syntax:



(menucmd "menugroupl.menunamel=+menugroup2.menuname2")

You can also insert a menu with the Pn= syntax. The following macro inserts a
menu after the P5 menu. (You can also use the menucmd function with this
format.)

(menucmd "P5=+mymenu.new3")

If you use this method to insert a menu, remember that you cannot rely on its
being inserted at the P6 menu location as you might expect. There are two
reasons that this may not be the case.

m [f the current menu bar has only three menus, inserting a menu after
menu P5 results in the new menu's location being P4.

m [f the user inserts or removes a customization file with the CUILOAD
command or when another application inserts or removes customization
files, menu numbering can get out of sync.

This is the syntax for removing a menu:

(menucmd "Gmenugroup.menuname=-")

The following example removes the menu NEW3 that is a member of the
MyMenu group.

(menucmd "Gmymenu.new3=-")

As you might expect, the preceding format is preferable to the Pn= format
because it removes only the specified menu. The following example removes the
menu at the P4 location (whatever it is).

$P4=-
Note Use the Pn syntax as part of the syntax for a menucmd statement only. Use
the $Pn syntax for macro-specific statements.

Control Toolbars Across Partial CUI Files

To control toolbars across partial CUI files, use the following syntax at the Enter
toolbar name or [ALL]: prompt of the -TOOLBAR command.


ms-its:ACAD_ACR.chm::/CUILOAD.htm
javascript:hhctrl_d0e12287.Click()

menugroup.subsection-name

This syntax accesses the toolbar identified by menugroup . menuname and
allows you to use the full spectrum of -TOOLBAR command options on that
toolbar.

If the menu group is left out of any of these commands and functions, the
program defaults to the main CUI file.

You should be aware of the following:
= [mage tile menus cannot be swapped from external customization files.

®  You can swap customization elements of the same type only; that is, one
shortcut menu for another, one toolbar for another, and so on. Trying to
swap between types may result in unpredictable behavior.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
[Corcr | B[ o e |

To create a ribbon panel

To copy an existing toolbar to ribbon panels

To remove a ribbon panel

To add a row to a ribbon panel

To add a sub-panel to a row on a ribbon panel

To remove a row or sub-panel from a ribbon panel

To reposition a row or sub-panel on a ribbon panel

To add a command to a ribbon panel
To reposition a command on a ribbon panel
To remove a command from a ribbon panel

To create a flyout in a row on a ribbon panel

To show the label and set the orientation of a command or flyout on a ribbon
anel

To set the size of a command or flyout on a ribbon panel

To set the button and flyout style of a flyout on a ribbon panel

To control the display of ribbon panel titles on the ribbon

To associate a tool palette group with a ribbon panel
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
[Corcr | B[ o e |

To create a ribbon panel

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Ribbon Panels. Click
New Panel.

A new panel (named Panell) is placed at the bottom of the Ribbon
Panels tree.

-5 Menus

--IHJ Shorto Paste
-2 Keybo
[+ Doubl Find...

3. Right-click Panell. Click Rename. Enter a new panel name.
4. Select the new panel in the tree view, and update the Properties pane

= In the Display Text box, enter the text you want to display for the
title of the panel when it is displayed on the ribbon.

= In the Description box, enter a description for the ribbon panel.

m In the Aliases box, enter an alias for the ribbon panel.



E General
MName
Display Text
Description

El Appearance
Rows

B Advanced
Aliazes
Element [D

5. Click OK.

My Tools
My Tools

1

ID_PanelPanell
uIDU_1062

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
[Corcr | B[ o e |

To copy an existing toolbar to ribbon panels

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Toolbars to expand it.

3. Select the toolbar that you want to copy to panels.
4. Right-click the selected toolbar. Click Copy to Ribbon Panels.

Customizations in All CUI Files P
All Customization Files | @
-5 Walk and Fly -
[#-55 Multleader
- Menu Insert Separator
(-F=3 Ribbo
-5 Ribbao Copy To Ribbon Panels
""" Quick Mew Toolbar
----- * Rolloy
- 1yE] Shorte Mew Flyout

5. In the Convert to Ribbon Panel dialog box, click Yes.
6. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
[Corcr | B[ o e |

To remove a ribbon panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Select the panel that you want to remove.
4. Right-click the selected panel. Click Delete.

-85 Solid Editing
FH-£57 Action Reconder

B8
..... Quick Propet New Panel
..... *5 Rollover Too Mew Row

-FfEl| Shortcut Mer
a0 Keyboard Sh Rename

-3y Double Click
-y Mouse Butto Deleis
----- @ LISP Files )
Duplicate
-2 Legacy :

warning There is no way to undo the removal of an interface element, so
be careful when removing interface elements. If you remove the wrong
interface element, the best thing to do is click Cancel to not save
changes, but this will also undo any other changes that you might have
made.

5. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
[Corcr | B[ o e |

To add a row to a ribbon panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Select the panel to which you want to add a row.
4. Right-click the selected panel. Click New Row.

FH-£57 Action Reconder

=557 My Tools
-
----- Guick Properti Mew Panel
..... *5 Rollover Toolt
G-FEl) Shortcut Meny New Bow
[-00 Keyboard Sho Find...
(-4 Double Click £
-y Mouse Button e
----- @ LISP Files
H-875 Send
=55 My Tools
Fors
..... Cuick Properti Mew Panel
----- 5 Rollover Tool
+-1fE] Shortcut Meny Mow. Fow
+-m Keyboard Sho Find...

+- % Mouse Button Replace...
- E. Legacy

c
E
r+1-&gy Double Click £
E
c



5. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
[Corcr | B[ o e |

To add a sub-panel to a row on a ribbon panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to add a
sub-panel.

4. Create a new row for the sub-panel if needed, or click the plus sign (+)
next to the row where you want to add a sub-panel.

5. Click the plus sign (+) next to the row where you want to add a sub-
panel.

6. Select the row where you want to add a sub-panel.
7. Right-click the selected row. Click New Sub-Panel.

FH-£57 Action Reconder

EIEj My Tools
=
Lde <PAN New Panel
..... Quick Properti Mew Row

----- + 5 Rollover Tool
-RfE) Shortcut Men Mew Sub-Panel
H-20 Keyboard Sha New Flyout

43y Double Click £
Add 5 t
-y Mouse Button S




@& Send
=87 My Tools
-
e <PAI Mew Panel
----- Quick Proper
Mew R
----- *5 Rollover Too ok
-l Shorteut Men Mew Sub-Panel
EEI---';I'_I Keyboard Sh New Flyout
+-43% Double Click
S% MZI:SD.: BLIrl'tu Add Separator

8. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
[Corcr | B[ o e |

To remove a row or sub-panel from a ribbon panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel from which you want to
remove a row or sub-panel.

4. Select the row or sub-panel that you want to remove.

5. Right-click the selected row or sub-panel. Click Delete.

-7 Action Recorder

=57 My Tools
&-{=5 Row 1
=] Row 2
----- H# <PAN Mew Panel

Mew Row

----- Cuick Properti
----- + 5 Rollover Toolt New Sub-Panel

G-HEl) Shortcut Meny Mew Flyout
(20 Keyboard Sho
Add 5 t
(-4 Double Click £ spareet
-y Mouse Button Eonae
----- @ LISP Files
5@ Legacy Delete

&-[F] Partial CUI File

Duplicate e




-85 Send
E-55 My Tools

8 % <PAN Mew Panel
Mew R

----- Quick Propert St
..... + Rollover Toolt Mew Sub-Panel
&-RfE] Shortcut Men New Flyout
#2010 Keyboard Sha

fi-&gay Double Click Add Separator
-y Mouse Button
E

4 Rename
]{é. Legacy
----- | Partial CUI Fil Delete

6. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
[Corcr | B[ o e |

To reposition a row or sub-panel on a ribbon panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to
reposition a row or sub-panel.

4. Drag the row or sub-panel that you want to reposition up or down under
the ribbon panel’s node. Use the visual indicator bar to the position the
row above or below other rows or sub-panels.

=57 My Tools
&#-{=5 Row 1
#-{=5 Row 2
¢ <PANE|/SEPARATOR>
w5 [
----- Cuick Properties
----- *5 Rollover Tooltips

5. Click OK.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
[Corcr | B[ o e |

To add a command to a ribbon panel

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to add a
command.

4. Click the plus sign (+) next to the ribbon panel where you want to add a
command to a row, sub-panel, or flyout. If you need to, continue
expanding sub-panels, rows, and flyouts to get to the location you want
to add a command.

5. Drag a command from the Command List pane to the row on a panel.
Use the visual indicator bar to specify the position of the command.



=55 My Tools
-{=5 Row 1
[#-{=5 Row 2
¢ <PANEL SEPARATOR>
=-{=8 Row 3
‘g Fillet
----- Cuick Properties
----- *5 Rollover Tooltips

G-fEl) Shortcut Menus

F

m

>

Command List: !I
/ Q@

| All Commands | | * %

Command Source |Z|
Cell ACAD D
EE Cell Borders
=
E Change Space ACAD
El”ﬁj My Tools
i+-{== Row 1
G-{== Row 2
----- 9 <PANEL SEFARATOR:= =
-5, Row 3 i
‘.. Fillet
----- Quick Properties
----- *5 Rollover Tooltips =
= ns
I
Command List: l o
...... /i' a
[MJ Commands ‘\“ v] o b
T
Command Source El
Cell ACADLT |:|
EE Cell Borders
i ACADLT
E Change Space ACADLT

6. In the Properties pane, do the following

m In the Orientation box, click the down arrow and select
Horizontal or Vertical to control how the command looks when its
label is shown.

m In the Size box, click the down arrow and select Standard,
Medium, or Large to control the size of the button on the ribbon.



m In the Show Label box, click the down arrow and select Yes or
No to control if a label is displayed below or to the right of the
image for the command.

= Display
MName Chamfer
1= Appearance
Crrientation Harizontal
Size Standard
Show Label Mo
&l Command
Command Mame Chamfer
Description

Extended Help File
Command Display Mame CHAMFER

Macro “C"C_chamfer

Tags
& Advanced

Element ID UIDU_1066
1= Images

Small image RCDATA_16_CHAMFE
| Large image RCDATA_32 CHAMFE

7. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
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To reposition a command on a ribbon panel

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to
reposition a command.

4. Click the plus sign (+) next to the row where you want to reposition a
command on. If you need to, continue expanding sub-panels, rows, and
flyouts to get to the command.

5. Drag the command up or down in the row or to a different row. Use the
visual indicator bar to specify the position of the command.

El"ﬁj My Tools
+-{==5 Row 1
=-{== Row 2

- Ray
: g9l Construction Line

------ Y <PAMEL SEFARATOR:

EI@ Row 3

----- Quick Properties
..... + = Rollover Tooltips

6. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
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To remove a command from a ribbon panel

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to
remove a command.

4. Click the plus sign (+) next to the row where you want to remove a
command. If you need to, continue expanding sub-panels, rows, and
flyouts to get to the command.

5. Select the command that you want to remove.

6. Right-click the selected command. Click Remove.

=87 My Tools
=-{== Row 1

.5 Circle New Row
""" * .ﬁrc Mew Sub-Panel

[-fms Row 2 Mew Flyout

525 Row 3 Rename

¢ Cham Remove

----- Cuick Properties Duplicate

7. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
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To create a flyout in a row on a ribbon panel

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to add a
flyout.

4. Right-click the row to which you want to add a flyout. Click New
Flyout.

A new flyout (named New Flyout) is created in the last position of the
row.

5. Right-click New Flyout. Click Rename. Enter a new name.

E-55 My Tools

...... * Arc New Row
...... J Line Mew Sub-Panel

...... J <PANEL Mew Flyout

Rename

e ¢ Fillet Remowve
----- Cuick Properties _
----- *5 Rollover Tooltips Duplicate

6. In the Command List pane, drag the commands that you want to add to
the new flyout in the Customizations In <file name> pane.



=87 My Tools
=)-f== Row 1

----- J <PANEL SEFARATOR:=
[#-{=2 Row 3

---- Cuick Properties

----- *5 Rollover Tooltips Ul

m

>

Command List: j
[ 2

| All Commands | 2 & R

Command Source E
(%) Circle Certer Radius ACAD E
Circle, 2 Points
| & Circle. 3 Points
@ Circle, Center, Diameter ACAD

Elﬁ My Tools
=-f== Row 1

& & Circle Commands 4

----- Y <PANEL SEFARATOR:=
[#-{=2 Row 3

---- Cuick Properties

----- *5 Rollover Tooltips

b o

>

[
Command List: l
I

/ Q

| All Commands / 7 & ®

Command Source E

(%) Circle Center Radius ACADLT
8 Circle, 2 Points ACADLT
‘ Circle, 3 Points ACADLT
@ Circle, Center, Diameter ACADLT

7. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels

oo B[ e |

To show the label and set the orientation of a command or flyout on a
ribbon panel

1.
2.

Click Tools tab » Customization panel » User Interface. ki

In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

Click the plus sign (+) next to the ribbon panel where you want to show
the label for a command.

Click the plus sign (+) next to the row where you want to show the label
for a command. If you need to, continue expanding sub-panels, rows,
and flyouts to get to the command.

Select the command that you want to show its label for.
In the Properties pane, do the following:

= [n the Orientation box, click the down arrow and select
Horizontal or Vertical.

m In the Show Label box, click the down arrow and select Yes or
No.



El Display

MName Chamfer
El Appearance
Orientation Harizontal
Size Standard
Show Label Mo
EH Command
Command Name Chamfer
Description

Extended Help File
Command Display Mame CHAMFER

Macro “C"C_chamfer
Tags
B Advanced
Element ID IDU_1066
EH Images
Small image RCDATA_16_CHAMFE
Large image RCDATA_32 CHAMFE
7. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
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To set the size of a command or flyout on a ribbon panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel which has the command
or flyout that you want to set the size for.

4. Click the plus sign (+) next to the row which has the command or flyout
that you want to set the size for. If you need to, continue expanding sub-
panels, rows, and flyouts to get to the command.

5. Select the command or flyout that you want to set the size for.

6. In the Properties pane, in the Size box, click the down arrow and select
Standard, Medium, or Large.



H General
Mame Circle Commands
Description

El Appearance
Cirientation Horzontal
Size Standard
Show Label Mo
Button Style BExecute
lUse Recent Command | Yes
Flyout Style lcons

B Advanced
Element ID Jiou_1067

EH Images
Small image
Large image

7. Click OK.
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Panels >

Create and Edit Ribbon Panels
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To set the button and flyout style of a flyout on a ribbon panel

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to
change the style of a flyout.

4. Click the plus sign (+) next to the row that contains the flyout you want
to change. If you need to, continue expanding sub-panels, rows, and
flyouts to get to the command.

5. Select the flyout that you want to change, and update its properties in the
Properties pane:

= In the Button Style box, click the down arrow and select Execute
or Expand.

= In the Flyout Style box, click the down arrow and select Icons,
Icons and Text, Descriptive, or Gallery.



H General
Mame Circle Commands
Description

El Appearance
Cirientation Horzontal
Size Standard
Show Label Mo
Button Style BExecute
lUse Recent Command | Yes
Flyout Style lcons

B Advanced
Element ID Jiou_1067

EH Images
Small image
Large image

6. Click OK.
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To control the display of ribbon panel titles on the ribbon
m  Right-click the ribbon, and select Show Panel Titles.

A| Dimensions it Multileaders |

Show Related Tool Palette Group

Tool Palette Group 3
Tabs 3
Pansls 3

¥ Show Panel Titles

Customize...

Help
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To associate a tool palette group with a ribbon panel

1. If the Tool Palettes window is not displayed, click View tab » Palettes
panel » Tool Palettes.

2. On the ribbon, right-click a ribbon panel.

3. Click Tool Palette Group and then click one of the available tool palette
groups.



B =T AutoCAD 2009 Drawi

Blocks & References

A Y
watine | AT A
Text

Text 4

Home

Multileader

Show Related Tool Palette Group
Tool Palette Group 3 All Palettes
Annotation and Design
i ' 3D Make
Panels J Tables
v Show Panel Titles g
i Materials
Help Materials Library

Generic Lights
Photometric Lights
Cameras

Visual Styles

¥ DMNone

Click Workspace Switching on the application status bar.

Click Save Current As.

v 2D Drafting & Annotation
3D Medeling
AutcCAD Classic

Save Current 4s.., -
{ﬁ} Workspace Settings... P 4 -
Customize... 1 F

In the Save Workspace dialog box, click the down arrow next to the
Name drop-down list.

Select the name of the current workspace to overwrite it with the
updated tool palette association for the ribbon panel.



|E| Save Workspace =™
MName: - fo—
Cancel

Note To identify the current workspace, click Workspace Switching on
the application status bar and find out which workspace is checked. The
workspace with a check mark to the left of its name is the current
workspace.

8. Click Save.
9. In the Workspace - Already Exists dialog box, click Replace.
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To add a control to a ribbon panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to add a
control.

4. Create a new row for the control if you need to, or click the plus sign (+)
next to the row where you want to add a control.

5. In the Command List pane, in the Categories list, click Control
Elements.

The Command List pane displays control elements only.

— - |
! Command List: ol

| Q

[ Control Elements = & K

All Commands

ACAD Commands
IMPRESSION Commands
EXPRESS Commands
Custom Commands

Control Elements
i File

»

m

6. Drag a control from the Command List pane to add to the panel. Use the
visual indicator bar to specify the position of the control.



=55 My Tools
&-{=5 Row 1
¢ <PAMEN SEPARATOR:>

m

----- Cuick Propegies

1
Command List: ! o

/' Q
/

| All Commands | & %

T
Command ‘ Source B

Layer Fitter Comba Control CONTROL

7. Click OK.
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To reposition a control on a ribbon panel

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to
reposition a control.

4. Click the plus sign (+) next to the row where you want to reposition a
control. If you need to, continue expanding sub-panels, rows, and flyouts
to get to the control.

5. Drag the control up or down on the row or to a different row. Use the
visual indicator bar to specify the position of the command.

=87 My Tools
[-{mm Row 1

..... - Layer Control ﬂ
S Line Type Cartral
- <PANEL SEPARATOR>

[#-f=5 Row 3
----- Cuick Properties

6. Click OK.
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To remove a control from a ribbon panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to
remove a control.

4. Click the plus sign (+) next to the row where you want to remove a
control. If you need to, continue expanding sub-panels, rows, and flyouts
to get to the control.

5. Select the control that you want to remove.

6. Right-click the selected control. Click Remove.

Elﬁj My Tools
(-{== Row 1
EI@ Row 2

----- Cuick Propertie
----- *5 Rollover Toottp
-1¢fEl| Shortcut Menu
H-D Keyboard Shard

-3y Double Click A

[
[
[
=

-y Mouse Buttons

7. Click OK.

ayer Control

Mew Row
Mew Sub-Panel
Mew Flyout

Rename

Remowve

Duplicate
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To change the properties of a gallery button on a ribbon panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Panels to expand it.

3. Click the plus sign (+) next to the ribbon panel where you want to
change a control.

4. Click the plus sign (+) next to the row where you want to change a
gallery control.

5. Click the gallery control element.

i#-87 Linking & Bxtraction
=575 Tex
=-f=E Row 1
e Multiling Test...
=-{ & Sub-Panel 1
-5 Row 1

e "3 Ribbon Gallery - Text Style

..... +# <PANEL SEPARATOR>
== Row 2
#-{== Row 3

6. In the Properties pane, do the following:

» In the Gallery Style box, click None, Window, or ComboBox.



» In the Thumbnail Size box, click Standard or Large.

» In the Show Label box, click Collapsed, Hidden, or Visible.

E General
Mame
Cantrol Ribbon Galleny - Text Style
E Appearance
Gallery Style Windaow
Thumbnail Size Lange
Show Label Vizible
7. Click OK.
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To create a ribbon tab

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Ribbon Tabs. Click
New Tab.

%= Toolbars
-5 Menus
M| Fibbon Tabs
-85 Rib Mew Tab

- Qu
-1 Ro Rename
IE—" Sh Delete

..._|_| -
-4gy Do Find...

A new ribbon tab (named Tab1) is placed at the bottom of the Ribbon
Tabs node.

3. Right-click Tab1. Click Rename. Enter a new name for the ribbon tab.

4. Select the new ribbon tab in the tree view, and update the Properties
pane:

m In the Description box, enter a description for the ribbon tab.

= [n the Aliases box, enter an alias for the ribbon tab.



B General
My Utilities
Display Text Mew Tab
Description
B Advanced
Aliazes ID_TabSourceMew Tab
Element ID uIDU_00639
EH Images
Image

5. Click OK.
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To remove a ribbon tab

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Tabs to expand it.

3. Select the ribbon tab that you want to remove.

4. Right-click the selected ribbon tab. Click Remove.

£ Output - 2D
£ Output - 3D
-3
=557 Ribbon Panel
-5 My Tools
-85 Draw - 3D
-8 Modify - 2
-8 Modify - 3
..Ej Layers - 3

Mew Tab

Rename

Remowve

Duplicate

warning There is no way to undo the removal of an interface element, so
be careful when removing interface elements. If you remove the wrong
interface element, the best thing to do is click Cancel to not save
changes, but this will also undo any other changes that you might have
made.

5. Click OK.
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To add a ribbon panel to a ribbon tab

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Tabs to expand it.

3. Click the plus sign (+) next to the ribbon tab where you want to add a
ribbon panel.

4. Click the plus sign (+) next to Ribbon Panels in the Customizations In
<file name> pane to expand it.

5. Drag the ribbon panel from the Ribbon Panels node to the ribbon tab.
Use the visual indicator bar to specify the position of the ribbon panel on
the ribbon tab.



== Ribbon Tabs
- Home - 2D
[#-£= Blocks & References
£ Annotate
£ Toals
£ View - 2D
&£ View - 3D
- Home - 3D
£ Visualize
£ Output - 2D
£ Output - 30

=87 Ribbon Pan
w-83

-85 Draw - 3D
-8 Modify - 2D
-8 Modify - 3D
-7 Layers - 3D

6. Click OK.
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To remove a ribbon panel from a ribbon tab

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Tabs to expand it.

3. Click the plus sign (+) next to the ribbon tab where you want to remove
a ribbon panel.

4. Select the ribbon panel that you want to remove.

5. Right-click the selected ribbon panel. Click Remove.

-3 Output - 3D
=3 My Utiities
97 Annotation

=57 Ribbon Panels Mew Tab

-5 My Tools
-85 Draw - 3D
"Ej Madify - 2D Remove

-5 Modify - 3D | ,

Rename

warning There is no way to undo the removal of an interface element, so
be careful when removing interface elements. If you remove the wrong
interface element, the best thing to do is click Cancel to not save
changes, but this will also undo any other changes that you might have
made.

6. Click OK.
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To set the initial position of a ribbon panel on a ribbon tab

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Ribbon Tabs to expand it.

3. Click the plus sign (+) next to the ribbon tab where you want to
reposition a ribbon panel.

4. Select the ribbon panel that you want to move and drag it to the new
location.

. @73 Output - 3D
- B3 My Utilties

-7 Properties - 2
{97 Properties - 3
-7 Annotation

=897 Ribbon Panels
. -7 My Tools

. @87 Draw-3D
. @57 Modify - 2D

A splitter bar is displayed between the ribbon panels indicating the
location the ribbon panel when the pointing device button is released.

5. Once the splitter bar is in the place where you want to insert the ribbon
panel, release the pointing device button.

6. Click OK.
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By customizing ribbon panels, you can organize commands that you use
frequently similar to toolbars. With ribbon panels, you can quickly access
commands, and reduce the number of user interface elements that are displayed.

Show Me: Create a Ribbon Panel

Click the Play arrow below the following image to start the animation.

The following animation shows how to create a ribbon panel, add a row, and add
commands to rows.



Ribbon panels are organized by rows, sub-panels, and panel separators. Rows
and sub-panels are used to organize how commands and controls are displayed
on the ribbon panel. A panel separator is automatically added to each ribbon
panel and controls which rows are shown by default. Rows located below a
panel separator are displayed only when a ribbon panel is expanded.

The following table describes the properties of the Draw - 2D ribbon panel as
they appear in the Properties pane.



Properties for the 2D Draw Ribbon Panel

Properties Pane

Item Description Example

Name Name of the panel; does 2D Draw
not appear in the user
interface.

Display Text Title of the panel; Home
displayed when the

ribbon is set to display
titles or when a panel is
floating.

Description Text used to describe the
element; does not appear
in the user interface and
is optional.

Rows Number of rows that are 4
on the ribbon panel.

Aliases Specifies the aliases for ID_Draw
the panel. Click the [...]
button to open the Aliases
dialog box. Each alias in
the CUI file should be
unique and is used to
reference the panel
programmatically.

Element ID Tag that uniquely UIDU_0003
identifies a panel.

A row, similar to a toolbar, determines the order and position that commands and



controls appear on the ribbon panel. Rows run horizontally on a ribbon panel. If
all the commands and controls cannot be displayed on the ribbon panel, a gray
down arrow is displayed for expanding the ribbon panel. Rows can be divided
using a sub-panel which, holds rows to order and position commands and
controls.

The following table describes the properties for Sub-Panel 1of the Draw - 2D
Draw ribbon panel as they appear in the Properties pane.

Properties for Sub-Panel 1 of the Draw - 2D Draw Ribbon Panel

Properties Pane
Item

Description Example

Name Logical name assigned to ~ Sub-Panel 1
the sub-panel; does not
appear in the user
interface and is optional.

Description Text used to describe the
element; does not appear
in the user interface and
is optional.

Rows Number of rows that are 2
on the sub-panel.

Collapse Large Controls whether large No
Images images are collapsed

when a sub-panel is

resized. The values are

Yes or No.

Element ID Tag that uniquely UIDU_0006
identifies a panel section.




The following table describes the properties for Row 1 of Sub-Panel 1 of the
Draw - 2D Draw ribbon panel as they appear in the Properties pane.

Properties for Row 1 of Sub-Panel 1 of the Draw - 2D Draw Ribbon
Panel

Properties Pane
Item

Description Example

Name Logical name assigned to
the row; does not appear
in the user interface and
is optional.

Description Text used to describe the
element; does not appear
in the user interface and
is optional.

Element ID Tag that uniquely UIDU_0007
identifies a panel section.

Commands and controls can be added to rows and sub-panels, you can remove
the commands and controls that you use infrequently, and rearrange the order of
commands and controls. Along with commands and controls, you can also create
flyouts that contain multiple commands and only take up the space of a single
command. In addition to using rows and sub-panels to organize commands, you
can also use menu separators. Menu separators are used to add space or lines
between commands and controls. There are three different styles of menu
separators: line, space, and invisible.

The following table describes the properties for the Line command of Row 1on
the Draw - 2D ribbon panel as they appear in the Properties pane.

Properties for the Line Command on Row 1 of the Draw - 2D Draw



Properties

Pane Ttem Description Example

Name Text used as the name Line
and label of the command
button; does appear in the
user interface.

Orientation Controls the direction of Vertical
the icon and label for the
button. The values are
Horizontal or Vertical.

Size Controls the size of the Large
button. The values are
Standard, Medium, or
Large.

Show Label Controls whether a label Yes
is displayed for the
button. The values are
Yes or No.

Command Text that contains the Line
Name name of the command as

it appears in the

Command List pane.

Description Text used to describe the Creates straight line
element; does not appear segments
in the user interface.

Extended Help Text that displays the file
File name and ID for the
extended tooltip that is



displayed when the
cursor hovers over a
toolbar or panel button.

Command Text that contains the LINE
Display Name name of the command

that is related to the

command.
Macro The command macro. It ACAC_line

follows the standard
macro syntax.

Note When you change the
name of a macro, the
name of its corresponding
menu item or toolbar
button does not change.
You must change a menu
item or toolbar button
name by selecting it in
the tree view.

Tags Keywords associated to a
command. Tags provide
an additional field to
search when using the
Search field in the menu
browser.

Element ID Tag that uniquely UIDU_0005
identifies a command.

Small Image ID string of the small- RCDATA_16_LINE
image resource (16 x 16
bitmap). The string must
include alphanumeric
characters with no



punctuation other than a
hyphen (-) or an
underscore (_). It can also
be a user-defined bitmap.
Click the [...] button to
open the Select Image
File dialog box.

Large Image

ID string of the large-
image resource (32 x 32
bitmap). If the specified
bitmap is not 32 x 32, the
program scales it to that
size. The string must
include alphanumeric
characters with no
punctuation other than a
hyphen (-) or an
underscore (_). It can also
be a user-defined bitmap.
Click the [...] button to
open the Select Image
File dialog box.

RCDATA_32_LINE

Rows on ribbon panels, like toolbars, can contain flyouts that hold a number of
commands and separators to help organize similar tools. A ribbon panel flyout is
created in a different way then a flyout on a toolbar. Instead of the flyout
referencing a toolbar, it is created like a sub-menu on a menu; it has many of the
same properties as a toolbar flyout does.

The following table describes the properties for the Point flyout of Row 2 on the
Draw - 2D ribbon panel as they appear in the Properties pane.

Properties for the Point Flyout on Row 2 of the Draw - 2D Draw Ribbon

Panel




Properties - :
Pane Item Description Example

Name

Logical name for the flyout;
does not appear in the user
interface.

Point

Description

Text used to describe the
element; does not appear in
the user interface.

Orientation

Controls the direction of the
flyout. The values are
Horizontal and Vertical.

Horizontal

Size

Controls the size of the
button. The values are
Standard, Medium, or
Large.

Standard

Show Label

Controls whether a label is
displayed for the flyout.
The possible values are Yes
or No.

No

Button Style

Controls whether the
current command button is
executed or the flyout is
displayed when the button
is clicked. The values are
Execute or Expand.
Execute runs the command
associated with the button;
Expand displays a popup
menu with the commands
of flyout.

Execute




Use Recent
Command

Flyout Style

Element ID

Small Image

Large Image

Controls whether the last
used button is set as the
current button or not. The
values are Yes or No.

Controls if the text, icons,
or a combination of both
are displayed for commands
on the flyout.

Tag that uniquely identifies
a panel section.

ID string of the small-
image resource (16 x 16
bitmap). The string must
include alphanumeric
characters with no
punctuation other than a
hyphen (-) or an underscore
(_). It can also be a user-
defined bitmap. Click the
[...] button to open the
Select Image File dialog
box.

ID string of the large-image
resource (32 x 32 bitmap).
If the specified bitmap is
not 32 x 32, the program
scales it to that size. The
string must include
alphanumeric characters
with no punctuation other
than a hyphen (-) or an
underscore (_). It can also
be a user-defined bitmap.

Yes

Icons and Text

UIDU_0049

RCDATA_16_POINT

RCDATA_16_POINT



Click the [...] button to
open the Select Image File
dialog box.

Display Ribbon Panels on the Ribbon

The display of ribbon panels on the ribbon is done through ribbon tabs. Once a
ribbon tab is created, a panel can then be added to it. Ribbon tabs are then added
to a workspace, which controls which ribbon tabs are displayed on the ribbon.
For more information on ribbon tabs, see Create and Edit Ribbon Tabs.

Associating Tool Palette Group with a Ribbon Panel

You can associate a tool palette group with a ribbon panel. Associating a tool
palette group to a ribbon panel allows you to quickly access additional tools that
are related to a ribbon panel and are defined on a tool palette. The association of
a tool palette group to a ribbon panel is done from the ribbon. For more
information about tool palettes and tool palette groups, see Customize Tool

Palettes and Organize Tool Palettes.

See Also
= Customize Commands
= Add or Switch Ribbon Panel Controls
m  Create and Edit Ribbon Tabs

m  To create a ribbon panel (Procedure)

m  To copy an existing toolbar to ribbon panels (Procedure)

=  To remove a ribbon panel (Procedure)

m  To add a row to a ribbon panel (Procedure)

m  To add a sub-panel to a row on a ribbon panel (Procedure)

m  To remove a row or sub-panel from a ribbon panel (Procedure)

m  To reposition a row or sub-panel on a ribbon panel (Procedure)

m  To add a command to a ribbon panel (Procedure)
m  To reposition a command on a ribbon panel (Procedure)
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To remove a command from a ribbon panel (Procedure)

To show the label and set the orientation of a command or flyout on
a ribbon panel (Procedure)

To set the size of a command or flyout on a ribbon panel
(Procedure)

To create a flyout in a row on a ribbon panel (Procedure)

To set the button and flyout style of a flyout on a ribbon panel
(Procedure)

To control the display of ribbon panel titles on the ribbon
(Procedure)

To associate a tool palette group with a ribbon panel (Procedure)
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Ribbon panel controls are drop-down lists, sliders, text boxes, and other panel-
specific controls. For example, the Layers panel contains controls for changing
the layers in a drawing. In the Customize User Interface (CUI) Editor, you can
add, remove, and relocate controls on panels.

The following table describes the controls found in the Customize User Interface
(CUI) Editor that can be used on ribbon panels. The control elements in the left
column of this table are not always the text that is displayed as a tooltip in the
program (for example, RibbonFindTextControl is displayed as Find Text in the
program's tooltip). In addition to the ribbon panel controls, many of the controls
that can be used with toolbars can also be added to a row on a ribbon panel. To
learn more about the controls that can be used on toolbars and ribbon panels, see
Add or Switch Toolbar Controls.

Controls available for ribbon panels

Control

Type
3D Navigation Combo Control Multiple

Control element




3D Navigation Point Triplet 1 Control Multiple
3D Navigation Point Triplet 2 Control Multiple
ActionRecorderComboBoxItem Drop-
down
list
ActionRecorderPlaybackButtonltem Button
ActionRecorderPreferenceButtonltem Button
ActionRecorderRecordButtonltem Button



ActionRecorderTreeViewRibbonltem Tree
view

ActionRecorderUserInputButtonltem Button

ActionRecorderUserMessageButtonltem Button

DimensionStyleCombo Drop-
down
list



Find Text Control Text
box
LayerStateCombo Drop-
down
list
LightsBrightnessSlider Slider
LightsContrastSlider Slider
LightsDateSlider Slider
LightsMidTonesSlider Slider



LightsTimeSlider

Slider

LinetypeCombo

Drop-
down
list

LineWeightCombo

Drop-
down
list

LockedLayerFadingSlider

Slider

Multileader Style Control

Drop-
down
list

MultiLeaderStyleCombo

Drop-
down
list

Named View Control

Drop-
down
list

Nav3DLensLengthSlider

Slider



Nav3DStepSizeSlider Slider
Nav3DStep VelocitySlider Slider
ObjectColorCombo Drop-
down
list
OpenDrawingList Button
OutputSizeList Drop-
down
list
PlotStyleCombo Drop-
down
list
Render Progress Control Button



and
progress
bar

Render Style Control

Drop-
down
list

RenderOutputFileButton

Button

RenderOutputFileTextBox

Text
Box

RenderOutputFileToggleButton

Toggle

RenderPresetList

Drop-
down
list

RenderQualitySlider

Slider
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RibbonCommandToggleButton! AdvancedRenderSettings

RibbonCommandToggleButton!Camera

RibbonCommandToggleButton! CommandLine

RibbonCommandToggleButton! DbConnect

RibbonCommandToggleButton!DefaultLighting

Toggle

Toggle

Toggle

Toggle

Toggle
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RibbonCommandToggleButton! DesignCenter

RibbonCommandToggleButton! DrawingRecoveryManager

RibbonCommandToggleButton! DrawingStatusBar

RibbonCommandToggleButton! ExternalReferences

RibbonCommandToggleButton!Layer

RibbonCommandToggleButton!LightGlyph

RibbonCommandToggleButton!Lights

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle

Toggle
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RibbonCommandToggleButton!LockedLayerFading Toggle
RibbonCommandToggleButton!Materials Toggle
RibbonCommandToggleButton!MarkupSetManager Toggle
RibbonCommandToggleButton!Properties Toggle
RibbonCommandToggleButton!QuickCalc Toggle
RibbonCommandToggleButton!SheetSetManager Toggle




RibbonCommandToggleButton!SunProperties

RibbonCommandToggleButton!SunStatus

RibbonCommandToggleButton! ToolPalette

RibbonCommandToggleButton! ViewCube

RibbonCommandToggleButton!VisualStyleEdgelJitter

Toggle

Toggle

Toggle

Toggle

Toggle
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RibbonCommandToggleButton! VisualStyleEdgeOverhang

RibbonCommandToggleButton!VisualStylelntersectionEdge

RibbonCommandToggleButton!
Visual StyleObscuredEdge

RibbonCommandToggleButton!VisualStyles

Toggle

Toggle

Toggle

Toggle



RibbonCommandToggleButton! VisualStyleSilouetteEdgeJitter

Toggle

RibbonCommandToggleButton! XRayMode

Toggle

RibbonFindTextControl

Text
box and
button

RibbonLockingButton

Button
and
drop-
down
menu
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StatusBarPanesCheckList

Button
and
drop-
down
menu

TableStyleCombo

Drop-
down
list

TextStyleCombo

Drop-
down
list

TFontSizeCombo

Drop-
down
list

ViewPortList

Drop-
down
list

Visual StyleCombo

Drop-
down
list

VisualStyleEdgeColor

Drop-
down
list



VisualStyleEdgelJitterSlider Slider
VisualStyleEdgeOverhangSlider Slider
VisualStylelntersectionEdgeColor Drop-
down
list
VisualStyleObscuredEdgeColor Drop-
down
list
VisualStyleSilouetteEdgelJitterSlider Slider




See Also
m  Customize Ribbon Panels and Tabs

m  To add a control to a ribbon panel (Procedure)

m To reposition a control on a ribbon panel (Procedure)

m  To remove a control from a ribbon panel (Procedure)

m To change the properties of a gallery button on a ribbon panel
(Procedure)
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Customize the User Interface > Customize Ribbon Panels and Tabs > Add or
Switch Ribbon Panel Controls >

Add or Switch Ribbon Panel Controls
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To add a control to a ribbon panel

To reposition a control on a ribbon panel

To remove a control from a ribbon panel

To change the properties of a gallery button on a ribbon panel
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Customize the User Interface > Customize Ribbon Panels and Tabs >

Create and Edit Ribbon Tabs
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Ribbon tabs control the display and order of ribbon panels on the ribbon. You
add ribbon tabs to a workspace to control which ribbon tabs are displayed on the
ribbon.

Show Me: Create a Ribbon Tab

Click the Play arrow below the following image to start the animation.

The following animation shows how to create a ribbon tab, add ribbon panels to
a ribbon tab, and control the display of a ribbon tab on the ribbon through a
workspace.



Ribbon tabs do not contain any commands or controls like a ribbon panel does;
instead, they manage the display of ribbon panels on the ribbon. Once a ribbon
tab is created, you can then add references to any of the ribbon panels from the
Ribbon Panels node in the Customizations In <file name> pane to the ribbon
tab. References to a ribbon panels can be created by using copy and paste, or by
dragging a ribbon panel from the Ribbon Panels node onto the ribbon tab.

After references to ribbon panels are added to a ribbon tab, you can change to



order in which the ribbon panels appear by dragging them up or down under the
ribbon tab’s node in the Workspace Contents pane. The initial display order is set
by the order in which panels appear under the ribbon tab’s node in the
Customizations In <file name> pane. New ribbon tabs are added automatically
to all workspaces, just like new toolbars and menus are. If you do not want the
ribbon tab on the ribbon for a particular workspace, remove it from the
workspace using the Workspace Contents pane.

You use the Workspace Contents pane of the Customize User Interface Editor to
add and remove ribbon tabs from the ribbon, which is controlled by the current
workspace. Once a ribbon tab has been added to a workspace, you can control
the order in which the tab is displayed on the ribbon by expanding the Ribbon
Tabs node under the Workspace Contents pane. Drag the ribbon tab up or down
under the Ribbon Tabs node on the Workspace Contents pane to change the
display order.

A ribbon panel is displayed by default; you can keep its association to a specific
ribbon tab, but turn it off. Select the ribbon panel under the ribbon tab in the
Workspace Contents pane. You can also control a ribbon panel’s collapsing style
and orientation from the Workspace Contents pane.

The following table describes the properties for the Home - 2D ribbon tab as
they appear in the Properties pane.

Properties for the Home - 2D ribbon tab

Prope.rtles Description Example
pane item
Name Name of the tab; does not = Home - 2D
appear in the user
interface.
Display Text Title of the tab; displayed =~ Home

when the ribbon tab is
assigned to a workspace
and the Ribbon palette is
displayed.




Description Text used to describe the
element; does not appear
in the user interface.

Aliases Specifies the aliases for ID TabHome
the ribbon tab. Click the
[...] button to open the
Aliases dialog box. Each
alias in the CUI file
should be unique and it is
used to reference the
ribbon tab
programmatically.

Element ID Tag that uniquely UIDU_1158
identifies a panel.

Image ID string of the small- RCDATA_16_LINE
image resource (16 x 16
bitmap). The string must
include alphanumeric
characters with no
punctuation other than a
hyphen (-) or an
underscore (_). It can also
be a user-defined bitmap.
Click the [...] button to
open the Select Image
File dialog box.

See Also

m  Customize Ribbon Panels and Tabs

= Customize Workspaces
m  To create a ribbon tab (Procedure)

m  To remove a ribbon tab (Procedure)




To add a ribbon panel to a ribbon tab (Procedure)

To remove a ribbon panel from a ribbon tab (Procedure)

To set the initial position of a ribbon panel on a ribbon tab
(Procedure)
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Customize the User Interface > Customize Ribbon Panels and Tabs > Create and
Edit Ribbon Tabs >

Create and Edit Ribbon Tabs
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To create a ribbon tab

To remove a ribbon tab

To add a ribbon panel to a ribbon tab

To remove a ribbon panel from a ribbon tab

To set the initial position of a ribbon panel on a ribbon tab
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Customize the User Interface > Add Shortcut Keys and Temporary Override
Keys >

Add Shortcut Keys and Temporary Override Keys
[Corcr | B[ o e |

To create a shortcut key

To modify a shortcut key

To create a temporary override key

To modify a temporary override key

To print a list of shortcut keys or temporary override keys
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Customize the User Interface > Create a Double Click Action >

Create a Double Click Action
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To create a double click action

To modify a double click action
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Customize the User Interface > Create a Double Click Action >

Create a Double Click Action
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To modify a double click action

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, click the plus
sign (+) next to Double Click Actions to expand it.

3. Click a double click action.

f.zé Camera

-y Circle

Elf.zg Dimension

ik b gl Properties
-igy Blipse

iy Bdruded Surface
48y Hatch

In the Properties pane, the properties for the double click action you
selected are displayed.

4. In the Object Name box, enter a DXF name or one of the special object
names used for an inserted object.

E General
Mame Dimengion
Description

& Advanced
Object Mame DIMENSION

Element [D DC_D021

5. If you want to replace the current command assigned to the double click
action, click in the Command List pane and drag a different command to
the selected double click action in the Customizations In <file name>
pane.



(-4 Circle

EIE& Dimension 44

. g Propdgi

-4y Hlipse

E& Extruded Furface
&gy Hatch

>

o & ®

2l Dimension Edit
¢, Dimengion Text Edit

*'Ei Dim Style, Save gz New Shle...

Source

6. In the Customize User Interface Editor, click OK.
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Customize the User Interface > Customize Mouse Buttons > Accept Coordinate
Entry in Button Menus >

Accept Coordinate Entry in Button Menus
oo [ | ok e |

To add a mouse button combination

[
1. Click Tools tab » Customization panel » User Interface.
2. In the Customize User Interface Editor, click the Customize tab.

3. In the Customizations In <file name> pane, click the plus sign (+) next
to Mouse Buttons to expand the list.

4. Right-click a mouse button section. Click New Button.

i& Double Click Actions
EI'% Mouse Buttons
‘% Click

o EXESED

b + Buttor Mew Button

B + Buttor
- Cirl«Click Paste
-y Cirl+ Shift+ _

..... & LISP Files Find...

-5 Legacy Replace...
M- Partial CUI Files

A new mouse button (named Buttonn) is placed at the bottom of the
selected list.

5. In the Command List pane, drag the command you want to add to the
mouse button in the Customizations In <file name> pane.



‘% Click
EI'% Shift+Click N
i -9 Button 2: Snap Menu

b J Button 3: Transparent Orbit

“.-ge Button 4: <nonez 4

m

...'% Cirl+Click
-0y Ctri+Shift+Click
..... & LISP Files
-9 Legacy
&[T Partial CUI Files I~
f
Command List: / 2
7
All Commands ,\‘( v] x K
I
Command Source E
Quick Properties ACAD
Wi Quick Select...
QuickCalc gt
QuickCalc o
QVDrawing ACAD

6. Click OK.
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Customize the User Interface > Customize Mouse Buttons >

Accept Coordinate Entry in Button Menus
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When you click one of the buttons on a multibutton pointing device, the program
reads not only the button number but also the coordinate of the crosshairs at the
time you click. By carefully constructing macros, you can choose to either
ignore the coordinate or use it with the command activated by the button.

As described in Pause for User Input in Macros, you can include a backslash (\)
in a command to pause for user input. For the Mouse and Digitize Buttons
menus, the coordinate of the crosshairs is supplied as user input when the button
is clicked. This occurs only for the first backslash in the command; if the item
contains no backslashes, the crosshairs coordinate is not used. Consider the
following commands:

line
line \

The first button starts the LINE command and displays the Specify First Point
prompt in the normal fashion. The second button also starts the LINE command,

but the program uses the current crosshairs location at the Specify First Point
prompt and displays the Specify Next Point prompt.

See Also
m  Customize Commands

m  Create Macros

m  To add a mouse button combination (Procedure)
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Customize the User Interface > Customize Legacy Interface Elements > Create
Tablet Menus >

Create Tablet Menus
[Corcr | B[ o e |

To define rows and columns in a tablet menu

To clear a tablet menu assignment
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Customize the User Interface > Customize Legacy Interface Elements > Create
Tablet Menus >

Create Tablet Menus
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To define rows and columns in a tablet menu

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Legacy to expand the list.

Click the plus sign (+) next to Tablet Menus to expand the list.
Click the plus sign (+) next to a tablet menu to expand the list.
Click the row that you want to define.

In the Command List pane, locate the command you want to add.
Drag the command to a column.

Click OK.

® N o kW
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Customize the User Interface > Customize Legacy Interface Elements > Create
Tablet Menus >

Create Tablet Menus
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To clear a tablet menu assignment

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Legacy to expand the list.

3. Click the plus sign (+) next to Tablet Menus to expand the list.
4. Click the plus sign (+) next to a tablet menu to expand the list.

5. Right-click the row or column that you want to clear. Click Clear
Assignment.

6. Click OK.

Please send us your comment about this page
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Customize the User Interface > Customize Legacy Interface Elements > Create
Screen Menus >

Create Screen Menus
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To display the screen menu
1. Click Tools menu » Options.

2. In the Options dialog box, Display tab, under Window Elements, select
Display Screen Menu.

3. Click OK.

Please send us your comment about this page
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Customize the User Interface > Customize Legacy Interface Elements > Create
Screen Menus >

Create Screen Menus
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To set screen menus to reflect the current command
1. At the command prompt, enter menuctl.
2. Do one of the following:
= Enter 1 to set screen menus to reflect the current command.

= Enter 0 to set screen menus to ignore the current command.

Please send us your comment about this page
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Customize the User Interface > Customize Legacy Interface Elements > Create
Screen Menus >

Create Screen Menus
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To add commands to the screen menu

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Legacy to expand the list.

3. In the Legacy list, click the plus sign (+) next to a screen menu to
expand the list.

4. In the Command List pane, locate the command you want to add. Drag
the command to the screen menu. An arrow is displayed next to the
cursor when the command can be dropped.

5. Click OK.

Please send us your comment about this page
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Customize the User Interface > Customize Legacy Interface Elements > Create
Screen Menus >

Create Screen Menus
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To create a submenu on a screen menu

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Legacy to expand the list.

3. In the Legacy list, right-click Screen Menu. Click New Screen Menu.

A new screen menu (named ScreenMenul) is placed at the bottom of the
Screen Menus tree.

4. Do one of the following:
m Enter a new name over the default name ScreenMenul.

m Right-click ScreenMenul. Click Rename. Then, enter a new
menu name.

m Click ScreenMenul, wait, and click again over the screen menu’s
name again to edit its name in-place.

5. Select the new screen menu in the tree view, and update the Properties
pane as follows:

= In the Description box, enter a description for the screen menu.

= In the Start Line box, enter the line number for the first option in
the menu.

m In the Number of Lines box, enter the number of total lines that



should be available for the screen menu.
m In the Aliases box, enter an alias.

6. In the Command List pane, drag the command to a location just below
the screen menu in the Customizations In <file name> pane.

7. Click OK.
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Customize the User Interface > Customize Legacy Interface Elements > Create
Image Tile Menus >

Create Image Tile Menus
[Concer || || Qe Reference||

To create an image tile slide
1. In AutoCAD, draw the geometry that you want to appear in the slide.
2. Click Home tab » View panel » Center.
3. At the command prompt, enter mslide.
4. In the Create Slide File dialog box, specify the file name.
5

. Click Save, and add it to a slide library file if desired. You can associate
this image slide to a new image tile.

Please send us your comment about this page
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Customize the User Interface > Customize Legacy Interface Elements > Create
Image Tile Menus >

Create Image Tile Menus
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To view an image tile slide
1. At the command prompt, enter vslide.

2. In the Select Slide File dialog box, browse to and select the slide file you
want to view.

3. Click Open.

The slide file should be displayed in the drawing window. Perform a
Regen on the drawing to clear the slide file from the display.

Please send us your comment about this page
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Customize the User Interface > Customize Legacy Interface Elements > Create
Image Tile Menus >

Create Image Tile Menus
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To create an image tile slide library

1. Place all your slides in a single folder location that you want to add to a
slide library.

Click Start menu (Windows) » Run.
In the Run dialog box, enter cmd in the text box.

Click OK to bring up a DOS window.

A L

At the command prompt, enter CD <folder location of slides>.

As an example: CD “c:\slides”

6. While in the location of the slide files, enter dir *.sld /b > <file name>.
As an example: dir *.sld /b > “myslides”

A text file will be created with the names of the slide files contained in
the current folder.

7. With the text file created of all the slide files in the current folder, enter
<AutoCAD Install folder>\slidelib.exe <slide library file name> <
<text file with slide names>.

As an example: “C:\Program Files\AutoCAD
2009\slidelib.exe” “myslidelib” < “myslides”
8. When you finish, close the DOS window.

warning After you create the slide library, place the individual slide files in a safe
place so they do not accidently get deleted. This is important if you need to
rebuild the slide library one day.
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Customize the User Interface > Customize Legacy Interface Elements > Create
Image Tile Menus >

Create Image Tile Menus
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To create an image tile menu and assign an image tile slide

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Legacy to expand the list.

3. In the Legacy list, right-click Image Tile Menu. Click New Image Tile
Menu.

A new image tile menu (named ImageTileMenu1l) is placed at the
bottom of the Image Tile Menus tree.

4. Do one of the following:
= Enter a new name over the default name ImageTileMenul.

m Right-click ImageTileMenul. Click Rename. Then, enter a new
image tile name.

m Click ImageTileMenul, wait, and click again over the image tile’s
name again to edit its name in-place.

5. In the Command List pane, drag a command to the new image tile menu
in the Customizations In <file name> pane.

6. In the Properties pane, enter the properties for the new image tile slide as
follows:

m In the Name box, enter the text to display in the list box for the
image tile.



= In the Description box, enter a description for the image tile.

m In the Slide library box, enter the name of the image tile slide
library that contains the slide for the image tile. The image tile
slide library must be in one of the folders that defines the Support
File Search Path. If you do not have a slide library, but rather an
image tile slide file, you enter its name in the image tile slide
library box.

m In the Slide label box, enter the name of the image tile slide file
contained in the image tile slide library listed in the Slide library
box.

7. Click OK.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');
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You can configure up to four areas of your digitizing tablet as menu areas for
command input.

The nodes in the Customize User Interface (CUI) Editor are labeled Tablet Menu
1 through Tablet Menu 4 and define the macros associated with tablet selections.

The tablet menu areas that you define with the Cfg option of the TABLET
command are divided into equal-sized menu selection boxes, which are
determined by the number of columns and rows you specify in each area. These
tablet menu selection boxes correspond directly with the lines that follow the
Tablet section labels from left to right and top to bottom (whether or not they
contain text).

For example, if you configure a menu area for five columns and four rows, the
command on the line immediately following the Row label corresponds to the
left-most selection box in the top row. The program can recognize up to 32,766
commands in each tablet section, which should be more than enough for any
tablet menu.

You can add your own macros to the Macros cell in the Properties pane. The
command labels in this area correspond to the 225 boxes at the top of your tablet
template (rows A through I and columns 1 through 25). You can add a macro
using standard command syntax. The following table shows the Click mouse
button properties as they appear in the Properties pane.

Properties for the Tablet Menu 1

Properties pane .


ms-its:ACAD_ACR.chm::/TABLET.htm

Aliases

Specifies the aliases for TABLETI,

the tablet menu. Click the TABLET1STD
[...] button to open the

Aliases dialog box. Each

alias in the CUI file

should be unique and it is

used to reference the

tablet menu

programmatically.

Rows

Number of rows that can 9
be customized for the
tablet menu.

Columns

Number of columns that 25
can be customized for the
tablet menu.

See Also

Customize Commands

Create Macros

To define rows and columns in a tablet menu (Procedure)

To clear a tablet menu assignment (Procedure)
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Customize the User Interface > Customize Legacy Interface Elements >
Customize Tablet Buttons

[_concrr )T

To customize tablet buttons, you follow the same procedures as for customizing
mouse buttons.

Tablet buttons are the buttons that are found on the pointing device, also known
as a puck, used with a digitizer tablet. Pucks come in a variety of shapes, sizes,
and button configurations. You can customize all the buttons on a puck except
for the first button.

Some hardware manufacturers utilize a slightly different button layout from one
puck to another. One might start with the first button in the upper-left corner and
count across and down from 1 through F, while another might start in the upper-
left corner and have a different numbering scheme.

Note It is important to test your button assignments as they are assigned to ensure
the proper button is being mapped. You may need to refer to your owners
manual that came with your puck for how the buttons are laid out.

To customize tablet buttons, you follow the same procedures as for customizing
mouse buttons.

For more information about customizing tablet buttons, see Customize Mouse
Buttons.
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Customize the User Interface > Customize Legacy Interface Elements >
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Screen menus provide a legacy interface for displaying menus in a palette. You
create and edit screen menus in the Customize User Interface (CUI) Editor.

By default, the screen menu is disabled. You turn on the screen menu display in
the Options dialog box, Display tab. In addition, the MENUCTL system variable
controls whether the screen menu is updated as you enter commands at the
command prompt.

Note Future releases of the product will not support screen menus.

In the Customize User Interface (CUI) Editor, each screen menu consists of
several menu lines, which define the screen submenus. You assign a submenu to
a screen menu by dragging it to the screen menu in the Customize In pane. You
assign a command to a menu by dragging it from the Command List pane to the
numbered line in the menu. Unassigned lines are left empty in the menu.

Edit Screen Menu Properties

You can modify screen menu properties, as shown in the following table.

Properties for screen menus

Name Sets the name of SCREEN
the menu.
Description Text that describes

the element; does



not appear in the
user interface.

Start line Sets the start line of 1
the screen menu
submenu.

Number of lines Sets the number of 26
lines in a screen
submenu.

Aliases Specifies the alias SCREEN, S

for the screen

menu. “Collection”

is displayed if

multiple definitions

are assigned to this

alias. Click the [...]

button to open the

Aliases dialog box.

For the AutoCAD screen menu, which is the root menu, the aliases in the Aliases
box are Screen (which represents the beginning of the screen menu) and S
(which represents the submenu section label). Line assignments for other menus
define the order of the options on the menu. For example, the File menu on Line
3 in the tree view of the AutoCAD screen menu is in the third position on the
AutoCAD screen menu.

The submenu names in the tree view correspond to the name of the first
submenu item. For example, the New submenu contains commands such as
OPEN, QSAVE, and SAVEAS—in addition to NEW. The Aliases box for these
submenus defines which menu contains them and the Start Line box specifies
their position on that menu. The New submenu is displayed in position 3 on the
File screen menu. Therefore, in the Properties pane, its start line is 3. When you
double-click Aliases to display the Aliases dialog box, you can see that its menu
assignment is 01_FILE.

You can designate which menu items are always displayed by controlling the



start line settings. For example, since the New submenu is set to start on line 3,
the menu items on lines 1 and 2 of the AutoCAD screen menu (the AutoCAD
and **** menu options) continue to display when the New submenu is
displayed.

Similarly, you can set a menu to mask or show menu options on other menus by
using blank lines. For example, there are only 22 lines (including blank lines)
defined for the New submenu. Therefore, the Assist and Last submenus on lines
25 and 26 of the AutoCAD screen menu continue to be displayed when the New
submenu is selected. An option on line 22, however, would be hidden.

See Also
m  Customize Commands

m  (Create Macros

m To display the screen menu (Procedure)

m To set screen menus to reflect the current command (Procedure)

m  To add commands to the screen menu (Procedure)

m To create a submenu on a screen menu (Procedure)
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Customize the User Interface > Customize Legacy Interface Elements > Create
Screen Menus >

Create Screen Menus
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To display the screen menu

To set screen menus to reflect the current command
To add commands to the screen menu

To create a submenu on a screen menu
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Customize the User Interface > Customize Legacy Interface Elements >
Create Image Tile Menus
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The purpose of an image tile menu is to provide an image that can be selected
instead of text. You can create, edit, or add image tiles and image tile slides.

An image tile dialog box displays images in groups of 20, along with a scrolling
list box on the left that displays the associated slide file names or related text. If
an image tile dialog box contains more than 20 slides, the additional slides are
added to a new page. Next and Previous buttons are activated so that you can
browse the pages of images.

The following is an example of an image tile menu.

i
i

gt
=g
g

You define an image tile menu in the Customize User Interface (CUI) Editor.
The following table shows the properties for an image tile menu.

Properties for the Tiled Viewport Layout image tile menu

Properties pane .

Name String that is used only in ~ Tiled Viewport Layout
the CUI Editor and is not
displayed in the user



interface.

Description Text that describes the
element and does not
appear in the user
interface.

Aliases Specifies the aliases for image_vporti
the image tile menu.
Click the [...] button to
open the Aliases dialog
box. Each alias in the
CUI file should be unique
and it is used to reference
the image tile menu
programmatically.

The following table shows the properties for an image tile slide.

Properties of the Four: Equal tile slide on the Tiled Viewport Layout
image tile menu

Name String displayed in the Four:
list box on the left side of  Equal
the image tile menu
dialog box. The string
must include
alphanumeric characters
with no punctuation other
than a hyphen (-) or an
underscore (_).

Command Name The name of the Tiled



Description

Macro

Element ID

Slide library

Slide label

command as it appears in
the Command List pane.

Text that describes the
element; does not appear
in the user interface.

The command macro. It
follows the standard
macro syntax.

Tag that uniquely
identifies a command.

A file that is made up of
multiple slides and
created using the file
slidelib.exe.

Name of a slide contained
in the slide library file or
a slide image that is
stored separately.

Viewports,
Four:
Equal

ACAC-
vports 4

MM_0427

acad

vport-4

You can use any slide generated by AutoCAD as an image. Keep the following

suggestions in mind as you prepare slides for an image tile menu.

m  Keep the image simple. When an image tile menu is displayed, you
must wait for all images to be drawn before making a selection. If you
show numerous complex symbols, use simple, recognizable images

rather than full renditions.

= Fill the box. When making a slide for an image, be sure to fill the screen
with the image before starting MSLIDE. If the image is very wide and
short, or long and thin, the image tile menu will look best if you use
PAN to center the image on the screen before making the slide.

Images are displayed with an aspect ratio of 3:2 (3 units wide by 2 units


ms-its:ACAD_ACR.chm::/MSLIDE.htm

high). If your drawing area has a different aspect ratio, it can be difficult
to produce image slides that are centered in the image tile menu. If you
work within a layout viewport that has an aspect ratio of 3:2, you can
position the image and be assured that it will look the same when it is
displayed in the image tile menu.

=  Remember the purpose of the images. Do not use images to encode
abstract concepts into symbols. Image tiles are useful primarily for
selecting a graphic symbol.

See Also
m  Customize Commands
m  (Create Macros

m  To create an image tile slide (Procedure)
m  To view an image tile slide (Procedure)

m  To create an image tile slide library (Procedure)

m To create an image tile menu and assign an image tile slide
(Procedure)

Please send us your comment about this page
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Customize the User Interface > Customize Legacy Interface Elements > Create
Image Tile Menus >

Create Image Tile Menus
[Concer || || Qe Reference||

To create an image tile slide

To view an image tile slide

To create an image tile slide library

To create an image tile menu and assign an image tile slide

Please send us your comment about this page
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Customize the User Interface > Load an AutoL.ISP File >

L.oad an AutoL.ISP File
[ concere ||| cuic Refeence |

To load an AutoLISP file in the Customize User Interface Editor

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click LISP Files. Click Load

LISP.
% Mouse Buttons
..... @
-5 Legacy Load LISP
@ Partial C
Find...
Replace...

3. In the Load LISP dialog box, locate and select the AutoLISP file you
want to load. Only files with the extension LSP can be selected.

Tip Even though files with the LSP extension can only be loaded using
this method, you can still load other types of custom program files. Use

AutoCAD commands such as NETLOAD, VBALOAD, or ARX to load
other types of custom program files.

4. Click Open.

Please send us your comment about this page
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Customize the User Interface > Customize Workspaces >
Customize Workspaces

[ conce || L] vick Rooronce |

To create a workspace using the Customize User Interface Editor

To create a workspace using the Workspace toolbar

To change the properties of a workspace

To modify the Quick Access toolbar

To display menus on the menu browser or menu bar

To reposition menus on the menu browser or menu bar

To display toolbars
To change the properties of a toolbar

To display ribbon tabs

To reposition a ribbon tab on the ribbon

To reposition a ribbon panel on a ribbon tab

To control the display of ribbon panels for a ribbon tab

To change the properties of a palette

To duplicate a workspace

To set a workspace current

To set a workspace as default

To restore a workspace with a command line switch
To import a workspace to a main CUI file




Please send us your comment about this page
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DIESEL >

DIESEL Expressions in Macros
[ concepe | IRCHETRNE)

You can use DIESEL string expressions in customization (CUI) files as an
additional method of creating macros.

These expressions can return string values (text strings) in response to standard

AutoCAD commands, AutoLISP and ObjectARX® routines, and other macros.
They can also return string values to the menu itself, thereby altering the
appearance or content of a menu label.

This string provides a way to toggle between paper space and model space if
TILEMODE is set to 0. This expression is evaluated transparently. If the special
character AP (which toggles MENUECHO on and off) is omitted, the expression
displays only the issued command.

A DIESEL expression that you use in a menu item must follow the
$section=submenu format where the section name is M and the submenu is
the DIESEL expression you want. Frequently, you can implement a macro more
easily with AutoLISP.

The following examples show two menu items that produce the same result; one
uses DIESEL, and the other uses AutoLISP.

This menu item uses the DIESEL expression:

ACACAPSM=$(if, $(=, $(getvar,cvport), 1), mspace, pspace)

This menu item uses the AutoLISP expression:

ACACAP(1if (= (getvar '"cvport") 1)(command "mspace")+
(command "pspace"))(princ) AP

Both menu items provide a way to switch between paper space and model space
(if TILEMODE is set to 0), but the DIESEL expression is shorter and is



evaluated transparently, not requiring the call to the AutoL.ISP princ function.
If the special character AP (which switches MENUECHO on and off) is omitted
in both cases, the DIESEL expression displays only the issued command,
whereas the AutoLISP expression displays the entire line of code.

Because the value returned by a DIESEL expression is a text string, it can be
used in response to an AutoLISP getxxx function call. This functionality
enables menu items to evaluate current drawing conditions and to return a value
to an AutoLISP routine.

The next example is based on these assumptions:
m  The AutoLISP routine is loaded into memory.
m  The CUI excerpt is included in the current customization file.
m  The symbols to insert are one unit high by one unit wide.

m  The DIMSCALE variable is set to the drawing's scale factor (that is, a
drawing to be plotted at a scale of 1" = 10" would have a scale factor of
120, or a 1/4" = 1' scale drawing would have a scale factor of 48).

If you load and execute the sample AutoLISP routine, AutoCAD inserts the
symbol at the size and location you have specified. When plotted, the symbols
are the specified size (if the drawing is plotted at the same scale as that specified
by DIMSCALE).

The following is a sample AutoLISP routine.

(defun C:SYMIN ( )
(setg sym
(getstring
"\nEnter symbol name: ") ; Prompts for a symbol name
)

(menucmd "s=symsize") ; Switches the screen menu
;  to the symsize submenu
(setq
siz (getreal
"\nSelect symbol size: ") ; Prompts for a symbol size
pl (getpoint
"\nInsertion point: ") ; Prompts for insertion point
)

(command "insert" ; Issues the INSERT command
sym ; using the desired symbol
pl siz siz 0) ;  lnsertion point, and size



(menucmd "s=") ; Switches to the previous
;  SCreen menu
(princ) ; Exits quietly
)

Note An AutoLISP routine that you use regularly should include error checking to
verify the validity of user input.

The DIESEL expressions in the following example multiply the current value of
DIMSCALE by the specified value, and return an appropriate scale factor.

This cannot be done with similar AutoLISP code; a value returned by an
AutoLISP expression cannot typically be used as a response to a getxxx
function call (such as, the getreal function in the preceding sample).

$M=$(*, $(getvar,dimscale), 0.375)
$M=$(*, $(getvar,dimscale), 0.5)
$M=$(*, $(getvar,dimscale), 0.625)

DIESEL expressions can also return string values to pull-down menu item
labels, so that you can make menus unavailable or otherwise alter the way they
are displayed. To use a DIESEL expression in a pull-down menu label, make
sure that the first character is the $ character.

In the next example, the current layer is set to BASE and the following DIESEL
expression is used as the label.

$(eval, "Current layer: " $(getvar,clayer))

The result is that the appropriate pull-down menu is displayed and updated
whenever the current layer changes.

Current Layer: BASE

You can also use this method to interactively change the text displayed in a pull-
down menu. You use an AutoLISP routine that sets the USERS1-5 system
variables to the selected text, which can be retrieved by a DIESEL macro in a
menu label.

Note The width of pull-down and shortcut menus is determined when the

customization file is being loaded. Menu labels generated or changed by

DIESEL expressions after a menu is loaded are truncated to fit within the
existing menu width.

If you anticipate that a DIESEL-generated menu label will be too wide, you can



use the following example to ensure that the menu width will accommodate your
labels. This example displays the first 10 characters of the current value of the
USERS3 (USERS1-5) system variable.

$(eval, "Current value: " $(getvar,users3))+
$(if, $(eq, $(getvar,users3d),""), 10 spaces )"CACusers3

You cannot use trailing spaces in a menu label to increase the menu width,
because trailing spaces are ignored while the menu is being loaded. Any spaces
you use to increase the width of a menu label must be within a DIESEL
expression.

The next example uses the same DIESEL expression as the label and a portion of
the menu item. It provides a practical way to enter the current day and date into a
drawing.

$(edtime, $(getvar,date),DDD", "D MON YYYY)ACACtext +
\\\ $M=$(edtime, $(getvar,date),DDD", "D MON YYYY);

Also, you can use a DIESEL macro to mark pull-down menu labels or make
them unavailable. The following pull-down menu label displays an unavailable
ERASE while a command is active. The text is displayed normally when a
command is not active.

$(if,$(getvar,cmdactive), ~)ERASE

You can use a similar approach to place a mark beside a pull-down menu item or
to interactively change the character used for the mark.

Please send us your comment about this page
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DIESEL >

DIESEL Error Messages
[__concepr )RR

Generally, if you make a mistake in a DIESEL expression, what went wrong will
be obvious. Depending on the nature of the error, DIESEL embeds an error
indication in the output stream.

Error message Description

$? Syntax error (usually a missing right parenthesis or a
runaway string)

$(func,??) Incorrect arguments to func
$(func)?? Unknown function func
$(++) Output string too long—evaluation truncated

Please send us your comment about this page
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DIESEL > Customize the Status Line >

Overview of the MODEMACRO System Variable
ST uick Reference ||

The status line can provide the user with important information without
interrupting the work flow. The MODEMACRO system variable controls the
user-defined area on the status line. The calculated value of the MODEMACRO
system variable is displayed in a left-aligned panel in the status bar at the bottom
of the AutoCAD® window. This variable is set to the null string when you start
AutoCAD. Its value is not saved in the drawing, the configuration file, or
anywhere else.

The number of characters displayed on the status line is limited only by the size
of the AutoCAD window (and your monitor). The default panels move to the
right as the content of the MODEMACRO panel grows. It is possible to push the
default panels completely off the screen (if you want to).

You can use the MODEMACRO system variable to display, in the status line,
most data known to AutoCAD. With its calculation, decision, and editing
facilities you can compose the status line to your precise specifications.

MODEMACRO is a user-string variable. It can be set to any string value. The
maximum string value is 4095 characters. You can set MODEMACRO with
SETVAR or by entering modemacro at the command prompt. If you modify the
MODEMACRO setting, you can experiment with various status line formats;
however, the maximum number of characters you can enter in this manner is
255.

If you set MODEMACRO to the null string by entering a period (.), AutoCAD
displays the standard status line.

Please send us your comment about this page
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DIESEL > Customize the Status Line >

Set MODEMACRO Values
(TSI | Quick Reference ||

You can use text strings and DIESEL to display messages in the user-defined
section of the status line.

The value of MODEMACRO determines what is displayed in the mode status
line. The simplest (and least useful) MODEMACRO consists of constant text.
For example, to display a company name in the status line, you enter the
following:

Command: medemacro

New value for MODEMACRO, or . for none <"">: Greg's Bank and Grill

This MODEMACRO value always displays the same text; the status line does

not reflect changes to the AutoCAD internal state. It doesn't change until you
change MODEMACRO.

To make the status line reflect the AutoCAD current state, enter macro
expressions using the DIESEL language in the following format:

$(somefun, argl, arg2, ...)

In the macro expression, somefun is the name of the DIESEL function (similar
to an AutoLISP function name) and argl, arg2, and so on, are arguments to
the function, interpreted according to the function's definition. Unlike AutoLISP,
DIESEL macro expressions have only one data type: strings. Macros that operate
on numbers express the numbers as strings and convert back and forth as
required.

For descriptions of the DIESEL functions, see Catalog of DIESEL Functions.

Now define a more interesting status line (for example, one that shows the
current text style name):

Command: modemacro



New value for MODEMACRO, or . for none <"">: Style: $(getvar, textstyle)

m  Style: is a text string to be displayed on the status line.

= $(getvartextstyle) is a DIESEL function (getvar) and argument that
retrieves the current value of the TEXTSTYLE system variable.

Note The examples in this topic may show the MODEMACRO string as more
than one line of text. You enter it as one long string at the prompt.

You can retrieve any system variable by entering $(getvar, varname). The
current setting of the system variable replaces the macro expression on the status
line. Then, when you switch text styles, for example, MODEMACRO is
reevaluated. If it changes, the new text style name is displayed on the status line.

Expressions can be nested, and they can be as complex as you want. The
example that follows displays the current snap value and angle (in degrees) in
the status line. It uses nested expressions to convert the snap angle from radians
to degrees and truncates the value to an integer.
Command: modemacro
New value for MODEMACRO, or . for none <"">: Snap: $(getvar, snapunit)
$(fix,$(*,$(getvar,snapang),$(/,180,3.14159)))
You can also display the values in the current linear and angular units modes.
Command: modemacro
New value for MODEMACRO, or . for none <"">: Snap: $(rtos,$(index,0,
$(getvar,snapunit))),$(rtos,$(index,1,$(getvar,snapunit))) $(angtos,

$(getvar,snapang))

DIESEL copies its input directly to the output until it comes to the dollar sign
character ($) or a quoted string. You can use quoted strings to suppress
evaluation of character sequences that would otherwise be interpreted as
DIESEL functions. You can include quotation marks in quoted strings by using
two adjacent quotation marks. In the following example, the current layer is set
to LAYOUT, and MODEMACRO is set to the string.

Command: modemacro

New value for MODEMACRO, or . for none <"">: "$(getvar,clayer)= """ $(getvar,clayer)" """

The status line displays the following:
$(getvar,clayer)="LAYOUT"
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DIESEL > Customize the Status Line >

Set MODEMACRO with AutoLISP

Concept

Another way to set MODEMACRO values is to use AutoLISP.

You can save the code samples shown here as ASCII format text files and load
them with the AutoLISP 1oad function.

The following AutoLISP command defines a MODEMACRO string that
provides similar information to that in the built-in status line. Because AutoLISP
cannot continue strings from line to line, you use the AutoLISP strcat
function to assemble the complete MODEMACRO string from shorter
component strings.

(defun C:ACADMODE ( )
(setvar "modemacro"
(strcat
"Layer $(substr,$(getvar,clayer),1,8)"
"$(if, $(getvar,orthomode), Ortho)"
"$(if, $(getvar, snapmode), Snap)"
"$(if, $(getvar, tabmode), Tablet)"
"$(if, $(=,$(getvar, tilemode),0),"
"$(if, $(=, $(getvar,cvport),1), P)"
ll)ll

)

Save this AutoLISP routine in a file called acadmode.lsp. When you load the
routine and execute it, it displays information on the status line. This is not the
most useful application of this feature; it is provided only as an example.

The following sample acad.lsp file uses the S: : STARTUP function to set the
MODEMACRO variable to a string defined by the AutoLISP file model.Isp.

;7 Sample acad.lsp file that uses S::STARTUP to load the



;;; file MODE1.LSP which defines a MODEMACRO string
(defun S::STARTUP ( )

(load "model")

(princ)
)
;+; Additional AutoLISP files can also be defined or
;;; loaded here

When the AutoLISP file (model.lIsp) is loaded, it uses the MODEMACRO
system variable to define a status line that displays L: followed by the first eight
characters of the layer name, the drawing name and a portion of the path, and the
first letter of each name of the currently active modes. The position of the
drawing name remains constant, regardless of the length of the layer name.

;;; MODE1.LSP
Zéétvar "modemacro"
(strcat
"L:$(substr,$(getvar,clayer),1,30)"
"$(substr, ,1,%(-,30,%(strlen, $(getvar,clayer)))) "
M ANAANANN Note the 8 spaces here
I|<. .ll
"$(if, $(eq, $(getvar, dwgname), UNNAMED) , UNNAMED, "
"$(substr,$(getvar, dwgname), "
"$(if,$(>,$(strlen, $(getvar,dwgprefix)),29),"
"$(-,$(strlen,$(getvar,dwgprefix)),29),1"
ll),"
"$(strlen, $(getvar, dwgname))"

ll)ll

mn ) "
I|>II
"$(if, $(getvar,orthomode), 0, )"
"$(if, $(getvar, snapmode), S, )"
"$(if, $(getvar, tabmode), T, )"
"$(if,$(and, "

"$(=,%(getvar, tilemode), 0),$(=, $(getvar,cvport),1)),P)"

)

)
Indenting code improves the readability of AutoLISP files and DIESEL strings.

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >
+ (addition)
[_concepe | NN

Returns the sum of the numbers vali, val2, ..., valo.

$(+, val1 [, valz, .., val9])

If the current thickness is set to 5, the following DIESEL string returns 15.

$(+, $(getvar,thickness),10)

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

- (subtraction)

[_concrr ) CHETETERRE)

Returns the result of subtracting the numbers val2 through val9 from vali.

$(-, vali1 [, valz , .., val9])

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

* (multiplication)

[_concrr )T

Returns the result of multiplying the numbers vali, val2, ..., val9.

$(*, val1 [, valz, .., val9])

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

/ (division)

[_concrr )T

Returns the result of dividing the number vall by val2, ..., valo.

$(/, val1 [, valz, .., val9])

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

= (equal to)
[_concepe | IRCHCRRNOSN)

If the numbers vall and valZ are equal, the string returns 1; otherwise, it
returns 0.

$(=, vali, val2)

Please send us your comment about this page
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< (less than)">
DIESEL > Catalog of DIESEL Functions >
< (less than)

| Concor | (IRGGEEE|

If the number vall is less than val2, the string returns 1; otherwise, it returns
0.

$(< , vall, val2)

The following expression gets the current value of HPANG,; if the value is less
than the value stored in the system variable USERR1, it returns 1. If the value
10.0 is stored in USERR1 and the current setting of HPANG is 15.5, the
following string returns O.

$(<, $(getvar,hpang),$(getvar,userri))

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

> (greater than)

[_concrr ) CHEETRRE)

If the number vall is greater than val2, the string returns 1; otherwise, it
returns 0.

$(>, vali, val2)

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

I= (not equal to)

[_concrr )T

If the numbers vall and valZ are not equal, the string returns 1; otherwise, it
returns 0.

$(!=, vali, valz)

Please send us your comment about this page
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<= (less than or equal to)">

DIESEL > Catalog of DIESEL Functions >

<= (less than or equal to)
| Concor | (IRGGEEE|

If the number vall is less than or equal to valZ2 , the string returns 1;
otherwise, it returns 0.

$(<=, vali, val2)

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

>= (greater than or equal to)

[_concrr ) CHETETERE)

If the number vall is greater than or equal to val2, the string returns 1;
otherwise, it returns 0.

$(>=, vali, valz)

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

and

[_concrr )T

Returns the bitwise logical AND of the integers vall through valo.

$(and, vali1 [, valz,.., val9])

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

DIESEL > Catalog of DIESEL Functions >
angtos

[_concrr ) CHETETRE)

Returns the angular value in the format and precision specified.

$(angtos, value [, mode, precision])

Edits the given value as an angle in the format specified by the mode and
precision as defined for the analogous AutoLISPfunction. (The values for
mode are shown in the following table.) If mode and precision are omitted,
it uses the current values chosen by the UNITS command.

String format

0 Degrees

1 Degrees/minutes/seconds
2 Grads

3 Radians

4 Surveyor's units

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >
edtime

[_concrr )T

Returns a formatted date and time based on a given picture.

$(edtime, time, picture)

Edits the AutoCAD Julian date given by time (obtained, for example, from
$(getvar,date) according to the given picture). The picture consists
of format phrases replaced by specific representations of the date and time.
Characters not interpretable as format phrases are copied literally into the result
of $(edtime). Format phrases are defined as shown in the following table.
Assume that the date and time are Saturday, 5 September 1998 4:53:17.506.

mm

D 5 H 4
DD 05 HH 04
DDD Sat MM 53
DDDD Saturday SS 17
M 9 MSEC 506
MO 09 AM/PM AM

MON Sep am/pm am




MONTH September A/P A

YY 98 a/p a

YYYY 1998

Enter the entire AM/PM phrase as shown in the preceding table; if AM is used
alone, the A will be read literally and the M will return the current month.

If any AM/PM phrases appear in the picture, the H and HH phrases edit the time
according to the 12-hour civil clock (12:00-12:59 1:00-11:59) instead of the 24-
hour clock (00:00-23:59).

The following example uses the date and time from the preceding table. Notice
that the comma must be enclosed in quotation marks because it is read as an
argument separator.

$(edtime, $(getvar,date),DDD"," DD MON YYYY - H:MMam/pm)

It returns the following:
Sat, 5 Sep 1998 - 4:53am

If time is 0, the time and date at the moment that the outermost macro was
executed is used. This avoids lengthy and time-consuming multiple calls on
$(getvar, date) and guarantees that strings composed with multiple
$(edtime) macros all use the same time.

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

€q
[_concrr TR

If the strings vall and valZ2 are identical, the string returns 1; otherwise, it
returns 0.

$(eq, vali, val2)

The following expression gets the name of the current layer; if the name matches
the string value stored in the USERS1 (USERS1-5) system variable, it returns 1.
Assume the string "PART12" is stored in USERS1 and the current layer is the
same.

$(eq, $(getvar,usersl),$(getvar,clayer))Returns 1

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

eval

[_concrr )T

Passes the string St r to the DIESEL evaluator and returns the result of
evaluating it.

$(eval, str)

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

fix

[_concrr )T

Truncates the real number value to an integer by discarding any fractional part.

$(fix, value)

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

getenv

[_concrr )RR

Returns the value of the environment variable varname.

$(getenv, varname)

If no variable with that name is defined, it returns the null string.

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

getvar

[_concrr )RR

Returns the value of the system variable with the given varname.

$(getvar, varname)

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >
if
[_concepe | ICHENCRTENENN)

Conditionally evaluates expressions.

$(if, expr, dotrue [, dofalse])

If expr is nonzero, it evaluates and returns dotrue. Otherwise, it evaluates
and returns dofalse. Note that the branch not chosen by expr is not
evaluated.

Please send us your comment about this page
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DIESEL > Catalog of DIESEL Functions >

index

[_concrr )T

Returns the specified member of a comma-delimited string.

$(index, which, string)

Assumes that the St ring argument contains one or more values delimited by
the macro argument separator character, the comma. The which argument
selects one of these values to be extracted, with the first item numbered 0. This
function is most frequently used to extract X, Y, or Z coordinate values from
point coordinates returned by $(getvar).

Applications can use this function to retrieve values stored as comma-delimited
strings from the USERS1-5 system variables.
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DIESEL > Catalog of DIESEL Functions >

nth
[_concept | [CHTIERERIORN)

Evaluates and returns the argument selected by which.

$(nth, which, arge [, argi,.., arg7])

If which is 0, nth returns argo, and so on. Note the difference between
$(nth) and $(1index); $(nth)returns one of a series of arguments to the
function, while $ (index) extracts a value from a comma-delimited string
passed as a single argument. Arguments not selected by which are not
evaluated.
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DIESEL > Catalog of DIESEL Functions >

or

[_concrr )T

Returns the bitwise logical OR of the integers vall through valg.

$(or, vaii [, valz,.., val9])
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javascript:doComments('./html/ac.cmtdialog.htm');

DIESEL > Catalog of DIESEL Functions >

Itos
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Returns the real value in the format and precision specified.

$(rtos, value [, mode, precision])

Edits the given value as a real number in the format specified by the mode and
precision as defined by the analogous AutoLISP function. If mode and
precision are omitted, it uses the current values selected with the UNITS
command.

Edits the given value as a real number in the format specified by mode and
precision. If mode and precision are omitted, it uses the current values
selected with the UNITS command.
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DIESEL > Catalog of DIESEL Functions >
strlen

[_concrr )T

Returns the length of string in characters.

$(strlen, string)
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DIESEL > Catalog of DIESEL Functions >

substr

[_concrr )T

Returns the substring of st ring, starting at character start and extending for
length characters.

$(substr, string, start [, length])

Characters in the string are numbered from 1. If Iength is omitted, it returns
the entire remaining length of the string.
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DIESEL > Catalog of DIESEL Functions >

upper
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Returns the string converted to uppercase according to the rules of the current
locale.

$(upper, string)
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DIESEL > Catalog of DIESEL Functions >

XO0r
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Returns the bitwise logical XOR of the integers val1l through val9.

$(xor, vali1 [, valz,.., val9])
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Slides and Command Scripts >
Create Slides
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Slides are snapshots of drawing files. You can use slides for giving presentations,
creating custom image tile menus, and viewing an image of another drawing
while you work.

Topics in this section

s Overview of Slides

A slide is a snapshot of a drawing. Although it contains a picture of the
drawing at a given instant, it is not a drawing file.

m  View Slides

You can view slides individually using VSLIDE. To view a series of
slides for a presentation, use a script file.

m  Create and View Slide Libraries

A slide library is a file containing one or more slides. Slide library files
are used for creating custom image tile menus and for combining several
slide files for convenient file management.
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Slides and Command Scripts >
Create Command Scripts
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A script is a text file that contains a series of commands. Common uses for
scripts are to customize startup and to run slide shows.

Topics in this section

m  Overview of Command Scripts

=  Run Scripts at Startup
A script that runs at startup can open a drawing and change its settings.

= Run Slide Shows from Scripts

Scripts are useful for creating slide shows.
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Customize the User Interface > Customize Workspaces >
Customize Workspaces
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To import a workspace to a main CUI file

1. Click Tools tab » Customization panel » User Interface. I

The Transfer tab is displayed, with the main CUI file displayed in the
Customizations In pane (left side).

2. On the Transfer tab, in the Customizations In <file name> pane (right
side), click the Open Customization File button.

2@ H

3. In the Open dialog box, locate and select the customization file that
contains the workspace you want to add.

4. In the right pane, drag the workspace from the CUI file to the
Workspaces node in the main CUI file (left pane).



P

El Customize User Interface

Trnsle

Customizations in Main CUT ‘ Customizations in New CUI File
Main CU| File (acad.cui) "] é E? New CUI File
=48 Workspaces 4 & -8 Workspaces
----- £ 2D Drafting &\hﬂnutation Default (cument) LN
L% 3D Modeling %= Toolbars
Lk AutoCAD Classic - Menus
#-%E= Toolbars &-¥=3 Ribbon Tabs
H-ZE Menus &-£57 Ribbon Panels
-7 Ribbon Tabs - Quick Properties
#-57 Ribbon Panels -5 Rollover Tooltips
----- & Quick Properties -l Shortcut Menus
----- & Rollover Tooltips ---'_I'_I Keyboard Shortcuts
[-RfE Shortcut Menus -5y Double Click Actions
[+-02 Keyboard Shortcuts % Mouse Buttons
[ L= o PSR B EJN PR, PO nien ren

5. Click OK.
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Slides and Command Scripts > Create Slides > Overview of Slides >

Overview of Slides

[ conce || L] vk Roeronce |

To make a slide
1. Display the view you want to use for the slide.
2. At the command prompt, enter mslide.

3. In the Create Slide File dialog box, enter a name and select a location for
the slide.

AutoCAD offers the current name of the drawing as a default name for
the slide and automatically appends the .sld file extension.

4. Click Save.

The current drawing remains on the screen, and the slide file is saved in
the folder that you specified.

Please send us your comment about this page
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Slides and Command Scripts > Create Slides > View Slides >

View Slides
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To view a slide
1. At the command prompt, enter vslide.

2. In the Select Slide File dialog box, select a slide to view and click OK.

The slide image is displayed in the drawing area.

3. Click View menu » Redraw.

The slide image disappears.
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Slides and Command Scripts > Create Slides > Create and View Slide Libraries >

Create and View Slide Libraries
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To create a slide library

1. Use a Windows ASCII text editor to create a list of slide files to include
in the library. The file would look similar to this example:

entrance.sld
hall.sld
stairs.sld
study.sld
balcony.sld

2. Name and save the file as a text file with a .txt file extension.

3. Click Start menu (Windows) » All Programs (or Programs) »
Accessories » Command Prompt.

4. In the Command Prompt window, at the prompt, enter CD <folder
location of slides> to change folders.

As an example: CD “c:\slides”

5. At the prompt, enter the following syntax to create the slide library:
slidelib libraryname < 1list.txt

For example, if you named your text file areas.txt, you could create a
library called house.slb by entering slidelib house < areas.txt. The
SLIDELIB utility appends the file extension .slb to the slide library file.

Please send us your comment about this page
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Slides and Command Scripts > Create Slides > Create and View Slide Libraries >

Create and View Slide Libraries
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To view a slide in a slide library
1. At the command prompt, enter filedia.
2. Enter 0 and press ENTER.
3. At the command prompt, enter vslide.
4

. Enter library(slidename) to specify the slide.

For example, enter house (balcony) to open the balcony slide, which is
stored in the house slide library file.

5. To remove the slide from the display, click View menu » Redraw.
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Slides and Command Scripts > Create Slides >
Overview of Slides
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A slide is a snapshot of a drawing. Although it contains a picture of the drawing
at a given instant, it is not a drawing file.

You cannot import a slide file into the current drawing, nor can you edit or print
a slide. You can only view it.

You can use slide files in the following ways:

= For making presentations within AutoCAD®

m For viewing a snapshot of a drawing while working on a different
drawing

m  For creating menus of image tiles within a dialog box

You create a slide by saving the current view in slide format. A slide created in
model space shows only the current viewport. A slide created in paper space
shows all visible viewports and their contents. Slides show only what was
visible. They do not show objects on layers that were turned off or frozen or
objects in viewports that were turned off.

When you view a slide file, it temporarily replaces objects on the screen. You
can draw on top of it, but when you change the view (by redrawing, panning, or
zooming), the slide file disappears, and AutoCAD redisplays only what you
drew and any preexisting objects.

You can display slides one by one or use a script to display slides in sequence.
Slides also can be used in custom menus. For example, if you create scripts that
insert blocks containing mechanical parts you use frequently, you can design a
custom image tile menu that displays a slide of each part. When you click the
slide image on the menu, AutoCAD inserts the block into the drawing.

A slide library is a file containing one or more slides. Slide library files are used



for creating custom image tile menus and for combining several slide files for
convenient file management.

You cannot edit a slide. You must change the original drawing and remake the
slide. If you use a low-resolution graphics monitor when creating a slide file and
later upgrade to a high-resolution monitor, you can still view the slide. AutoCAD
adjusts the image accordingly; however, the slide does not take full advantage of
the new monitor until you remake the slide file from the original drawing.
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Slides and Command Scripts > Create Slides >
View Slides
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You can view slides individually using VSLIDE. To view a series of slides for a
presentation, use a script file.

Be careful about using editing commands while you view a slide, which looks
like an ordinary drawing. Editing commands affect the current drawing
underneath the slide but not the slide itself.

Some commands may force redrawing, which removes the slide from display.
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Slides and Command Scripts > Create Slides >

Create and View Slide Libraries
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A slide library is a file containing one or more slides. Slide library files are used
for creating custom image tile menus and for combining several slide files for
convenient file management.

You can create slide libraries from slide files using the SLIDELIB utility. After
you have set up a slide library, you can view slides by specifying the name of the
slide library and the slide.

Do not delete the original slides after creating the slide library. The SLIDELIB
utility cannot update a slide library once it is created. If you want to add or
delete a slide, update the slide list file and remake the library with SLIDELIB.
When you remake the slide library, all the slide files that you intend to include
must be available.
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Slides and Command Scripts > Create Slides > Create and View Slide Libraries >

Create and View Slide Libraries
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To create a slide library

To view a slide in a slide library
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Slides and Command Scripts > Create Command Scripts > Overview of
Command Scripts >

Overview of Command Scripts
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This script turns on the grid, sets the global linetype scale to 3.0, and sets layer 0
as the current layer with red as the color.

To create a script that changes settings in a drawing
1. In a text editor, enter grid on.
. On the next line, enter Itscale 3.0.

2

3. On the next line, enter layer set 0 color red 0.

4. Add a blank line.

5. Save the file as ASCII text (TXT file), with a file extension of .scr.

The script file may contain comments, as follows:

; Turn grid on

grid on

; Set scale for linetypes

ltscale 3.0

; Set current layer and its color

layer set 0@ color red 0

; Blank line above to end LAYER command

Please send us your comment about this page
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Slides and Command Scripts > Create Command Scripts > Run Scripts at
Startup >

Run Scripts at Startup
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To run a script at startup
1. Click Start menu (Windows) » Run.

2. In the Run dialog box, enter acad drawing_name /b script_name .

To start a new file, instead of a drawing file name, enter the /t switch and
the name of a template file: /t template_drawing.

To open a drawing file to a particular view, follow the drawing name
with the /v switch and the name of the view: /v view_name.

The name of the script file must be the last parameter listed. The file
extensions are optional.

3. Click OK.

AutoCAD opens the drawing and executes the commands in the script
file. When the script has been completed, the command prompt is
displayed.
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Slides and Command Scripts > Create Command Scripts > Run Slide Shows fron
Scripts >

Run Slide Shows from Scripts
||

To run slide shows from scripts

1. Create the slide library file as described in To create a slide library .

2. Create a script file using an ASCII text editor, as shown in To create a
script that preloads slides.

3. At the command prompt, enter script.

4. In the Select Script File dialog box, select a script file and click Open.
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Slides and Command Scripts > Create Command Scripts > Run Slide Shows fron
Scripts >

Run Slide Shows from Scripts

I —
I oncept ” Procedure “ Quick Reference I

To create a script that preloads slides

In this example of a script that displays three slides (files slidel.sld, slide2.sld,
and slide3.sld), the time it takes to access the disk drive and load the next slide
into memory overlaps with the viewing time for the current slide.

1.

On the first line of the script, enter vslide slidel.

The first line begins the slide show and loads slidel.

On the second line, enter vslide *slide2.

The asterisk (*) preceding the slide name on the second line preloads
slide2.

On the third line, enter delay 2000.

The third line specifies a delay of 2000 milliseconds to allow the
audience to view slidel.

On the fourth line, enter vslide. On the fifth line, enter vslide *slide3.
On the sixth line, enter delay 2000.

The fourth, fifth, and sixth lines display slide2, preload slide3, and
specify a delay for viewing slide2.

On the seventh line, enter vslide. On the eighth line, enter delay 3000.

The seventh and eighth lines display slide3 and specify a delay for
viewing slide3.

On the last line, enter rscript to repeat the script.

To stop a repeating script press ESC. To continue the script, enter



resume.

The script may contain comments, as follows:

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Slides and Command Scripts > Create Command Scripts >
Overview of Command Scripts
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A script is a text file with one command on each line.

You can invoke a script at startup, or you can run a script during a work session
by using the SCRIPT command. A script also provides an easy way to create
continuously running displays for product demonstrations and trade shows.

The BACKGROUNDPLOT system variable must be set to 0 before a script can
plot multiple jobs.

You create script files outside the program using a text editor (such as
Microsoft® Windows® Notepad) or a word processor (such as Microsoft Word)
that can save the file in ASCII format. The file extension must be .scr.

Each line of the script file contains a command. Each blank space in a script file
is significant because SPACEBAR is accepted as a command or data field
terminator. You must be very familiar with the sequence of prompts to provide
an appropriate sequence of responses in the script file.

Note Keep in mind that prompts and command names may change in future
releases, so you may need to revise your scripts when you upgrade to a later
version of this program. For similar reasons, avoid the use of abbreviations;
future command additions might create ambiguities.

A script can execute any command at the command prompt except a command
that displays a dialog box. In most cases, a command that displays a dialog box
has an alternative version of the command that displays command prompts
instead of a dialog box.

Script files can contain comments. Any line that begins with a semicolon (;) is
considered a comment, and it is ignored while the script file is being processed.
The last line of the file must be blank.


ms-its:ACAD_ACR.chm::/SCRIPT.htm

All references to long file names that contain embedded spaces must be enclosed
in double quotes. For example, to open the drawing my house.dwg from a script,
you must use the following syntax:

open "my house"
The following commands are useful in scripts:

'DELAY

Provides a timed pause within a script (in milliseconds)

'GRAPHSCR

Switches from the text window to the drawing area

RESUME

Continues an interrupted script

RSCRIPT

Repeats a script file

'TEXTSCR

Switches to the text window

When command input comes from a script, it is assumed that the settings of the
PICKADD and PICKAUTO system variables are 1 and 0, respectively;
therefore, you do not have to check the settings of these variables.

A script is treated as a group, a unit of commands, reversible by a single U
command. However, each command in the script causes an entry in the undo log,
which can slow script processing. If you like, you can use UNDO Control None
to turn off the undo feature before running the script, or you can write it at the
beginning of the script itself. Remember to turn it back on (UNDO Control All)
when the script is finished.

The script that is running stops when another script command is invoked.
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Slides and Command Scripts > Create Command Scripts >

Run Scripts at Startup
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A script that runs at startup can open a drawing and change its settings.

Suppose that every time you begin a new drawing, you turn on the grid, set the
global linetype scale to 3.0, and set layer 0 as your current layer, with red as the
color. You can do this using a drawing template, but you could do it instead with
the following script and store it in a text file called setup.scr.

grid on
ltscale 3.0
layer set 0@ color red 0

The first line turns on the grid. The second line sets the global scale for
linetypes. The third line sets the current layer to layer 0 and sets its default color
to red. AutoCAD assumes that in a script you want to use the version of LAYER
command that displays command prompts rather than the dialog box version.
The result is equivalent to entering -layer at the command prompt. The fourth
line is blank, ending LAYER.

Note VBA and AutoLISP® scripts that run at startup should check for whether the
AutoCAD process is visible or invisible. If the process is invisible, the script
should not execute, because the process may be performing background plotting
or publishing operations. To check for whether the AutoCAD process is visible
or invisible, you can use the Visible property of the Application object in the
AutoCAD Object Model.

You could run a script at startup to open a drawing by using the following syntax
in the Run dialog box:

ACAD drawing_name /b setup

All file names that contain embedded spaces must be enclosed in double quotes,



for example, “guest house”. You can also specify the view that is displayed
when the drawing opens by using the /v switch and the view name. The /b switch
and the script file must be the last parameter listed.

Including the file extensions .exe, .dwg, .dwt, and .scr is optional. If AutoCAD
cannot find the script file, AutoCAD reports that it cannot open the file.

To run the same script at startup but create a new drawing using the
MyTemplate.dwt file as the template, enter the following in the Run dialog box:

ACAD /t MyTemplate /b setup

This command creates a new drawing and issues a sequence of setup commands
from the setup.scr file. When the script has finished running, the command
prompt is displayed. If you want to use the default template for the new drawing,
you can omit the /t switch and the template file name.

Note You can no longer use this method to start a new drawing and give it a
name. Name the drawing when you save it.
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Slides and Command Scripts > Create Command Scripts >
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Scripts are useful for creating slide shows.

Scripts are useful for creating slide shows. Ordinarily, the speed with which you
can display slides is limited by the number of times AutoCAD must access the
disk to read the slide file. You can, however, preload the next slide from disk
into memory while your audience is viewing the current slide and then quickly
display the new slide from memory.

To preload a slide, place an asterisk before the file name in VSLIDE. The next
VSLIDE command detects that a slide has been preloaded and displays it
without asking for a file name.

The disk-access time to load the next slide overlaps with the viewing time for the
current slide. You can specify additional delays with the DELAY command.
Each delay unit is equal to one millisecond.

To stop a repeating script press ESC. You can resume the script with RESUME.

If the script will run for a long time, it is recommended that you use UNDO
Control None to turn off the Undo log file.
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Slides and Command Scripts > Create Command Scripts > Run Slide Shows fron
Scripts >

Run Slide Shows from Scripts
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To run slide shows from scripts

To create a script that preloads slides
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Introduction to Programming Interfaces > ActiveX Automation >

Overview of ActiveX
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You can create and manipulate AutoCAD objects from any application that
serves as an Automation controller. Thus, Automation enables macro
programming across applications, a capability that does not exist in AutoLISP.

Through Automation, AutoCAD exposes programmable objects, described by
the AutoCAD Object Model, that can be created, edited, and manipulated by
other applications. Any application that can access the AutoCAD Object Model
is an Automation controller, and the most common tool used for manipulating
another application using Automation is Visual Basic for Applications (VBA).
VBA is found as a component in many Microsoft Office applications. You can
use these applications, or other Automation controllers, such as Visual Basic,
.NET, and Delphi, to drive AutoCAD.

The advantage of implementing an ActiveX interface for AutoCAD is twofold:

m  Programmatic access to AutoCAD drawings is opened up to many more
programming environments. Before ActiveX Automation, developers
were limited to an AutoLISP or C++ interface.

m Sharing data with other Windows applications, such as Microsoft Excel
and Microsoft Word, is made dramatically easier.

For example, you might want to prompt for input, set preferences, make a
selection set, or retrieve drawing data. You can decide on the controller to use,
depending on the type of manipulation.

Using Automation, you can create and manipulate AutoCAD objects from any
application that serves as an Automation controller. Thus, Automation enables
macro programming across applications, a capability that does not exist in
AutoLISP. With Automation you can combine the features of many applications
into a single application.



The displayed objects are called Automation objects. Automation objects make
methods, properties, and events available. Methods are functions that perform an
action on an object. Properties are functions that set or return information about
the state of an object. Events are user-initiated actions or occurrences to which a
program responds.

Virtually any type of application can access the displayed Automation objects
within AutoCAD. These applications can be stand-alone executables, dynamic
linked library (DLL) files, and macros within applications such as Microsoft
Word or Microsoft Excel. The most common of these is most likely the stand-
alone executable. If you are using applications from application developers,
follow their instructions for installation and use of their product.

See Also
m  ActiveX and VBA Developer's Guide
m  ActiveX and VBA Reference
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Introduction to Programming Interfaces > ActiveX Automation >
Define a Command to Start Your Application
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You can use the acad.pgp file to define a new AutoCAD command that runs an
external command to start your application.

You can use the acad.pgp file to define a new AutoCAD command that runs an
external command to start your application. The following example defines the
RUNAPP1 command, which runs the application app1.exe in the c:\vbapps)
directory. (Add this code to the external commands section of your acad.pgp
file.)

RUNAPP1, start c:\vbapps\appl, 0

If your application requires command line parameters, you can use the following
code:

RUNAPP2, start c:\vbapps\app2, 0, *Parameters: ,

This example defines the RUNAPP2 command, which prompts you for
parameters and then passes them to your application.

You can also use the AutoLISP startapp function to start an application that
makes use of Automation. Once AutoLISP starts the external application, it has
no control over its actions. You can, however, use AutoLISP to locate and run
different applications based on certain parameters.
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After defining a new command to start your application, you can make that
command available from a menu or toolbar.

The macro can be called from an interface element in the customization (CUI)
file. If you use only one or two applications, you can add them to one of the
standard pull-down menus. If you have a group of applications, you can add
your own pull-down menu or toolbar that is specifically dedicated to those
applications. For information about creating, editing, and loading customization
files, see Customize the User Interface.
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VBA provides application integration with other VBA-enabled applications.
This means that AutoCAD, using other application object libraries, can be an
Automation controller for other applications such as Microsoft Word or Excel.

The stand-alone development editions of Visual Basic 6, which must be
purchased separately, complement AutoCAD VBA with additional components
such as an external database engine and report-writing capabilities.

Develop with AutoCAD VBA

VBA sends messages to AutoCAD by the AutoCAD ActiveX Automation
Interface. AutoCAD VBA permits the Visual Basic environment to run
simultaneously with AutoCAD and provides programmatic control of AutoCAD
through the ActiveX Automation Interface. This linking of AutoCAD, ActiveX
Automation, and VBA provides an extremely powerful interface. It not only
controls AutoCAD objects, but it also sends data to or retrieves data from other
applications.

The integration of VBA into AutoCAD provides an easy-to-use visual tool for
customizing AutoCAD. For example, you can create an application that extracts
attribute information automatically, inserts the results directly into an Excel
spreadsheet, and performs any data transformations you need.

Three fundamental elements define VBA programming in AutoCAD. The first is
AutoCAD itself, which has a rich set of objects that include AutoCAD entities,
data, and commands. AutoCAD is an open-architecture application with multiple
levels of interface. To use VBA effectively, familiarity with AutoCAD
programmability is highly desirable. However, you will find that the VBA
object-based approach is quite different from that of AutoLISP.

The second element is the AutoCAD ActiveX Automation Interface, which



establishes messages (communication) with AutoCAD objects. Programming in
VBA requires a fundamental understanding of ActiveX Automation. A
description of the AutoCAD ActiveX Automation Interface can be found in the
ActiveX and VBA Developer's Guide in the Help system. To display Developer
Help, click Help menu » Additional Resources » Developer Help.

The third element that defines VBA programming is VBA itself. It has its own
set of objects, keywords, constants, and so forth, that provide program flow,
control, debugging, and execution. The Microsoft extensive Help system for
VBA is included with AutoCAD VBA.

The AutoCAD ActiveX/VBA interface provides several advantages over other
AutoCAD API environments:

m  Speed. Running in-process with VBA, ActiveX applications are faster
than AutoLISP applications.

m  Ease of use. The programming language and development environment
are easy-to-use and come installed with AutoCAD.

m  Windows interoperability. ActiveX and VBA are designed to be used
with other Windows applications and provide an excellent path for
communication of information across applications.

m  Rapid prototyping. The rapid interface development of VBA provides
the perfect environment for prototyping applications, even if those
applications will be developed eventually in another language.

m  Programmer base. Programmers already use Visual Basic 6. AutoCAD
ActiveX/VBA opens up AutoCAD customization and application
development to these programmers as well as those who will learn
Visual Basic 6 in the future.

Please send us your comment about this page
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You load a VBA project with the VBALOAD command. Once loaded, its
modules and macros are available in the Macros dialog box.

Although Microsoft applications store VBA projects, macros, and programs
inside a specific document, AutoCAD uses a separate file with the .dvb
extension. In this way, VBA interfaces with AutoCAD in much the same way
that AutoLISP and ObjectARX do. Because VBA projects are stored in a
separate file, a VBA project can open and close different AutoCAD drawings
during an AutoCAD session.

Note AutoCAD VBA projects are not binary compatible with stand-alone Visual
Basic 6 projects (VBP files). However, forms, modules, and classes can be
exchanged between dissimilar projects using the IMPORT and EXPORT VBA
commands in the VBA integrated development environment (IDE).

You load a VBA project with the VBALOAD command. Once loaded, its
modules and macros are available in the Macros dialog box. To run the VBA
module you use the VBARUN command. If no VBA project is loaded, the
options are unavailable. Procedures listed in the Macro Name box use the
following syntax:

module.macro

In the Macros dialog box you choose the Macro Scope and select from the listed
modules.

Use the Command Prompt to Run a VBA Macro

The -VBARUN command can be used to run a macro from the command
prompt. This allows you to run VBA macros from the command prompt, scripts,
and other AutoCAD programming environments. The only argument for the
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command is the module name using the module.macro syntax. The syntax
looks like this:
-vbarun <module.macro>

Because macros with the same name can be duplicated in modules, the
module.macro syntax differentiates the macro and allows for unique selection.

Please send us your comment about this page
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You can load VBA projects automatically each time you run AutoCAD.

As you build up a number of VBA projects, you can load them automatically
each time you run AutoCAD. The macros they contain are immediately
available. Additionally, the APPLOAD command provides a Startup Suite option
that automatically loads the specified applications.

acvba.arx — Automatically Load VBA

You cannot load VBA until an AutoCAD VBA command is issued. If you want
to load VBA automatically every time you start AutoCAD include the following
line in the acad.rx file:

acvba.arx

You can automatically run a macro in the acad.dvb file by naming the macro
AcadStartup. Any macro in your acad.dvb file called AcadStartup automatically
executes when VBA loads.

acad.dvb — Automatically Load a VBA Project

The acad.dvb file is useful if you want to load a specific VBA project that
contains macros you want each time you start AutoCAD. Each time you start a
new AutoCAD drawing session, AutoCAD searches for the acad.dvb file and
loads it.

If you want a macro in your acad.dvb file to run each time you start a new
drawing or open an existing one, add the following code to your acaddoc.Isp
file:
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The project name in the example is updatetitleblock.
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AutoLISP has been enhanced with Visual LISP (VLISP), which offers an
integrated development environment (IDE) that includes a compiler, debugger,
and other development tools to increase productivity. VLISP adds more
capabilities and extends the language to interact with objects using ActiveX.
VLISP also enables AutoLISP to respond to events through object reactors.

Unlike in ObjectARX, or VBA, each document opened in the Multiple Design
Environment (MDE) has its own Visual LISP namespace and environment. A
namespace is an insulated environment keeping AutoLISP routines that are
specific to one document from having symbol or variable name and value
conflicts with those in another document. For example, the following line of
code sets a different value to the symbol a for different documents.

(setqg a (getvar "DWGNAME"))

Visual LISP provides mechanisms for loading symbols and variables from one
namespace to another. More information about namespaces can be found in the
AutoLISP Developer's Guide in the Help system. To display Developer Help,
click Help menu » Additional Resources » Developer Help.

AutoLISP applications or routines can interact with AutoCAD in many ways.
These routines can prompt the user for input, access built-in AutoCAD
commands directly, and modify or create objects in the drawing database. By
creating AutoLISP routines you can add discipline-specific commands to
AutoCAD. Some of the standard AutoCAD commands are actually AutoLISP
applications.

Visual LISP provides three file format options for AutoLISP applications:

m  Reading an LSP file (.Isp)—an ASCII text file that contains AutoLISP
program code.



m  Reading an FAS file (.fas)—a binary, compiled version of a single LSP
program file.

m  Reading a VLX file (.vix)—a compiled set of one or more L.SP and/or
dialog control language (DCL) files.

Note Like-named AutoLISP application files are loaded based on their Modified
time stamp; the LSP, FAS, or VLX file with the most recent time stamp is loaded
unless you specify the full file name (including the file name extension).

Because AutoCAD can read AutoLISP code directly, no compiling is required.
While Visual LISP provides an IDE, you may choose to experiment by entering
code at the command prompt, which allows you to see the results immediately.
This makes AutoLISP an easy language to experiment with, regardless of your
programming experience.

Even if you are not interested in writing AutoLISP applications, your AutoCAD
package includes many useful routines. Routines are also available as shareware
through third-party developers. Knowing how to load and use these routines can
enhance your productivity.

Note When command input comes from the AutoLISP command function, the
settings of the PICKADD and PICKAUTO system variables are assumed to be 1
and 0, respectively. This preserves compatibility with previous releases of
AutoCAD and makes customization easier (because you don't have to check the
settings of these variables).

For information about AutoLISP programming, see the AutoLISP Developer's
Guide, and for information about AutoLISP and Visual LISP functions, see the
AutoLISP Reference in the Help system. To display Developer Help, click Help
menu > Additional Resources » Developer Help. AutoLISP programs can use
dialog boxes with their applications. Programmable dialog boxes are described
only in the AutoLISP Developer's Guide.

Please send us your comment about this page
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AutoLISP applications are stored in ASCII text files that you can edit. Before
you can use an AutoLISP application, it must first be loaded.

AutoLISP applications are stored in ASCII text files with the .Isp extension.
These files generally have a header portion that describes a routine, its use, and
any specific instructions. This header might also include comments that
document the author and the legal information regarding the use of the routine.
Comments are preceded by a semicolon (;). You can view and edit these files
with a text editor or word processor that can produce an ASCII text file.

Before you can use an AutoLISP application, it must first be loaded. You can use
the APPLOAD command or the AutoLISP 1load function to load an application.
Loading an AutoLISP application loads the AutoLISP code from the LSP file
into your system's memory.

Loading an application with the 1oad function involves entering AutoL.ISP
code at the command prompt. If the 1oad function is successful, it displays the
value of the last expression in the file at the command prompt. This is usually
the name of the last function defined in the file or instructions on using the
newly loaded function. If 1oad fails, it returns an AutoL.ISP error message. A
load failure can be caused by incorrect coding in the file or by entering the
wrong file name at the command prompt. The syntax for the 1oad function is

(load filename [onfailure])

This syntax shows that the load function has two arguments: f1lename, which
is required, and onfailure, which is optional. When loading an AutoLISP file
at the command prompt, you typically supply only the filename argument.
The following example loads the AutoLISP file newfile.Isp.

Command: (load "newfile")
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The .Isp extension is not required. This format works for any LSP file in the
current library path.

To load an AutoLISP file that is not in the library path, you must provide the full
path and file name as the filename argument.

Command: (load "d:/files/morelisp/newfile")
Note When specifying a directory path, you must use a slash (/) or two

backslashes (\\) as the separator, because a single backslash has a special
meaning in AutoLISP.

See Also
m  QOverview of File Organization
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AutoCAD loads the contents of three user-definable files automatically:
acad.lsp, acaddoc.lsp, and the MNL file that accompanies your current
customization file. By default, the acad.lsp file is loaded only once, when
AutoCAD starts, whereas acaddoc.lIsp is loaded with each individual document
(or drawing). This lets you associate the loading of the acad.Isp file with
application startup, and the acaddoc.Isp file with document (or drawing) startup.
The default method for loading these startup files can be modified by changing
the setting of the ACADLSPASDOC system variable.

If one of these files defines a function of the special type S: : STARTUP, this
routine runs immediately after the drawing is fully initialized. The

S: :STARTUP function is described in S::STARTUP Function: Postinitialization
Execution. As an alternative, the APPLOAD command provides a Startup Suite
option that loads the specified applications without the need to edit any files.

The acad.lsp and acaddoc.lsp startup files are not provided with AutoCAD. It is
up to the user to create and maintain these files.

Command Autoloader

When you automatically load a command using the 1oad or command
functions, the command's definition takes up memory whether or not you
actually use the command. The AutoLISP autoload function makes a
command available without loading the entire routine into memory. Adding the
following code to your acaddoc.lIsp file automatically loads the commands
CMD1, CMD?2, and CMD3 from the cmds.Isp file and the NEWCMD command
from the newcmd.Isp file.

(autoload "CMDS" '("CMD1" "CMD2" "CMD3"))
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(autoload "NEWCMD" '("NEWCMD"))

The first time you enter an automatically loaded command at the command
prompt, AutoLISP loads the entire command definition from the associated file.
AutoLISP also provides the autoarxload function for ObjectARX
applications. See autoload and autoarxload in the AutoLISP Reference in
the Help system. To display Developer Help, click Help menu » Additional
Resources » Developer Help.

Note Like-named AutoLISP startup files are loaded based on their Modified time
stamp; the LSP file with the most recent time stamp is loaded unless you specify
the full file name (including the file name extension).

See Also
m [.0ad an AutoLISP File
m  S::STARTUP Function: Postinitialization Execution
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You can create an acad.lsp file if you regularly use specific AutoLISP routines.
When you start AutoCAD, it searches the support file search path for an acad.lsp
file. If an acad.Isp file is found, it is loaded into memory.

The acad.lsp file is loaded at each drawing session startup when AutoCAD is
launched. Because the acad.lsp file is intended to be used for application-
specific startup routines, all functions and variables defined in an acad.lsp file
are only available in the first drawing. You will probably want to move routines
that should be available in all documents from your acad.lsp file into the
acaddoc.lsp file.

The recommended functionality of acad.lsp and acaddoc.Isp can be overridden
with the ACADLSPASDOC system variable. If the ACADLSPASDOC system
variable is set to O (the default setting), the acad.Isp file is loaded just once: upon
application startup. If ACADLSPASDOC is set to 1, the acad.lsp file is reloaded
with each new drawing.

The acad.lsp file can contain AutoLISP code for one or more routines, or just a
series of 1oad function calls. The latter method is preferable, because
modification is easier. If you save the following code as an acad.lsp file, the files
mysessionapp1.lsp, databasesynch.Isp, and drawingmanager.lIsp are loaded
every time you start AutoCAD.

(load "mysessionappl")
(load "databasesynch")
(load "drawingmanager'")

warning Do not modify the reserved acad2009.Isp file. Autodesk provides the
acad2009.1sp file, which contains AutoLISP defined functions that are required
by AutoCAD. This file is loaded into memory immediately before the acad.lsp
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file is loaded.

See Also
m  QOverview of File Organization

m  Prevent AutoL.ISP Errors When Loading Startup Files
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The acaddoc.lsp file is intended to be associated with each document (or
drawing) initialization. This file is useful if you want to load a library of
AutoLISP routines to be available every time you start a new drawing (or open
an existing drawing).

Each time a drawing opens, AutoCAD searches the library path for an
acaddoc.lsp file. If it finds one, it loads the file into memory. The acaddoc.lsp
file is always loaded with each drawing regardless of the settings of
ACADLSPASDOC.

Most users will have a single acaddoc.lsp file for all document-based AutoLISP
routines. AutoCAD searches for an acaddoc.Isp file in the order defined by the
library path; therefore, with this feature, you can have a different acaddoc.Isp
file in each drawing directory, which would load specific AutoLISP routines for
certain types of drawings or jobs.

The acaddoc.lsp file can contain AutoLISP code for one or more routines, or just
a series of 1oad function calls. The latter method is preferable, because
modification is easier. If you save the following code as an acaddoc.Isp file, the
files mydocumentapp1.lsp, build.Isp, and counter.Isp are loaded every time a
new document is opened.

(load "mydocumentappl")
(load "build")
(load "counter™")

warning Do not modify the reserved acad2009doc.Isp file. Autodesk provides the
acad2009doc.lIsp file, which contains AutoLISP-defined functions that are
required by AutoCAD. This file is loaded into memory immediately before the
acaddoc.lIsp file is loaded.
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See Also
= QOverview of File Organization

m  Prevent AutoL.ISP Errors When Loading Startup Files
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When AutoCAD loads a customization file, it searches for an MNL file with a
matching file name. If it finds the file, it loads the file into memory. This
function ensures that AutoCAD loads the AutoLISP functions that are needed for
proper operation of a menu.

This function ensures that AutoCAD loads the AutoLISP functions that are
needed for proper operation of a menu. For example, the default AutoCAD
customization file, acad.cui, relies on the file acad.mnl. This file defines
numerous AutoLISP functions used by the menu. The MNNL file is loaded after
the acaddoc.lsp file.

Note If a customization file is loaded with the AutoLISP command function—
with syntax similar to (command "menu" '"newmenu" )—the associated
MNL file is not loaded until the entire AutoL.ISP routine has run.

In this example, calls to the princ function can be used to display status
messages. The first use of princ displays the following at the command
prompt:

Newmenu utilities... Loaded.

The second call to princ exits the AutoLISP function. Without this second call
to princ, the message would be displayed twice. As mentioned previously, you
can include the onfailure argument with calls to the 1oad function as an
extra precaution.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Introduction to Programming Interfaces > AutoL.ISP and Visual
LISP > Automatically [.oad and Run AutoL.ISP Routines >

Prevent AutoLISP Errors When Loading Startup Files
| Concept || ISEESISEC|

If an AutoLISP error occurs while you are loading a startup file, the remainder of
the file is ignored and is not loaded.

Files specified in a startup file that do not exist or that are not in the AutoCAD
library path generally cause errors. Therefore, you may want to use the
onfailure argument with the 1oad function. The following example uses the
onfailure argument:

(princ (load "mydocappl" "\nMYDOCAPP1.LSP file not loaded."))
(princ (load "build" "\nBUILD.LSP file not loaded."))

(princ (load "counter" "\nCOUNTER.LSP file not loaded."))
(princ)

If a call to the 1oad function is successful, it returns the value of the last
expression in the file (usually the name of the last defined function or a message
regarding the use of the function). If the call fails, it returns the value of the
onfailure argument. In the preceding example, the value returned by the
load function is passed to the princ function, causing that value to be
displayed at the command prompt.

For example, if an error occurs while AutoCAD loads the mydocapp1.Isp file,
the princ function displays the following message and AutoCAD continues to
load the two remaining files:

MYDOCAPP1.LSP file not loaded.

If you use the command function in an acad.lsp, acaddoc.lsp, or MNL file, it
should be called only from within a defun statement. Use the S: : STARTUP
function to define commands that need to be issued immediately when you begin
a drawing session.



See Also

m  S::STARTUP Function: Postinitialization Execution
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You can define an S::STARTUP function to perform any needed setup operations
after the drawing is initialized.

The startup LISP files (acad.lsp, acaddoc.lsp, and MNL) are all loaded into
memory before the drawing is completely initialized. Typically, this does not
pose a problem, unless you want to use the command function, which is not
guaranteed to work until after a drawing is initialized.

If the user-defined function S: : STARTUP is included in an acad.lsp,
acaddoc.Isp, or MNL file, it is called when you enter a new drawing or open an
existing drawing. Thus, you can include a definition of S: : STARTUP in the
LISP startup file to perform any setup operations.

For example, if you want to override the standard HATCH command by adding a
message and then switching to the BHATCH command, use an acaddoc.lsp file
that contains the following:

(defun C:HATCH ( )
(alert "Using the BHATCH command!")
(princ "\nEnter OLDHATCH to get to real HATCH command.\n'")
(command "BHATCH")
(princ)
)
(defun C:OLDHATCH ( )
(command ".HATCH")
(princ)
)
(defun-q S::STARTUP ( )
(command "undefine" "hatch")
(princ "\nRedefined HATCH to BHATCH!\n")

)


ms-its:ACAD_ACR.chm::/HATCH.htm
ms-its:ACAD_ACR.chm::/BHATCH.htm

Before the drawing is initialized, new definitions for HATCH and OLDHATCH
are defined with the defun function. After the drawing is initialized, the

S: :STARTUP function is called and the standard definition of HATCH is
undefined.

Note To be appended, the S: : STARTUP function must have been defined with
the defun-q function rather than defun.

Because an S: : STARTUP function can be defined in many places (an acad.lsp,
acaddoc.lsp, or MNL file or any other AutoLISP file loaded from any of these),
it's possible to overwrite a previously defined S: : STARTUP function. The
following example shows one method of ensuring that your startup function
works with other functions.

(defun-q MYSTARTUP ( )

... your startup function ...

)
(setq S::STARTUP (append S::STARTUP MYSTARTUP))

The previous code appends your startup function to that of an existing

S: :STARTUP function and then redefines the S: : STARTUP function to
include your startup code. This works properly regardless of the prior existence
of an S: : STARTUP function.
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ObjectARX® (AutoCAD Runtime Extension) is a compiled-language
programming environment for developing AutoCAD applications. The
ObjectARX programming environment includes a number of dynamic link
libraries (DLLs) that run in the same address space as AutoCAD and operate
directly with core AutoCAD data structures and code. These libraries take
advantage of the AutoCAD open architecture, providing direct access to the
AutoCAD database structures, graphics system, and AutoCAD geometry engine
to extend AutoCAD classes and capabilities at runtime. Additionally, you can
use DLLs to create new commands that operate exactly the same way as native
AutoCAD commands.

You can use ObjectARX libraries in conjunction with other AutoCAD
programming interfaces, such as AutoLISP or VBA, enabling cross-API
integration.

The ObjectARX programming environment is described in the ObjectARX
Developer's Guide. The documentation is part of the ObjectARX Software
Development Kit, which can be downloaded from the Development Tools
section of the Autodesk website. For more information, click Help menu »
Additional Resources » Developer Help. Click ObjectARX once the Help
systems opens.
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To load an ObjectARX application, you use the Load option of the ARX
command. After loading, all commands defined by this application are available
at the command prompt.

Some ObjectARX applications use large amounts of system memory. If you are
finished using an application and want to remove it from memory, use the
Unload option of ARX.

You can also load an ObjectARX application with the arxload AutoLISP
function. The syntax for the arxload function is almost identical to that of the
load function used with AutoLISP files. If the arxload function loads the
ObjectARX program successfully, it returns the program name. The syntax for
the arxload function is as follows:

(arxload filename [onfailure])

The two arguments for the arxload function are filename and
onfailure. As with the 1oad function, the filename argument is required
and must be the complete path name description of the ObjectARX program file
to load. The onfailure argument is optional and typically not used when you
load ObjectARX programs from the command prompt. The following example
loads the ObjectARX application myapp.arx.

(arxload "myapp")

As with AutoLISP files, AutoCAD searches the library path for the specified
file. If you need to load a file that is not in the library path, you must provide the
full path name description of the file.

Note When specifying a directory path, you must use a slash (/) or two
backslashes (\\) as the separator, because a single backslash has a special
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meaning in AutoLISP.

Attempting to load an application that has previously been loaded results in an
error. Before using arxload you should use the arx function to check the
currently loaded applications.

To unload an application with AutoLISP, use the arxunload function. The
following example unloads the myapp application.

(arxunload "myapp")

Using the arxunload function not only removes the application from memory
but also removes the command definitions associated with that application.

See Also
m  QOverview of File Organization

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Introduction to Programming Interfaces > ObjectARX >

Automatically Load ObjectARX Applications
[T | quick Reference ||

Some ObjectARX samples contain an acad.rx file, which lists ObjectARX
program files that are loaded automatically when you start AutoCAD.

You can create or edit this file with a text editor or word processor that produces
files in ASCII text format, adding to or deleting from its contents to make the
appropriate ObjectARX programs available for use. As an alternative, the
APPLOAD command provides a Startup Suite option that loads the specified
applications without the need to edit any files.

Because AutoCAD searches for the acad.rx file in the order specified by the
library path, you can have a different acad.rx file in each drawing directory. This
makes specific ObjectARX programs available for certain types of drawings. For
example, you might keep 3D drawings in a directory called AcadJobs/3d_dwgs.
If that directory is set up as the current directory, you could copy the acad.rx file
into that directory and modify it in the following manner:

myappl

otherapp

If you place this new acad.rx file in the AcadJobs/3d_dwgs directory and you
start AutoCAD with that as the current directory, these new ObjectARX
programs are then loaded and are available from the AutoCAD command
prompt. Because the original acad.rx file is still in the directory with the
AutoCAD program files, the default acad.rx file will be loaded if you start
AutoCAD from another directory that does not contain an acad.rx file.

You can load ObjectARX programs from an MNL file using the arxload
function. This ensures that an ObjectARX program, required for proper
operation of a menu, will be loaded when the menu file is loaded.

You can also autoload many ObjectARX-defined AutoCAD commands. See
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Overview of AutoLISP Automatic [.oading and autoarxload in the AutoLISP
Reference in the Help system. To display Developer Help, click Help menu »
Additional Resources » Developer Help.

See Also
m  QOverview of AutoL.ISP Automatic [.oading
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The .NET Framework is a language-neutral programming environment
developed by Microsoft. In addition to the run-time environment, the Framework
provides class libraries that facilitate development of Windows- and Web-based
applications that are interoperable and secure.

AutoCAD supports .NET application development with ObjectARX managed
wrapper classes. See the “AutoCAD Managed Class Reference” and the
“ObjectARX Managed Wrapper Classes” sections of the ObjectARX Developer's
Guide, both in the ObjectARX SDK, for a complete list of the managed wrapper
classes that are available. For more information about the .NET Framework, see
the Microsoft documentation.

Managed wrapper classes are provided for most of the ObjectARX SDK,
enabling you to write applications in any language that is supported by the .NET
Framework, including VB .NET and C#. The managed classes implement
database functionality and enable you to write applications that read and write
drawing format (DWG) files. They also provide access to AutoCAD user
interface elements, including the command prompt and feature dialog boxes, the
AutoCAD editor, and the publishing and plotting components.
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To load a managed application, enter NETLOAD at the AutoCAD command
prompt and browse to the desired DLL file. Managed applications are unloaded
only when AutoCAD exits.
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Shapes are objects that you use like blocks. First you use the LOAD command to
load the compiled shape file containing the shape definition. Then you use the
SHAPE command to insert shapes from the file into your drawing. You can
specify the scale and rotation to use for each shape as you add it. AutoCAD SHP
fonts are a special type of shape file, and are defined in the same way as shape
files.

Blocks are more versatile and easier to use and apply than shapes. However,
shapes are more efficient for AutoCAD to store and draw. User-defined shapes
are helpful when you must insert a simple part many times and when speed is
important.

Compile Shape/Font Files

You enter the description of shapes in a specially formatted text file with a file
extension of .shp. To create the file, use a text editor or word processor that
enables you to save in ASCII format, and then compile the ASCII file.
Compiling a shape definition file (SHP) generates a compiled shape file (SHX).

The compiled file has the same name as the shape definition file but with a file
type of SHX. If the shape definition file defines a font, you use the STYLE
command to define a text style. Then, you use one of the text placement
commands (TEXT or MTEXT) to place the characters in the drawing. If the
shape definition file defines shapes, you use the LOAD command to load the
shape file into the drawing. Then, you use the SHAPE command to place the
individual shapes in the drawing (similar in concept to the INSERT command).

Compile PostScript Fonts

To use a Type 1 PostScript font in AutoCAD, you must first compile it into an



AutoCAD shape file. The COMPILE command accepts both SHP and PFB files
as input and generates an SHX file. Compiled versions of PostScript fonts can
take a lot of disk space, so compile only those fonts you use frequently.

AutoCAD cannot compile and load every Type 1 font. The PostScript font
facilities in AutoCAD are intended to process a subset of Adobe fonts. If you
receive an error while compiling a PostScript font, the resulting SHX file (if one
is generated) may not load into AutoCAD.

For more information on the Adobe Type 1 font format, refer to Adobe Typel
Font Format Version 1.1. When you've purchased and installed these fonts, you
can begin using them with AutoCAD.

Note Make sure you understand any copyright that accompanies the PostScript
fonts you use. The same copyright restrictions generally apply to the SHX form
of fonts you've compiled.
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Shapes and Shape Fonts >
Create Shape Definition Files

AutoCAD font and shape files (SHX) are compiled from shape definition files
(SHP). You can create or modify shape definition files with a text editor or word
processor that saves files in ASCII format.

Topics in this section

= Shape Descriptions

AutoCAD font and shape files (SHX) are compiled from shape
definition files (SHP). You can create or modify shape definition files
with a text editor or word processor that saves files in ASCII format.

m  Vector Length and Direction Code

A simple shape specification byte contains vector length and direction
encoded into one specification byte.

=  Special Codes

In addition to defining vectors, a specification byte can use special codes
to create additional forms and specify certain actions.

= Text Font Descriptions

Text fonts must include a special shape number 0 that conveys
information about the font itself.

= Sample Files

This topic contains sample files that help extend the font characters
provided with AutoCAD.

= Big Font Descriptions

Some languages, such as Japanese, use text fonts with thousands of non-
ASCII characters. In order for drawings to contain such text, AutoCAD
supports a special form of shape definition file called a Big Font file.



= Unicode Font Descriptions

A single Unicode font, due to its large character set, is capable of
supporting all languages and platforms. Unicode shape definition files
are virtually identical in format and syntax to regular AutoCAD shape
definition files.

m  Superscripts and Subscripts in SHX Files

You can modify shape definition files to improve their ability to display
superscripts and subscripts.
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To compile a shape or font file
=  On the command prompt, enter compile.

In the Select Shape File dialog box, you can select a shape definition file (SHP)
or PostScript font file (PFB). After you select the file name, compiling begins. If
AutoCAD finds an error in the shape descriptions, a message is displayed telling
you the type of error and the line number. When compiling is complete, the
following messages are displayed:

Compilation successful.

Output file name.shx contains nnn bytes.
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AutoCAD font and shape files (SHX) are compiled from shape definition files
(SHP). You can create or modify shape definition files with a text editor or word
processor that saves files in ASCII format.

The syntax of the shape description for each shape or character is the same
regardless of the final use (shape or font) for that shape description. If a shape
definition file is to be used as a font file, the first entry in the file describes the
font itself rather than a shape within the file. If this initial entry describes a
shape, the file is used as a shape file.

Being able to create your own shape definitions is a valuable skill. Keep in mind,
however, that this is a very complex subject to learn and requires patience.

Each line in a shape definition file can contain up to 128 characters. Longer lines
cannot be compiled. Because AutoCAD ignores blank lines and text to the right
of a semicolon, you can embed comments in shape definition files.

Each shape description has a header line of the following form and is followed
by one or more lines containing specification bytes, separated by commas and
terminated by a 0.

*shapenumber,defbytes, shapename
specbytel, specbyte2, specbyte3, ..., 0

The following list describes the fields of a shape description:

shapenumber

A number, unique to the file, between 1 and 258 (and up to 32768 for
Unicode fonts), and preceded by an asterisk (*). Non-Unicode font files use
the shape numbers 256, 257, and 258 for the symbolic identifiers
Degree_Sign, Plus_Or_Minus_Sign, and Diameter_Symbol. For Unicode



fonts these glyphs appear at the U+00B0, U+00B1, and U+2205 shape
numbers and are part of the “Latin Extended-A” subset.

Text fonts (files containing shape definitions for each character) require
specific numbers corresponding to the value of each character in the ASCII
code; other shapes can be assigned any numbers.

defbytes

The number of data bytes (Specbytes) required to describe the shape,
including the terminating 0. The limit is 2,000 bytes per shape.

shapename

The shape name. Shape names must be uppercase to be recognized. Names
with lowercase characters are ignored and are usually used to label font shape
definitions.

specbyte

A shape specification byte. Each specification byte is a code that defines
either a vector length and direction or one of a number of special codes. A
specification byte can be expressed in the shape definition file as either a
decimal or hexadecimal value. This section uses both decimal and
hexadecimal specification byte values for its examples (as do many of the
shape definition files). If the first character of a specification byte is a 0
(zero), the two characters that follow are interpreted as hexadecimal values.
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Shapes and Shape Fonts > Create Shape Definition Files >

Vector Length and Direction Code
IR | Quick Reference ||

A simple shape specification byte contains vector length and direction encoded
into one specification byte.

A simple shape specification byte contains vector length and direction encoded
into one specification byte (one specbyte field). Each vector length and
direction code is a string of three characters. The first character must be a 0,
which indicates to AutoCAD that the next two characters are interpreted as
hexadecimal values. The second character specifies the length of the vector in
units. Valid hexadecimal values range from 1 (one unit long) through F (15 units
long). The third character specifies the direction of the vector. The following
figure illustrates the direction codes.

= =} L ] 2

)
—_

[#4]
(=

A 8 c D E

All the vectors in the preceding figure were drawn with the same length
specification. Diagonal vectors stretch to match the X or Y displacement of the
closest orthogonal vector. This is similar to the action of the snap grid in
AutoCAD.

The following example constructs a shape named DBOX with an arbitrarily
assigned shape number of 230.



*230, 6, DBOX
014, 010, 01C, 018,012, 0

The preceding sequence of specification bytes defines a box one unit high byone
unit wide, with a diagonal line running from the lower left to the upper right.
After saving the file as dbox.shp, use the COMPILE command to generate the
dbox.shx file. Use the LOAD command to load the shape file containing this
definition, and then use the SHAPE command as follows:

Command: shape

Enter shape name or [?]: dbox

Specify insertion point: 1,1

Specify height <current>: 2

Specify rotation angle <current>: 0

The resulting shape is shown in the following illustration.

01a—
“
s [+
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes >
Codes 0, 1, and 2: End of Shape and Draw Mode Control
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Code 0 marks the end of the shape definition.

Codes 1 and 2 control Draw mode. Draw is activated at the start of each shape.
When Draw mode is turned on (code 1), the vectors cause lines to be drawn.
When Draw mode is turned off (code 2), the vectors move to a new location
without drawing.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Shapes and Shape Fonts > Create Shape Definition Files > Special Codes >
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Codes 3 and 4 control the relative size of each vector. The height specified with
the SHAPE command is initially considered the length of a single orthogonal
vector (direction 0, 4, 8, or C). Code 3 divides vector lengths by the next byte.
Code 4 multiplies vector lengths by the next byte. Codes 3 and 4 are followed by
a specification byte containing an integer scale factor (1 through 255). If you
want the shape height to specify the size of the entire shape, and you use 10
vector lengths to draw it, you can use 3,10 to scale the height specification. The
scale factor is cumulative within a shape; that is, multiplying by 2 and again by 6
results in a scale factor of 12. Usually, you should reverse the effect of your scale
factors at the end of the shape, especially for subshapes and text font shapes.
AutoCAD does not reset the scale factor for you.
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Codes 5 and 6: Location Save/Restore
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Code 5 pushes (saves) and code 6 pops (restores) the current coordinate position
while drawing a shape so that you can return to it from a later point in the shape.
You must pop everything you push. The position stack is only four locations
deep. If the stack overflows because of too many pushes or too many missing
pops, the following message is displayed when the shape is drawn.

Position stack overflow in shape nnn

Similarly, if you try to pop more locations than have been pushed onto the stack,
the following message is displayed when the shape is drawn.

Position stack underflow in shape nnn
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes >
Code 7: Subshape
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Code 7 draws the subshape number given by the next byte. For a non-Unicode
font the specification byte following code 7 is a shape number from 1 to 255. For
a Unicode font, code 7 is followed by a Unicode shape number from 1 to 65535.
Unicode shape numbers should be counted as two bytes (for specific information
about the differences between Unicode and non-Unicode fonts, see Unicode Font
Descriptions). The shape with that number (in the same shape file) is drawn at
this time. Draw mode is not reset for the new shape. When the subshape is
complete, drawing the current shape resumes.
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes >
Codes 8 and 9: X-Y Displacements
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Normal vector specification bytes draw only in the 16 predefined directions, and
the longest length is 15. These restrictions help make shape definitions efficient
but are sometimes limiting. With codes 8 and 9 you can draw nonstandard
vectors using X-Y displacements. Code 8 specifies the X-Y displacement given
by the next two bytes. Code 8 must be followed by two specification bytes in the
format:

8,X-displacement,Y-displacement

The X-Y displacements can range from -128 to +127. A leading + is optional, and
you can use parentheses to improve readability. The following example results in
a vector that draws (or moves) 10 units to the left and three units up.

8,(-10,3)

Following the two displacement specification bytes, the shape returns to Normal
Vector mode.

You can use code 9 to draw a sequence of nonstandard vectors. Code 9 specifies
any number of X-Y displacement pairs. The code sequence is terminated by a
(0,0) pair. The following example draws three nonstandard vectors and returns to
Normal Vector mode.

9! (3/1)1 (312)1 (21 '3)1 (010)

You must terminate the sequence of X-Y displacement pairs with a (0,0) pair in
order for AutoCAD to recognize any Normal Vectors or special codes that
follow.
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes >
Code 00A: Octant Arc
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Special code 00A (or 10) uses the next two specification bytes to define an arc.
This is called an octant arc because it spans one or more 45-degree octants,
starting and ending on an octant boundary. Octants are numbered
counterclockwise from the 3 o'clock position, as shown in the following
illustration.

3 2 1
4 0
2 =] 7

The arc specification is

10, radius, (-)0SC

The radius can be any value from 1 through 255. The second specification byte
indicates the direction of the arc (counterclockwise if positive, and clockwise if
negative), its starting octant (S, a value from 0 through 7), and the number of
octants it spans (C, a value from 0 through 7, in which 0 equals eight octants, or
a full circle). You can use parentheses to improve readability. For example,
consider the following fragment of a shape definition:

...012,10, (1, -032), 01E, . ..

This code draws a one-unit vector up and to the right, a clockwise arc from
octant 3 (with a radius of one unit for two octants), and then a one-unit vector
down and to the right, as shown in the following illustration.



CW———

two octants
(90 degrees)

oclant 2 octant 1
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes >
Code 00B: Fractional Arc
[ concepr | IR

Special code 00B (11) draws an arc that doesn't necessarily start and end on an
octant boundary. The definition uses five specification bytes.

11, start_offset,end_offset,high_radius, radius, (-)0SC

The start_offset and end_offset represent how far from an octant
boundary the arc begins or ends. The high_radius represents the most
significant eight bits of the radius; the high radius will be 0 unless the radius
is greater than 255 units. Multiply the high_radius value by 256 and add that
value to the radius value to generate an arc radius greater than 255. The
radius and ending specification byte are the same as for the octant arc
specification (code 00A, described previously).

You determine the startoffset by calculating the difference in degrees
between the starting octant's boundary (a multiple of 45 degrees) and the start of
the arc. Then, you multiply this difference by 256 and divide by 45. If the arc
starts on an octant boundary, its start offset is 0.

The end offset is calculated in a similar fashion, but you use the number of
degrees from the last octant boundary crossed to the end of the arc. If the arc
ends on an octant boundary, its end offset is 0.

For example, a fractional arc from 55 degrees to 95 degrees with a 3 unit radius
would be coded as follows:

11, (56, 28,0, 3,012)

Here is the explanation:

start_offset = 56 because ((55 - 45) * 256 / 45) = 56
end_offset = 28 because ((95 - 90) * 256 / 45) = 28
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Shapes and Shape Fonts > Create Shape Definition Files > Special Codes >
Codes 00C and 00D: Bulge-Specified Arcs
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Special codes 00C and 00D (12 and 13) provide another mechanism for
including arc segments in shape descriptions. They are similar to codes 8 and 9
in that you can use them to specify X-Y displacements. However, codes 00C and
00D draw arcs by applying a bulge factor to the displacement vector. Code 00C
draws one arc segment, while code 00D draws multiple arc segments (polyarcs)
until it is terminated by a (0,0) displacement.

Code 00C must be followed by three bytes describing the arc:

0C, X-displacement,Y-displacement,Bulge

Both the X and Y displacement and the bulge, which specifies the curvature of
the arc, can range from -127 to +127. If the line segment specified by the
displacement has length D, and the perpendicular distance from the midpoint of
that segment has height H, the magnitude of the bulge is ((2* H/ D) * 127). The
sign is negative if the arc from the current location to the new location is
clockwise.

A semicircle has bulge 127 (or -127) and is the greatest arc that can be
represented as a single-arc segment using these codes (use two consecutive arc
segments for larger arcs). A bulge specification of 0 is valid and represents a
straight-line segment. Note, however, that using code 8 for a straight-line
segment saves a byte in the shape description.

The polyarc code (00D, or 13) is followed by 0 or by more arc segment triples,



and is terminated by a (0,0) displacement. Note that no bulge is specified after
the final displacement. For example, the letter S might be defined by the
following sequence:

13,(0,5,127),(0,5,-127),(0,0)

Zero bulge segments are useful within polyarcs to represent straight segments;
they are more efficient than terminating the polyarc, inserting one straight
segment, and then starting another polyarc.

The number -128 cannot be used in arc segment and polyarc definitions.
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Special code 0O0E (14) is used only in dual-orientation text font descriptions,
where the font is used in both horizontal and vertical orientations. When this
special code is encountered in a character definition, the next code is either
processed or skipped, depending on orientation. If the orientation is vertical, the
next code is processed; if it is horizontal, the next code is skipped.

In horizontal text, the start point for each character is the left end of the baseline.
In vertical text, the start point is assumed to be the top center of the character. At
the end of each character, a pen-up segment is normally drawn to position to the
next character's start point. For horizontal text, it is to the right; for vertical text,
it is downward. The special 00E (14) code is used primarily to adjust for
differences in start points and endpoints, permitting the same character shape
definition to be used both horizontally and vertically. For instance, the following
definition of an uppercase D could be used in either horizontal or vertical text.

*68, 22, ucd
2,14,8,(-2, 6),1,030,012,044,016,038,2,010,1,06C, 2, 050,
1418/ ('41 '3)10

start —/_

horizontal
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Text Font Descriptions
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Text fonts must include a special shape number 0 that conveys information about
the font itself.

AutoCAD is packaged with numerous text fonts. You can use the STYLE
command to apply expansion, compression, or obliquing to any of these fonts,
thereby tailoring the characters to your needs. You can draw text of any height,
at any baseline angle, and with either horizontal or vertical orientation using
these fonts.

AutoCAD text fonts are files of shape definitions with shape numbers
corresponding to the ASCII code for each character. Codes 1 through 31 are for
control characters, only one of which is used in AutoCAD text fonts:

10 (LF)
The line feed (LF) must drop down one line without drawing. This is used for
repeated TEXT commands, to place succeeding lines below the first one.
*10,5, 1f
2,8,(0,-10),0
You can modify the spacing of lines by adjusting the downward movement
specified by the LF shape definition.

Text fonts must include a special shape number 0 that conveys information about
the font itself. The format has the following syntax:

*@, 4, font-name
above, below, modes, ©

The above value specifies the number of vector lengths above the baseline that
the uppercase letters extend, and below indicates how far the lowercase letters
descend below the baseline. The baseline is similar in concept to the lines on


ms-its:ACAD_ACR.chm::/TEXT.htm

writing paper. These values define the basic character size and are used as scale
factors for the height specified in the TEXT command.

The modes byte should be 0 for a horizontally oriented font and 2 for a dual-
orientation (horizontal or vertical) font. The special O0E (14) command code is
honored only when modes is set to 2.

The standard fonts supplied with AutoCAD include a few additional characters
required for the AutoCAD dimensioning feature.

% %d Degree symbol (°)
% %p Plus/minus tolerance symbol (+)
% %c Circle diameter dimensioning symbol

You can use these and the %%nnn control sequences, as described under TEXT
in the Command Reference.

Note AutoCAD draws text characters by their ASCII codes (shape numbers) and
not by name. To save memory, specify the shape name portion of each text shape
definition in lowercase as shown in the following example. (Lowercase names
are not saved in memory.)

*65,11, uca
024,043, 04d,02c,2,047,1,040,2,02e,0

Because the shape name uca contains lowercase letters, AutoCAD doesn't save
the name in memory. However, you can use the name for reference when editing
the font definition file. In this example, uca stands for uppercase A.
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Extended Simplex Roman

Concept

romans.shp - Extended Simplex Roman
Copyright 1997 by Autodesk, Inc.

"

r7

r 7

r 7

r 7

;; Permission to use, copy, modify, and distribute this software for
;7 any purpose and without fee is hereby granted, provided that the
;; above copyright notice appears in all copies and that the restric
;7 rights notice below appear in all supporting documentation.

r 7
r 7
r 7
r 7
r 7

Use, duplication, or disclosure by the U.S. Government is subject
to restrictions set forth in FAR 52.227-19 (Commercial Computer

; Software - Restricted Rights) and DFAR 252.227-7013(c)(1)(1ii)
(Rights in Technical Data and Computer Software), as applicable.

1
*UNIFONT, 6, ROMANS Copyright 1997 by Autodesk, Inc.
21,7,2,0,0,0

*QOO0A, 9, 1f

2,8,(0,-34),14,8, (30,34),0

*00020, 9, spc

2,8,(21,0),14,8, (-21,-30),0

*00021, 30, kexc
2,14,8,(-5,-21),14,5,8,(5,21),1,0EC, 2,05C, 1, 01A, 01E, 012, 016, 2,
8/ (51 '2)1141611418/ (51 '9)10

*00022, 41, kdblqgt
2,14,8,(-8,-25),14,5,8,(6,24),1,01A,016,012, 01E, 02C, 02B, 01A, 2,
8,(8,5),1,01A,016,012, 01E, 02C, 02B, 01A, 2, 8, (4, -19), 14, 6,

14,8, (8,-9),0

*00023, 57, kns
2,14,3,2,14,8,(-21,-50),14,4,2,14,5,8, (11,25),1,8, (-7, -32), 2,
8,(13,32),1,8,(-7,-32),2,8,(-6,19),1,0E0, 2,8, (-15, -6), 1, OEO, 2,
8,(4,-6),14,6,14,3,2,14,8, (21, -32),14,4,2,0

*00024, 67, kds

2114181 ('101 '25)11415181 (8125)11/81 (ol '29)12181 (41 29)11/
8,(0,-29),2,8,(5,22),1,026,8,(-3,1),048,8, (-3,-1),02A,02C, 02D,
01E, 02F, 8, (6, -2), 02F, 01E, 02D, 03C, 02A, 8, (-3, -1),048,8, (-3,1), 026,



2,8,(17,-3),14,6,14,8, (10, -13),0

*00025, 64, kpc
2,14,8,(-12,-21),14,5,8,(21,21),1,8, (-18,-21),2,8, (5,21),1, 02E,
02C, 02B, 029, 028, 026, 024, 023,021, 020, 02F, 8, (3, -1), 030, 8, (3,1), 021,
2,8,(-4,-14),1,029,02B,02C, 02E, 020, 021, 023, 024, 026, 028, 2,
8,(7,-7),14,6,14,8,(12,-9),0

*00026, 67, kand

2,14,8, (-13,-21),14,5,8, (23,12),1, 014,016, 018, 01A, 028, 8, (-2, -5),
8,(-2,-3),02A,029, 048,027,016, 025,024, 023,012, 8, (7,4),012, 023,
024, 025,027,029, 02B,02C, 8, (1, -3),8, (2, -3),8, (5,-7), 02E, 02F, 020,
012,014,2,8, (3,-2),14,6,14,8, (13,-9),0

*00027, 29, kapos
2,14,8,(-5,-25),14,5,8,(6,24),1,01A,016,012, 01E, 02C, 02B, 01A, 2,
8,(6,-19),14,6,14,8,(5,-9),0

*90028, 39, k1p
2,14,8,(-7,-25),14,5,8,(11,25),1,02A,8, (-2, -3),04B,8, (-1, -5), 04C,
8, (11 '5)IO4DI8I (21 '3)102E12181 (317)11416114181 (71 '16)10
*00029, 39, krp
2,14,8,(-7,-25),14,5,8,(3,25),1,02E, 8, (2, -3),04D, 8, (1, -5), 04C,
8,(-1,-5),04B,8,(-2,-3),02A,2,8,(11,7),14,6,14,8, (7, -16),0
*Q002A, 37, kas
2,14,8,(-8,-21),14,5,8,(8,21),1,0cCC, 2,8, (-5,9),1,8, (10, -6), 2,064,
1,8,(-10, -6),2,8, (13, -12),14,6,14,8,(8,-9),0

*0002B, 31, kpls
2,14,8,(-13,-18),14,5,8, (13,18),1,8, (0, -18),2,096,1, 8, (18,0), 2,
8,(4,-9),14,6,14,8,(13,-9),0

*0002C, 29, kcma
2,14,8,(-5,-2),14,5,8,(6,1),1,01A, 016,012, 01E, 02C, 02B, 01A, 2,
8,(6,4),14,6,14,8, (5, -13),0

*0002D, 25, ksub

2114181 ('131 '9)/1415181 (419)11181 (1810)12181 (41 '9)114161

14,8, (13, -9),0

*O002E, 26, kper
2,14,8,(-5,-2),14,5,8,(5,2),1,01A, 01E, 012, 016, 2, 8, (5, -2), 14,6,
14,8, (5,-9),0

*QOO2F, 25, kdiv

2,14,8, (-11, -25),14,5,8, (20, 25),1,8, (-18,-32),2,8,(20,7), 14,6,
14,8, (11, -16),0

*00030, 62, nO

2,14, 8, ('101 '21)11415181 (9121)11/81 ('31 '1)181 ('21 '3)181 ('11 '5)1
03CI8I (11 '5)181 (21 '3)181 (31 '1)1020181 (311)181 (2/3)181 (115)10341
8/ ('115)181 ('213)181 ('311)102812181 (111 '21)11416114181 (101 '9)10
*9E0O31, 27, nl

2,14,8,(-10, -21),14,5,8, (6,17),1,021,032,8, (0, -21),2,8, (9,0),
14,6,14,8, (10, -9),0

*00032, 37, n2

2,14,8, (-10, -21),14,5,8, (4,16),1, 014, 023,012,021, 040, 02F, O1E, 02D,
02C, 02B, 8, (-2, -3), 0AA, OEO, 2,8, (3,0),14,6,14,8, (10, -9),0
*00033, 46, n3

2,14,8, (-10, -21),14,5,8, (5,21),1,0B0,8, (-6, -8), 030, 02F, O1E,



8,(1,-3),02C,8,(-1,-3),02A,8,(-3,-1),038,8, (-3,1),016,025, 2,
8,(17,-4),14,6,14,8, (10, -9),0

*00034, 34, n4

2,14,8, (-10, -21),14,5,8, (13,21),1,8, (-10, -14),0F0, 2,8, (-5,14), 1,
8/(01'21)12181(710)11416114181(101_9)10

*00035, 52, n5

2,14,8, (-10, -21),14,5,8, (15,21),1,0A8,8, (-1, -9),012,8, (3,1), 030,
8,(3,-1),02E,8,(1,-3),02C,8,(-1,-3),02A,8,(-3,-1),038,8,(-3,1),
016,025,2,8, (17, -4),14,6,14,8, (10, -9),0

*00036, 68, N6

2,14,8,(-10,-21),14,5,8, (16,18),1,025,8, (-3,1),028,8, (-3, -1),
8,(-2,-3),8,(-1,-5),05C,8,(1,-4),02E,8,(3,-1),01@,8,(3,1),022,
8/(113)1014181('113)1026181('311)1018181('31'1)/02A181('1r'3)121
8,(16,-7),14,6,14,8, (10, -9),0

*00037,31,n7

2,14,8, (-10, -21),14,5,8, (17,21),1,8,(-10, -21),2,8, (-4,21),1, OEO,
2,8,(3,-21),14,6,14,8, (10, -9),0

*00038, 66, n8

2,14,8, (-10, -21),14,5,8, (8,21),1,8, (-3, -1),02B, 02C, 02D, 02F,
8,(4,-1),8,(3,-1),02E,02D,03C, 02B, 01A,8, (-3, -1),048,8, (-3,1), 016,
025, 034,023, 022,8, (3,1),8, (4,1),021,023,024,025,8, (-3,1), 048, 2,
8,(12,-21),14,6,14,8, (10, -9),0

*00039, 68, N9

2,14,8,(-10, -21),14,5,8, (16,14),1,8, (-1, -3),02A,8, (-3, -1),018,
8/('311)1026181('113)1014181(113)1022/81(311)1010181(31'1)102Er
8,(1,-4),05C,8,(-1,-5),8,(-2,-3),8,(-3,-1),028,8,(-3,1),025,2,
8,(16,-3),14,6,14,8, (10, -9),0

*0003A, 33, kcol

2,14,8, (-5, -14),14,5,8, (5,14),1,01A, 01E, 012,016, 2, 0CC, 1, 01A, O1E,
012,016, 2,8, (5,-2),14,6,14,8, (5, -9),0

*0003B, 38, ksmc

2,14,8, (-5, -14),14,5,8, (5,14),1,01A, 01E, 012,016, 2,8, (1, -13),1,
01A, 016,012, 01E, 02C, 02B, 01A, 2,8, (6,4),14,6,14,8, (5, -13),0
*QOO3C, 28, k1t
2114181('121'18)11415181(20118)11/81('161'9)181(161'9)12181(410)1
14,6,14,8, (12,-9),0

*@00O3D, 33, keq
2114181('131'12)11415181(4112)11/81(1810)12181('181'6)11/
8/(1810)12/81(4/'6)11416114181(131_9)10

*QOO3E, 28, kgt
2114181('121'18)11415181(4118)11/81(161'9)181('161'9)12181(2010)1
14,6,14,8, (12,-9),0

*O003F, 42, kqm
2,14,8,(-9,-21),14,5,8,(3,16),1,014,023,012, 021, 040, 02F, O1E, 02D,
02C, 02B, 01A, 049, 03C, 2, 05C, 1, 01A, 01E, 012, 016, 2, 8, (9, -2), 14, 6,
14,8, (9, -9),0

*00040, 93, kea

2,14,3,2,14,8, (-27,-42),14,4,2,14,5,8, (18,13),1, 025,027, 038, 029,
01A, 02B, 03C, 02D, 01E, 02F, 030, 021, 023, 2,084, 1, 0AC, O1E, 020, 022,
8,(1,3),024,8,(-1,3),025,026,027,8,(-3,1),038,8,(-3,-1),029, 02A,



028B,8, (-1, -3),03C, 8, (1, -3),02D, 02E, 02F, 8, (3, -1),030,8, (3,1),021,
012,2,8,(6,-3),14,6,14,3,2,14,8, (27, -18),14,4,2,0

*00041, 39, uca
2114181('91_21)/1415181(9121)11181('81_21)12181(8121)11/
8/(81'21)12181('1317)11/0A012181(41'7)11416114181(91_9)10
*00042, 70, uch
2,14,3,2,14,8,(-21,-42),14,4,2,14,5,8, (4,21),1,8, (0, -21), 2,
8,(0,21),1,090,8, (3,-1),01E,02D, 02C, 02B, 01A, 8, (-3, -1), 2,098, 1,
090, 8, (3, -1), 01E, 02D, 03C, 02B, 01A, 8, (-3, -1), 098, 2, 8, (17,0), 14, 6,
14,3,2,14,8, (21, -18),14,4,2,0

*00043, 55, ucc
2,14,3,2,14,8,(-21,-42),14,4,2,14,5,8, (18,16),1, 025,026,027, 048,
029, 02A,02B,8, (-1, -3),05C, 8, (1, -3), 02D, 02E, 02F, 040, 021, 022, 023, 2,
8,(3,-5),14,6,14,3,2,14,8, (21, -18),14,4,2,0

*00044, 61, ucd
2,14,3,2,14,8,(-21,-42),14,4,2,14,5,8, (4,21),1,8, (0, -21), 2,
8,(0,21),1,070,8, (3,-1),02E,02D,8, (1, -3),05C,8, (-1, -3),02B, 02A,
8,(-3,-1),078,2,8,(17,0),14,6,14,3,2,14,8, (21, -18),14,4,2,0
*00045, 55, uce

2,14,3,2,14,8,(-19, -42),14,4,2,14,5,8, (4,21),1,8, (0, -21), 2,
8,(0,21),1,0D0, 2,8, (-13,-10),1,080, 2,8, (-8, -11),1,0D0, 2,8, (2,0),
14,6,14,3,2,14,8, (19, -18),14,4,2,0

*00046,37, uct
2114181('91_21)/1415181(4121)11181(01'21)12181(0121)1110D0121
8,(-13,-10),1,080,2,8, (6,-11),14,6,14,8,(9,-9),0

*00047, 60, UCg
2,14,3,2,14,8,(-21,-42),14,4,2,14,5,8, (18,16),1, 025,026,027, 048,
029, 02A,028B,8, (-1, -3),05C, 8, (1, -3), 02D, 02E, 02F, 040, 021, 022, 023,
034,2,058,1,050,2,8, (3,-8),14,6,14,3,2,14,8, (21, -18),14,4,2,0
*00048, 39, uch

2,14,8,(-11, -21),14,5,8, (4,21),1,8, (0, -21),2,8, (14,21),1,
8,(0,-21),2,8,(-14,11),1,0E0, 2,8, (4, -11),14,6,14,8, (11, -9),0
*00049, 25, uci
2114181('41_21)/1415181(4121)11181(01'21)12181(410)114161

14,8, (4,-9),0

*@004A, 37, UC]
2,14,8,(-8,-21),14,5,8,(12,21),1,8, (0, -16),8, (-1, -3),01A, 029, 028,
027,016,8, (-1,3),024,2,8, (14, -7),14,6,14,8,(8,-9),0

*0004B, 49, uck
2,14,3,2,14,8,(-21,-42),14,4,2,14,5,8, (4,21),1,8, (0, -21), 2,
8,(14,21),1,0EA,2,052,1,8,(9,-12),2,8,(3,0),14,6,14,3, 2,

14,8, (21,-18),14,4,2,0

*0004C, 43, ucl

2,14,3,2,14,8, (-17,-42),14,4,2,14,5,8, (4,21),1,8, (0, -21), 2,
8,(0,0),1,0C0,2,8,(1,0),14,6,14,3,2,14,8,(17,-18),14,4,2,0
*0004D, 49, ucm
2114181('121'21)11415181(4121)11/81(01_21)12181(0121)11/
8/(81'21)12181(8121)11181('81_21)12181(8121)11/81(01_21)121
8,(4,0),14,6,14,8, (12,-9),0

*O@004E, 41, ucn



2114181('111'21)11415181(4121)11/81(01_21)12181(0121)11/
8/(141_21)12181(0121)11/81(01_21)12181(410)11416114181(111'9)10
*QOO4F, 50, uco

2,14,8, (-11, -21),14,5,8, (9,21),1, 029, 02A,02B,8, (-1, -3), 05C,

8, (1, -3),02D, 02E, 02F, 040, 021, 022,023,8, (1,3),054,8, (-1, 3), 025,
026,027,048,2,8, (13, -21),14,6,14,8, (11, -9),0

*9EO50, 55, ucp
2,14,3,2,14,8,(-21,-42),14,4,2,14,5,8, (4,21),1,8, (0, -21), 2,
8,(0,21),1,090,8, (3,-1),01E, 02D, 03C, 02B, 01A, 8, (-3, -1), 098, 2,
8,(17,-10),14,6,14,3,2,14,8, (21, -18),14,4,2,0

*@OO51, 56, Ucq

2,14,8, (-11, -21),14,5,8, (9,21),1, 029, 02A,02B,8, (-1, -3), 05C,

8, (1, -3),02D, 02E, 02F, 040, 021, 022,023,8, (1,3),054,8, (-1, 3), 025,
026,027,048,2,8, (3,-17),1,06E, 2,8, (4,2),14,6,14,8, (11, -11),0
*00052, 61, ucr
2,14,3,2,14,8,(-21,-42),14,4,2,14,5,8, (4,21),1,8, (0, -21), 2,
8,(0,21),1,090, 8, (3,-1),01E, 02D, 02C, 02B, 01A, 8, (-3, -1), 098, 2, 070,
1,8,(7,-11),2,8,(3,0),14,6,14,3,2,14,8, (21, -18),14,4,2,0
*00053, 51, UCS

2,14,8, (-10, -21),14,5,8, (17,18),1,026,8, (-3,1),048,8, (-3, -1), 02A,
02C, 02D, O1E, 02F, 8, (6, -2), 02F, 01E, 02D, 03C, 02A, 8, (-3, -1), 048,
8,(-3,1),026,2,8,(17,-3),14,6,14,8, (10, -9),0

*00054, 31, uct
2114181('81_21)/1415181(8121)11181(01'21)12181('7121)11/0E0121
8,(1,-21),14,6,14,8,(8,-9),0

*00055, 39, ucu

2,14,8,(-11, -21),14,5,8, (4,21),1,0FC,8, (1, -3), 02E, 8, (3, -1), 020,
8,(3,1),022,8,(1,3),0F4,2,8, (4,-21),14,6,14,8, (11, -9),0
*00056, 33, UCV
2114181('91_21)/1415181(1121)11181(81'21)12181(8121)111
8/('81_21)12181(910)11416114181(91_9)10

*QO057, 49, ucw
2114181('121'21)11415181(2121)11/81(51_21)12181(5121)11/
8/('51_21)12181(5121)11/81(51_21)12181(5121)11/81('51'21)121
8,(7,0),14,6,14,8, (12,-9),0

*00058, 33, UCX

2,14,8, (-10, -21),14,5,8, (3,21),1,8, (14, -21), 2,8, (0,21),1,
8,(-14,-21),2,8,(17,0),14,6,14,8, (10, -9),0

*00059, 34, UCy
2,14,8,(-9,-21),14,5,8,(1,21),1,8,(8,-10),OBC,2,8,(8,21),1,
8/('81_10)12181(91'11)11416114181(91'9)10

*QOO5A, 37, UCZ

2,14,8, (-10, -21),14,5,8, (17,21),1,8, (-14,-21),2,8, (0,21),1, 0EO, 2,
8,(-14,-21),1,0E0,2,8,(3,0),14,6,14,8, (10, -9),0

*QOO5B, 37, k1b
2114181('71_25)/1415181(4125)11181(01'32)12181(0132)111070121
8,(-7,-32),1,070,2,8,(3,7),14,6,14,8,(7,-16),0
*Q0O5C, 25, kbks1sh

2,14,8, (-11, -25),14,5,8, (2,25),1,8, (18, -32),2,8,(2,7), 14, 6,
14,8, (11, -16),0



*@OO5D, 37, krb

2,14, 8, ('71 _25)/1415181 (9125)11181 (OI '32)12181 ('7132)11/ 070,2,
8,(-7,-32),1,070,2,8,(4,7),14,6,14,8,(7,-16),0

*@O005E, 28, kcaret

2114181 ('111 '25)11415181 (3120)11/81 (815)181 (81 '5)12181 (31 _20)1
14,6,14,8, (11, -9),0

*@OOS5F, 21, kundrl

2,14,8,(-12, -14),14,5,02E,1,8, (20,0),2,022,14,6,14,8, (12, -11),0
*00060, 29, krvap
2,14,8,(-5,-25),14,5,8, (4,24),1,01E, 012,016, 01A, 02C, 02D, O1E, 2,
8,(6,-19),14,6,14,8,(5,-9),0

*Q0061, 55, 1ca

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (15,14),1, OEC, 2, 0B4, 1, 026,
027,038,029, 02A,8, (-1, -3),02C, 8, (1, -3), 02E, 02F, 030, 021, 022, 2,
8,(4,-3),14,6,14,3,2,14,8, (19, -18),14,4,2,0

*00062,57, 1cb

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8, (4,21),1,8, (0, -21),2,0B4, 1,
022,021,030, 02F, 02E, 8, (1, -3),02C, 8, (-1, -3), 02A, 029, 038, 027, 026, 2,
8,(15,-3),14,6,14,3,2,14,8, (19, -18),14,4,2,0

*00063, 39, lcc

2,14,8, (-9, -14),14,5,8, (15,11),1, 026, 027,038,029, 02A, 8, (-1, -3),
02C, 8, (1, -3), 02E, 02F, 030, 021,022, 2, 8, (3, -3),14,6,14,8, (9, -9),0
*00064,57, 1cd

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8, (15,21),1,8, (0, -21), 2, 0B4,
1,026,027, 038,029, 02A, 8, (-1, -3),02C, 8, (1, -3), 02E, 02F, 030, 021, 022,
2,8,(4,-3),14,6,14,3,2,14,8, (19, -18),14,4,2,0

*00065, 42, 1ce
2,14,8,(-9,-14),14,5,8,(3,8),1,0C0, 024,025,016, 027, 038,029, 02A,
8,(-1,-3),02C,8,(1,-3),02E,02F, 030,021,022,2,8, (3, -3),14,6,

14,8, (9,-9),0

*00066,36, 1cf
2,14,8,(-6,-21),14,5,8,(10,21),1,028,029,8, (-1, -3),8, (0, -17), 2,
8,(-3,14),1,070,2,8,(3,-14),14,6,14,8, (6,-9),0

*PO067, 66, 1cg

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (15,14),1, 8, (0, -16),
8,(-1,-3),01A,029,038,027,2,8,(9,17),1,026,027,038, 029, 02A,
8,(-1,-3),02C,8,(1,-3),02E,02F, 030,021, 022,2,8, (4, -3),14,6,14, 3,
2,14,8, (19, -32),14,4,2,0

*00068, 48, 1ch

2,14,3,2,14,8,(-19, -42),14,4,2,14,5,8, (4,21),1,8, (0, -21),2,0A4, 1,
032,021,030, 02F, 8, (1, -3),0AC, 2,8, (4,0),14,6,14,3,2,14,8, (19, -18),
14,4,2,0

*00069, 32, 1ci
2,14,8,(-4,-21),14,5,8,(3,20),1,01E,012,016,01A, 2,8, (1, -7), 1, 0DC,
2,8,(4,0),14,6,14,8,(4,-9),0

*QOO6A, 39, 1C]
2,14,8,(-5,-21),14,5,8,(5,20),1,01E, 012,016, 01A, 2,8, (1, -7), 1,
8,(0,-16),8,(-1,-3),029,028,2,8,(9,7),14,6,14,8, (5, -16),0
*QOO6B, 49, 1ck

2,14,3,2,14,8, (-17,-42),14,4,2,14,5,8, (4,21),1,8, (0, -21), 2,



8,(10,14),1,0AA,2,042,1,8,(7,-8),2,8,(2,0),14,6,14,3, 2,

14,8, (17,-18),14,4,2,0

*0006C, 25, 1cl

2,14, 8, ('41 _21)/1415181 (4121)11181 (OI '21)12181 (410)114161

14,8, (4,-9),0

*QOO6D, 45, 1cm

2,14,8, (-15, -14),14,5,8, (4,14),1,0EC, 2,0A4, 1,032,021, 030, O2F,

8, (1, -3),0AC,2,0A4,1,032,021,030,02F,8, (1,-3),0AC, 2,8, (4,0),14,86,
14,8, (15, -9),0

*QOO6E, 46, 1cn

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (4,14),1, OEC, 2, 0A4, 1,032,
021,030, 02F, 8, (1, -3),0AC, 2,8, (4,0),14,6,14,3,2,14,8, (19, -18),
14,4,2,0

*QOO6F, 58, 1co

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (8,14),1,029,02A,8, (-1, -3),
02C, 8, (1, -3), 02E, 02F, 030, 021, 022, 8, (1, 3),024,8, (-1, 3), 026,027,
038,2,8, (11, -14),14,6,14,3,2,14,8, (19, -18),14,4,2,0
*9E0O70, 59, 1cp

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (4,14),1,8, (0, -21), 2,
8,(0,18),1, 022,021,030, 02F, 02E, 8, (1, -3),02C,8, (-1, -3),02A, 029,
038,027,026, 2,8, (15, -3),14,6,14,3,2,14,8, (19, -32),14,4,2,0
*@EO71, 59, 1cq

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (15,14),1,8, (0, -21), 2,
8,(0,18),1, 026,027,038, 029, 02A,8, (-1, -3),02C, 8, (1, -3), 02E, 02F,
030,021,022,2,8, (4,-3),14,6,14,3,2,14,8, (19, -32),14,4,2,0
*00072, 44, 1cr
2,14,3,2,14,8,(-13,-28),14,4,2,14,5,8, (4,14),1, 0EC, 2,084, 1,
8,(1,3),022,021,030,2,8,(1,-14),14,6,14,3,2,14,8, (13, -18),14, 4, 2,
0

*QOO73, 60, 1cs
2,14,3,2,14,8,(-17,-28),14,4,2,14,5,8, (14,11),1,025,8, (-3,1), 038,
8,(-3,-1),02B,02D, 02F, 8, (5,-1),02F, 02D, 01C, 02B, 8, (-3, -1), 038,
8,(-3,1),025,2,8,(14,-3),14,6,14,3,2,14,8, (17, -18),14,4,2,0
*Q0074, 36, lct
2,14,8,(-6,-21),14,5,8,(5,21),1,8, (0, -17),8, (1, -3), 02F, 020, 2,
8,(-8,14),1,070,2,8,(3,-14),14,6,14,8, (6,-9),0

*QO075, 46, 1cu

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (4,14),1,0AC, 8, (1, -3), 02F,
030,021,032, 2,0A4,1,0EC, 2,8, (4,0),14,6,14,3,2,14,8, (19, -18), 14, 4,
2,0

*00076,33, 1lcv

2,14, 8, ('81 _14)/1415181 (2114)11181 (61 '14)12181 (6114)111

8/ ('61 _14)12181 (810)11416114181 (81 _9)10

*QOO77,49, lcw

2,14, 8, ('111 '14)11415181 (3114)11/81 (41 _14)12181 (4114)11/

8, ('41 _14)12181 (4114)11/81 (41 _14)12181 (41 14)11/81 ('41 '14)121
8,(7,0),14,6,14,8, (11, -9),0

*Q0078, 43, 1cx
2,14,3,2,14,8,(-17,-28),14,4,2,14,5,8,(3,14),1,8, (11, -14), 2, OE4,
1,8,(-11,-14),2,8,(14,0),14,6,14,3,2,14,8, (17, -18),14,4,2,0



*90079, 37, lcy

2,14, 8, ('81 _14)/1415181 (2114)11181 (61 '14)12181 (6114)111
8,(-6,-14),04B,02A,029,018,2,8, (15,7),14,6,14,8, (8, -16),0
*QOO7A, 47, 1cz
2,14,3,2,14,8,(-17,-28),14,4,2,14,5,8, (14,14),1,8, (-11, -14), 2,
OE4,1,0B0, 2,8, (-11,-14),1,080, 2,8, (3,0),14,6,14,3, 2,

14,8, (17,-18),14,4,2,0

*QOO7B, 54, k1br

2,14,3,2,14,8, (-13,-50),14,4,2,14,5,8, (9, 25),1,029, 01A, 02B, 02C,
02D, 01E, 02D, 02C, 02A, 029, 02F, 02E, 02C, 02B, 01A, 02B, 02C, 02D, O1E, 02F,
2,8,(5,7),14,6,14,3,2,14,8, (13,-32),14,4,2,0

*QOO7C, 25, kvbar

2114181 ('41 _25)/1415181 (4125)11181 (OI '32)12181 (417)114161
14,8, (4, -16),0

*0007D, 54, krbr

2,14,3,2,14,8, (-15,-50),14,4,2,14,5,8, (5,25),1, 02F, 01E, 02D, 02C,
02B, 01A, 02B, 02C, 02E, 02F, 029, 02A, 02C, 02D, 01E, 02D, 02C, 02B, 01A, 029,
2,8,(9,7),14,6,14,3,2,14,8, (15, -32),14,4,2,0

*QOO7E, 37, kt1lde

2,14,8, (-13,-14),14,5,8, (4,6),1,024,8, (1,3),021,020, 02F, 8, (4, -3),
02F, 020,021, 023,024, 2,8, (4,-12),14,6,14,8, (13,-9),0
*00080, 4, keuroRef

7,020AC, 0

*O00A0, 9, spc

2,8,(21,0),14,8, (-21,-30),0

*QOOA1, 28, kiexc
2,14,8,(-5,-21),14,5,050,1,0E4,2,054,1,012,016, 01A, 01E, 2,
8,(8,-19),14,6,14,8,(5,-9),0

*O00A2, 43, kcent
2,14,8,(-9,-17),14,5,03E,1,8, (12,20), 2,06C, 1,026, 027,038, 029, 02A,
8,(-1,-3),02C,8,(1,-3),02E,02F, 030,021,022,2,8, (3, -3), 14,6,
14,8, (9, -9),0

*©@00A3, 37, kpound

2,14,8, (-10, -21),14,5,8, (12,18),1, 025,027, 029, 02B, OFC, 03A, OE0, 2,
8,(-8,10),1,068,014,060,2,8, (9, -11),14,6,14,8, (10, -9),0
*O00A5, 44, kyen
2,14,8,(-12,-21),14,5,8,(1,21),1,8, (8, -10),08BC, 2,8, (8,21), 1,
8,(-8,-10),2,078,1,0E0,2,8, (-14,-3),1,0E0, 2,8, (6, -8), 14,6,
14,8, (12, -9),0

*OQO00A7, 78, kpar

2,14,8,(-10, -25),14,5,060,1,012,016,01A, 01C, 02D, 01E, 02F, 020, 021,
012,023,014, 025,016, 8, (-8, 4), 016,025,014, 023,012,021, 010,
8,(8,-4),2,094,028,1,01A, 01E, 012, 014, 025, 016, 027,028, 029, 01A, 02B,
01C, 02D, 01E, 8, (8, -4), 01E, 02D, 01C, 02B, 01A, 029, 018, 8, (-8,4), 2,
8,(16,-9),14,6,14,8, (10, -13),0

*QOOAA, 51, 1cau
2,14,8,-7,-21,14,5,8,4,14,3,2,1,0A0,2,054,1, 02A, 029, 028, 027, 016,
8,-1,3,024,8,1,3,012,021, 020, 02F, 02E, 2,034,1,0CC, 2,4,2,8, 4, -15,
14,6,14,8,7,-9,0

*O00AB, 25, kfrew



2,14,8, (-9, -14),14,5,0A0,1,076,072,2,050, 1, 07A, 07E, 2,030, 14, 6,
14,8, (9, -9),0

*9OOBO, 25, kdeg
2,14,8,(-3,-21),14,5,8,(1,19),1,10, (2,64),2,8, (8, -19), 14, 6,
14,8, (3,-9),0

*000B1, 39, kpls-min
2,14,8,(-13,-21),14,5,8,(13,21),1,8, (0, -18),2,096,1, 8, (18,0), 2,
8, ('181 '11)1118/ (1810)12181 (41 '1)11416114181 (13/ '9)10
*@00B5, 48, kmicro

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,07C,1,022,8, (3,19), OAC,
8,(1,-3),02F,030,021,032,2,0A4,1,0EC, 2,8, (4,0),14,6,14,3, 2,
14,8, (19, -32),14,4,2,0

*QOOBA, 56, 1cou
2,14,8,-7,-21,14,5,8,4,14,3,2,1,0A0, 2,8, -4,14,1, 028,029, 01A, 8, -1,
-3,02C, 8,1, -3,01E, 02F, 020,021,012, 8,1, 3,024, 8, -1, 3,016, 027, 2, 4, 2,
8,6,-21,14,6,14,8,7,-9,0

*QOOBB, 25, KFfrw

2,14,8, (-9, -14),14,5,030,1,072,076, 2,050, 1, 07E, 07A, 2, 0A0, 14, 6,
14,8, (9, -9),0

*@00BC, 43, kquart
2,14,8,(-14,-25),14,5,8, (4,21),1, 021,022, 0EC, 2,8, (-2, -14), 1,
8,(16,29),2,8,(2,-23),1,0A8,8,(7,9),0EC, 2,8, (7,3),14,6,
14,8, (14, -13),0

*QOOBD, 50, khalf
2,14,8,(-14,-25),14,5,8, (4,21),1, 021,022, 0EC, 2,8, (-2, -14), 1,
8,(16,29),2,8,(-6,-18),1,014, 023,021,020, 02F, 02D, 01C, 02B,
8,(-7,-8),080,2,8,(4,3),14,6,14,8, (14, -13),0

*O00BF, 47, kigm

2,14,8,(-9,-21),14,5,8, (13,4),1,016,012, 01E, 01C, 02B, 01A, 029, 038,
8,(-3,1),025,024,023,012, 021,022,034, 2,054,1,012,016, 01A, 01E, 2,
8,(8,-19),14,6,14,8,(9,-9),0

*QOOCO, 43, uch

2,14,8, (-9, -25),14,5,8,(9,23),1,047,2,04E,1,8, (-8, -21), 2,

8, (8121)11/81 (8/ '21)12181 ('1317)1110A012181 (41 '7)114161

14,8, (9,-9),0

*@OOCL, 43, uch
2,14,8,(-9,-25),14,5,8,(9,23),1,041,2,04A,1,8, (-8, -21), 2,

8, (8121)11/81 (8/ '21)12181 ('1317)1110A012181 (41 '7)114161
14,8, (9, -9),0

*QOOC2, 44, UC

2,14,8,(-9,-25),14,5,8, (5,23),1,041,04F,2,049,1,8, (-8, -21), 2,

8, (8121)11/81 (8/ '21)12181 ('1317)1110A012181 (41 '7)114161

14,8, (9,-9),0

*@OOC3, 55, uch

2,14,8, (-9, -25),14,5,8, (4,22),5,1,023,10, (2, -50), 01E, 10, (2, 82),
023,2,6,8, (51 '1)11181 ('81 _21)12181 (8121)11/81 (8/ '21)12181 ('1317)1
1,0A0,2,8,(4,-7),14,6,14,8,(9,-9),0

*QOOC4, 53, uc,,

2,14,8, (-9, -25),14,5,8, (4,24),1,01E,012,016, 01A, 2,080, 1, 01E, 012,
016, 01A,2,03A,1,8,(-8,-21),2,8,(8,21),1,8,(8,-21),2,8,(-13,7),1,



0A0,2,8,(4,-7),14,6,14,8,(9,-9),0

*@OOCS5, 45, uch

2,14,8, (-9, -25),14,5,8,(7,23),1,10, (2,64),2,02E,1,8, (-8, -21), 2,
8, (8121)11/81 (8/ '21)12181 ('1317)1110A012181 (41 '7)114161
14,8, (9, -9),0

*QOOC6, 45, uch

2,14,8, (-9, -21),14,5,010,1, 8, (8,21),8, (0,-21),080,2,8,(-8,7),1,
058,2,8,(5,4),1,050,2,8, (-5,10),1,080,2,8, (2, -21),14, 6,
14,8, (9, -9),0

*@OOC7, 65, uct
2,14,3,2,14,8,(-21,-42),14,4,2,14,5,8, (18,16),1, 025,026,027, 048,
029, 02A,02B,8, (-1, -3),05C, 8, (1, -3), 02D, 02E, 02F, 040, 021, 022, 023, 2,
8,(-9,-11),1,01E, 030,012, 024,016,028, 034,2,0A0,14,6,14, 3,2,

14,8, (21,-32),14,4,2,0

*QOOCS, 53, uch

2,14,3,2,14,8,(-19, -50),14,4,2,14,5,8,(6,25),1,8, (9, -4), 2,
8,(2,-2),1,0D8,8, (0,-19),0D0,2,8, (-13,10),1,080, 2,8, (7, -10), 14,6,
14,3,2,14,8, (19, -18),14,4,2,0

*0OOCY, 53, uch

2,14,3,2,14,8,(-19, -50),14,4,2,14,5,8,(6,21),1,8, (9, 4), 2,
8,(2,-6),1,0D8,8, (0,-19),0D0,2,8, (-13,10),1,080, 2,8, (7, -10), 14,6,
14,3,2,14,8, (19, -18),14,4,2,0

*@OOCA, 53, uch

2,14,3,2,14,8, (-19, -50),14,4,2,14,5,8, (6,23),1,041, 010, 04F, 2,
8,(2,-2),1,0D8,8,(0,-21),0D0,2,8,(-13,11),1,080, 2,8, (7, -11),14, 6,
14,3,2,14,8, (19, -18),14,4,2,0

*QOOCB, 61, uch

2,14,3,2,14,8, (-19, -50),14,4,2,14,5,8, (6,24),1,01E, 012, 016, 01A, 2,
070,1,01E,012,016,01A, 2,8, (4, -3),1,0D8, 8, (0, -21),0D0, 2,
8,(-13,11),1,080,2,8,(7,-11),14,6,14,3,2,14,8, (19, -18),14,4,2,0
*@OOCC, 29, uch

2,14,8,(-4,-25),14,5,8, (4,23),1,026,2,04D,1, 8, (0,-21),2,8, (4,0),
14,6,14,8,(4,-9),0

*@OOCD, 29, uch

2,14,8,(-4,-25),14,5,8, (4,23),1,022,2,048B,1, 8, (0,-21),2,8, (4,0),
14,6,14,8,(4,-9),0

*@OOCE, 30, uch
2,14,8,(-4,-25),14,5,8,(2,23),1,022,02E,2,02A,1,8, (0, -21), 2,

8/ (410)11416114/81 (41 '9)10

*QOOCF, 41, uch
2,14,8,(-4,-25),14,5,8,(1,24),1,01E,012,016, 01A, 2, 040, 1, 01E, 012,
016101A12181 ('1/ '3)11181 (Or '21)12181 (410)11416114181 (41 '9)10
*QOOD1, 41, uc

2,14,8, (-11, -25),14,5,040,1,8, (0,19), 8, (14, -19), 8, (0, 19), 2,
8,(-13,3),1,032,010,8, (4, -3),010,032,2,8, (5, -25), 14,6,
14,8, (11, -9),0

*QOOD2, 44, uch

2,14,8, (-11, -25),14,5,8, (6,25),1,08F, 2,8, (-6, -2),1,029, 02A, 04B,
05C, 04D, 02E, 02F, 040, 021, 022, 043, 054, 045, 026, 027,048, 2, 8, (13, -19),
14,6,14,8, (11, -9),0



*QOOD3, 42, uch

2,14,8, (-11, -25),14,5,8, (6,21),1,081,2,06A, 1,029, 02A, 04B, 05C, 04D,
02E, 02F, 040, 021, 022, 043, 054, 045, 026, 027,048, 2,8, (13, -19),14, 6,
14,8, (11, -9),0

*@OOD4, 57, uch

2,14,8, (-11, -25),14,5,8, (6,23),1,041,04F, 2,8, (-6,-2),1,029, 02A,
028B,8, (-1, -3),05C, 8, (1, -3),02D, 02E, 02F, 040, 021, 022, 023, 8, (1, 3),
054,8, (-1,3),025,026,027,048,2,8, (13, -21),14,6,14,8, (11, -9),0
*@OODS5, 66, uch

2,14,8, (-11, -25),14,5,8, (6,22),5,1,023,10, (2, -50), 01E, 10, (2, 82),
023,2,6,8,(3,-1),1,029,02A,028,8, (-1, -3),05C, 8, (1, -3),02D, 02E,
02F, 040,021, 022,023, 8, (1,3),054,8, (-1,3), 025,026,027, 048, 2,
8,(13,-21),14,6,14,8, (11, -9),0

*QOOD6, 66, UCA

2,14,8, (-11, -25),14,5,8, (6,24),1,01E, 012,016, 01A, 2,080, 1, 01E, 012,
016, 01A, 2,8, (-5, -3),1,029,02A, 028, 8, (-1, -3),05C, 8, (1, -3), 02D, 02E,
02F, 040,021, 022,023, 8, (1,3),054,8, (-1,3), 025,026,027, 048, 2,
8,(13,-21),14,6,14,8, (11, -9),0

*QOODS, 54, UC>

2,14,8, (-11, -21),8,(9,21),1,029,02A,028B, 8, (-1, -3),05C, 8, (1, -3),
02D, 02E, 02F, 040, 021, 022, 023, 8, (1,3), 054, 8, (-1,3), 025,026, 027, 048,
2,8, ('61 '21)11/81 (16121)12181 (31 '21)114181 (_11/ '9)10
*QOODY, 43, uch

2,14,8, (-11, -25),14,5,8, (15,21),1,087,2,06B,1,0DC, 8, (1, -3), 02E,
8,(3,-1),020,8,(3,1),022,8,(1,3),0D4,2,8,(4,-19),14,6,
14,8, (11, -9),0

*QOODA, 45, uch

2,14,8, (-11, -25),14,5,8, (15,25),1,089,2,8, (-3, -2),1,0DC, 8, (1, -3),
02E, 8, (3,-1),020,8,(3,1),022,8,(1,3),0D4,2,8, (4,-19), 14,6,
14,8, (11, -9),0

*QOODB, 46, uch

2,14,8, (-11, -25),14,5,8, (15,23),1,047,049,2,8, (-3, -2), 1, OFC,

8/ (11 '3)102Er8l (31 '1)1020181 (311)1022/81 (113)10F412181 (41 _21)1
14,6,14,8, (11, -9),0

*@OODC, 55, uch

2,14,8, (-11, -25),14,5,8, (14,24),1, 01E, 012, 016, 01A, 2,088, 1, 01E,
012,016, 01A, 2,8, (-2,-3),1,0FC, 8, (1, -3),02E, 8, (3,-1),020,8, (3,1),
022,8,(1,3),0F4,2,8, (4,-21),14,6,14,8, (11, -9),0

*@OODD, 38, uch

2,14,8,(-9,-25),14,5,8, (13,25),1,089,2,049,1,8, (8, -9), 0AC, 2,

8/ (8119)11/81 ('81 '9)12181 (gl '10)11416114181 (91 '9)10
*@00DF, 53, kgers
2,14,8,(-9,-21),14,5,030,1,012, 8, (0,16),023,012, 021, 020, 02F, O1E,
02D, 02C, 02B, 01A, 029, 028, 2,020,1, 8, (3, -1), 01E, 02D, 03C, 02B, 01A, 029,
028,027,016, 012, 01E, 2, 8, (10, -2), 14, 6,14, 8, (9, -9),0

*QO0EO, 63, 1c..

2,14,3,2,14,8,(-19, -42),14,4,2,14,5,8,(5,21),1,8, (8, -4), 2,
8,(2,-3),1,0EC,2,0B4,1,026,027,038,029,02A,8, (-1, -3),02C,
8,(1,-3),02E,02F, 030,021,022, 2,8, (4,-3),14,6,14,3, 2,

14,8, (19, -18),14,4,2,0



*QOOE1, 63, 1c

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8,(5,17),1,8, (8,4), 2,
8,(2,-7),1,0EC,2,0B4,1,026,027,038,029,02A,8, (-1, -3),02C,
8,(1,-3),02E,02F, 030,021,022, 2,8, (4,-3),14,6,14,3, 2,

14,8, (19, -18),14,4,2,0

*QOOE2, 64, 1cA

2,14,3,2,14,8, ('191 '42)114141211415181 (5118)11/81 (413)181 (41 '3)1
2,04D,1,0EC, 2,0B4,1,026, 027,038,029, 02A, 8, (-1, -3),02C, 8, (1, -3),
02E, 02F, 030, 021,022, 2, 8, (4, -3),14,6,14,3,2,14,8, (19, -18),14,4,2,0
*@OOE3, 63, 1cf

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8, (4,18),1,032, 010, 03E, 010,
032,2,07C, 1, 0EC, 2, 0B4,1, 026,027,038, 029, 02A, 8, (-1, -3), 02C,
8,(1,-3),02E,02F, 030,021,022, 2,8, (4,-3),14,6,14,3, 2,

14,8, (19, -18),14,4,2,0

*@OOE4, 71, 1c,,

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8, (4,20),1,01E, 012, 016, 01A, 2,
090, 1, 01E, 012,016, 01A, 2,8, (2, -6),1,0EC, 2,0B4, 1,026, 027,038, 029,
02A,8, (-1, -3),02C,8,(1,-3),02E,02F,030,021,022,2,8, (4, -3),14,6,
14,3,2,14,8, (19, -18),14,4,2,0

*QOOES5, 63, 1ct

2,14,3,2,14,8,(-19, -42),14,4,2,14,5,8,(7,19),1,10, (2,64), 2,
8,(8,-5),1,0EC,2,0B4,1,026,027,038,029,02A,8, (-1, -3),02C,
8,(1,-3),02E,02F, 030,021,022, 2,8, (4,-3),14,6,14,3, 2,

14,8, (19, -18),14,4,2,0

*QOOE6, 51, 1c

2,14,8,(-10, -14),14,5,8, (10,8),1,070,014,8, (-1,3), 026,028, 02A,
026,028, 02A,8, (-1, -3),04C, 8, (1, -3),02E, 020, 022, 02E, 020, 021, 023, 2,
8,(-7,11),1, 0EC, 2, 0A0, 14,6,14,8, (10, -9),0

*QOOE7, 49, 1ct

2,14,8, (-9, -14),14,5,8, (15,11),1, 026, 027,038,029, 02A, 8, (-1, -3),
02C, 8, (1, -3), 02E, 02F, 030, 021,022, 2,8, (-8, -9),1, 01E, 030,012, 024,
016, 028,034,2,090,14,6,14,8, (9, -16),0

*QOOES, 48, 1c3
2,14,8,(-9,-21),14,5,8,(5,21),1,08F, 2,8, (-10, -9),1,0C0, 024, 025,
016, 027,038,029, 02A, 8, (-1, -3),02C, 8, (1, -3), 02E, 02F, 030, 021, 022, 2,
8/ (31 '3)11416114181 (91 '9)10

*QOOE9, 48, 1c,
2,14,8,(-9,-21),14,5,8,(5,17),1,081,2,8, (-10, -13),1,0C0, 024, 025,
016, 027,038,029, 02A, 8, (-1, -3),02C, 8, (1, -3), 02E, 02F, 030, 021, 022, 2,
8/ (31 '3)11416114181 (91 '9)10

*QOOEA, 51, 1c”

2,14,8, (-9, -21),14,5,8,(5,18),1,8, (4,3),8, (4,-3),2,0AA,1,0C0, 024,
025,016,027, 038,029, 02A, 8, (-1, -3),02C, 8, (1, -3), 02E, 02F, 030, 021,
022,2,8,(3,-3),14,6,14,8,(9,-9),0

*QOOEB, 58, 1c%

2,14,8,(-9,-21),14,5,8, (4,20),1,01E,012,016, 01A, 2,080, 1, 01E, 012,
016, 01A, 2,8, (-9, -12),1,0C0, 024, 025,016,027, 038, 029, 02A, 8, (-1, -3),
02C, 8, (1, -3), 02E, 02F, 030, 021,022, 2,8, (3, -3),14,6,14,8, (9, -9),0
*QOOEC, 27, 1c_
2,14,8,(-7,-21),14,5,8,(3,21),1,08F, 2,04A,1,0DC, 2,8, (4,0), 14,6,



14,8, (7,-9),0

*@OOED, 27, 1c
2,14,8,(-7,-21),14,5,8,(3,17),1,081,2,088B,1,0DC, 2,8, (4,0), 14,6,
14,8, (7,-9),0

*QOOEE, 34, 1cE

2114181 ('71 _21)/1415181 (3118)11181 (413)181 (41 '3)12181 ('41 _5)111
oDC, 2,8, (4,0),14,6,14,8,(7,-9),0

*QOOEF, 39, 1c«
2,14,8,(-7,-21),14,5,8,(3,20),1,01E, 012,016, 01A, 2,060, 1, 01E, 012,
016,01A,2,8,(-2,-7),1,0DC,2,8,(4,0),14,6,14,8,(7,-9),0
*QOOF1, 56, 1c

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8, (4,18),1,032, 010, 03E, 010,
032,2,8,(-11,-7),1,0EC,2,0A4,1,032,021,030, 02F, 8, (1, -3), 0AC, 2,
8,(4,0),14,6,14,3,2,14,8, (19, -18),14,4,2,0

*QOOF2, 64, 1cs

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8,(5,21),1,8, (9, -4),2,069, 1,
029, 02A, 8, (-1, -3),02C, 8, (1, -3), 02E, 02F, 030, 021,022, 8, (1, 3), 024,
8,(-1,3),026,027,038,2,8, (11, -14),14,6,14,3,2,14,8, (19, -18), 14, 4,
2,0

*QOOF3, 66, 1c

2,14,3,2,14,8,(-19, -42),14,4,2,14,5,8,(5,17),1,8, (9, 4), 2,
8,(-6,-7),1,029,02A,8,(-1,-3),02C,8, (1, -3),02E,02F, 030,021,022,
8,(1,3),024,8,(-1,3),026,027,038,2,8, (11, -14),14,6,14, 3, 2,

14,8, (19, -18),14,4,2,0

*QOOF4, 73, 1c“

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8,(5,18),3,2,1,8, (9, 6),

8/ (gl '6)12/412/81 ('61 _4)111029102AI8I (_11 '3)102(:/8/ (11 '3)102Er
02F, 030,021,022, 8, (1,3),024,8, (-1,3), 026,027,038, 2,8, (11, -14),
14,6,14,3,2,14,8, (19, -18),14,4,2,0

*QOOF5, 68, 1cA

2,14,3,2,14,8,(-19, -42),14,4,2,14,5,8, (4,18),1,032, 010, 03E, 010,
032,2,8,(-7,-7),1,029,02A,8, (-1, -3),02C, 8, (1, -3), 02E, 02F, 030, 021,
022,8,(1,3),024,8,(-1,3),026,027,038,2,8, (11, -14),14, 6,14, 3, 2,
14,8, (19, -18),14,4,2,0

*QOOF6,74,1c”

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8, (4,20),1,01E, 012, 016, 01A, 2,
090, 1, 01E, 012,016, 01A, 2,8, (-5, -6),1, 029, 02A, 8, (-1, -3), 02C,

8, (1, -3),02E,02F, 030,021,022, 8, (1,3),024,8, (-1,3), 026,027,038, 2,
8,(11,-14),14,6,14,3,2,14,8, (19, -18),14,4,2,0

*@OOF7, 41, kto

2,14,8, (-9, -14),14,5,8,(8,13),1,01E, 012,016, 01A, 2,8, (-5, -6),1,
0Co,2,8,(-7,-6),1,01E,012,016, 01A, 2,8, (10, -1),14,6,14,8, (9, -9), 0
*QOOF8, 24, 1C>

7I@6F1218I (_3114)114181 (919)11181 (_13/ _14)12181 (1710)1

14,8, (-10, -9),0

*QOOF9, 54, 1c—

2,14,3,2,14,8,(-19, -42),14,4,2,14,5,8,(5,21),1,8, (9, -4), 2,
8,(-10,-3),1,0AC, 8, (1, -3),02F, 030,021,032, 2, 0A4,1, 0EC, 2, 8, (4, 0),
14,6,14,3,2,14,8, (19, -18),14,4,2,0

*QOOFA, 54, 1c



2,14,3,2,14,8,(-19, -42),14,4,2,14,5,8,(5,17),1,8, (9, 4), 2,
8,(-10,-7),1,0AC, 8, (1, -3),02F, 030,021,032, 2, 0A4,1, 0EC, 2,8, (4,0),
14,6,14,3,2,14,8, (19, -18),14,4,2,0

*QOOFB, 61, 1C-

2,14,3,2,14,8,(-19, -42),14,4,2,14,5,8,(5,18),3,2,1,8, (9, 6),
8,(9,-6),4,2,2,8,(-10,-4),1,0AC, 8, (1, -3),02F, 030,021, 032,2,0A4,1,
QEC, 2,8, (4,0),14,6,14,3,2,14,8, (19, -18),14,4,2,0

*QOOFC, 62, 1c_

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8, (4,20),1,01E, 012, 016, 01A, 2,
090, 1, 01E, 012,016, 01A, 2,8, (-9, -6),1, 0AC, 8, (1, -3), 02F, 030, 021, 032,
2,0A4,1,0EC, 2,8, (4,0),14,6,14,3,2,14,8, (19, -18),14,4,2,0
*QOOFD, 43, 1cA

2114181 ('81 _14)/1415181 (2114)15103211/81 (914)16/81 (61 '14)121
8,(6,14),1,8,(-6,-14),04B,02A, 029,018, 2,8, (15,7), 14, 6,
14,8, (8, -16),0

*QOOFF, 53, 1c”
2,14,8,(-8,-21),14,5,8,(3,20),1,01E,012,016, 01A, 2,080, 1, 01E, 012,
016,01A,2,8,(-9,-6),1,8,(6,-14),2,8,(6,14),1,8, (-6, -14),04B, 02A,
029,018, 2,8, (15,7),14,6,14,8, (8, -16),0

*00104, 50, c164

2,14, 8, ('91 _21)/1415181 (9121)11181 ('81 _21)12181 (8121)11/
8,(8,-21),3,2,10, (5,36),1,10, (5,-100),4,2,2,8, (-13,7),1, 0A0, 2,

8/ (41 '7)11416114181 (91 '9)10

*00105, 66, 165

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (15,14),1, 0EC, 3, 2, 10,
(5,36),2,10, (5, -100),4,2,2,0B4,1,026,027, 038,029, 02A, 8, (-1, -3),
02C, 8, (1, -3), 02E, 02F, 030, 021, 022, 2, 8, (4, -3),14,6,14, 3, 2,

14,8, (19, -18),14,4,2,0

*00106, 71,c143

2,14,3,2,14,8,(-21,-42),14,4,2,14,5,3,2,2,8, (18,48),1,8,(8,6), 2,
8, (-26,-54),4,2,8,(18,16),1,025,026,027,048,029, 02A, 02B,
8,(-1,-3),05C,8, (1,-3),02D,02E, 02F, 040,021, 022,023, 2,8, (3, -5),
14,6,14,3,2,14,8, (21, -18),14,4,2,0

*00107,54,c134

2,14, 8, ('91 _14)/1415181 (15111)1312181 (_15110)11/81 (614)121
8,(9,-14),4,2,1,026,027, 038,029, 02A,8, (-1, -3),02C, 8, (1, -3), 02E,
02F, 030,021,022, 2,8, (3,-3),14,6,14,8, (9, -9),0

*010C, 49, c172

2,14,8, (-11, -27),8, (18,16),1, 025,026, 027, 048, 029, 02A, 02B,
8,(-1,-3),05C,8,(1,-3),02D,02E, 02F, 040,021, 022,023,2,8, (-7,18),1,
042,2,04A,1,046,2,8, (14, -27),14,8, (-10,-9),0

*0010D, 41, c159

2,14,8, (-9, -20), 0F0, 0B4, 1,026, 027,038,029, 02A, 8, (-1, -3), 02C,
8,(1,-3),02E,02F, 030,021,022, 2,068,0D4,1,042,2,04A,1,046, 2,

8, (13, -20),14,009A,0

*QO10E, 53, c210

2,14,8, (-11, -27),8, (4,21),1,0FC,06C, 2, OF4,064,1,070, 8, (3, -1), 02E,
02D, 8, (1,-3),05C,8, (-1, -3),02B,02A,8, (-3,-1),078,2,8, (7,23),1,
042,2,04A,1,046,2,8, (14, -27),14,8, (-10,-9),0

*QO10F, 46, c212



2,14,8, (-10, -21),8, (15,21),1, OFC, 06C, 2, 0B4, 1,026,027, 038, 029, 02A,
8,(-1,-3),02C,8,(1,-3),02E,02F,030,021,022,2,8, (4,18),1,
8,(-3,-4),2,8,(3,-17),14,00A, 0

*00118, 66, c168

2,14,3,2,14,8, (-19, -42),14,4,2,14,5,8, (4,21),1,8, (0, -21), 2,
8,(0,21),1,0D0, 2,8, (-13,-10),1,080, 2,8, (-8, -11),1,0D0, 3, 2, 10,
(5,36),1,10, (5,-100),4,2,2,8,(2,0),14,6,14,3,2,14,8, (19, -18),
14,4,2,0

*00119, 66, 169
2,14,8,(-9,-14),14,5,8,(3,8),1,0C0, 024,025,016, 027, 038,029, 02A,
8,(-1,-3),02C,8,(1,-3),02E,02F, 030, 3,2,10, (5,36),2,10, (5, -100), 1,
4,2,021,022,2,3,2,10,(5,36),2,10, (5,-100),4,2,2,8,(3,-3), 14,6,
14,8, (9, -9),0

*QO11A, 43, c183

2,14,8, (-10, -27),8, (4,21),1,0FC,06C, 2, OF4, 064, 1, 0D0, 2, D8, OAC, 1,
080, 2,088,0BC,1,0D0,2,8, (-7,23),1,042,2,04A,1,046,2,8, (13, -27),
14, 09A, 0

*0011B, 44,c216

2,14,8, (-9, -20),030,084,1,0C0, 024,025,016, 027, 038, 029, 02A,
8,(-1,-3),02C,8,(1,-3),02E,02F,030,021,022,2,068,0D4,1,042,2,04A,
1,046,2,8, (13, -20),14,09A, 0

*Q0141,51, c157

2,14,3,2,14,8, (-17,-42),14,4,2,14,5,8,(3,21),1,8, (0, -21), 2,

8/ ('11 11)11181 (718)12181 (_61 '19)1110C012181 (310)1141611413121
14,8, (17,-18),14,4,2,0
*00142,33,c136

2,14, 8, ('41 _21)/1415181 (5121)11181 (OI '21)12181 ('1110)11/81 (416)1
2,8,(3,-16),14,6,14,8,(4,-9),0

*Q0143,52,c227

2,14, 8, ('111 '21)11415181 (4121)181 (513)11181 (413)12181 ('91 _6)111
8, (OI '21)12181 (0121)11181 (141 _21)12181 (0121)11/81 (OI _21)121
8,(4,0),14,6,14,8, (11, -9),0

*Q0144,57,C228

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (4,14),8, (4,2),1,8, (3,2), 2,
8,(-7,-4),1,0EC,2,0A4,1,032,021,030,02F, 8, (1,-3),0AC,2,8,(4,0),
14,6,14,3,2,14,8, (19, -18),14,4,2,0

*00147,38,c213

2,14,8, (-11, -27),8, (4,21),1,0FC,06C, 2, OF4,064,1, 8, (14, -21), OF4,
064,2,078,024,1,042,2,04A,1,046,2,8, (15, -27),14,8, (-11,-9),0
*00148, 37, c229

2,14,8, (-10, -20), 040, OE4, 1, OEC, 2, 0A4, 1,032,021, 030, 02F, 8, (1, -3),
0AC, 2,8, (-5,16),1,042,2,04A,1,046,2,8, (13, -20),14,09A, 0
*00150, 58, c138

2,14,8, (-11, -21),14,5,8, (9,21),1, 029, 02A,02B,8, (-1, -3), 05C,

8, (1, -3),02D, 02E, 02F, 040, 021, 022,023,8, (1,3),054,8, (-1, 3), 025,
026,027,048,2,034,1,044,2,040,1,04C,2,8, (9, -24),14,6,
14,8, (11, -9),0

*QO151, 68, c139

2,14,3,2,14,8, (-19, -28),14,4,2,14,5,8, (8,14),1,029,02A,8, (-1, -3),
02C, 8, (1, -3), 02E, 02F, 030, 021, 022, 8, (1, 3),024,8, (-1, 3), 026,027,



038,2,8,(4,4),1,044,2,058,1,04C, 2,8, (12, -18),14, 6,14, 3,2,

14,8, (19, -18),14,4,2,0

*Q0158, 53, 252

2,14,8, (-11, -27),8, (4,21),1,0FC,06C, 2, OF4, 064,1,090, 8, (3, -1), O1E,
02D, 02C, 02B, 01A, 8, (-3, -1),098,2,070,1,8, (7, -11),2,8, (-7,23),1,
042,2,04A,1,046,2,8, (14, -27),14,8, (-10,-9),0

*@O159, 35, 253
2,14,8,(-7,-20),040,0E4,1, 0EC, 2,084,1,8, (1,3),022,021,030, 2, 058,
024,1,042,2,04A,1,046,2,0FD,05D,14,8, (-6, -9),0

*0015A, 62,c151

2114181 ('101 '21)11415181 (17118)181 ('916)11/81 (4/3)12181 (51 '9)111
026,8,(-3,1),048,8, (-3,-1),02A,02C, 02D, 01E, 02F, 8, (6, -2), 02F, O1E,
02D, 03C, 02A,8, (-3, -1),048,8, (-3,1),026,2,8, (17, -3),14, 6,
14,8, (10, -9),0

*@O15B, 71, c152

2,14,3,2,14,8, (-17,-28),14,4,2,14,5,8, (14,11),8,(-7,5),1,8, (3, 2),
2,8,(4,-7),1,025,8,(-3,1),038,8,(-3,-1),028B,02D, 02F, 8, (5, -1), 02F,
02D, 01C, 02B, 8, (-3, -1),038,8, (-3,1),025,2,8, (14, -3),14,6,14,3, 2,
14,8, (17,-18),14,4,2,0

*00160,57, c230

2,14,8, (-10, -27),8,(17,18),1,026,8, (-3,1),048,8, (-3, -1),02A, 02C,
02D, 01E, O2F, 8, (6, -2), 02F, 01E, 02D, 03C, 02A, 8, (-3, -1), 048, 8, (-3,1),
026,2,8,(7,20),1,042,2,04A,1,046,2,8, (14, -27),14,8, (-10,-9),0
*00161,52,c231

2,14,8, (-9, -20),0E0, 0B4,1,025,8, (-3,1),038,8, (-3, -1), 02B, 02D, 02F,
8,(5,-1),02F,02D,01C,028B,8, (-3, -1),038,8, (-3,1),025,2,060,0D4, 1,
042,2,04A,1,046,2,8, (12, -20),14,8,(-8,-9),0

*00164, 35, c155
2,14,8,(-8,-27),8,(8,21),1,0FC,06C, 2,8, (-7,21),1,0E0, 2,078,024, 1,
042,2,04A,1,046,2,8, (12, -27),14,8,(-8,-9),0

*00165, 36, 156
2,14,8,(-6,-21),8,(5,21),1,0FC,02C, 8, (1, -3),02F, 020, 2,088, 0E4, 1,
070,2,074,1,8,(-3,-4),2,8,(6,-17),14,8, (-6, -9),0

*QO16E, 45, c222

2,14,8, (-11, -27),8, (4,21),1,0FC, 8, (1, -3), 02E, 8, (3, -1), 020,
8,(3,1),022,8,(1,3),0F4,2,078,024,1,021,024,027,029,02C, 02F, 2,

8, (11, -23),14,8, (-11,-9),0

*QO16F, 38, c133

2,14,8, (-10, -20), 040, 0E4, 1, 0AC, 8, (1, -3), 02F, 030, 021,032, 2, 0A4, 1,
0EC, 2,8, (-5,16),1, 021,024,027, 029, 02C, 02F, 2,8, (9, -16),14, 09A, 0
*QO170, 52, c235

2,14,8,(-11, -21),14,5,8, (4,21),1,0FC,8, (1, -3), 02E, 8, (3, -1), 020,
8,(3,1),022,8,(1,3),0F4,2,058,034,1,044,2,048,1,04C, 2,8, (9, -2), 2,
8,(4,-22),14,6,14,8, (11, -9),0

*QO171, 60, c251

2,14,3,2,14,8,(-19, -28),14,4,2,14,5,8, (4,14),1,0AC, 8, (1, -3), 02F,
030, 021,032,2,0A4,1,0EC, 2,8, (-8,18),1,044, 2,050, 1, 04C, 2,
8,(3,-18),2,8,(4,0),14,6,14,3,2,14,8, (19, -20),14,4,2,0
*QO179, 45, c141

2,14,8, (-10, -21),14,5,8, (17,21),1,8, (-14,-21), 2,8, (5,24), 1,



8/(413)12181('9/'6)1110E012181('141'21)11/0E012/81(310)114161
14,8, (10, -9),0

*QO17A,58,c171

2,14,3,2,14,8,(-17,-28),14,4,2,14,5,8, (14,14),8,(-7,2),1,8, (3, 2),
2,8,(4,-4),1,8,(-11, -14),2,0E4,1,0B0, 2,8, (-11, -14),1, 0B0, 2,
8,(3,0),14,6,14,3,2,14,8,(17,-18),14,4,2,0

*QO17B, 45, c189

2,14,8,(-10, -21),14,5,8, (17,21),5,3,2,8,(-13,6),1,10, (2,96), 4, 2,
6,1,8, (-14,-21),0E0, 2,8, (-14,21),1,0E0, 2,8, (3, -21),14,6,
14,8, (10, -9),0

*O17C, 59, c190
2,14,3,2,14,8,(-17,-28),14,4,2,14,5,8, (14,14),5,3,2,8, (-11,5), 1,
10, (1,96),4,2,6,8,(-11,-14),2,0E4,1,0B0, 2,8, (-11, -14),1, 08B0, 2,
8,(3,0),14,6,14,3,2,14,8,(17,-18),14,4,2,0

*Q017D, 42, C166

2,14,8, (-10, -27),8,(17,21),1,8, (-14, -21),2,0F4, 064, 1, OE0, 2,
8,(-14,-21),1,0E0,2,8,(-7,23),1,042,2,04A,1,046,2,8, (14, -27),
14,8, (-10, -9),0

*QO17E, 38, Cc167
2,14,8,(-9,-20),0E2,1,8, (-11, -14),2,0E4,1,0B0O, 2, 0B8, OEC, 1, OBO, 2,
8,(-5,16),1,042,2,04A,1,046,2,8,(12,-20),14,8,(-8,-9),0
*00410, 38, _
2114181('91_21)/2181(417)11191(1010)1(010)12181('131_7)11191
(8121)1(81'21)1(010)12181(110)11/2114181('91'9)/0

*00411, 46, _
2114181('101'21)12181(15121)11191(_11/0)1(01'21)1(910)1(311)1
(111)1(112)1(013)1('112)/('1/1)/('311)1('919)/(010)/218/(17/'11)/
1,2,14,8,(-11,-9),0

*00412, 68, ,
2114181('111'21)12181(13121)11191(_910)1(01_21)/(910)1(311)1
(111)1(112)1(013)1('112)/('1/1)/('311)1('919)/(010)/218/(9110)11/
9/(31'1)1(11'1)/(11'2)1(01'2)1('11_2)1('11'1)1('31'1)1(010)121
8/(91'11)1112114181(_11/'9)10

*00413, 28, f
2,14,8,(-8,-21),2,8,(16,21),1,9,(-12,0),(0,-21),(0,0),2,8,(13,0),
112114181('91'9)10

*00414, 50, ,,
2114181('121'21)12181(221_4)11191(014)1('2010)1(01'4)1(010)121
8,(2,4),1,9,(3,3),(1,2),(1,4),(0,12), (11,0), (0, -21), (0,0), 2,
8/(410)11/2114181('121'13)10
*00415, 40, ..
2,14,8,(-9,-21),2,8,(17,21),1,9
8/('1111)11191('1210)1(010)12181
*00416,66, Tt
2114181('121'21)12181(110)11/91(9112)1(010)1218/(219)11/91
(01'21)1(010)12/81(11121)11191('111'11)1(010)12/81('11111)11/91
(111'11)1(010)12181(111'10)11191('9112)1(010)12/81(101'12)11/21
14,8, (-12,-9),0

*Q0417, 68, T
2114181('91_21)/2181(3120)11/91(411)1(310)1(31'1)1(11'2)1(01'2)1

I(_1310)1(01_21)1(1310)1(010)121
(15,-11),1,2,14,8,(-10,-9),0



(-1,-2),(-3,-2 ,( -1),(2,-2),(2,-2),(0,-2),(-1,-2),(-2,-2),
(-3,-1),(-3,0) ( 1),(-3,2),(0,0),2,8,(9,9),1, 9 (-4,0),(0,0),2,
8, (12, 12) ,2.14,8, (-9,-9),0

*0@418 30,
2114181('111'21)12181(4121)11191(01'21)1(14121)/(01'21)1(010)121
8,(4,0),1,2,14,8,(-11,-9),0

*00419, 48, %
2114181('111'21)12181(4121)11191(01'21)1(14121)/(01'21)1(010)121
8/('11126)11191(11'1)1(21_1)1(210)1(211)1(111)1(010)12181(71'26)1
1,2,14,8,(-11,-9),0

*0041A,46,S
2114181('101'21)12181(1810)11191('9112)1(010)12/81(919)11191
('141'14)1(010)/2181(0114)11/91(OI_21)1(010)12/81(1610)11121
14,8, (-10,-9),0

*0041B, 36, <
2114181('101'21)12181(1610)11191(0121)1('1110)1(01'17)1('11'2)1
('11'1)1('21'1)/(010)12181(1910)1112114181(_101'9)10
*0041C, 32, E
2114181('121'21)12181(2010)11191(0121)1('81_15)/('8115)1(01'21)1
(010)12181(2010)1112114181('121'9)10

*0041D, 46, _
2114181('111'21)12181(4121)11191(01'21)1(010)12/81(0111)11191
(1410)1(010)12/81(01_11)11191(0121)1(010)12181(41'21)11/21

14,8, (-11,-9),0

*Q041E, 64,
2114181('111'21)12181(9121)11191(410)1(21'1)1(2/'2)1(11'2)1
(11'3)1(01'5)1('11'3)1('11'2)1('2/'2)/('2/'1)/('410)1('2/1)/
('212)1('112)1('113)1(015)1(113)/(112)1(2/2)1(2/1)/(010)/21
8,(13,-21),1,2,14,8,(-11,-9),0

*Q041F, 30, _
2114181('111'21)12181(410)11/91(0121)1(1410)1(0/'21)1(010)121
8/(410)11/2114181('111'9)10

*00420, 44, _
2114181('101'21)12181(410)11/91(0121)1(910)1(31'1)1(11'1)1(11_2)1
(01'3)1('11_2)1('11'1)1('31'1)1('910)1(010)1218/(161_10)11121
14,8, (-10, -9),0

*00421, 62,
2114181('101'21)12181(18116)11191(_112)1('111)1('111)1('211)1
('410)1('21_1)1('11'1)1('11'1)1('11'2)1('1/'3)/(01'5)1(1/‘3)/
(11'2)1(21'2)1(21'1)1(4/0)1(211)/(212)1(1/2)1(0/0)/218/(21'5)11/
2,14,8,(-10,-9),0

*00422, 36,
2,14,8,(-8,-21),2,8,(8,21),1,9,(0,-21),(0,0),2,8,(-7,21),1,9,
(1410)1(010)12/81(11_21)1112114181('81_9)10

*Q0423, 44,

2,14,8,(-8,-21),2,8,(15,21),1,9, (-7, -17), (-1, -2), (-1, -1), (-2, -1),
(-1,0),(0,0),2,8, (-2,21),1,9, (7,-17), (0,0),2.8, (8, -4),1, 2,

14,8, (-8, -9),0

00424, 74, "
2114181('131'21)12181(11/19)11191(410)1(31'1)1(21'1)1(21'2)1

)



(11'2)1(01'4)1('11'2)1('21'2)1('2/'1)/('3/'1)/('410)1('3/1)/
('211)1('212)1('112)1(014)1(112)/(212)1(2/1)1(3/1)/(010)/21
8/(212)11/91(01'21)1(010)12181(1310)1112114181('131'9)10
*00425, 36,
2114181('81_21)/2181(15121)11191('141'21)1(010)/2181(0121)11/91
(141'21)1(010)12181(110)1112/14181('81_9)10

*00426, 40, -
2114181('111'21)12181(4121)11191(01'21)1(1610)1(01'4)1(010)121
8/('2125)11191(01'21)1(010)12181(410)1112114181('11/_13)10
*00427,44,—
2114181('101'21)12181(3121)11191(01'8)1(11'3)1(11'1)1(31'1)1
(9,0),(0,0),2,8,(0,13),1,9,(0,-21),(0,0),2,8,(4,0),1,2,

14,8, (-11,-9),0

*00428,40, "
2114181('141'21)12181(4121)11191(01'21)1(2110)1(0121)1(010)121
8/('1010)11191(01'21)1(010)12181(1410)1112/1418/('151'9)10
*00429,50,™
2114181('141'21)12181(4121)11191(01'21)1(2310)1(01'4)1(010)121
8/('12125)11191(01'21)1(010)12181(10121)11/91(0/'21)1(010)12/
8/(410)11/2114181('151'13)10

*0042A,48, S
2114181('101'21)12181(1121)11191(410)1(OI'21)1(810)1(210)1(211)1
(111)1(112)1(014)1('112)/('1/1)/('211)1('1010)/(010)12/
8,(16,-12),1,2,14,8,(-11,-9),0

*0042B, 54, >
2114181('121'21)12181(4121)11191(01'21)1(910)1(211)1(111)1(112)1
(014)1('112)1('111)1('211)1('910)1(010)12181(16/9)11191(01'21)1
(010)12181(410)/112114181('121'9)10

*0042C, 44, @
2114181('101'21)12181(4121)11191(01'21)1(1010)1(211)1(111)1(112)1
(014)1('112)1('111)1('211)1('1010)1(010)12/81(161'12)11/21

14,8, (-10,-9),0

*0042D, 64, _
2114181('91_21)/2181(6111)11/91(1010)1(010)1218/('1417)11191
(212)1(211)1(410)1(21'1)1(21'2)/(11'2)1(1/'3)/(01'5)1('1/‘3)/
('11'2)1('21'2)/('21_1)/(‘4/0)1('211)/('2/2)1(0/0)/218/(171'3)11/
2,14,8,(-10,-9),0

*0042E, 76, _
2114181('131'21)12181(14121)11191(410)1(21'1)1(21'3)1(11'4)1
(01'5)1('11_4)1('21'3)1('21'1)1('410)/('2/1)1('213)/('1/4)1(015)/
(114)1(213)1(211)1(010)12181(_51'1@)11191('510)/(010)12181(0110)1
1191(Or'2121(010)12181(2210)1112114181('131_9)10

*0042F,54,Y
2114181('101'21)12181(210)11/91(7111)1(010)1218/(71'11)11191
(0121)1('910)1('31'1)1('11'1)1('1/’2)/(0/'2)1(1/'2)/(1/'1)1
(31'1)1(910)1(0/0)12181(41'11)11/2114181('101'9)10

*00430,62,
2114181('91_14)/2181(1513)11/91('21'2)1('21_1)1('310)1('211)1
('111)1('111)1('113)1(012)1(113)1(212)1(2/1)1(3/0)/(21'1)1(2/'2)/
(010)12181(013)11191(OI_14)1(010)12181(410)1112114181(_101_9)10



*00431, 64,
2114181('91_21)/2181(14121)11191('21'1)1('51'1)/('21_1)1(_11'2)1
(01'12)1(11'2)1(11'1)1(21'1)1(3/0)1(2/1)/(212)/(113)1(0/2)1
('113)1('111)1('111)1('211)/('3/0)1('21'1)/('2/'2)/(010)/21
8,(15,-11),1,2,14,8,(-10,-9),0

*00432, 68,
2114181('91_21)/2181(4111)11/91(212)1(211)1(312)1(112)1('112)1
('111)1('310)1('21'1)1('11'1)1(01'15)/(1/'2)1(1/'1)/(2/'1)1(310)/
(211)1(212)1(113)1(012)1('1/3)1('212)/('2/1)1('310)/(0/0)12/
8,(11,-14),1,2,14,8,(-10,-9),0

*00433, 56,
2114181('81_14)/2181(3111)11/91(112)1(311)1(310)1(31_1)1(11'2)1
('11'2)1('21'1)/('51_1)1('21'1)1('11'2)1(0/'1)/(11'2)1(3/‘1)/
(310)1(311)1(112)1(010)12181(31'3)1112114181('9/'9)10

*00434,72,
2114181('91_14)/2181(15111)11191('111)1('111)1('211)1('310)1
('21'1)1('21'2)/('11'3)1(Or'2)1(11'3)/(2/'2)1(2/'1)/(3/0)1(2/1)/
(212)1(010)1218/(0111)11/91(01'16)1('11'3)1('11'1)1(_21'1)1
('310)1('211)1(010)12181(1316)11/2114181('101'16)10

*00435, 56,
2114181('91_14)/2181(318)11191(1210)1(012)1('112)1('111)1('211)1
('310)1('21_1)1('21'2)1('11'3)1(01'2)/(1/'3)1(2/'2)/(2/'1)1(310)/
(211)1(212)1(010)12181(31_3)1112114181('91'9)10

*00436, 58,
2114181('111'14)12181(110)11/91(718)1(010)12181(1216)11/91
('91'9)1('919)1(010)12181(910)11/91(01_14)1(010)12181(318)11/91
(71'8)1(010)12/81(110)11/2114181('111'9)10

*00437,62,
2,14,8,(-7,-14),2
('11'1)1('21'1)/(
(31'1)1(11'2)1('1
14181(_71'9)10
*00438, 46,
2114181('91_14)/2181(4114)11/91(01_10)1(11'3)1(21'1)1(310)1(211)1
(3,3),(9,0),2,8,(0,10),1,9, (0,-14),(0,0),2,8,(4,0),1,2,

14,8, (-10,-9),0

*00439, 64,
2114181('91_14)/2181(4114)11/91(01_10)1(11'3)1(21'1)1(310)1(211)1
(313)1(010)1218/(0110)11/91(01'14)1(010)12/81('9118)11191(11'1)1
(21'1)1(210)1(2/1)1(111)1(010)12181(51_18)1112/14181('101_9)10
*0043A, 46,
2,14,8,(-8,-14),2,8,(4,14),1,9,(0,-14),(0,0),2,8,(4,8),1,9,
(71'8)1(010)12/81('1114)11191('101_10)1(010)12/81(121'4)1112/
14181(_81'9)10

*0043B, 44,
2114181('91_14)/2181(14114)11191('610)1(01'10)1('11'3)1('21'1)1
('210)1(010)12/81(11114)11191(OI'14)1(010)12181(410)11121
14181(_91'9)10

*0043C, 32,
2114181('111'14)12181(1810)11191(0114)1('71_11)/('7111)1(01'14)1

181(818)11191(21'1)1(11'1)1(11'2)1(_11'2)1
'410)1('311)1(010)12/81(0112)11191(311)1(310)1
l_2)1(_21_1)1(_310)1(010)12181(91_8)11121



(010)12181(1810)1112114181('111'9)10

*0043D, 46, -
2114181('91_14)/2181(417)11191(11/@)1(010)12181(017)11191(01'14)1
(010)12181(_11/14)11191(01'14)1(010)12181(1510)/1121

14,8, (-10,-9),0

*0043E, 56,
2114181('91_14)/2181(8114)11/91(310)1(21'1)1(21'2)1(11'3)1(01_2)1
('11'3)1('21'2)/('21'1)1('310)1('211)/('2/2)1('113)/(0/2)1(1/3)/
(212)1(211)1(010)12181(111'14)11/2114181('101'9)10

*0043F, 46,
2114181(_91_14)12181(4114)11191(OI_14)1(010)12181(0110)11191
(313)1(211)1(310)1(21'1)/(1/'2)/(01'11)1(019)/2/81(410)/112/
14,8, (-10,-9),0

*00440, 60,
2114181(_91_14)12181(4114)11191(OI_21)1(010)12181(0118)11191
(212)1(211)1(310)1(21'1)1(21'2)/(11'3)1(0/'2)/('11'3)1('21'2)1
('21'1)1('310)1('211)1('212)1(010)12181(151_3)11121

14,8, (-10,-16),0

*00441, 50,
2114181('81_14)/2181(15111)11191('212)1('211)1('310)1('21_1)1
('21'2)1('11'3)/(01'2)1(11'3)1(21'2)/(21'1)1(3/0)1(211)/(212)1
(010)12181(21'3)1112114181('91'9)10

*00442, 66,

2114181('141'14)12181(4114)11191(01'14)1(010)12/81(0110)11191
(313)1(211)1(210)1(21'1)1(11'3)1(01'10)1(010)12/81(0110)11191
(313)1(211)1(210)1(21'1)/(1/'3)/(01'10)1(019)/2/81(410)/112/

14,8,(-14,-9),0

*00443, 44,
2114181('71_14)/2181(1114)11/91(61_14)1(010)12/81(6114)11191
('61'14)1('21'4)1('21'2)1('21_1)1(_110)1(010)12/81(1417)1112/
14,8,(-7,-16),0

*00444, 66,
2,14,8,(-11,-14),2,8,(14,14),1,9,(-6,0),(-2,-1),(-2,-2),(-1,-3),
(0 2) (1, 3) (2, 2) (2,-1), (6, 0) (2,1),(2, 2) (1,3),(0,2), ( 1,3),
(-2,2),(-2,1),(9,0),2,8,(-3,0),1,9,(0,-21),(0,0),2,8,(11,7),1, 2,
14, 8 (-11,-16),0

*0@445,36,

2114181('61_14)/2181(111 ) r( 1 14) (0 0) 2/81(0114)11191
('111'14)1(010)/2181(1 ’ ) 11 18 ( 7 9) 0

*00446, 50,
2114181('91_14)/2181(4114)11/91(01_10)1(11'3)1(21'1)1(310)1(211)1
(313)1(010)1218/(0110)11/91(01'14)1(210)1(01'3)/(010)12181(213)1
1,2,14,8,(-10,-12),0

*00447, 46,
2114181('91_14)/2181(3114)11/91(01_5)1(11'3)1(2/'1)1(310)1(211)1
(3,3),(9,0),2,8,(0,5),1,9,(0,-14),(0,0),2,8,(4,0),1, 2,
14181(_91'9)10

*00448, 66,
2114181('141'14)12181(2410)11191(0114)1(010)12/81(01_10)11191
('31'3)1('21'1)/('210)1('211)1('1/3)/(0110)1(010)12/8/(0/‘10)11/



9/('31_3)1(_21'1)1('210)1('211)1('113)1(0110)1(010)12181(241'14)1
1,2,14,8,(-14,-9),0

*00449, 70,
2114181('141'14)12181(1414)11191('31'3)1('21'1)/('210)1('211)1
('113)1(0110)1(010)12181(201'10)11191(_31'3)1('21'1)1('210)1
('211)1('113)1(0110)1(010)12/81(1010)11191(01'14)1(210)1(01'3)1
(010)12181(213)/112114181('141'12)10

*0044A, 64,
2114181('91_14)/2181(418)11191(111)1(211)1(310)/(110)1(21_1)1
(11'1)1(11'2)1(01'2)1('11'2)1('1/'1)/('2/'1)1('410)/('2/1)1
('111)1(010)12/81('3112)11191(310)1(01_14)1(010)12181(1410)11121
14181(_91'9)10

*0044B, 72,
2114181('101'14)12181(418)11/91(111)1(211)1(310)1(110)1(21'1)1
(11'1)1(11'2)1(01'2)1('11'2)1('1/'1)/('2/'1)1('410)/('2/1)1
('111)1(010)12/81(0112)11191(01'14)1(010)12181(13114)11/91
(01'14)1(010)12/81(410)1112114181(_11/_9)10

*0044C, 62,
2114181('91_14)/2181(418)11191(111)1(211)1(310)/(110)1(21_1)1
(11'1)1(11'2)1(01'2)1('11'2)1('1/'1)/('2/'1)1('410)/('2/1)1
('111)1(010)12/81(0112)11191(01'14)1(010)12181(1410)11121
14181(_91'9)10

*0044D, 60,
2114181('81_14)/2181(2111)11/91(212)1(211)1(310)1(21_1)1(21'2)1
(11'3)1(01'2)1('11'3)1('21'2)1('21'1)/('3/0)1('211)/('2/2)1(010)/
2181(1214)11191('610)1(010)12181(91'7)1112/1418/('91_9)10

*@044E, 70,
2114181('121'14)12181(4114)11191(01'14)1(010)12/81(017)11191
(510)1(011)1(113)1(212)1(211)1(2/0)1(21'1)/(2/'2)1(11'3)/(01'2)/
('11'3)1('21'2)/('21'1)1('210)1('211)/('2/2)1('113)/(0/1)1(010)/
2181(151'7)1112/14181('121'9)10

*0044F, 54,
2114181('81_14)/2181(310)11191(415)1(010)12181(61'5)11191(0114)1
('610)1('21_1)1('11'1)1('11'2)1(01'1)/(1/'2)1(1/'1)/(2/'1)1(610)/
(010)12181(41'5)1112114181('91'9)10

*020A0, 4, keuroRef2

7,0020AC, 0

*020A7, 49, kpes
2,14,8,(-11,-21),14,5,030,1,8,(0,21),050,02F, 01E, 02D, 05C, 02B, 01A,
029,058,2,8,(12,13),1,8,(0,-18), 02D, 02F,010,2,8,(-6,14),1,060, 2,
8,(3,-14),14,6,14,8,(11,-9),0

*©20AC, 45, keuro
2,14,8,(-10,-21),8,(2,10),5,1,014,00A, (9, -043),2,6,5,1,01C, 00A, (9,04
2,6,8,(-1,2),5,1,8,(13,0),2,6,04C,1,0B0,2,08C,080,14,8,(-10,-9),0
*02126, 53, komega
2,14,8,(-11,-21),14,5,8,(3,1),1, 01E, 040,014,036, 025,8, (-1, 3), 044,
8,(1,3),023,022,021, 040, 02F, 02E, 02D, 8, (1, -3),04C,8,(-1,-3),02B,
03A,01C,040,012,2,8,(3,-1),14,6,14,8,(11,-9),0

*02205, 64, kdiam
2,14,3,2,14,8,(-19,-40),14,4,2,14,5,8,(8,17),1,029,02A,8, (-1, -3),
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6,2,2,0,0,0

*QOOO0A, 7, 1f

2,0AC, 14,8, (9,10),0

*00020, 7, spc

2,060,14,8,(-6,-8),0

*00021,17, kexc
2,14,06C,1,014,2,014,1,044,2,020,06C,14,8,(-2,-3),0
*00022, 20, kdblgt
2,14,8,(-1,-6),044,1,023,2,010,1,02B,2,04C,030,14,8, (-3,1),0
*00023, 27, kns
2,14,8,(-2,-6),024,1,040,2,024,1,048,2,023,1,06C,2,020,1, 064, 2,
@6D, 14,8, (-4,-3),0

*00024, 25, kds
2,14,8,(-2,-6),014,1,030,012, 016,028,016, 012,030, 2,027,1, 06C, 2,
040,14,8,(-4,-3),0

*00025, 31, kpc
2,14,8,(-2,-6),064,1,01C,010,014,018,2,040,1,8, (-4,-6),2,040,1,
018,014,010, 01C, 2,020,14,8, (-4, -3),0

*00026, 24, kand
2,14,8,(-2,-6),041,1,02A,018,016,014, 022,014,016, 01A, 01C, O4E, 2,



020,14,8,(-4,-3),0

*00027, 28, kapos
2,14,3,2,14,8,(-1,-12),14,4,2,044,1,023,2,06C, 020,14, 3, 2,
14,8,(-5,2),14,4,2,0

*00028,16, k1lp

2,14,8,(-1,-6),064,020,1,02A,02C, 02E,2,020,14,03A,0
*00029, 15, krp

2,14,8,(-1,-6),064,1,02E,02C,02A,2,040,14,03A, 0

*0002A, 27, kas
2,14,8,(-2,-5),021,1,044,2,02E,1,048,2,041,1,04A,2,044,1, 04E, 2,
02F,14,8,(-4,-3),0

*0002B, 19, kpls
2,14,8,(-2,-5),021,1,044,2,02E,1,048,2,06F,14,8,(-4,-3),0
*0002C, 28, kcma
2,14,3,2,14,02B,14,4,2,014,010,1,01C, 01A, 2,012,020, 14,3, 2,
14,8, (-3,-8),14,4,2,0

*©002D, 14, ksub

2,14,8,(-2,-3),034,1,040,2,020,03C,14,048,0

*O002E, 12, kper

2,14,01C,1,014,2,02F,14,8,(-2,-3),0

*QOO2F, 17, kdiv
2,14,8,(-2,-6),1,8,(4,6),2,020,06C,14,8, (-4,-3),0

*00030, 34, nO
2,14,3,2,14,8,(-3,-12),14,4,2,010,1,016, 044,012,010, 01E, 04C, 01A,
018,2,040,14,3,2,14,8,(-7,-6),14,4,2,0

*00031,18,n1
2,14,8,(-1,-6),054,1,012,06C,2,018,1,020,2,020,14,03A, 0
*00032, 23, N2
2,14,8,(-2,-6),054,1,012,020, 01E, 01C, 01A, 028, 01A, 02C, 040, 2, 020,
14,8, (-4,-3),0

*00033,29,n3
2,14,8,(-2,-6),054,1,012,020, 01E,01C, 01A, 018, 2,010, 1, 01E, 01C, 01A,
028,016,2,01C,060,14,8, (-4,-3),0

*00034,19, n4
2,14,8,(-2,-6),041,1,048,8,(3,4),06C,2,030,14,8,(-4,-3),0
*00035, 23, n5
2,14,8,(-2,-6),014,1,01E, 020, 012, 024, 016, 038, 024, 040, 2, 020, 06C,
14,8, (-4,-3),0

*00036, 24, N6
2,14,8,(-2,-6),034,1,030, 01E, 01C, 01A, 028, 016, 034, 022, 010, 2, 030,
06C, 14,8, (-4,-3),0

*PO0O37,16,Nn7

2,14,8,(-2,-6),064,1,040,06B,2,050,14,8, (-4,-3),0

*00038,32,n8
2,14,8,(-2,-6),010,1,016,014,012,020, 012,014,016, 028, 01A, 01C, O1E,
2,020,1,01E,01C, 01A, 028, 2,050, 14,8, (-4, -3),0

*00039, 24, N9
2,14,8,(-2,-6),010,1,010, 022,034,016, 028, 01A, 01C, 01E, 030, 2, 020,
03C,14,8,(-4,-3),0

*POO3A, 17, kcol



2,14,04C,044,1,01C,2,01C,1,01C,2,02F,14,8,(-2,-3),0
*0003B, 34, ksmc
2,14,3,2,14,8,(-1,-8),14,4,2,010,044,1,01C, 2,01C, 1,02C, 01A, 2,012,
020,14,3,2,14,8,(-5,-8),14,4,2,0

*POO3C, 29, k1t
2,14,3,2,14,8,(-3,-12),14,4,2,064,030,1,03A, 03E, 2,020, 14, 3, 2,
14,8,(-5,-6),14,4,2,0

*©003D, 18, keq
2,14,04B,044,1,040,2,02C,1,048,2,060,02C,14,8, (-4,-1),0
*QOO3E, 28, kgt
2,14,3,2,14,8,(-3,-12),14,4,2,064,1,03E,03A, 2,050, 14, 3, 2,
14,8,(-7,-6),14,4,2,0

*@OO3F, 36, kam
2,14,3,2,14,8,(-3,-12),14,4,2,054,1,012,010, 01E, 01C, 01A, 01C, 2,
@ic,1,01C,2,030,14,3,2,14,8,(-7,-6),14,4,2,0

*00040, 28, kea
2,14,8,(-2,-6),032,1,01A, 018,014,012, 010, 02C, 012, 024,016, 028, O1A,
04C, 01E, 030, 2,020,14,8, (-4,-3),0

*00041, 21, uca
2,14,8,(-2,-6),1,024,043,04D,02C,2,047,1,040,2,02E,14,8, (-4,-3),0
*00042, 29, uch
2,14,8,(-2,-6),1,030,012,014,016,028,2,020,1, 012,014, 016, 038, 2,
010,1,06C,2,050,14,8,(-4,-3),0

*00043, 23, ucc
2,14,8,(-2,-6),040,014,1,01A, 028,016, 044,012,020, 01E, 2, 02E, 03C,
14,8, (-4,-3),0

*00044,22,ucd
2,14,8,(-2,-6),1,030,012,044,016,038,2,010,1, 06C, 2, 050,

14,8, (-4,-3),0

*00045, 25, uce
2,14,8,(-2,-6),1,064,040,2,048,03C,1,020,2,028,03C,1,040, 2,020,
14,8, (-4,-3),0

*00046, 21, ucf
2,14,8,(-2,-6),1,064,040,2,048,03C,1,020,2,03C,040,14,8,(-4,-3),0
*00047,22, ucg
2,14,8,(-2,-6),032,1,010,03C, 038,016, 044,012, 030, 2, 020, 06C,

14,8, (-4,-3),0

*00048, 22, uch
2,14,8,(-2,-6),1,064,2,03C,1,040,2,034,1,06C,2,020,14,8,(-4,-3),0
*00049, 21, uci
2,14,8,(-1,-6),064,1,020,2,018,1,06C,2,018,1,020,2,020,14,03A,0
*Q004A, 19, ucj
2,14,8,(-2,-6),014,1,01E, 020,012,054, 2,020, 06C, 14,8, (-4, -3),0
*0004B, 23, uck
2,14,8,(-2,-6),1,064,2,040,1,03A,018,2,010,1, 03E, 2,020,

14,8, (-4,-3),0

*0004C, 16, ucl

2,14,8,(-2,-6),064,1,06C,040,2,020,14,8, (-4,-3),0

*@004D, 17, ucm
2,14,8,(-2,-6),1,064,04D,043,06C,2,020,14,8, (-4,-3),0



*0004E, 19, ucn

2,14,8,(-2,-6),1,064,8, (4,-6),064,2,06C,020,14,8, (-4,-3),0
*QOO4F, 17, uco
2,14,8,(-2,-6),1,064,040,06C,048,2,060,14,8, (-4,-3),0
*0EO50, 19, ucp
2,14,8,(-2,-6),1,064,030,01E, 01C, 01A, 038, 2, 06F, 14,8, (-4, -3),0
*@O0O51, 25, ucq
2,14,8,(-2,-6),022,1,01E, 01A, 018, 016, 044, 012, 020, 01E, 03C, 01A, O1E,
2,020,14,8,(-4,-3),0

*00052, 23, ucr
2,14,8,(-2,-6),1, 064,030, 01E, 01C, 01A, 038, 2, 010, 1, 03E, 2, 020,
14,8, (-4,-3),0

*00053, 22, UCS
2,14,8,(-2,-6),014,1,01E, 020, 012, 046, 012, 020, 01E, 2, 020, 05C,
14,8, (-4,-3),0

*00054,19, uct
2,14,8,(-2,-6),064,1,040,2,028,1,06C,2,040,14,8, (-4,-3),0
*00O55, 20, ucu
2,14,8,(-2,-6),064,1,05C, 01E, 020,012, 054, 2, 020, 06C, 14,8, (-4, -3),0
*00056,15, ucv

2,14,06B,064,1,06D,063,2,020,06C,14,8, (-5, -3),0

*00057, 24, ucw
2,14,068,064,1,9,(2,-6),(1,3),(1,-3),(2,6),(0,0),2,020, 66C,
14,8, (-5,-3),0

*00058, 22, ucx

2114181 ('21 _6)11181 (416)12104811/81 (41 _6)121020/14181 ('41 _3)10
*00059, 25, ucy
2,14,8,(-2,-6),064,1,8,(2,-3),03C,2,034,1,8,(2,3),2,020, 06C,
14,8, (-4,-3),0

*0005A,19,ucz
2,14,8,(-2,-6),064,1,040,8, (-4, -6),040,2,020,14,8, (-4,-3),0
*QOO5B,17, k1lb
2,14,8,(-1,-6),1,064,020,2,06C,1,028,2,040,14,03A, 0
*0005C, 17, kbks1sh
2,14,8,(-2,-6),064,1,8,(4,-6),2,020,14,8,(-4,-3),0
*@OO5D, 15, krb

2,14,8,(-1,-6),064,1,020,06C, 028,2,040,14,03A, 0
*@O05E, 16, kcaret
2,14,8,(-2,-6),044,1,022,02E,2,04D,14,8,(-4,1),0
*QOO5F, 11, kundrl

2,14,028,01C,1,040,2,021,14,04A, 0

*00060, 27, krvap
2,14,3,2,14,8,(-1,-12),14,4,2,064,1,02D, 2,04D, 14, 3,2,14,8, (-5, 2),
14,4,2,0

*00061, 24, 1ca
2,14,04B,020,1,018,016,024,012,010, 01E, 02C, 01A, 2,012, 1, 01E, 2, 020,
14,8, (-4,-3),0

*00062, 25, 1cb
2,14,8,(-2,-6),1,064,2,04C,1,022,010, 01E, 02C, 01A, 018, 026, 2, 02C,
060,14,8,(-4,-3),0



*00063,17, 1cc
2,14,04B,042,1,038,01A, 02C, 01E, 030, 2,020,14,8, (-4, -3),0
*00064, 25, 1cd
2,14,8,(-2,-6),041,1,02A, 018,016,024, 012,010, 02E, 2,044,1, 06C, 2,
020,14,8,(-4,-3),0

*00065, 20, 1ce
2,14,04B,024,1,030,012,016,028,01A,02C, 01E, 020, 2, 030,
14,8,(-4,-3),0

*00066, 22, 1cf
2,14,8,(-2,-6),034,1,030,2,023,1,016,018, 01A, 05C, 2, 050,
14,8,(-4,-3),0

*00067, 22, 1cg

2,14,04B,01C, 1, 01E, 020,012, 044, 016, 028, 01A, 02C, 01E, 030, 2, 020,
14,8,(-4,-5),0

*00068, 21, 1ch
2,14,8,(-2,-6),1,064,2,04C,1,022,010, 01E, 03C,2,020,14,8, (-4,-3),0
*00069,17, 1ci
2,14,06C,1,044,2,014,1,014,2,020,06C,14,8,(-2,-3),0
*O006A, 35, 1cj
2,14,3,2,14,8,(-3,-12),14,4,2,01C,1,01E, 010,012,054, 2,014, 1,014,
2,020,06C,14,3,2,14,8,(-7,-10),14,4,2,0

*0006B, 23, 1ck
2,14,8,(-2,-6),1,064,2,04C,1,020,022,2,02A,1,02E, 2,020,
14,8,(-4,-3),0

*0006C, 28, 1cl
2,14,3,2,14,8,(-1,-12),14,4,2,064,1,05C, 01E, 2,020, 14, 3, 2,

14,8, (-5,-6),14,4,2,0

*0006D, 24, 1cm
2,14,04B,1,044,2,01C,1,012,01E,01C, 2, 014,1, 012, 01E, 03C, 2, 020,
14,8,(-4,-3),0

*O@O06E, 21, 1cn
2,14,8,(-2,-6),1,044,2,02C,1,022,010, 01E, 03C,2,020,14,8, (-4, -3),0
*0@006F, 20, 1co
2,14,04B,030,1,028,016,024,012,020,01E,02C, 01A, 2,030,
14,8,(-4,-3),0

*00070,22, 1cp
2,14,04B,02C,1,064,2,01C,1,012,020,01E,02C, 01A, 038, 2, 060,

14181 (_41 '5)101

*00071, 22, 1cq
2,14,04B,04F,1,064,2,01C, 1,016,028, 01A, 02C, 01E, 030, 2, 020,

14181 (_41 '5)101

*00072,19, 1cr
2,14,04B,1,044,2,02C,1,022,010, 01E, 2,020,03C,14,8, (-4, -3),0
*00073,18, 1cs
2,14,04B,1,030,012,016,028,016,012,030,2,04D,14,8, (-4,-3),0
*00074,21, 1ct
2,14,8,(-2,-6),044,1,040,2,026,1,05C,01E,012,2,02F,14,8, (-4, -3),0
*00075, 20, 1cu
2,14,04B,044,1,03C, 01E, 010,022, 2,024,1,04C, 2,020,14,8, (-4,-3),0
*00076,14, 1cv



2,14,04B,044,1,04D,043,2,04D,14,8, (-4, -3),0

*00077,23, lcw

2,14,04B,044,1,9, (11 _4)1 (114)1 (11 '4)1 (114)1 (010)12104DI

14,8, (-4,-3),0

*00078,16,1cx

2,14,04B,1,042,2,048,1,04E,2,020,14,8, (-4, -3),0

*90079,19, lcy

2,14,04B,044,1,04D, 2,043,1,06B,018,2,024,060,14,8, (-4, -5),0
*QOO7A, 15, 1cz

2,14,04B,044,1,040,04A,040,2,020,14,8, (-4, -3),0

*QOO7B, 19, k1br
2,14,8,(-1,-6),064,020,1, 01A, 01C, 01A, 01E, 01C, 01E, 2, 020, 14, 03A, 0
*QOO7C, 13, kvbar

2,14,06C,1,064,2,06C,020,14,8, (-2,-3),0

*0007D, 18, krbr
2,14,8,(-1,-6),1,012,014, 012,016,014, 016, 2, 06C, 040, 14, 03A, 0
*QOO7E, 15, kt1de

2,14,04B,034,1,012,02F,012,2, 04D, 14,8, (-4, -2),0
*00080, 4, keuroRef

7,020AC, 0

*OO00A0, 7, NoBrkSpc

2,060,14,8, (-6,-8),0

*QOOA1, 18, kiexc
2,14,06C,1,044,2,014,1,014,2,8,(2,-6),14,8,(-2,-3),0
*O00A2, 23, kcent
2,14,8,(-2,-5),01E,1,8,(2,6),2,01E,1, 038, 01A, 02C, 01E, 030, 2, 020,
14, 04A, 0,

*0@00A3, 23, kpound
2,14,8,(-2,-6),040,1,048,012, 044,012, 01E, 2,02B, 1,028, 2, 06F,
14,8, (-4,-3),0

*@OOA5, 34, kyen
2,14,8,(-2,-6),064,1,8,(2,-3),03C,2,025,1,020,2,027,1,020, 2,018,
1181 (213)12181 (21 '6)114181 ('41 '3)10

*O00A7, 45, kpar
2,14,3,2,14,8,(-3,-12),14,4,2,014,1,01E, 010,012,016, 018, 016, 012,
2,021,1,016, 018, 01A, 01E, 010, 01E, 01A, 2,8, (3, -2),14, 3, 2,
14,8,(-7,-6),14,4,2,0

*QOOAA, 36, 1cau
2,14,8,(-1,-6),2,3,2,8,3,9,1,01A, 018,016, 024,012,010, 01E, 02C, O1E,
2,049,1,040,2,4,2,8,2,-3,14,8,(-3,1),0

*O00AB, 21, kfrew
2,14,8,(-2,-5),021,1,026,022,2,020,1,02A, 02E, 2, 02F, 14,8, (-4, -2),0
*QOOBO, 19, kdeg
2,14,8,(-1,-6),054,1,012, 01E, 01A, 016, 2, 05C, 040, 14,8, (-3,2),0
*000B1, 23, kpls-min
2,14,8,(-2,-6),014,1,040,2,027,1,044,2,02A,1,040, 2, 04D,

14,8, (_41 '2)10

*@00B5, 24, kmicro
2,14,04B,02C,1,8,(1,6),1,03C, 01E, 010, 023, 2,024, 1, 04C, 2, 020,
14,8, (-4, -5),0



*QOOBA, 35, 1cou
2,14,8,(-1,-6),3,2,2,8,3,12,1,028, 01A, 02C, 01E, 020, 012, 024, 016, 2,
06B,1,040,2,4,2,8,2,-3,14,8,(-3,1),0

*QOOBB, 22, KFfrw
2,14,8,(-2,-5),014,1,022,026,2,020,1, 02E, 02A, 2,040, 01C,

14,8, (_41 '2)10

*000BC, 41, kquart
2,3,2,14,8,(-5,-12),1,8, (10,12),2,8, (-8, -6),1,064,01A,2,05C, 1,
020,2,8,(6,-4),1,048,8,(3,4),06C,2,060,14,8, (-9,-6),4,2,0
*@OOBD, 45, khalf
2,3,2,14,8,(-5,-12),1,8,(10,12),2,8, (-8, -6),1,064,01A,2,05C, 1,
020,2,8,(3,-1),1,012,020, 01E, 01C, 01A, 028, 01A, 02C, 040, 2, 040,

14,8, (-9,-6),4,2,0

*OOOBF, 32, kigm
2,3,2,14,8,(-3,-12),8,(6,2),1,02A, 028,026, 024, 022,024, 2,024,1,
024,2,8,(8,-12),14,8,(-7,-6),4,2,0

*OOCO, 31, uch
2,14,8,(-2,-6),1,024,022,02E,02C, 2,8, (-4,1),1,040,2,8,(-2,4),1,
02712/81 (61 _6)114181 ('41 '3)10

*@OOC1, 31, uch
2,14,8,(-2,-6),1,024,022,02E,02C, 2,8, (-4,1),1,040,2,8,(-2,4),1,
02112/81 (21 _6)114181 ('41 '3)10

*@OOC2, 32, uch
2,14,8,(-2,-6),1,024,022,02E,02C, 2,8, (-4,1),1,040, 2,8, (-4,3),1,
022, 02E, 2,8, (2,-4),14,8,(-4,-3),0

*@OOC3, 33, uch
2,14,8,(-2,-6),1,024,022,02E,02C, 2,8, (-4,1),1,040,2,8, (-4,4),1,
012, 02F,012,2,8, (2,-6),14,8,(-4,-3),0

*QOOC4, 32, uc,,
2,14,8,(-2,-6),1,024,043,2,029,1,014,2,040,1,01C, 2,027,1, 04D, 02C,
2,047,1,040,2,02E,14,8,(-4,-3),0

*QOOCS5, 25, uch
2,14,8,(-2,-6),1,024,032, 016, 01A, 03E, 02C, 2,8, (-4,1),1,040, 2, 02F,
14,8, (-4,-3),0

*0OOC6, 33, uch
2,14,8,(-2,-6),1,034,8,(2,3),020,2,8,(-2,-3),1,020,2,03C, 1,028,
064,2,04B,1,020,2,04F,14,8, (-4,-3),0

*@OOC7, 29, uct
2,14,8,(-2,-6),02E,1,010, 014,018,014, 2,021, 1, 01A, 028,016, 044,012,
020, 01E, 2, 02E, 03C, 14,8, (-4, -5),0

*QOOCS, 28, uch
2,14,8,(-2,-6),1,044,040,2,016,1,027,2,04C,018,1,020, 2, 02A, 1, 040,
2,020,14,8,(-4,-3),0

*0OOCY, 28, uch
2,14,8,(-2,-6),1,044,040,2,025,1,029,2,03C,018,1, 020, 2, 02A, 1, 040,
2,020,14,8,(-4,-3),0

*QOOCA, 29, uch
2,14,8,(-2,-6),1,044,040,2,016,1,016,01A, 2,03C, 018,1, 020, 2, 02A, 1,
040,2,020,14,8, (-4, -3),0

*QOOCB, 32, uch



2,14,8,(-2,-6),1,044,040,2,016,1,014,2,028,1,01C, 2, 03C, 018, 1, 020,
2,02A,1,040,2,020,14,8,(-4,-3),0

*@OOCC, 25, uch
2,14,8,(-1,-6),044,1,020,2,014,1,027,2,02D,1,04C,2,018,1,020, 2,
020,14, 03A,0

*@OOCD, 25, uch
2,14,8,(-1,-6),044,1,020,2,024,1,029,2,01E,1,04C, 2,018,1, 020, 2,
020,14, 03A,0

*QOOCE, 26, uch
2,14,8,(-1,-6),044,1,020,2,014,1,016,01A, 2, 01E, 1, 04C, 2,018, 1, 020,
2,020,14,03A, 0

*QOOCF, 29, uch
2,14,8,(-1,-6),044,1,020,2,014,1,014,2,028,1,01C, 2, 01E, 1, 04C, 2,
018,1, 020, 2,020, 14, 03A, 0

*QOODO, 25, uc
2,14,8,(-2,-6),1,064,030, 01E, 04C, 01A, 038, 2, 024,015, 1, 020, 2, 01D,
04F, 14,8, (-4,-3),0

*@OOD1, 25, uc
2,14,8,(-2,-6),1,044,04E,044,2,048,014,1,012,02F,012,2,8, (2, -6),
14,8, (-4,-3),0

*@OOD2, 25, uch
2,14,8,(-2,-6),1,044,040,2,016,1,027,2,02C, 030, 1, 04C, 048, 2, 060,
14,8, (-4,-3),0

*@OOD3, 25, uch
2,14,8,(-2,-6),1,044,040,2,025,1,029,2,01C, 030, 1, 04C, 048, 2, 060,
14,8, (-4,-3),0

*QOOD4, 26, uch
2,14,8,(-2,-6),1,044,040,2,016,1,016,01A, 2,01C, 030, 1, 04C, 048, 2,
060,14,8,(-4,-3),0

*@OODS5, 27, uch
2,14,8,(-2,-6),1,044,040,2,024,1,01A, 027, 01A, 2, 01C, 040, 1, 04C, 048,
2,060,14,8, (-4,-3),0

*0OOD6, 31, uch
2,14,8,(-2,-6),1,044,2,012,1,014,2,02B,1, 040, 2,016,1,014,2, 02D, 1,
04C, 048,2,060,14,8, (-4, -3),0

*QOODS, 29, ucd”
2,14,8,(-2,-6),1,8,(4,6),2,018,1, 01E, 04C, 01A, 028,016, 044,012, 020,
2181 (31 '6)11418/ ('41 _3)10

*QOODY, 24, uch
2,14,8,(-2,-6),064,1,05C, 01E, 020,012, 054, 2, 01A, 1,027, 2,050, 06C,
14,8, (-4,-3),0

*QOODA, 24, uch
2,14,8,(-2,-6),064,1,05C, 01E, 020,012, 054, 2,018, 1,029, 2, 050, 05C,
14,8, (-4,-3),0

*QOODB, 25, uch
2,14,8,(-2,-6),064,1,05C, 01E, 020,012, 054, 2, 01A, 1,016, 01A, 2, 050,
05C, 14,8, (-4,-3),0

*@OODC, 27, uch
2,14,8,(-2,-6),064,1,05C, 01E, 020, 012, 054, 2, 01A, 1,014, 2,028, 1, 01C,
2,05E,14,8,(-4,-3),0



*@OODD, 25, uch

2,14,8,(-2,-6),044,1,02E,02C, 2,024,1,022,2,025,1,029, 2, 050, 05C,
14,8, (-4,-3),0

*@OODE, 27, 1c
2,14,8,(-2,-6),02C,1,084,2,03C, 1,012,020, 01E, 02C, 01A, 028, 016, 2,
8/ (61 '1)114181 ('41 '5)10

*O00DF, 24, kgers
2,14,8,(-2,-6),1,012,044, 012,010, 01E, 01C, 01A, 01E, 01C, 01A, 018, 2,
040,14,8,(-4,-3),0

*0O00EO, 39, 1c..
2,14,8,(-2,-6),020,1,018, 016,024,012, 010, 01E, 02C, 01A, 2,012, 1, O1E,
2,2,3,2,8,(-3,10),1,047,2,8, (11, -12),4,2,14,8, (-4, -3),0
*QOOE1, 39, 1c
2,14,8,(-2,-6),020,1,018, 016,024,012, 010, 01E, 02C, 01A, 2,012, 1, O1E,
2,2,3,2,8,(-3,12),1,049,2,8, (11, -10), 4,2,14,8, (-4, -3),0
*QOOE2, 40, 1cf
2,14,8,(-2,-6),020,1,018, 016,024,012, 010, 01E, 02C, 01A, 2,012, 1, O1E,
2,2,3,2,8,(-3,10),1,026,02A,2,8, (11, -10),4,2,14,8, (-4, -3),0
*QOOE3, 40, 1cf
2,14,8,(-2,-6),020,1,018, 016,024,012, 010, 01E, 02C, 01A, 2,012, 1, O1E,
2,3,2,8,(-7,10),1,012,02F,012,2,8, (7, -11),4,2,14,8, (-4, -3),0
*QOOE4, 37, 1c,,
2,14,8,(-2,-6),020,1,018,016,024,2,034,1,01C,2,030,1,014,2,03A, 1,
012,010, 01E, 02C, 01A, 2,012, 1, 01E, 2,020,14,8, (-4, -3),0
*QOOES, 38, 1ct
2,14,8,(-2,-6),3,2,8,(3,8),1,022,026,02A, 02E, 2,8, (3,-6),4,2,1,
01A, 018,016, 024, 012, 010, 01E, 02C, 01E, 2, 020,14, 8, (-4, -3),0
*QOOE6, 30, 1C
2,14,04B,021,1,01A, 016,024,012, 01E, 03C, 2,034, 1,012, 01E, 01C, 028, 2,
0ic,1,01E, 010, 2,020,14,8, (-4, -3),0

*QOOE7, 24, 1ct
2,14,04B,042,1,038,01A,02C, 01E, 030, 2, 028,1, 01C, 010, 01C, 018, 2, 041,
14,8, (-4, -5),0

*QOOES, 27, 1cS
2,14,8,(-2,-6),024,1,030, 012,016,028, 01A, 02C, 01E, 020, 2, 054, 1, 027,
2,050,06C,14,8, (-4, -3),0

*QOOEY, 26, 1c,
2,14,8,(-2,-6),024,1,030,012, 016,028, 01A, 02C, 01E, 020, 2, 064, 1, 029,
2,05E,14,8,(-4,-3),0

*@OOEA, 27, 1c”
2,14,8,(-2,-6),024,1,030,012, 016,028, 01A, 02C, 01E, 020, 2, 054, 1, 016,
01A, 2,05E, 14,8, (-4, -3),0

*QOOEB, 31, 1c%
2,14,8,(-2,-6),024,1,030,012, 016,028, 01A, 02C, 01E, 020, 2, 064, 010, 1,
01C,2,048,1,014,2,06E,14,8, (-4,-3),0

*QOOEC, 18, 1c_
2,14,8,(-1,-6),010,1,044,2,025,1, 02F, 2,020, 05C, 14, 03A, 0
*QOOED, 18, 1c
2,14,8,(-1,-6),010,1,044,2,016,1, 021, 2,020, 06C, 14, 03A, 0
*QOOEE, 19, 1cE



2,14,8,(-1,-6),010,1,044,2,016,1,012, 01E, 2,020, 05C, 14, 03A, 0
*@OOEF, 22, 1c«<
2,14,8,(-1,-6),010,1,044,2,016,1,014,2,020,1,01C, 2,020, 05C,

14, 03A, 0

*QOOFO, 30, 1c
2,14,8,(-2,-6),8,(3,4),1,028,01A, 02C, 01E, 020, 012, 024, 036, 2, 01C, 1,
02112/81 (31 _6)114181 ('41 '3)10

*@OOF1, 27, 1c
2,14,8,(-2,-6),1,044,2,014,1,012, 02F, 012, 2, 04A, 1,022,010, 01E, 03C,
2,020,14,8,(-4,-3),0

*QOOF2, 27, 1cs
2,14,8,(-2,-6),030,1,028, 016,024,012, 020, 01E, 02C, 01A, 2, 054, 1, 027,
2,050,06C,14,8, (-4, -3),0

*QOOF3, 26, 1c
2,14,8,(-2,-6),030,1,028,016,024,012, 020, 01E, 02C, 01A, 2, 064, 1, 029,
2,05E,14,8,(-4,-3),0

*QOOF4, 27, 1c“
2,14,8,(-2,-6),030,1,028,016,024,012, 020, 01E, 02C, 01A, 2, 054, 1, 016,
01A, 2, 05E, 14,8, (-4,-3),0

*QOOF5, 32, 1cA
2,14,8,(-2,-6),030,1,028, 016,024,012, 020, 01E, 02C, 01A, 2,8, (-3,5),
1,012,02F,012,2,8,(2,-6),14,8, (-4,-3),0

*QOOF6, 35, 1c”
2,14,8,(-2,-6),030,1,028,016,024,2,034,1,01C,2,040,1,014, 2,
8,(-4,-3),1,012,020,01E, 02C, 01A, 2, 030,14, 8, (-4, -3),0
*QOOF7, 23, kto
2,14,8,(-2,-5),021,1,014,2,021,1,048,2,022,1,01C, 2, 04E,

14,8, (_41 '2)10

*QOOF8, 24, 1cd”

2,14,04B,010,1, 020,012,024, 016,028, 01A, 02C, 01E, 2,018, 1, 042, 2, 04D,
14,8, (-4,-3),0

*QOOF9, 27, 1c—
2,14,8,(-2,-6),044,1,03C, 01E, 010, 022, 2,038, 044, 1, 02F, 2, 01E, 1, 04C,
2,020,14,8,(-4,-3),0

*QOOFA, 26, 1c
2,14,8,(-2,-6),044,1,03C, 01E, 010, 022, 2,036,1,021, 2,02D, 1, 04C, 2,
020,14,8,(-4,-3),0

*QOOFB, 27, 1c-
2,14,8,(-2,-6),044,1,03C, 01E, 010, 022, 2,036, 1,012, 01E, 2, 01E, 1, 04C,
2,020,14,8,(-4,-3),0

*QOOFC, 32, 1c_
2,14,8,(-2,-6),064,010,1,01C, 2,01A, 1, 03C, 01E, 010, 022, 2, 044, 018, 1,
01C, 2, 01E, 1, 04C, 2, 020,14,8, (-4, -3),0

*QOOFD, 27, 1cA

2,14,8,(-2,-6),044,1,04D,2,8, (-1,5),1,021,2,02D,1,06B, 018, 2, 024,
060,14,8,(-4,-3),0

*QOOFE, 25, uc
2,14,8,(-2,-6),1,064,2,01E,019, 1,030, 01E, 01C, 01A, 038, 2, 01F, 01C,
050,14,8, (-4, -3),0

*QOOFF, 30, 1c”



2,14,8,(-2,-6),044,1,04D, 2,054,018,1,014,2,020,1,01C, 2, 01E, 1, 06B,
018,2,024,060,14,8, (-4, -5),0

*00104, 26, c164
2,14,8,(-2,-6),1,024,043, 04D, 02C,2,047,1,040,2,02C, 1, 01A, O1E, 2,
022,14,8,(-4,-3),0

*00105, 30, c165
2,14,04B,020,1,018,016,024,012,010, 01E, 02C, 01A, 2,012, 1, 01E, 3, 2,
01A, 01E, 4,2,2,021,14,8, (-4,-3),0

*00106, 28,143
2,14,8,(-2,-6),040,014,1, 01A, 028, 016, 044,012,020, 01E, 2, 038, 024, 1,
021,2,08C,030,14,8, (-4, -3),0

*00107,30,c134
2,14,04B,042,1,038,01A, 02C, 01E, 030, 2,3,2,8, (-5,10),1,021, 2, 029,
8/ (gl '10)1412114181 (_41 '3)10

*0010C, 31, c172
2,14,8,(-2,-8),040,014,1, 01A, 028, 016, 044,012,020, 01E, 2, 026,1, 012,
2,01A,1,016,2,050,08C, 14,8, (-4, -3),0

*0010D, 29, c159
2,14,8,(-2,-6),042,1,038,01A, 02C, 01E, 030, 2, 028, 054, 1,012, 2, 01A, 1,
016, 2,050, 06C, 14,8, (-4, -3),0

*QO10E, 32, c210
2,14,8,(-2,-8),1,030,012,044,016,038,2,010,1,06C, 2,010, 074,1,012,
2,01A,1,016,2,050,08C, 14,8, (-4, -3),0

*QO10F, 31, c212
2,14,8,(-2,-6),041,1,02A, 018,016, 024,012,010, 02E, 2, 044, 1, 06C, 2,
020, 064,1,01A, 2,010, 05C, 14,8, (-4, -3),0

*90118, 28, c168
2,14,8,(-2,-6),1,064,040,2,048,03C,1,020,2,028,03C,1,040,1, 01A,
01E,2,022,14,8,(-4,-3),0

*QO119, 27, c169
2,14,04B,024,1,030,012,016, 028, 01A, 02C, 01E, 020, 3, 2, 01A, 01E, 4, 2, 2,
014,030,14,8, (-4, -3),0

*@O11A, 35, c183
2,14,8,(-2,-8),1,064,040,2,048,03C,1,020,2,028,03C, 1,040, 2,028,
074,1,012,2,01A,1, 016, 2,050, 08C, 14,8, (-4, -3),0

*@011B, 32, c216
2,14,8,(-2,-6),024,1,030,012, 016,028, 01A, 02C, 01E, 020, 2, 018, 054, 1,
012,2,01A,1, 016, 2,050, 06C, 14,8, (-4, -3),0

*Q0141, 29, c157
2,14,8,(-2,-6),064,1,06C, 040, 2,048,034,1,3,2,8,(4,5),2,8, (8, -11),
4,2,14,8,(-4,-3),0

*Q0142, 47, c136
2,14,3,2,14,8,(-1,-12),14,4,2,064,3,2,010, 4,2,1,05C, 01E, 2, 3, 2,

8/ ('315)11/81 (3/4)12181 (41 '9)14121141312114181 ('51 '6)114141210
*Q0143, 24,227

2,14,8,(-2,-6),1,064,8, (4,-6),064,2,038,014,1,021,2,08C, 030,
14,8, (-4,-3),0

*00144,42,c228
2,14,3,2,14,8,(-3,-8),14,4,2,1,044,2,01C, 1,012,010, 01E, 03C, 2,
8,(-2,5),1,011,2,019,8,(4,-5),14,3,2,14,8, (-7,-6),14,4,2,0



*00147,27,c213
2,14,8,(-2,-8),1,064,8,(4,-6),064,2,027,1,012,2,01A,1, 016, 2,050,
08C,14,8,(-4,-3),0

*00148, 29, c229
2,14,8,(-2,-6),1,044,2,01C,1,012,010, 01E, 03C, 2,018, 054,1, 012, 2,
01A,1,016,2,040,06C,14,03A,0

*00150, 27,138
2,14,8,(-2,-6),1,064,040,06C,048,2,074,010,1,03C,2,020,1,034, 2,
07C,030,14,8,(-4,-3),0

*00151, 29, c139
2,14,04B,030,1,028,016, 024,012,020, 01E, 02C, 01A, 2,074,1,02C, 2, 028,
1,024,2,07C,050,14,8,(-4,-3),0

*00158, 33, c252
2,14,8,(-2,-8),1,064,030,01E,01C,01A,038,2,010,1,03E, 2,028,074, 1,
012,2,01A,1,016,2,050,08C,14,8,(-4,-3),0

*00159, 29, c253
2,14,8,(-2,-6),1,044,2,02C,1,022,010,01E,2,026,1,012,2,01A,1, 016,
2,050,06C,14,8,(-4,-3),0

*@015A,27,c151
2,14,8,(-2,-6),014,1,01E, 020,012, 046,012, 020, 01E, 2,024, 038,1, 021,
2,08C,030,14,8,(-4,-3),0

*0015B, 31, c152
2,14,04B,1,030,012,016,028,016,012,030,2,3,2,8,(-5,2),1,021, 2,
029,8,(9,-10),4,2,14,8,(-4,-3),0

*00160, 30, c230
2,14,8,(-2,-8),014,1,01E, 020,012,046, 012, 020, 01E, 2,026,1, 012, 2,
01A,1,016,2,050,08C,14,8,(-4,-3),0

*00161, 29, c231
2,14,8,(-2,-6),1,030,012,016,028,016,012,030,2,027,1,012,2,01A,1,
016, 2,050,06C,14,8,(-4,-3),0

*00164, 28, c155
2,14,8,(-2,-8),064,1,040,2,028,1,06C,2,074,1,012,2,01A,1, 016, 2,
050,08C,14,8,(-4,-3),0

*00165, 26, c156
2,14,8,(-2,-6),044,1,040,2,026,1,05C,01E, 012, 2, 054,1, 01A, 2, 030,
05C,14,8,(-4,-3),0

*0O16E,27,c222
2,14,8,(-2,-9),064,1,05C, 01E, 020,012,054, 2,027,1,012, 016, 01A, 01E,
2,040,07C,14,8,(-4,-3),0

*0016F, 31, c133
2,14,8,(-2,-7),044,1,03C, 01E, 010,022, 2,024,1,04C, 2,028,054,1,012,
016, 01A, 01E, 2,040, 05C, 14,8, (-4,-3),0

*00170, 28, c235
2,14,8,(-2,-6),064,1,05C,01E,020,012,054,2,016,1,03C, 2,028,1, 034,
2,07C,050,14,8,(-4,-3),0

*00171, 30, uue
2,14,04B,044,1,03C, 01E, 010, 022,2,024,1,04C, 2,074,018,1,02C, 2,028,
1,024,2,07C,050,14,8,(-4,-3),0

*00179, 25, c141
2,14,8,(-2,-6),064,1,040,8,(-4,-6),040,2,038,074,1,021,2,08C, 030,



14,8,(-4,-3),0

*0017A,28,c171

2,14,04B,044,1,040, 04A,040,2,3,2,8,(-5,10),1,021, 2,029, 8, (9, -10),
4,2,14,8,(-4,-3),0
*0017B, 32, c189
2,14,8,(-2,-6),064,1,040,8, (-4,
012,016, 4,4,2,040,08C, 14,8, (-4,
*0017C, 34,190
2,14,04B,044,1,040,04A,040,2,3,2,8,(-4,11),3,4,1,01A, 01E, 012, 016,
4,4,2,8, (81 _11)/412114181 ('41 _3)10

*0017D, 29, c166
2,14,8,(-2,-8),064,1,040,8,(-4,-6),040,2,028,074,1,012,2,01A, 1,
016,2,050,08C,14,8,(-4,-3),0

*@O17E, 27,c167
2,14,8,(-2,-6),044,1,040, 04A, 040, 2,028,054,1,012,2,01A,1, 016, 2,
050,06C,14,8,(-4,-3),0

*00410, 21, ucra
2,14,8,(-2,-6),1,024,043,04D,02C,2,047,1,040,2,02E,14,8,(-4,-3),0
*00411,24,ucrb
2,14,8,(-2,-6),1,064,030,01C,014,038,03C, 030, 01E, 01C, 01A, 038, 2,
060,14,8,(-4,-3),0

*@0412, 29, ucrv
2,14,8,(-2,-6),1,030,012,014,016,028,2,020,1,012, 014,016, 038, 2,
010,1,06C,2,050,14,8,(-4,-3),0

*00413,17, ucrg
2,14,8,(-2,-6),1,064,040,01C,2,05C,020,14,8,(-4,-3),0
*00414, 23, ucrd
2,14,8,(-2,-6),01C,1,014,050,064,028,04B,02C, 050, 01C, 2,014, 020,
14,8,(-6,-3),0

*@0415, 25, ucre
2,14,8,(-2,-6),1,064,040,2,048,03C,1,020,2,028,03C, 1,040, 2,020,
14,8,(-4,-3),0

*00416, 22, ucr!
2,14,8,(-2,-6),062,2,038,1,06C,2,038,064,1,06E, 2,020,
14,8,(-6,-3),0

*00417, 27, ucr!
2,14,8,(-2,-6),014,1,01E, 020,012,014, 016,018,010, 012, 014, 016, 028,
01A,2,060,05C,14,8,(-4,-3),0

*00418, 20, ucri
2,14,8,(-2,-6),1,042,04C,064,2,048,1,06C,2,060,14,8,(-4,-3),0
*00419, 24, ucrikr
2,14,8,(-2,-6),1,042,04C,064,2,018,1,028,2,018,1,06C, 2, 060,
14,8,(-4,-3),0

*@041A, 23, ucrk
2,14,8,(-2,-6),1,064,2,040,1,03A,018,2,010,1, 03E, 2,020,
14,8,(-4,-3),0

*©041B, 17, ukrl
2,14,8,(-2,-6),1,010,063,010,06C,2,020,14,8, (-5,-3),0
*@041C,17,ucrm
2,14,8,(-2,-6),1,064,04D,043,06C,2,020,14,8,(-4,-3),0

-6),040,2,084,028,1, 3, 4,01A, 01E,
-3),0



*@041D, 22, ucrn
2,14,8,(-2,-6),1,064,2,03C,1,040,2,034,1,06C,2,020,14,8,(-4,-3),0
*@041E, 23, ucro
2,14,8,(-2,-6),014,1,044,012,020,01E, 04C, 01A, 028, 016, 2, 060, 01C,
14,8,(-4,-3),0

*0041F, 16, ucrp
2,14,8,(-2,-6),1,064,040,06C,2,020,14,8,(-4,-3),0

*00420,19, ucrr
2,14,8,(-2,-6),1,064,030,01E,01C,01A,038,2,06F, 14,8, (-4,-3),0
*00421, 23, ucrs
2,14,8,(-2,-6),040,014,1,01A,028,016,044,012, 020, 01E, 2, 02E, 03C,
14,8,(-4,-3),0

*00422,19, ucrt
2,14,8,(-2,-6),064,1,040,2,028,1,06C,2,040,14,8,(-4,-3),0
*00423, 23, ucru
2,14,8,(-2,-6),014,1,01E,020,012,054,04C, 038,016, 034, 2, 060, 06C,
14,8,(-4,-3),0

*00424,25,ucrf
2,14,8,(-2,-6),020,1,064,018,01A,02C, 01E, 020,012, 024,016, 018, 2,
040,06C,14,8,(-4,-3),0

*@0425, 22, ucrx

2114181 ('21 _6)11181 (416)12104811/81 (41 _6)121020/14181 ('41 _3)10
*00426, 21, ucr!
2,14,8,(-2,-6),1,064,06C,040,064,06C,010,01C, 2,014, 020,

14,8, (-5,-3),0

*00427,19, ucrch
2,14,8,(-2,-6),064,1,03C,01E,030,044,06C,2,020,14,8,(-4,-3),0
*00428, 21, ucrsh
2,14,8,(-2,-6),1,064,06C,030,044,04C, 030,064, 06C, 2,020,
14,8,(-6,-3),0

*00429, 24, ucr!
2,14,8,(-2,-6),1,064,06C,030,044,04C, 030,064, 06C, 010, 01C, 014, 2,
020,14,8,(-7,-3),0

*0042A, 23, ucr'
2,14,8,(-2,-6),054,1,014,010,06C, 030,012,014, 016, 038, 2, 060, 03C,
14,8, (-5,-3),0

*0042B, 24, ucrs
2,14,8,(-2,-6),1,030,012,014,016,038,03C, 064, 2,050,1, 06C, 2,020,
14,8, (-5,-3),0

*0042C, 21, ucr]
2,14,8,(-2,-6),1,030,012,014,016,038,03C, 064, 2, 060, 06C,
14,8,(-4,-3),0

*@042D, 25, ucr'
2,14,8,(-2,-6),014,1,01E,020,012,024,028,020, 024,016, 028, 01A, 2,
060,05C, 14,8, (-4,-3),00,

*0@042E, 26, ucr!
2,14,8,(-2,-6),1,064,03C,010,024,012,010,01E, 04C, 01A, 018, 016, 024,
2,050,03C,14,8,(-4,-3),0

*0042F, 22, ucrya
2,14,8,(-2,-6),1,022,020,044,038,01A,02C, 01E, 030, 02C, 2, 020,



14,8, (-4,-3),0

*00430, 25, 1cra
2,14,8,(-2,-6),014,1,024,012,020, 01E, 014, 04C, 014, 01A, 028, 016, 2,
060,01C, 14,8, (-4,-3),0

*00431, 22, 1crb
2,14,8,(-2,-6),044,030,1,038,04C, 030,012,016, 038, 2, 02C, 060,
14,8, (-4,-3),0

*00432,24,1crv
2,14,8,(-2,-6),1,044,020,10, (1, -36), 028,030, 10, (1, -36), 038, 2,060,
14,8, (-4,-3),0

*00433,16, 1lcrg
2,14,8,(-2,-6),1,044,030,2,04C,020,14,8, (-3,-3),0
*00434,24,1crd
2,14,8,(-2,-6),01C, 1,014,010, 034,012,010, 04C, 028, 030, 01C, 2, 014,
020,14,8, (-4, -3),00,

*00435, 20, 1cre
2,14,04B,024,1,030,012,016, 028, 01A, 02C, 01E, 020, 2, 030,

14,8, (-4,-3),0

*00436, 23, 1crg
2,14,8,(-2,-6),1,042,2,048,1,04E,2,028,1, 044, 2,040, 04C,

14,8, (-4,-3),0

*00437, 25, 1crz
2,14,8,(-2,-6),034,1,012,020, 01E, 01A, 018, 010, 01E, 01A, 028, 016, 2,
060,01C, 14,8, (-4,-3),0

*00438,17,lcri
2,14,8,(-2,-6),044,1,04C,042,04C,2,020,14,8,(-4,-3),0
*00439, 23, lcrii
2,14,8,(-2,-6),044,1,04C,042,04C,2,044,018,1,028, 2,050, 04C,
14,8, (-4,-3),0

*0043A,19, 1crk
2,14,8,(-2,-6),1,044,02C, 020,022, 02A, 02E, 2,020,14,8, (-4, -3),0
*0043B, 16, 1crl
2,14,8,(-2,-6),1,043,020,04C,2,020,14,8, (-4,-3),0
*@043C,17,1crm
2,14,8,(-2,-6),1,044,02E,022,04C,2,020,14,8, (-4,-3),0
*@043D, 18, 1crn
2,14,8,(-2,-6),1,044,02C, 040, 024,04C, 2,020,14,8, (-4, -3),0
*@043E, 25, 1cro
2,14,04B,14,8,(0,-2),014,1,024,012, 020, 01E, 02C, 01A, 028, 016, 2, 060,
01C,14,8,(-4,-3),0

*0043F, 16, 1lcrp
2,14,8,(-2,-6),1,044,040,04C,2,020,14,8,(-4,-3),0
*00440, 20, 1crr
2,14,8,(-2,-6),1,044,030, 01E, 01C, 01A, 038, 2,060, 01C, 14,8, (-4, -3),0
*@0441, 23, 1crs
2,14,8,(-2,-6),040,014,1,01A, 028,016, 024,012,020, 01E, 2, 020, 03C,
14,8, (-4,-3),0

*00442,18, lcrt
2,14,8,(-2,-6),020,1,044,028,040,2,020,04C,14,8, (-4,-3),0
*00443,22, 1cru



2,14,8,(-2,-6),014,1,01E, 020, 012,034, 02C, 028, 026, 2, 060, 04C,
14,8,(-4,-3),0

*@0444,25, 1crf
2,14,8,(-2,-6),020,1,044,018,01A, 01C, 01E, 020,012, 014, 016, 018, 2,
040,04C,14,8, (-4,-3),0

*00445, 20, 1crh
2,14,04B,14,8,(0,-2),1,042,2,048,1,04E,2,020,14,8,(-4,-3),0
*00446, 21, 1crc
2,14,8,(-2,-6),044,1,04C, 030,044, 04C, 010, 01C, 2, 014,020,
14,8,(-4,-3),0

*00447,18, 1crch
2,14,8,(-2,-6),044,1,03C, 030, 034,04C, 2,020,14,8, (-3,-3),0
*00448, 21, 1crsh
2,14,8,(-2,-6),1,044,04C,020,024,02C, 020,044, 2,04C, 020,
14,8,(-4,-3),0

*00449, 24, 1crshch
2,14,8,(-2,-6),1,044,04C,020,024,02C, 020, 044, 04C, 010, 01C, 2, 014,
020,14,8,(-5,-3),0

*0044A, 21, lcrtvznak
2,14,8,(-2,-6),044,1,010,04C, 020,012,016, 028, 2, 050, 02C,
14,8,(-4,-3),0

*0044B, 24, 1cryyy
2,14,8,(-2,-6),1,044,02C, 020, 01E, 01A, 028, 2,040, 1,044, 2,04C, 020,
14,8,(-4,-3),0

*@044C, 19, 1crmznak
2,14,8,(-2,-6),1,044,02C, 020, 01E, 01A, 028, 2,050,14,8, (-3,-3),0
*@044D, 25, 1creee
2,14,8,(-2,-6),014,1,01E, 020,012,014, 028, 020, 014, 016, 028, 01A, 2,
060,03C,14,8, (-4,-3),0

*©044E, 26, 1cryu
2,14,8,(-2,-6),1,044,02C, 010, 014,012,010, 01E, 02C, 01A, 018, 016, 014,
2,050,02C,14,8, (-4,-3),0

*0044F, 22, 1crya
2,14,8,(-2,-6),1,022,018,016, 012,030, 02C, 028, 020, 02C, 2, 020,
14,8,(-4,-3),0

*@20A0, 4, keuroRef2

7,0020AC, 0

*©20A7, 32, kpes
2,14,06B,14,010,1,064, 020, 01E, 01C, 01A, 028, 2,8, (4,3),1,05C, O1E,
012,2,025,1,028,2,03E,020,14,8, (-6,-3),0

*@20AC, 45, keuro
3,2,2,14,8,(-4,-12),080,024,1,01C, 01A, 048,026, 044,5, 044,022,040, 01E,
6,2,8,(-1,-1),5,1,050,6,2,024,1,060,2,8,(6,-7),14,8,(-8,-6),4,2,0
*02126, 24, komega
2,14,8,(-2,-6),1,010,014, 025,024,012, 020, 01E, 02C, 02B, 01C, 010, 2,
020,14,8,(-4,-3),0

*02205, 28, kdiam
2,14,8,(-2,-6),012,1,016, 024,012,020, 01E, 02C, 01A, 028, 2,01B, 1, 063,
2,010,03D,03C,14,8,(-4,-3),0

*©221E, 18, kinfin
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Shapes and Shape Fonts > Create Shape Definition Files > Big Font
Descriptions >

Define a Big Font
[ Concor | (IREGEEIE

Special codes in the first line of a Big Font file specify how to read two-byte
hexidecimal codes.

A font with hundreds or thousands of characters must be handled differently
from a font containing the ASCII set of up to 256 characters. In addition to using
more complicated techniques for searching the file, AutoCAD needs a way to
represent characters with two-byte codes as well as one-byte codes. Both
situations are addressed by the use of special codes at the beginning of a Big
Font file.

The first line of a Big Font shape definition file must be as follows:

*BIGFONT nchars,nranges,bl,el,b2,e2, ...

where nchars is the approximate number of character definitions in this set; if
it is off by more than about 10 percent, either speed or file size suffers. You can
use the rest of the line to name special character codes (escape codes) that
signify the start of a two-byte code. For example, on Japanese computers, Kanji
characters start with hexadecimal codes in the range 90-AF or EO-FF. When the
operating system sees one of these codes, it reads the next byte and combines the
two bytes into a code for one Kanji character. In the *“BIGFONT line, nranges
tells how many contiguous ranges of numbers are used as escape codes; b1, e1l,
b2, e2, and so on, define the beginning and ending codes in each range.
Therefore, the header for a Japanese Big Font file might look like this:

*BIGFONT 4000, 2,090, 0AF, OEQ, OFF

After the *BIGFONT line, the font definition is just like a regular AutoCAD text
font, except that character codes (shape numbers) can have values up to 65535.
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Shapes and Shape Fonts > Create Shape Definition Files > Big Font
Descriptions >

Define an Extended Big Font File
| Concept || ISEESISEC|

To reduce the size of composite Kanji characters, you can define an extended
Big Font file. Extended big fonts use the subshape code, followed immediately
by a 0.

The first line of an extended Big Font file is the same as the regular Big Font
file. This is the format for the remaining lines of the file:

*@,5, font-name
character-height, 0, modes, character-width,©®

*shape-number,defbytes, shape-name

code, 0, primitive#,basepoint-x,basepoint-y,width, height,

code, 0, primitive#,basepoint-x,basepoint-y,width, height,
terminator

The following list describes the fields of a Big Font definition file:

character height

Used along with character width to indicate the number of units that define
the font characters.

character width

Used along with character height to indicate the number of units that define
the font characters. The character-height and character-width
values are used to scale the primitives of the font. In this context, primitives



are the points, lines, polygons, or character strings of the font geometrically
oriented in two-dimensional space. A Kanji character consists of several
primitives used repeatedly in different scales and combinations.

modes

The modes byte should be 0 for a horizontally oriented font and 2 for a dual-
orientation (horizontal or vertical) font. The special 00E (14) command code
is honored only when modes is set to 2.

shape-number

Character code.

defbytes
Byte size. It is always 2 bytes, consisting of a hexadecimal or a combination
of decimal and hexadecimal codes.

shape-name

Character name.

code

Shape description special code. It is always 7 so that it can use the subshape
feature.

primitive#

Reference to the subshape number. It is always 2.

basepoint-x

X origin of the primitive.

basepoint-y

Y origin of the primitive.

width
Scale of the width of the primitive.

height
Scale of the height of the primitive.

terminator



End-of-file indicator for the shape definition. It is always 0.

To arrive at the scale factor, AutoCAD scales down the primitive to a square unit
and then multiplies it by the height and width to get the shape of the character.
Character codes (shape numbers) in the Big Font shape definition file can have
values up to 65535. The following table describes the fields of the extended Big
Font file.

Variable Description
shape-number XXXX 2 bytes  Character
code
code 7,0 2 bytes  Extended font
definition
primitive# XXXX 2 bytes  Refer to
subshape
number
basepoint-x 1byte  Primitive X
origin
basepoint-y 1byte  Primitive Y
origin
width 1byte  Scale of
primitive
width
height 1byte  Scale of
primitive

height




terminator 0 1byte  End of shape
definition

The following figure is an example of a 16 x 16 dot matrix that you could use to
design an extended Big Font, such as a Kanji character. In the example, the
distance between each dot is one unit. The callout points to a square unit.

height

one square unit 2
G width

The following figure shows examples of Kanji characters. Each character
occupies an MxN matrix (matrices don't have to be square), similar to the one
shown in the previous figure. The numbers above each figure are the associated
shape numbers.

807
..... SEIa
BADF BCES




The following figure shows Kanji primitives.

g9A4  8BCA  8BE0  8C8t
I I AN

ale /

B

6CB3  BCC3  8CFB

U O

Note Not all fonts are defined in a square matrix; some are defined in rectangular
matrices.

Example: Shape Definition File for an Extended Big Font
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Shapes and Shape Fonts > Create Shape Definition Files > Big Font
Descriptions >

Use Big Font Text in a Drawing
| Concor | (IRGGEEE|

To use a Big Font for drawing text, you set up a text style and then specify the
name of the Big Font file.

To use a Big Font for drawing text, you must set up a text style by using the
STYLE command and then specify the name of the Big Font file. The same text
style can use a normal ASCII font as well; enter only the two file names,
separated by a comma. The following example uses the command prompt
version of the STYLE command. To enable Big Fonts from the Text Style dialog
box, choose the Use Big Font option.

Command: -style

Enter name of text style or [?] <current>: style_name

Specify full font name or font file name (TTF or SHX): txt,greek

AutoCAD assumes that the first name is the normal font and that the second is
the big font.

If you enter only one name, AutoCAD assumes it is the normal font and removes
any associated Big Font.

By using leading or trailing commas when specifying the font file names, you
can change one font without affecting the other, as shown in the following table.

N T

normal, big Both normal and Big Font specified

normal, Normal font only (Big Font unchanged)



,big Big Font only (normal font unchanged)

normal Normal font only (if necessary, Big Font
removed)

ENTER (null response)  No change

When you use the STYLE command to list styles or to revise an existing style,
AutoCAD displays the normal font file, a comma, and the Big Font file. If the
style has only a Big Font file, it is displayed with a leading comma: ,greek.

For each character in a text string, AutoCAD searches the Big Font file first. If
the character is not found there, the normal font file is searched.
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Shapes and Shape Fonts > Create Shape Definition Files > Big Font
Descriptions >

Use a Big Font to Extend a Font
| Concept || ISEESISEC|

To include special symbols in text strings, you can use a Big Font instead of
extending a standard text font.

In some drafting disciplines, many special symbols can appear in text strings.
The AutoCAD standard text fonts can be extended to include special symbols.
However, extending standard text fonts has several limitations:

m  The number of shapes is 255 per font file.

m  Standard character set uses almost half the available shape numbers.
Only codes 1 through 9, 11 through 31, and 130 through 255 are
available.

m  Multiple text fonts require duplication of the symbol definitions in each
font.

m  Special symbols require that you enter %%nnn, where nnn is the
symbol's shape number.

The Big Font mechanism avoids these problems. You can select one or more
seldom-used characters, such as the tilde (7) or the vertical bar (|), as an escape
code, and use the next character to select the appropriate special symbol. For
instance, you can use the following Big Font file to draw Greek letters by
entering a vertical bar (|, ASCII code 124) followed by the equivalent Roman
letter. Because the first byte of each character is 124, the character codes are
biased by 124 x 256, or 31744.

*BIGFONT 60,1,124,124
*0,4,Greek

above, below, modes, 0
*31809, n, uca
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Shapes and Shape Fonts > Create Shape Definition Files >

Unicode Font Descriptions
[ concepe | IRCEETNNE)

A single Unicode font, due to its large character set, is capable of supporting all
languages and platforms. Unicode shape definition files are virtually identical in
format and syntax to regular AutoCAD shape definition files.

The main difference is in the syntax of the font header as shown in the following
code:

*UNIFONT, 6, font-name
above, below, modes, encoding, type, O

The font-name, above, below, and modes parameters are the same as in
regular fonts. The remaining two parameters are defined as follows:

encoding
Font encoding. Uses one of the following integer values.
0 Unicode
1 Packed multibyte 1
2 Shape file

type
Font embedding information. Specifies whether the font is licensed. Licensed
fonts must not be modified or exchanged. Bitcoded values can be added.

0 Font can be embedded
1 Font cannot be embedded
2 Embedding is read-only

Another important difference is the handling of the code 7 subshape reference. If
a shape description includes a code 7 subshape reference, the data following the
code 7 is interpreted as a two-byte value. This affects the total number of data



bytes (defbytes) in the shape description header. For example, the following
shape description is found in the romans.shp file:

*00080, 4, keuroRef
7,020AC, 0

The second field in the header represents the total number of bytes in the shape
description. If you are not used to working with Unicode font descriptions, you
may be inclined to use three bytes rather than four, but this would cause an error
during the compiling of the SHP file. This is true even if the shape number you
are referencing is not in the two-byte range (below 255); the compiler always
uses two bytes for this value, so you must account for that in the header.

The only other difference between Unifont shape definitions and regular shape
definitions is the shape numbers. The Unifont shape definitions that AutoCAD
provides use hexadecimal shape numbers as opposed to decimal values.
Although hexadecimal numbers are not required, their use makes it easier to
cross-reference the shape numbers with the \U+ control character values.
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Shapes and Shape Fonts > Create Shape Definition Files >

Superscripts and Subscripts in SHX Files
IR v (|| ik Rernce |

You can modify shape definition files to improve their ability to display
superscripts and subscripts.

The AutoCAD SHX fonts have limited superscript and subscript capabilities.
However, it is relatively easy to modify shape definition files to improve
superscript and subscript capability.

Creating superscripts and subscripts requires two steps. First, the “imaginary
pen” that is creating the text, vector by vector, on your screen needs to be shifted
up or down. Then, the font “scale” needs to be reduced. In addition, the reverse
process has to take place to return to the normal font. The font needs to
recognize four new keys: two for superscripts and two for subscripts. To avoid
altering the existing font definitions, you can access these with the numeric
keypad on your keyboard.
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Shapes and Shape Fonts > Create Shape Definition Files > Superscripts and
Subscripts in SHX Files >

Superscripts and Subscripts in SHX Files
[ Concept | | || QK Reference |

To add superscript and subscript definitions to a font

This example procedure is based on the AutoCAD Romans font file, although a
similar method applies to any AutoCAD font. This procedure adds four new
shape definitions to a font: super_on, super_off, sub_on, and sub_off, which
control the position and size of the characters that follow. For simplicity, this
example replaces the left- and right-bracket characters ([and]) and the left and
right curly brace characters ({and}) with the new characters. You may choose to
replace other characters or use a shape number in the extended range (ASCII
codes 128 through 256). If you use an extended shape number, you need to use
the %%nnn method (where nnn is the ASCII value of the character) for placing
the new characters.

1. Edit your SHP file with an ASCII text editor.

2. Search for the shape definitions of the characters you are replacing. To
comment out those definitions so the new definitions can take their
place, insert a semicolon in front of each line of the shape definition. The
shape definition may continue for a number of lines.

The left- and right-bracket characters have ASCII values of 91 and 93
(05B and 05D hex values, if the font is Unicode). The left and right curly
brace characters have ASCII values of 123 and 125 (07B and 07D hex).

3. Add the first and second values on the second line of the definition, and
divide the total by 2 as shown in the following example:

*UNIFONT, 6,Extended Simplex Roman for UNICODE
21,7,2,0 21 + 7 = 28, then 28 / 2 = 14. This number is used 1



4. Add the following lines to the end of the SHP file:

*91, 8, super_on

2,8,(0,14),003,2,1,0

*93, 8, super_off

2,004,2,8,(0,-14),1,0

*123,8, sub_on

2,8,(0,-14),003,2,1,0

*125, 8, sub_off

2,004,2,8,(0,14),1,0

Notice the 14 and -14 values in the preceding lines. They are Y axis
offsets for the imaginary pen. The value 14 is half the maximum height
of a character in this font, which is the correct approximation for
superscripts and subscripts. This value needs to be calculated for each

font file, but you can modify it any way you want.
5. Save the file.
6. Use the COMPILE command to compile the SHP file.

Once the shape is compiled and an appropriate style is defined, you can
access the new pen-up and pen-down commands by entering the [, ], {,
and } characters. The [ character initiates superscript and the ] character
returns from superscript to normal. The { character initiates subscript
and the } character returns from subscript to normal.
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Basic Customization > Customize a Publish to Web Template >

Customize a Publish to Web Template
[ concere ||| cuic Refeence |

To create quick access to the Publish to Web templates
1. Click Tools menu » Options.

2. In the Options dialog box, Files tab, click the plus sign (+) next to
Template Settings. Then click the plus sign next to Drawing Template
File Location.

3. Move the cursor to the path name that is displayed and click inside it,
and press F2, and press CTRL+C to copy it.

4. Click OK or Cancel to close the Options dialog box.
5. Click File menu » Open.

6. In the Select File dialog box, right-click an empty area in the vertical
panel on the left side, and click Add on the shortcut menu.

7. Enter a name in the Item name box (for example, Templates).

8. Press CTRL+V to paste the path into the Item Path box, and click OK.

You can now access the Template folders by clicking the button in the
left panel of the Select File dialog box.
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Customize the User Interface > Customize Quick Properties >

Customize Quick Properties

[ conce || L] vk Rooronce |

To control which object types are used with the Quick Properties panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select Quick Properties.

=-{l] ACAD
EI@ Workspaces
¢ %% 2D Drafting & Annotation Defautt (cument)

%% 3D Modeling
"= Toolbars

{ﬁI Menus

--E| Ribbon Tabs
#-875 Ribbon Panels

- Quick Properties

- Rollover Toottips K
%] Shortcut Menus

-2 Keyboard Shortcuts

E& Double Click Actions

3. In the Objects pane, click Edit Object Type List.

= o]
~ [H| General
3 Point Angular Dimensicn Color
Aligned Dimension Layer
Angular Dimension 7] Linetype
Arc .
Arc Length Dimension [C] Linetype scale
Block Reference [C] Plot style
Circle [] Lineweight




4. In the Edit Object Type List dialog box, select the object type you want
to display properties for on the Quick Properties panel.

& Edit Object Type List
[ 2D Polyline =
3 Point Angular Dimensicn
[ 30 Face
[C] 20 Polyline
~ [£13D Solid
[ Box
[C] cone
[C] cylinder
[T Pyramid
[C] sphere
[ Terus
[C] wedge
[ Extrusion
[C] Sweep
[[] Revolve
[ Loft
[C] None -

| ok || cancel

&, Edit Object Type List
[C] 20 Polyline
3 Point Angular Dimensicn
[C] 3D Face
[C] 20 Polyline
[£] ACADPROXY_ENTITY
Aligned Dimension
[C] Alignment Grip
[C] Alignment Parameter
Angular Dimension
Arc
Arc Length Dimension
[C] Array Action
[C] Attribute

8

L3

ok || Cancel




If an object type is checked, the properties for the object type are
displayed on the Quick Properties panel when an object of the same type
is selected in the drawing window. Clear the check mark next to an
object type to remove support for the object type from the Quick
Properties panel.

5. Click OK.

6. In the Customize User Interface Editor, click Apply.
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Customize the User Interface > Customize Quick Properties >

Customize Quick Properties

[ conce || L] vk Rooronce |

To control the display of a property for an object on the Quick Properties
panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select Quick Properties.

=] ACAD
=48 Workspaces
. 4% 2D Drafting & Annatation Default (cument)
~43 3D Modeling
i ek AutoCAD Classic
%= Toolbars
- Menus
[#-£=3 Ribbon Tabs
-85 Fibbon Panels
- Quick Properties
- Rollover Toottips R
%] Shortcut Menus
-2 Keyboard Shortcuts
i& Double Click Actions

3. In the Objects pane, select an object from the Object Type list.

4. In the Properties pane, select the properties you want displayed for an
object type on the Quick Properties panel.



__ ¢ [H General

3 Point Angular Dimension b [ 3D Visualization

Aligned Dimension s Geomelry

Angular Dimension Center X

Arc

Arc Length Dimension ekl

Bleck Reference [] Center Z
Radius

Diametnc Dimension Diameter

\I.-llatd;d ) i Circumferance

ogg imension .

Leader i

e [C] Mormal X

MText [] Mormal ¥

Multileader [C] Mormal Z

If a property is checked, the property is displayed on the Quick
Properties panel when an object of the same type is selected in the
drawing window. Clear the check mark next to a property to remove the
property for the selected object type from the Quick Properties panel.

5. Click Apply.
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Customize the User Interface > Customize Quick Properties >

Customize Quick Properties

[ conce || L] vk Rooronce |

To control the display of custom properties and attributes for block
references on the Quick Properties panel

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select Quick Properties.
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3. In the Objects pane, select Block Reference from the Object Type list.
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4. In the Properties pane, select the check box next to Custom and
Attributes.

If the Custom category is checked, the dynamic properties for a block
are displayed on the Quick Properties panel. If the Attributes category is
checked, the attributes for a block are displayed on the Quick Properties
panel

5. Click Apply.

Please send us your comment about this page



javascript:doComments('./html/ac.cmtdialog.htm');

Customize the User Interface > Customize Quick Properties >

Customize Quick Properties
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To override the general properties for all object types

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select Quick Properties.
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3. In the Properties pane, select the check boxes next to the general
properties you want the Quick Properties panel to display for all object

types.
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Layer

[7] Linetype

[7] Linetype =cale
[] Plot style

[7] Lineweight
[] Hyperlink

4. Click Reset Overrides.

| Reset Overrides

The on/off state of general

properties can be shared with all

v | defined object types in the
current CUI file using the Reset
Ovemndes button.

I
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5. Click Apply.
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Customize the User Interface > Customize Quick Properties >

Customize Quick Properties
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To restore the default settings for Quick Properties

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Quick Properties.

3. Click Restore Default.
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""" 1= Restore Default
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4. Click Restore the Default Quick Properties Settings.



,& Quick Properties-Restore Default

; You have chosen to replace your Quick
—  Properties settings with the default settings.

What do you want to do?

< Restore the default Quick Properties

settings
All custom settings will be lost

< Keep the custom settings

Cancel

5. Click Apply.
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Customize the User Interface > Customize Quick Properties >

Customize Quick Properties
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To synchronize Quick Properties with rollover tooltips

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Quick Properties.

3. Click Synchronize with Rollover Tooltips.

--Ej Ribbon Panels ‘ ‘l

.

""" F= Rall Restore Default
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4. Click Apply Rollover Tooltips Settings to Quick Properties Panel.



Quick Properties-Synchronize with Rollover Tooltips

You can synchronize settings for Quick Properties panel and
Rollover Tooltips. What do you want to do?

The Quick Properties panel and Rollover Tocltips will display the same
properties after synchronization. Any changes made to Quick Properties panel
or Rollover Tooltips after synchronization will not be shared.

< Apply Rollover Tooltips settings to Quick Properties
panel

< Apply Quick Properties settings to Rollover Tooltips

5. Click Apply.
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Customize the User Interface > Customize Rollover Tooltips >
Customize Rollover Tooltips
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To control which objects support rollover tooltips

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select Rollover Tooltips.
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3. In the Objects pane, click Edit Object Type List.
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4. In the Edit Object Type List dialog box, select the object type you want
to display properties for on a rollover tooltip.

& Edit Object Type List
[ 2D Polyline =
3 Point Angular Dimensicn
[ 30 Face
[C] 20 Polyline
~ [£13D Solid
[ Box
[C] cone
[C] cylinder
[T Pyramid
[C] sphere
[ Terus
[C] wedge
[ Extrusion
[C] Sweep
[[] Revolve
[ Loft
[C] None -

| ok || cancel

&, Edit Object Type List
[C] 20 Polyline
3 Point Angular Dimensicn
[C] 3D Face
[C] 20 Polyline
[£] ACADPROXY_ENTITY
Aligned Dimension
[C] Alignment Grip
[C] Alignment Parameter
Angular Dimension
Arc
Arc Length Dimension
[C] Array Action
[C] Attribute

8

L3

ok || Cancel




If an object type is checked, the properties for the object type are
displayed on a rollover tooltip when the cursor hovers over an object of
the same type. Clear the check mark next to an object type to remove
support for the object type from rollover tooltips.

5. Click OK.

6. In the Customize User Interface Editor, click Apply.
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Customize the User Interface > Customize Rollover Tooltips >
Customize Rollover Tooltips
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To control which properties are displayed on a rollover tooltip

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select Rollover Tooltips.
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3. In the Objects pane, select an object from the Object Type list.
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4. In the Properties pane, select the properties you want displayed for an
object type on a rollover tooltip.

If a property is checked, the property is displayed on a rollover tooltip
when the cursor hovers over an object of the selected type in the drawing
window. Clear the check mark next to a property to remove the property
for the selected object type from a rollover tooltip.

5. Click Apply.
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Customize the User Interface > Customize Rollover Tooltips >
Customize Rollover Tooltips
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To override the general properties for all object types that support rollover
tooltips

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, select Rollover Tooltips.
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3. In the Properties pane, select the check boxes next to the general
properties you want rollover tooltips to display for all object types.
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4. Click Reset Overrides.

| Reset Overrides

The on/off state of general

properties can be shared with all

v | defined object types in the
current CUI file using the Reset
Ovemndes button.

I

[M][Heb]@)_:

5. Click Apply.
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Customize Rollover Tooltips
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To restore the default settings for rollover tooltips

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Rollover Tooltips.

3.

Click Restore Default.

--Ej Ribbon Panels

m

Restore Default

Synchronize with Quick Properties

Find...

Replace...

4. Click Restore the Default Rollover Tooltips Settings.



~

,& Rollover Tooltips-Restore Default

4. You have chosen to replace your Rollover
— Tooltips settings with the default settings.

What do you want to do?

< Restore the default Rollover Tooltips

settings
All custom settings will be lost

< Keep the custom settings

Cancel

5. Click Apply.
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Customize the User Interface > Customize the Quick Access Toolbar >

Customize the Quick Access Toolbar
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To add a command to the Quick Access toolbar

. Click Tools tab » Customization panel » User Interface. i

. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

. Select the workspace that you want to modify.

=-{l] ACAD
Elf:ﬂ Workspaces
¢ %% 2D Drafting & Annotation Defautt (cument)

€% 3D Modeling

. Under the Workspace Contents pane, click the plus sign (+) next to the
Quick Access Toolbar node to expand it.

. Under the Command List pane, drag the command you want to add to
the Quick Access toolbar from the Command List pane to the Quick
Access Toolbar node under the Workspace contents pane.
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IEl Customize User Interface =
Customize | Transfer
‘ Customizations in All CUI Files 5‘ Workspace Contents o
- [ Customize Workspace ]
Command List: =3 E\ﬁ‘ MyWorkspace
,a (-7 Quick Access Toolbar
g New
[ All Commands -] & * % Open...
¢ Save
Command Source - /*’?* E'UZI
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[-%= Toolbars
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A splitter bar will be displayed between under Quick Access Toolbar
node to indicate the location where the command will be added when the
pointing device button is released.

6. Once the splitter bar is in the location you want to insert the command,
release the pointing device button.

7. Click OK.

Please send us your comment about this page
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Customize the User Interface > Add Shortcut Keys and Temporary Override
Keys >

Add Shortcut Keys and Temporary Override Keys
[Corcr | B[ o e |

To create a shortcut key

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, click the plus
sign (+) next to Keyboard Shortcuts to expand it.

3. Click the plus sign (+) next to Shortcut Keys to expand it.

4. In the Command List pane, drag the command to the Shortcut Keys node
of the Customizations In <file name> pane.

=22 Keyboard Shortouts

- -] Shortcut 4

@ Temporany ide Keys
E& Double Click ns

- Mouse Buttons

& LISP Files

-9 Legacy

-] Partial CUI File
|
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Command List: [ o
| All Commands | »| * ®
|
Command Source |i|
28 Revision Cloud ACAD
=" Ribbon ACAD

In the Properties pane, the properties for the new shortcut key you
created are displayed.

5. In the Key(s) box, click the [...] button to open the Shortcut Keys dialog



box.

H General
MName Revigion Cloud
EH Command
Description Creates a revision cloud using a pg

Extended Help File
Command Display Name REVCLOUD

Macro “CC_revcloud
Tags
H Access

E Advanced

6. In the Shortcut Keys dialog box, click in the Press New Shortcut Key
box to ensure the box has focus.

Shortcut Keys

Press new shortcut key:
|

Currently assigned to:
[unassigned]

| Cancel | | ok |

7. Hold down the modifier key CTRL with a combination of SHIFT and
ALT if desired and press a letter, number, function, or virtual key. Valid
modifier and key combinations include the following:

m Function (Fn) keys containing no modifiers
m Number Pad (NUMPADRN) keys containing no modifiers

m CTRL+letter, CTRL+number, CTRL+function, CTRL+virtual
key

s CTRL+ALT+letter, CTRL+ALT+number, CTRL+ALT+function,
CTRL+ALT+virtual key

m CTRL+SHIFT+letter, CTRL+SHIFT+number,
CTRL+SHIFT+function, CTRL+SHIFT+virtual key

s CTRL+SHIFT+ALT+letter, CTRL+SHIFT+ALT+number,
CTRL+SHIFT+ALT+function, CTRL+SHIFT+ALT+virtual key

Note The virtual keys that are supported are Escape, Insert, Delete,



Home, End, Page Up, Page Down, Left Arrow, Right Arrow, Up
Arrow, and Down Arrow. The virtual key Escape can only be
used by itself or with the modifier combination
CTRL+SHIFT+ALT.

Under the Press New Shortcut Key box, Currently Assigned To displays
any current assignments for the shortcut key.

8. If you do not want to replace the current assignment, use a different
shortcut key. Otherwise, click OK to assign the shortcut key and close
the Shortcut Keys dialog.

9. In the Customize User Interface Editor, click OK.

Please send us your comment about this page
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Customize the User Interface > Add Shortcut Keys and Temporary Override
Keys >

Add Shortcut Keys and Temporary Override Keys
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To modify a shortcut key

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, click the plus
sign (+) next to Keyboard Shortcuts to expand it.

3. Click the plus sign (+) next to Shortcut Keys to expand it.
4. Click a shortcut key.

t-JEl) Shortcut Menus
-2 Keyboard Shortcuts
. =] Shortcut Keys
- T Hypedink...
--Jia] Revision Cloud
--Jal Toggle HIDEPALETTES

In the Properties pane, the properties for the shortcut key you selected
are displayed.

5. In the Key(s) box, click the [...] button to open the Shortcut Keys dialog
box.



E General

MName Revigion Cloud
EH Command
Description Creates a revision cloud using a pg

Extended Help File
Command Display Name REVCLOUD

Macro “CC_revcloud
Tags
H Access
[ZE N CTRL+SHIFT+R o

E Advanced

. Hold down the modifier key CTRL with a combination of SHIFT and
ALT if desired and press a letter, number, function, or virtual key. Valid
modifier and key combinations include the following:

Function (Fn) keys containing no modifiers
Number Pad (NUMPADR) keys containing no modifiers

CTRL+letter, CTRL+number, CTRL+function, CTRL+virtual
key

CTRL+ALT+letter, CTRL+ALT+number, CTRL+ALT+function,
CTRL+ALT+virtual key

CTRL+SHIFT+letter, CTRL+SHIFT+number,
CTRL+SHIFT+function, CTRL+SHIFT+virtual key

CTRL+SHIFT+ALT+letter, CTRL+SHIFT+ALT+number,
CTRL+SHIFT+ALT+function, CTRL+SHIFT+ALT+virtual key

Note The virtual keys that are supported are Escape, Insert, Delete,
Home, End, Page Up, Page Down, Left Arrow, Right Arrow, Up
Arrow, and Down Arrow. The virtual key Escape can only be
used by itself or with the modifier combination
CTRL+SHIFT+ALT.

Shortcut Keys

Press new shortcut key:

CTRL+5HIFT=R)

Currently assigned to:
[unassigned]

Cancel | | oK




Below the Press New Shortcut Key box, Currently Assigned To displays
any current assignments for the key.

7. 1f you do not want to replace the current assignment, use a different
shortcut key. Otherwise, click OK to assign the shortcut key and close
the Shortcut Keys dialog.

8. In the Customize User Interface Editor, click OK.
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Customize the User Interface > Add Shortcut Keys and Temporary Override
Keys >

Add Shortcut Keys and Temporary Override Keys
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To create a temporary override key

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, click the plus
sign (+) next to Keyboard Shortcuts to expand it.

3. In the Customizations In <file name> pane, right-click Temporary
Override Keys. Click New Temporary Override.

=20 Keyboard Shortcuts
- [-fiaf Shortcut Keys

i& Double Click Actions Mew Termnporary Override
- Mouse Buttons
..... @ LISP Files Rename
'5' Legacy Delete
&-[F] Partial CUI Files
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A new temporary override (named TemporaryOverridel) is placed at the
bottom of the Temporary Override Keys tree.

4. Do one of the following:
= Enter a new name over the default name TemporaryOverridel.

= Right-click TemporaryOverridel. Click Rename. Enter a new
temporary override name.

m Click TemporaryOverridel, wait, and click again over the
temporary override’s name again to edit its name in-place.



5. Select the new temporary override in the tree view, and update the
Properties pane:

m In the Description box, enter a description for the temporary
override key.

= In the Key(s) box, click the [...] button to open the Shortcut Keys
dialog box. In the Shortcut Keys dialog box, click in the Press
New Shortcut Key box to ensure the box has focus, and press a
key. Valid modifier keys include function (Fn keys) with no
modifiers, SHIFT+letter, or SHIFT+number key.

m In the Macro 1 (Key Down) box, enter a macro to be executed
when the temporary override key is pressed. When no value is
assigned, the default macro is Ac/\c.

m In the Macro 2 (Key Up) box, enter a macro to be executed when
the temporary override key is released. When no value is defined,
key up restores the application to its previous state (before the
temporary override was executed).

Note For information about creating a macro, see Create Macros.

Please send us your comment about this page
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Customize the User Interface > Add Shortcut Keys and Temporary Override
Keys >

Add Shortcut Keys and Temporary Override Keys
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To modify a temporary override key

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, click the plus
sign (+) next to Keyboard Shortcuts to expand it.

3. Click the plus sign (+) next to Temporary Override Keys to expand it.

4. In the Customizations In <file name> pane, click the temporary override
key you want to modify.

G-fEl) Shortcut Menus

EI---_I_I Keyboard Shortcuts

-1 Shortout Keys

: LJ Temporany Overide Keys
B

: Lﬂ Toggles Object Snap Mode

-[&] Toggles Polar Mode

5. Update the Properties pane as necessary:

m In the Description box, enter a description for the temporary
override key.

= In the Key(s) box, click the [...] button to open the Shortcut Keys
dialog box. In the Shortcut Keys dialog box, click in the Press
New Shortcut Key box to ensure the box has focus, and press a
key. Under the Press New Shortcut Key box, Currently Assigned
To displays any current assignments for the key. If a key you
select is not already assigned, click OK.



» In the Macro 1 (Key Down) box, enter a macro to be executed
when the temporary override key is pressed. When no value is
assigned, the default macro is ~Ac/\c.

m In the Macro 2 (Key Up) box, enter a macro to be executed when
the temporary override key is released. When no value is defined,
key up restores the application to its previous state (before the
temporary override was executed).

H General
Mame Toggles Orthogaonal Mode
Description Toggles Orthogonal Mode
B Shoricut
Keyis) F&

Macro 1 (Key Down) “P"_orthomode SM=8{f ${znd, S(ge
Macro 2 (Key Up)

Note For information about creating a macro, see Create Macros.
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Customize the User Interface > Add Shortcut Keys and Temporary Override
Keys >

Add Shortcut Keys and Temporary Override Keys
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To print a list of shortcut keys or temporary override keys

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customizations In <file name> pane, click the Keyboard
Shortcuts node.

----- Cuick Properties

----- *g Rollover Tooltips

-l Shorteut Menus

[=Ea)s] Keyboard Shortcuts

1"g|' Shortcut Keys
Temporary Ovemide Keys
(-4 Double Click Actions

3. In the Shortcuts pane, filter the type and status of keyboard shortcuts to
print.

» In the Type drop-down list, select the type of keyboard shortcuts
to display in the list. Choices include All Keys, Accelerator Keys,
or Temporary Override Keys.

m In the Status list, select the status of keyboard shortcuts displayed
in the list. Choices include All, Active, Inactive, and Unassigned.

4. In the Shortcuts pane, click Print.



Shortcuts

T (Al S r—
Mame Keys Type  Source =

 Clean Screen  CTRL+D Acc.. ACAD 3

 Command Line CTRL+9 Acc.. ACAD

' Copy Clip CTRL+C Acc.. ACAD

o Copywith Ba.. CTRL+SHIF.. Acc.. ACAD

 CTRL+H CTRL+H Acc.. ACAD

 CTRL+R CTRL+R Acc... T

o ot CTRI +X Ace  ACADN X

::upytu::bboa-dhﬁl Print |
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Customize the User Interface > Create a Double Click Action >

Create a Double Click Action
[ concere ||| cuic Refeence |

To create a double click action

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click Double Click Actions.
Click New Double Click Action.

- Keyboard Shortcts
R+ Double Click Actions

- Mouse Buttons New Double Click Action
& LISP Files
- Legacy Paste

&[T Partial CUI Files

Find... =

The new double click action (named DoubleClick1) is placed at the
bottom of the Double Click Actions tree.

3. Do one of the following:
= Enter a new name over the default name DoubleClick1.

m Right-click DoubleClick1. Click Rename. Enter a new double
click action name.

m Click DoubleClick1, wait, and click again over the double click
action’s name again to edit its name in-place.

4. In the Properties pane, do the following:

m In the Description box, enter a description for the double click
action.

» In the Object Name box, enter a DXF name or one of the special



object names used for an inserted object. The value will

automatically be converted to uppercase after the box loses focus.

E General
Mame
Description

B Advanced
Cbject Name
Element ID

DoubleClick 1

DCU_0001

5. In the Command List pane, drag the command you want to add to the

location just below the double click action in the Customizations In <file
name> pane.

Eé #line

gy e

&gy DWF Underlay 4

-y Mouse Buttons i

----- & LISP Files =

]:l:}q Legacy

&[T Partial CUI Files -
f

Command List: /

=1

Note Only a single command can be associated with a double click action
at a time.

6. Click OK.
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Customize the User Interface > Customize Workspaces >
Customize Workspaces
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To create a workspace using the Customize User Interface Editor

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, right-click the Workspaces tree
node, and select New Workspace.

E‘"{_l] ACAD
Y oicpscer
. % 2D Draft Mew Workspace
. %% 3D Mod
L% AutoCAI Rename
E= Toolbars Delete
-5 Menus
[#-F= Fibbon Tabs Paste
-85 Fibban Pan

A new, empty workspace (named Workspace1) is placed at the bottom of
the Workspaces tree.

3. Do one of the following:
= Enter a new name over the default name Workspacel.

m Right-click Workspacel. Click Rename. Then, enter a new
workspace name.

m Click Workspacel, wait, and click again over the workspace’s
name again to edit its name in-place.

4. In the Workspace Contents pane, click Customize Workspace.



Workspace Contents

[ Customize Workspace
Eﬂ[- MyWorkspace
----- SR Guick Access Toolb

== Toolbars
{3 Menus
-85 Palettes

-3 Ribbon Tabs

»

5. In the Customizations In <file name> pane, click the plus sign (+) next
to the Toolbars tree node, Menus tree node, or Partial CUI files tree node
to expand it.

Note The menu, toolbar, ribbon tabs, and partial CUI file nodes now
display check boxes so that you can easily add elements to the
workspace.

6. Click the check box next to each menu, toolbar, panels, or partial CUI
file that you want to add to the workspace.

Customizations in All CUI Files

>

| All Customization Files

=-{l] ACAD -
=48 Workspaces

----- -I:I- 20 Drafting & Annotation Default {cument)

----- £ 30 Modeling

----- LF AutoCAD Classic

----- -I:I- MyWarkspace

E—]El = Toolbars

SR Dimension

SR Draw

SR Draw Crder

SR Inguiny

R Insert

SR Layouts

SR Modify

SR Modify 11

(i im I

In the Workspace Contents pane, the selected elements are added to the
workspace.

m

[ &L T [ T I<[]

-

7. In the Workspace Contents pane, click Done.



Workspace Contents

>

[ Done

Elﬁ My\Workspace
-5 Quick Access Tool
== Toolbars

..... E Modify
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----- SR My Custom Tools
=-[ZE Menus
[ File

8. Click OK.
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Customize the User Interface > Customize Workspaces >
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To create a workspace using the Workspace toolbar

1. Right-click over the Quick Access toolbar or one of the other toolbars
that is currently displayed in the interface.

A shortcut menu is displayed with the available toolbars contained under
the customization group that the toolbar belongs to.

2. Click Workspaces to display the toolbar if it is not currently displayed.

Walk and Fly
Web
Workspaces

Loom

Lock Location r

Customize...

A check mark is displayed to the left of any toolbar that is currently
displayed.

3. Make the necessary changes to the size, location, and any other
properties to the toolbars and palettes that are displayed.

4. On the Workspaces toolbar, select Save Current As.



[l AutoCAD Classic EE
20 Drafting & Annotation =
3D Maodeling
AutoCAD Classic

Save Current As...

Workspace settings...

Customize... -

5. In the Save Workspace dialog box, enter a name in the text box or select
an existing one to overwrite from the drop-down list.

P =

|E| Save Workspace

[
Name:  MyWorkspace] - Save

Cancel

6. Click Save to create or modify the workspace.

Note The Workspaces toolbar will be visible when the workspace is restored. If
the Workspaces toolbar is not visible, click Tools menu » Workspaces » Save
Current As.

Please send us your comment about this page
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To change the properties of a workspace

[
1. Click Tools tab » Customization panel » User Interface.
2. In the Customize User Interface Editor, click the Customize tab.

3. On the Customize tab, in the Customizations In <file name> pane, click
the workspace whose properties you want to change.

=-i] ACAD
=- %8 Workspaces
¢ %% 2D Drafting & Annotation Defautt (¢

4. In the Properties pane, do any of the following;:
= In the Name box, enter a new name for the workspace.
= In the Description box, enter a description.

m In the Start On box, select an option (Model, Layout, Do Not
Change).

m In the Menu Bar box, select an option (On, Off).

= In the Status Bar box, select an option (All Off, Application Only,
All On, Drawing Status Bar Only).

m In the Model/Layout Tab box, select an option (On, Off, Do Not
Change).

m In the Screen Menus box, select an option (On, Off, Do Not



Change).
m In the Scroll Bars box, select an option (On, Off, Do Not

Change).

E General
Mame MyWarkspace
Description

= Display
Start On Model
Menu bar Off
Status bar Application onby
Maodel/Layout tabs On

5. Click OK.
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To modify the Quick Access toolbar

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

3. Select the workspace that you want to modify.

4. In the Workspace Contents pane, click the plus sign (+) next to the Quick
Access Toolbar node to expand it and do the following:

m To add a command, drag the command you want to add to the
Quick Access toolbar from the Command List pane to the Quick
Access Toolbar node.

m To remove a command, right-click the command you want to
remove and click Remove from Workspace.

m To reposition a command, drag it up or down under the Quick
Access Toolbar node.

5. Click OK.

Please send us your comment about this page
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To display menus on the menu browser or menu bar

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

3. Select the workspace that you want to modify.
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4. In the Workspace Contents pane, click Customize Workspace.

Workspace Contents

[ Customize Workspace
EI{I' MyWorkspace (curewt)
-5 Quick Access Toolbgr

==

-7= Toolbars

m Menus

IIIEE Palettra

5. In the Customizations In <file name> pane, click the plus sign (+) next
to the Menus tree node, or Partial CUI files tree node to expand it.

6. Click the check box next to each menu, or partial CUI file that you want
to add to the workspace.



"= Toolbars
=-v| FF Menus

V| =] File
[ Edit
(] View
(] Insert
] Format
] Tools
] Draw
[ Dimension
] Modify
] Window
] Help
Jea] My Custom Tools

In the Workspace Contents pane, the selected elements are added to the
workspace.

RERREREREEEES

7. In the Workspace Contents pane, click Done.

Workspace Contents

[ Done

Elﬁ' My\Workspace (cu
-5 Quick Access Toolbr

Note Make sure to set the workspace current to ensure the changes are
displayed.

8. Click OK.
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To reposition menus on the menu browser or menu bar

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

3. Select the workspace that you want to modify.
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4. In the Workspace Contents pane, click the plus sign (+) next to the
Menus node to expand it.

A splitter bar will be displayed between the pull-down menus indicating
the location the pull-down menu would be moved to when the pointer
button is released.

5. Click and hold down the pointer button over the menu that you want to
move and drag the menu into the new location.

m Diraw
[ Dimension

rT| Madify

e

rT| Express
FTI

EEI--EE Palettes



A splitter bar will be displayed between the menus indicating the
location the menu would be moved to when the pointer button is
released.

6. Once the splitter bar is in the place where you want to insert the menu,
release the pointer button to reposition the menu.

Note Make sure to set the workspace current to ensure the changes are
displayed.

7. Click OK.

My Tools  Window Help
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To display toolbars

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

3. Select the workspace that you want to modify.
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4. In the Workspace Contents pane, click Customize Workspace.

Workspace Contents

[ Customize Workspace
=-4% MyWorkspace (cuest)
5] Quick Access Toolbgr

-7= Toolbars
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5. In the Customizations In <file name> pane, click the plus sign (+) next
to the Toolbars tree node, or Partial CUI files tree node to expand it.

6. Click the check box next to each toolbar, or partial CUI file that you
want to add to the workspace.
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In the Workspace Contents pane, the selected elements are added to the
workspace.

7. In the Workspace Contents pane, click Done.

Workspace Contents

[ Done

=-4% MyWorkspace {cu
i) Quick Access Toolber

Note Make sure to set the workspace current to ensure the changes are
displayed.

8. Click OK.
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To change the properties of a toolbar

--
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the workspace that contains

the toolbar you want to modify.
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3. In the Workspace Contents pane, click the plus sign (+) next to Toolbars
to expand the list.

4. Click the toolbar that you want to modify.

>

Workspace Contents

[ Daone ]

El'ﬁ' My\Warkspace (cument)
----- o Quick Access Toolbar
== Toolbars

»

m,. |

‘i“:l'. Insert -



5. In the Properties pane, do any of the following:

= In the Orientation box, select an option (Floating, Top, Bottom,
Left, or Right).

m (Only if Orientation is set to Floating) In the Default X Location
box, enter a number. A value of 0 starts the location of the toolbar
at the left edge of the screen, as the number increases the further
from the left the toolbar is placed.

m (Only if Orientation is set to Floating) In the Default Y Location
box, enter a number. A value of 0 starts the location of the toolbar
at the top edge of the screen, as the number increases the further
from the top the toolbar is placed.

m (Only if Orientation is set to Floating) In the Rows box, enter a
number. Enter a number to have the buttons on the toolbar wrap
around to create the number of rows if possible. 0 is the default

value.
El Appearance
COrientation Floating
Default X Location 0
Default ¥ Location 0
FRows 1
6. Click OK.
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To display ribbon tabs

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

3. Select the workspace that you want to modify.

=-{l] ACAD
Eli:ﬂ Workspaces
¢ %% 2D Drafting & Annotation Defautt (¢

4% 30 Modeling
-k AutoCAD Classic

4. In the Workspace Contents pane, click Customize Workspace.

Workspace Contents

[ Customize Workspace
=-4% MyWorkspace (cuest)
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-7= Toolbars
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5. In the Customizations In <file name> pane, click the plus sign (+) next
to the Ribbon Tabs tree node, or Partial CUI files tree node to expand it.

6. Click the check box next to each ribbon tab, or partial CUI file that you
want to add to the workspace.
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In the Workspace Contents pane, the selected elements are added to the
workspace.

7. In the Workspace Contents pane, click Done.

Workspace Contents

[ Daone

=4 MyWaorkspace
-5 Quick Access Tool
2= Toolbars

ij Menus

. DD Palettes

=-F=3 Ribbon Tabs
£33 Output
£ Home - 2D
£ Toals
[-F View - 2D

Note Make sure to set the workspace current to ensure the changes are
displayed.

8. Click OK.
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To reposition a ribbon tab on the ribbon

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

3. Select the workspace that has the ribbon tab you want to reposition.

4. In the Workspace Contents pane, click the plus sign (+) next to the
Ribbon Tabs node to expand it.

5. Drag the ribbon tab into the new location.

A vertical indicator bar shows the new location the ribbon tab.

Workspace Contents

.E..>.).‘.. |

[ Daone
=4 MyWorkspace

-5 Quick Access Toolbar

== Toolbars

--[FF Menus

--EE Palettes

=-£75, Ribbon Tabs
(=-F=3 Output
- Home - 2D
&£ Toals

-2 [

6. Once the splitter bar is in the place where you want to insert the ribbon
tab, release the pointing device button.

Note Make sure to set the workspace as current to ensure the changes are



displayed.
7. Click OK.
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To reposition a ribbon panel on a ribbon tab

1. Click Tools tab » Customization panel » User Interface. I

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

3. Select the workspace that you want to modify.

4. In the Workspace Contents pane, click the plus sign (+) next to the
Ribbon Tabs node to expand it.

5. Click the plus sign (+) next to the ribbon tab with the ribbon panel that
you want to reposition to expand it.

6. Click and hold down the pointer button over the ribbon panel that you
want to reposition. Drag the ribbon panel into the new location.

A vertical indicator bar shows the new location the ribbon panel.



>

Workspace Contents
[ Done
EI-¢[- MyWarkspace
-5 Quick Access Toolbar
= Toolbars
TR Menus
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£ Output
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FY

.57 Window

L9 Windows Elemerts

7. Once the splitter bar is in the place where you want to insert the ribbon

panel, release the pointing device button.
Note Make sure to set the workspace as current to ensure the changes are

displayed.
8. Click OK.
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To control the display of ribbon panels for a ribbon tab

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to the
Workspaces node to expand it.

3. Select the workspace that has the ribbon tab for which you want to
change the properties of the ribbon panels.

4. In the Workspace Contents pane, click the plus sign (+) next to the
Ribbon Tabs node to expand it.

5. Click the plus sign (+) next to the ribbon tab for which you want to
change the properties of the ribbon panels.

6. Select the ribbon panel that you want to change.
7. In the Properties pane, do any of the following:

= In the Resize Style box, select an option (Default, NoCollapse, or
CollapseLast).

= In the Show box, select an option (Yes or No).

m In the Orientation box, select an option (Docked or Floating).

El Appearance
Resize Style Default
Show fas
Crrientation docked

8. Click OK.
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To change the properties of a palette

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the workspace that contains
the palette you want to modify.
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3. In the Workspace Contents pane, click the plus sign (+) next to Palettes
to expand the list.

4. Click the palette that you want to modify.

Workspace Contents

>

[ Customize Workspace ]

=T Menus -
EI--EE Palettes

E Command Line -
----- sr SheetSet Manager
-{5% Tool Palette
e
ﬂ Markcup Set Manager
----- M CQuick Cale 5
13| Desian Certer
-l dbConnect Manager
fi] Extemal References
----- % Advanced Render Settings -

m




5. In the Properties pane, do any of the following:

In the Show box, select an option (No, Yes, or Do Not Change).

In the Orientation box, select an option (Floating, Top, Bottom,
Left, or Right).

In the Allow Docking box, select an option (No, Yes, or Do Not
Change).

Note To specify that a window should be anchored, set Orientation
to Left, Right, Top, or Bottom, and set Auto Hide to On.

In the Auto Hide box, select an option (On, Off, or Do Not
Change).

In the Use Transparency box, select an option (No, Yes, or Do
Not Change).

In the Transparency Amount box, enter a number (if applicable).

In the Default Group box, select a Tool Palette group. (Tool
Palettes only)

In the Height box, enter a number. A value of 0 is equivalent to
Do Not Change.

In the Width box, enter a number. A value of 0 is equivalent to Do
Not Change.

El Appearance
Show Mo
COrientation Floating
Allow Docking Yes
Auto Hide Off

B Size
Height 550
\wiidth 280

6. Click OK.
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To duplicate a workspace

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, in the
Customizations In <file name> pane, click the plus sign (+) next to
Workspaces to expand it.

3. Right-click the workspace. Click Duplicate Workspace.
=] ACAD
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Set Default

Rename

Paste

A duplicate of the workspace (named Copy of <workspace name>) is
placed at the bottom of the Workspaces tree).

4. Do one of the following:

m Enter a new name over the default name Copy Of <workspace



name>.

m Right-click Copy Of <workspace name>. Click Rename. Enter a
new name for the workspace.

m Click Copy Of <workspace name>, wait, and click again over the
workspace’s name again to edit its name in-place.

5. Modify the workspace as necessary.

6. Click OK.
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To set a workspace current

.
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, click the plus
sign (+) next to Workspaces to expand it.

3. Right-click the workspace you want to set current. Click Set Current.
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4. Click OK.
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To set a workspace as default

[ B
1. Click Tools tab » Customization panel » User Interface.

2. In the Customize User Interface Editor, Customize tab, click the plus
sign (+) next to Workspaces to expand it.

3. Right-click the workspace you want to set as default. Click Set Default.
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4. Click OK.

Note In the Network Deployment Wizard, the main and enterprise CUI files can
be specified. If the main CUI file has a default workspace set, the default
workspace will be set as the current workspace when the file is loaded into
AutoCAD the first time.
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To restore a workspace with a command line switch

1. Right-click the program icon on the Windows desktop. Click Properties.

A

AutoCAD
2009

Open

Open file location

Enable/Disable Digital Signature Icons
@ Run as administrator

Scan for Viruses...
Restore previous versions
Send To [

Cut
Copy
Create Shortcut

Delete

Rename

Properties

2. In the AutoCAD Properties dialog box, Shortcut tab, in the Target box,
edit the parameters for the switch using the following syntax:

“drive:pathname\acad.exe” [“drawing name”] [/switch “name”

For Example, enter “d:\AutoCAD 2009\acad.exe” /w “MyWorkspace”



=

# AutoCAD 2009 Properties
> PE

Security I Details | Previous Versions
General | Shorteut | Compatibility

@ AutoCAD 2009

Target type: Application

Target location: AutoCAD 2005

Target: "C:\Program Files'AutoCAD 2005 acad exe”

Start in: “C-\Program Files\AutoCAD 2009\ UserDataCach

Shortout key: .Nune

Run: | Normal window -
Comment: LaEch acad.exe
[ Open File Location ] [ Change lcon... ] [ Advanced... ]
oK || Canced || ooy
3. Click OK.
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